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Introduction

Laptop owners are special people.

You see, a laptop owner demands everything from a computer that a desktop
owner does: reliability, performance, expandability, and ease of use. Owners
of Mac Pro, Mac mini, and iMac desktop computers can draw the line right
there, because their computers are designed for a stationary existence. But
you and I are laptop owners. We also need that same computer to be an inch
thick (or less). We demand that it run for hours on a single battery charge.
We require that it be light as a feather. We want to conquer the coffee shop,
the library, and even a lecture hall or two!

Today’s Apple laptops deliver all that and more. If you’ve bought one of these
modern masterpieces — or you're thinking about it — I applaud your good
taste, common sense, and discerning eye. Apple laptops have everything:
super performance, a top-shelf LED screen, rugged reliability, and a trouble-
free, powerful operating system. Heck, your Intel-based Apple laptop can
even run — wait for it — Windows 7, 8, or 10. (If you absolutely have to, the
option is there.)

[ wrote this book for myself — and for every other Apple laptop owner who
wants to become a laptop techno-wizard. In these pages, you find a guide

to both your laptop’s hardware and OS X El Capitan, the latest version of
Apple’s superb operating system. After I cover the basics that every laptop
owner should know, you find out how to accomplish all sorts of cutting-edge
audio, visual, and Internet projects. (Oh, and if you already have another of
my books, you know that I don’t skimp on the power-user tips and tricks that
save you time, effort, and money.)

Foolish Assumptions

So who is the target audience for this book? As in past editions, | make no
assumptions about your previous knowledge of computers and software.

[ figure you've either just bought a MacBook or you're considering buying
one. Perhaps you’ve found a bargain on a gently used older MacBook, and
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you need guidance as you learn the ropes. Those are the only assumptions

I make. And unlike other books that require a lot of technical expertise to
understand, this book’s only requirement is your desire to become a Mac
laptop power user (someone who produces the best work in the least amount
of time and has the most fun doing it)!

By the way, if your friends and family predicted that you'll spend half your
life savings on software — or that no “decent” software is available for Mac
computers — just smile quietly to yourself! The MacBook comes complete
with as much software as any Windows box, and the free applications bun-
dled with your MacBook are better than anything available on a PC!

This book was written using one of the latest Intel quad-core MacBook
models, so owners of older Mac laptops might not be able to follow along
with everything I cover. However, if you've upgraded an older MacBook
with OS X El Capitan, you should be able to use most of this book with
no problem.

About This Book

In writing about the MacBook, I've kept one precept firmly in mind: OS X El
Capitan, the operating system you’ll run, is just as important as the laptop
itself. Therefore, you'll find that MacBook For Dummies is just as much about
familiarizing you with all the software you get as it is with introducing you
to hardware features like the keyboard and trackpad. After all, it’s relatively
easy to connect a power cable and turn on any new computer. What comes
next is the challenging part!

As in my other For Dummies titles, I respect and use the same everyday lan-
guage you do, avoiding jargon, ridiculous computer acronyms, and confusing
techno-babble whenever possible.

If you're upgrading from a PC running the Windows operating system, I've
got tips, tricks, and entire sections devoted to those hardy pioneers called
Switchers. You discover both the similarities and differences between your
MacBook running El Capitan and a PC running Windows. I also show you how
to make the switch as easily and quickly as possible.

A word about the conventions I use: Even with an absolute minimum of
techno-speak, this book needs to cover the keys you have to press or menu
commands you have to choose to make things work. Therefore, please keep
in mind this short list of conventions as you read:
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v~ Stuff you type: If | ask you to type (or enter) something, such as in a text
box or field, that text appears in bold, like this:

SONBER Type me.
&
You usually have to press Return before anything happens.

» Menu commands: I list menu paths and commands using another
format. For example, this instruction indicates that you should click the
Edit menu and then choose the Copy menu item:

Edit=> Copy

1+ Web addresses: No up-to-date book on a computer would be complete
without a bag full of web addresses for you to check out. When you see
these in the text, they look like this: www.mlcbooks . com. (By the way,
that website does exist. You’re always welcome to check out my little
acre of web space!)

v For the technically curious: Your MacBook is an elegant and sophisti-
cated machine, and as easy to use as a computer can be. But from time
to time, you may be curious about the technical details that surround
your hardware and software. (Perhaps you disassembled alarm clocks as
a kid, like I did.) Techie stuff is denoted with a margin icon, as discussed
in the next section. You don’t have to read the technical notes unless
you want to know what makes things tick. (Pun by sheer accident.)

lcons Used in This Book

Like other technology authors, I firmly believe that important nuggets of
wisdom should stand out on the page! With that in mind, this For Dummies
book includes a number of margin icons for certain situations:

A\

This is the most popular icon in the book. You find it parked next to sugges-
tions [ make to save you time and effort (and even cash!).

You don’t have to know this information, but the technologically curious love
high-tech details. (Of course, we're great fun at parties, too.)

¥ Always read this information before you take action! I'm discussing
something that could actually harm your hardware or throw a plumber’s
helper into your software.
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Consider these nuggets to be highlighter stuff — not quite as universally
accepted (or as important to the author) as a Mark’s Maxim (described
next), but good reminders nonetheless. [ use this icon to reinforce what you
should remember.

These gold-plated, cream-of-the-crop truisms are easily spotted: Just look
for the likeness of my rugged, MacBook-lovin’ mug. These are MFRs (short
for My Favorite Recommendations). In fact, I'll bet just about any MacBook
power user would tell you the same. Follow my Maxims to avoid the
quicksand and pitfalls I’ve encountered with all sorts of Macs for almost
three decades.™

Beyond the Book

Thanks to my hard-working good friends at Wiley, a ton of extra content
accompanies this book. Fire up your Safari browser and go online to find the
following:

1 Cheat Sheet: ['ve created a number of Cheat Sheet pages that cover

things like common keystrokes and maintenance procedures that every
MacBook owner should follow on a regular basis. You'll find them on the
web at www.dummies.com/cheatsheet/macbook.

+* Dummies.com online articles: At the beginning of each major part of

the book, you'll find a link to Dummies.com and articles that extend the
content covered in this book. This additional content includes all sorts
of different topics: tips on using Photo Booth, a discussion of the effec-
tiveness of reinstalling OS X, making a call with FaceTime, streaming
music with AirPlay, and even my history of Data Elves! (You’ll have to
read online to learn more about the Elves.) These articles also appear on
the book’s Extras page (www.dummies.com/extras/macbook).

+* Bonus chapters: If you're dying to find out how to share data among

wireless devices via Bluetooth technology, check out the handy
Bluetooth bonus chapter at the Wiley website (www . dummies . com/
extras/macbook) or at my website (www.mlcbooks . com). You'll
also find a spiffy bonus chapter dedicated to running Windows on your
MacBook using Boot Camp.

v~ Updates to this book, if we have any, are at

www .dummies .com/extras/macbook


http://www.dummies.com/cheatsheet/macbook
http://www.dummies.com/extras/macbook
http://www.dummies.com/extras/macbook
http://www.dummies.com/extras/macbook
http://www.mlcbooks.com/
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Where to Go from Here

Each chapter is a reference for a specific hardware or software topic. As fruit
of the hard work of my editors, you can begin reading anywhere you like,
because each chapter is self-contained. However, if you want to get the most
out of this tome (and your MacBook experience), there’s nothing wrong with
reading this book from front to back. I warn you, however, that J. K. Rowling
and Stephen King have nothing to fear from my no-frills prose!

Time for the first Mark’s Maxim in this book:

Take your time. After all, learning how to use your MacBook isn’t a race.
And don’t worry if you’re not a graphic artist, professional photogra-
pher, or video editor. With your Mac laptop and its software, you don’t
have to be!™
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In this part . . .

Tour the features of your MacBook and OS X El Capitan.
Compare the different MacBook models.

Unpack and set up your MacBook.

Maintain your laptop’s battery The Right Way.

Familiarize yourself with the basics of 0S X.




Chapter 1

Hey, It Really Does Have
Everything | Need

In This Chapter
Identifying the important parts of your Mac laptop
Comparing the different MacBook models
Finding the best location for your computer
Unpacking, plugging in stuff, and getting hooked up
Playing with your bundled software
Buying additional stuff you might need

M ost action films have one scene in common: I call it “gearing up,”
because the good guys strap on their equipment in preparation for

battle. (The era doesn’t matter: You see “gearing up” scenes in Gladiator,
Aliens, and virtually every movie Arnold has made.) You're sure to see lots
of clicking straps and equipping of offensive weapons (and sometimes even
a dash of war paint). The process usually takes a minute or so, all told with
whiplash camera work and stirring martial music in the background.

Well, fellow Mac road warrior, it takes only two seconds and one move —
closing the lid — for you to gear up. That’s because your MacBook is a self-
contained world, providing virtually all the essentials you’ll find on a desktop
iMac or Mac mini. This is indeed the decade of the laptop, meshing nicely
with your cellphone and that wireless connection at your local coffee shop.
You have selected the right companion for the open road.

Unlike some of Apple’s other designs, such as the Mac mini and the iMac,
your MacBook looks similar to a PC laptop running Windows. (In fact, an
Intel-based Mac laptop can run Windows if you absolutely must.) But your
laptop holds a number of pleasant surprises that no PC laptop can offer —
and, with the MacBook, MacBook Air, and MacBook Pro Retina, you’ll lose
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pounds and inches from your chassis! In this chapter, I introduce you to the
hardware and all the major parts of the machine. You even find out how to
unpack and connect your computer. And, as frosting on the cake, I preview
the software of which Apple is so proud, as well as the accessories you

should buy now rather than later.

Welcome to your Mac laptop, good reader. Gear up!

An Overview of Your Mac Laptop

Sure, your MacBook Pro might be about an inch thin (a MacBook, MacBook
Air, and MacBook Pro Retina are even more svelte than that — I get to that

later in the chapter), but a lot of superb design lives inside. You encounter

the same parts you’'d find in a desktop machine. In the following sections,

[ discuss those important parts — both the stuff you can see and the stuff

shoehorned within.

Are you using an older MacBook? It seems
that Apple’s product line changes every time
you tear a page from your 12-month calendar.
In addition, every new generation of laptops
includes new whiz-bang features. Sometimes
you can add those features separately to
your older machine, such as an external video
camera, but you can't update some things, such
as your MacBook's motherboard. Sigh.

Here's my take on this situation: If your older
laptop does what you need at a pace you can
accept, there’s no need to upgrade it.

Skeptical? Here's the proof: Before my upgrade
to a MacBook Air, yours truly was lugging
around a pristine iBook G3, which booted
0S X Tiger and did absolutely everything
| demanded. (A little more patience was
required, certainly, but technology authors are
simply brimming with patience.) The moral:

Feeling outdated? Never!

Avoid upgrade fever unless you really need a
new companion.

If you're the proud owner of an older MacBook,
as long as it can run 0S X El Capitan you can
still enjoy this book and discover new tips and
tricks from it. Unless the current breed of Intel-
based Mac laptops has a feature you absolutely
can't use on your mature MacBook (such as
Thunderbolt 2 support), you can sail on with
your current computer, fiercely proud of The
Bitten Apple that appears on the cover. (In fact,
older MacBooks have features that no longer
appear on some current models, such as optical
drives and built-in Ethernet ports.) Although this
book was written with the current MacBook,
MacBook Pro, MacBook Air, and MacBook
Pro Retina lines in mind, virtually everything
you read here still applies to your older laptop.
Unless it's steam-powered, of course.
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Figure 1-1:
The charis-
matic form
of a typical
Mac laptop.
|
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The parts you probably recognize

Every laptop requires some of the same gizmos. Figure 1-1 helps you track
them down. Of course, as you’d expect, a computer has a body of sorts in
which all the innards and brains are stored, a display screen, a keyboard, a
trackpad or other pointing device, and ports for powering and exchanging
data with outside toys.

FaceTime HD camera

LED screen

Keyboard Trackpad

That magnificent screen

What a view you have! Today’s Mac laptops feature an 11-, 12-, 13-, or 15-inch
LED display. LED screens use far less electricity than their antique CRT ances-
tors, and they emit practically no radiation.

Apple’s laptop screens offer a widescreen aspect ratio (the screen is consid-
erably wider than it is tall), which augurs well for those who enjoy watching
movies. (A favorite editor of mine loves it when I use the antique word augur,
meaning fo predict or foretell)

That reminds me: Throw away your printed dictionary! You won’t need it,
because OS X El Capitan includes the fantastic Dictionary widget. It uses the
Internet to retrieve definitions from the online Oxford American Dictionary
site (and, yes, it does contain augur). More on widgets in general in Chapter 3.

11
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The keyboard and trackpad

Hey, here’s something novel for your laptop. Unlike the external input devices
on a standard desktop computer, your MacBook has a built-in keyboard and
trackpad (which does the job of a mouse). The illuminated keyboard is a par-
ticular favorite of mine, offering special keys for activing all sorts of features
within OS X El Capitan (as well as keys for adjusting brightness and volume).

The latest crop of MacBook and MacBook Pro Retina laptops feature a new
trackpad design as well. The Force Touch trackpad can sense the amount of
pressure you apply with your fingers, activating features in OS X El Capitan
that used to require a right-click (like displaying the definition of a word in a
Pages document, or displaying a map of an address in Contacts). The Force
Touch trackpad can even provide tactile feedback to your fingertips while
you're using some applications!

The disc slot

You'll notice a long groove on the right side of your MacBook Pro. No, it’s not
for your credit card. This slot accepts CDs and DVDs into your optical drive.
If the drive is empty, loading a disc is as simple as sliding it in an inch or so;
the drive sucks in the disc automatically. Note that this drive accepts only
standard-size CDs and DVDs, so don’t try to load a minidisc or an odd credit-
card-shaped optical disc into your drive.

The MacBook, MacBook Air, and the MacBook Pro Retina do not have an
internal optical drive (more on all three models later in this chapter). You
can use the CD & DVD Sharing feature in El Capitan to read discs remotely
(from another Mac or PC on your network), or you can pick up an external
optical drive from Apple for about $80. (Such is the price you pay for super-
thin and super-light.)

“Luke, the printed label side of the disc should always be facing you when
you load a disc. Always.”

Food for your ears

A machine this nice had better have great sound, and the Mac doesn’t disap-
point. You have a couple of options for Mac laptop audio:

v All Mac laptops sport built-in stereo speakers (and a microphone
to boot).

v Use the built-in audio Line Out jacks to connect your Mac’s audio to a
pair of headphones, a more powerful (and expensive) external speaker
system, or a home stereo system. (There are also portable USB speaker
systems that can provide better-quality audio.)
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The power cable

Sorry, you can’t get a wireless power system — yet. (Apple’s working hard on
this one.) However, the MacBook Pro was the first major release of a laptop
with a magnetic power connector; the MacBook Air followed suit soon after.
The MagSafe 2 connector reduces the chances of your pride and joy being
yanked off a desk when someone trips over the power cord, because the
magnetic closure pops off under significant strain. Now that’s sassy.

When you connect your power cable, an amber light on the cable connector
indicates that your battery is charging; a green light indicates that the bat-
tery is fully charged.

Many MacBook owners ask me whether they should disconnect the power
cable after the battery is fully charged or leave it connected. I leave the cable
connected. It won’t cause any damage to your MacBook, and you can con-
tinue to use your laptop while it’s charging. (Oh, and road warriors prefer a
laptop battery that’s always topped off when it’s time to go mobile!)

The power button

Yep, you have a power button, too. It’s at the upper-right corner of the key-
board, bearing the familiar “circle with a vertical line” logo.

The FaceTime HD camera

Check out that tiny square lens above your screen. That’s a built-in FaceTime
HD camera, which allows you to chat with others in a videoconferencing
environment by using the Messages and FaceTime applications that come
with El Capitan. You can even take photos with the camera, using the Photo
Booth software that comes with your laptop, or set up a travelin’ webcam.

(If you need a higher-resolution camera — or one that can be easily turned or
tilted — check out the discussion of a favorite of mine later in this chapter.)

Note that a green light appears next to the lens when the camera is on —
handy information that could prevent visual embarrassment!

The battery

All of Apple’s current laptop computers do not include user-replaceable
batteries. The battery is sealed inside the case and can be replaced only by
an Apple technician. However, you should get several years of trouble-free
operation from your MacBook’s battery.

Although your laptop can display the remaining battery power in OS X

El Capitan, you can also monitor the battery level on some models of the
MacBook Pro from outside the case. A series of tiny LED lights on the left side
of the case indicate the remaining battery charge. Push the charge button,
and you see a number of lights that correspond to the approximate charge
remaining.
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The holes called ports

The next stop on your tour of Planet Laptop is Port Central — those rows
of holes on the sides of your computer. Each port connects a different type
of cable or device, allowing you to easily add all sorts of functionality to
your computer.

Each of these stellar holes has an icon to help you identify it. Here’s a list of

what you’ll find and a quick rundown of what these ports do.

The following connections are used for external devices and networking:

v Thunderbolt and Thunderbolt 2 port: The Thunderbolt port (and its

faster descendent, Thunderbolt 2) is the expansion racehorse of today’s
MacBooks. It offers the fastest data transfer rates and the ability to

add all sorts of peripherals, from external hard drives to monitors to
wired Ethernet connections. (A peripheral is another silly techno-nerd
term that means a separate device you connect to your computer.)
Thunderbolt 2 devices are somewhat more expensive than their
Thunderbolt, FireWire, and USB cousins, but prices are dropping as
more Thunderbolt 2 peripherals arrive on the market.

Although Thunderbolt-compatible monitors are available, they’re signifi-
cantly more expensive than a standard display. Luckily, you can also buy
an adapter for this port that allows you to send the video signal from
your laptop to another VGA or DVI monitor.

v FireWire port: These ports can connect external hard drives and optical

drives, as well as peripherals such as your digital video (DV) camcorder.
If you have a current MacBook Pro model, you have a fast FireWire 800
port. (The MacBook, MacBook Air, and MacBook Pro Retina models
don’t have a FireWire port.)

v USB port(s): Short for universal serial bus, the familiar USB port is the

jack-of-all-trades in today’s world of computer add-ons. Most external
devices you want to connect to your laptop (such as portable hard
drives, scanners, and digital cameras) use a USB port, including the
iPod. (Today’s PCs also include USB ports, allowing you to share exter-
nal USB peripherals like optical drives and scanners between your
MacBook and your desktop PC.) USB 3.0 connections are much faster
than the old USB 2.0 standard, but they still accept USB 2.0 devices run-
ning at the slower speed.

Get the lowdown on Thunderbolt, Thunderbolt 2, FireWire, and USB
ports in Chapter 21.

The MacBook uses a unique USB-C port that allows you to charge the
laptop, connect a USB 3.0 device or connect an external monitor or
projector — all from one port! However, you’ll need a USB-C to USB
adapter (about $20) to connect a USB device, and a USB-C AV Multiport
adapter (about $80) to connect an external display.
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v Ethernet port: Today’s MacBook Pro laptops include a standard giga-
bit (10/100/1000) Ethernet port, so the laptop is ready to join your
existing wired Ethernet network. (Alternatively, you can go wireless
for your network connection; more on that in the next section and in
Chapter 12.) Because the MacBook, MacBook Air, and the MacBook Pro
Retina are designed to be completely wireless, they don’t have a built-in
wired Ethernet port. If a wired connection is a necessity, you can add a
Thunderbolt-to-Gigabit-Ethernet adapter to add a wired network port to
your Air or Retina. (Apple sells one for about $30.) Or you can invest in
a laptop dock with a wired Ethernet port (which I discuss at the end of
this chapter).

v SD/SDXC card slot: All MacBook models include an SD (Secure Digital)
or SDXC (Secure Digital Extended Capacity) card slot, allowing you to
plug SD or SDXC memory cards from digital cameras, cellphones, and
portable devices directly into your laptop.

The following connections are used for external video and audio:

v+ HDMI port: The MacBook Pro Retina includes an HDMI port, allowing a
direct connection between your laptop and high-definition displays
and TVs.

+ Headphone/optical output port: Last (but certainly not least), you can
send the high-quality audio from your rectangular beast to a set of stan-
dard headphones or an optical digital audio device such as a high-end
home theater system.

Don’t forget the parts you can’t see

When you bought your new digital pride and joy, you probably noticed a
number of subtle differences between the low-end MacBook and MacBook
Air, the pricier MacBook Pro, and the iiber-expensive, top-end MacBook Pro
Retina models. I call these differences the Important Hidden Stuff (or IHS, if
you're addicted to acronyms). They’re just as important as the parts and
ports you can see.

Internal storage devices are as follows:

v CPU: Today’s Mac laptops feature the latest Intel Core i5 and i7 pro-
cessors. Of course, the faster the processor, the better. (Definitely not
rocket science.)

v Storage: Today’s MacBook models are equipped with either traditional
magnetic hard drives or solid-state drives. The drive capacities are dif-
ferent across the entire MacBook product line, but only the MacBook
Pro can be ordered from Apple with either a magnetic hard drive or
solid-state storage.
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The MacBook Pro Retina and MacBook Air, on the other hand, are avail-
able only with solid-state drives, which have a number of advantages
over traditional magnetic hard drives: You'll find no moving parts in a
solid-state drive, and it offers better performance than a standard hard
drive. Think of the solid-state drive as an internal USB flash drive that
uses RAM chips rather than magnetic platters to hold your data.

v Optical drive: Okay, 'm cheating a little here. I mentioned the optical
drive in an earlier section, but all you can see is the slot, so it qualifies
as an [HS item. Depending on your MacBook, your computer includes
one of the following:

® No built-in optical drive (MacBook, MacBook Air, and MacBook Pro
Retina)

The MacBook Air and MacBook Pro Retina can be equipped with
an external SuperDrive, or you can use another computer’s drive
remotely over your network (both wired and wireless, although
wired is faster and far more reliable).

e A DVD-R/CD-RW SuperDrive, which can play and record both CDs
and DVDs (MacBook Pro)

If you prefer to burn Blu-ray discs on your MacBook Pro, don’t give
up hope of recording! Thanks to those handy FireWire and USB
ports, it’s child’s play to add an external Blu-ray recorder.

Wireless communications devices include the following:

v Wireless Ethernet: “Look, Ma, no wires!” As mentioned earlier, you can
connect your laptop to an existing wireless Ethernet network. All current
Mac laptops have built-in AirPort Extreme hardware. With wireless con-
nectivity, you can share documents with another computer in another
room, share a single high-speed Internet connection between several
computers, or enjoy wireless printing. Truly sassy/

Although Apple would want you to build your wireless wonderland
with an Apple AirPort Extreme Base Station or an AirPort Time Capsule
unit — go figure — you can use your Mac with any standard 802.11b/g/n/
ac wireless network. And, yes, PCs and Macs can intermingle on the
same wireless network without a hitch. (Scandalous, ain’t it?)

+~ Bluetooth: Let’s get the old “digital pirate” joke out of the way: “Arrgh,
matey, [ needs me a wireless parrot.” (Engineers again . . . sheesh.)
Although strangely named, Bluetooth is another form of wireless con-
nectivity. This time, however, the standard was designed for accessories
such as your keyboard and mouse and devices such as a personal digital
assistant (PDA) and cellphone. (The latest Macs support version 4.0
Bluetooth hardware, also called Bluetooth LE or Bluetooth Smart.)

vww . allitebooks.cond
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Here’s the hidden display device:

v Video card: The standard Intel video hardware that’s built in to today’s
MacBooks is fine for typical home and business laptop applications.
However, if your applications rely heavily on high-speed 3D graphics or
digital video, you'll be pleased as punch to discover that today’s 15-inch
MacBook Pro Retina model can be ordered with the muscle-bound
AMD Radeon R9 M370X. This card is well suited to high-end mobile 3D
modeling, video editing on the road, and, well, honestly, blasting the
latest video game enemies into small smoking pieces with aplomb.

the MacBooks

So far in this chapter, I've discussed the common hardware shared by
today’s MacBook models. Now it’s time to compare the MacBook, MacBook
Air, MacBook Pro, and MacBook Pro Retina with an eye toward selecting the
right one for you. (Unless you decide to pick up one of each. Certainly an
elegant choice, but not everyone has that option!)

For example, consider the least expensive MacBook: The MacBook Air, shown
in Figure 1-2, is unique for both its size and weight. And yet the Air is just like
the MacBook, MacBook Pro, and the MacBook Pro Retina. Well, mostly.

“Hold on, Mark. How can it be so singular and yet share so much with its road
warrior siblings?” I answer that question in the following sections, which
discuss the many similarities and the handful of striking differences between
the four laptops in the MacBook line. If you're considering buying an Apple
laptop, these sections can help you decide whether you’d like to go ultra-thin
or stick with the more traditional (and somewhat thicker) laptop crowd.

One thing’s for sure: Apple never creates a mundane design!
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Compatring the MacBooks

Do you remember when Apple introduced the first iMacs? Although they
shared the same basic components as any computer — a monitor, keyboard,
ports, speakers, and cables — the iMac was revolutionary because it was
completely self-contained. And it came in colors. And it didn’t have a floppy
drive. In fact, Apple had redesigned the common computer with the focus
on style and ease of use and had scrapped the floppy drive (and rightly so,
seeing as how floppies had become practically useless and were unreli-

able to boot).

I consider the MacBook, MacBook Air, and the MacBook Pro Retina to be
extensions of the iMac revolution. With these designs, Apple has focused this
time on physical dimensions and weight and has tossed out anything that isn’t
absolutely necessary for the lecture hall, boardroom, or city park. However,
I'm happy to note that these ultra-light MacBooks are neither toys nor bare-
bones netbooks. In fact, both the MacBook and the MacBook Air share some
of the features of the high-end MacBook Pro Retina.

What are the similarities?
Consider the similarities between the different models:

1 Widescreen display: Each model sports a widescreen LED backlit
display. The MacBook sports a 12-inch display, the MacBook Air offers
either an 11-inch or 13-inch display, while the MacBook Pro is avail-
able with only a 13-inch display. The superb Retina display on the
MacBook Pro Retina is the star of the show, however, with the highest
resolution available on any Apple laptop. (It’s available in a 13-inch or
15-inch display.)

v Intel processor power: The MacBook Air, MacBook Pro, and MacBook
Pro Retina can be ordered from Apple with Core i5 or i7 power, while the
MacBook uses an Intel Core M processor.

v Keyboard and trackpad: All four MacBook models offer a backlit key-
board. The MacBook and MacBook Pro Retina offer the new Force Touch
trackpad, while the MacBook Air and MacBook Pro feature the older
Multi-Touch trackpad. (Read more about Multi-Touch in Chapter 4.)

v+~ El Capitan: All current laptops from Apple naturally run the latest
version of OS X with aplomb.

v FaceTime: Every MacBook is video ready, using a built-in FaceTime
camera. You can record audio with the built-in microphone as well. In
fact, the Retina has two microphones.
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1 Sealed battery: You can’t swap batteries with any of Apple’s cur-
rent MacBook line, because the battery is sealed inside. (Think iPod
and iPhone.)

1 Wireless support: The MacBook, MacBook Air, and MacBook Pro Retina
each have built in the latest AirPort Extreme hardware (802.11ac), while
the MacBook Pro includes slightly older (and slower) 802.11n hardware.
All three models feature built-in Bluetooth hardware. (Read more about
AirPort Extreme in Chapter 11.)

[ think most Apple laptop owners would agree that these major MacBook fea-
tures show there’s no underpowered pushover in the lineup!

So what’s so flippin’ radical?

I'm glad you asked! Here’s the checklist of striking differences that set the
MacBook and MacBook Air apart from the MacBook Pro and MacBook
Pro Retina:

+ Physical dimensions: You need a thin laptop? You've come to the right
place! The current Air laptop measures a mere 0.68 inches in height
(at its tallest point) when closed. (If you think that’s mind-blowing, the
MacBook is even thinner, measuring just 0.52 inches in height when
closed!) Oh, and hold on to your chair for this one: the MacBook is also
the lightweight champ at less than 2.03 pounds! (That’s a couple of
pounds you won’t be carrying around all day at that convention expo.
Take it from this traveler: You will feel the refreshing difference in just
an hour or two.) By comparison, the 13-inch MacBook Pro Retina weighs
3.48 pounds, and the MacBook Pro is a hefty 4.5 pounds.

v Cost: At the time of this writing, an entry-level 11-inch MacBook Air will
set you back $899, and the 13-inch Air is $999. The 12-inch MacBook is
slightly more expensive at $1299. By comparison, the 13-inch MacBook
Pro is $1099, while the 13- and 15-inch MacBook Pro Retina models are
pricier at $1299 and $1999 respectively.

v Ports: The MacBook only offers two ports, the USB-C (which requires
adapters for use as a USB 3.0 and external video port) and a headphone/
Audio Line out jack. The MacBook Air offers two conventional USB
3.0 ports, a headphone/Audio Line Out jack, and a Thunderbolt 2 port
for connecting an external monitor or high-speed drive. Note that I
didn’t mention a FireWire port, which can be a big problem for Apple
old-timers like me. [ have a huge collection of FireWire devices. The
MacBook Pro Retina also has no FireWire port (but it does include an
HDMI port for connecting the laptop to a high-definition TV or exter-
nal display).
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As I mentioned earlier, the MacBook, MacBook Air, and the MacBook
Pro Retina lack a wired Ethernet port. The latter two models can use a
Thunderbolt-to-Gigabit Ethernet adapter from Apple, while the MacBook
will require both a USB-C to Gigabit Ethernet adapter. (Rats.)

v Sealed case: You can’t add or replace RAM modules on the MacBook,

MacBook Air, or the MacBook Pro Retina. If you haven’t ordered your
laptop yet, it’s a very good idea to configure your MacBook with the
maximum RAM it can carry, because you won’t be able to add more in
the future. On the other hand, the MacBook Pro can be upgraded to
16GB of RAM by upgrading the RAM modules.

v No built-in optical drive: Whoaq, Nellie! This difference is a big one, and

it applies to the MacBook, MacBook Air, and the MacBook Pro Retina.
Apple decided that owners of these slimmer, trimmer laptops are likely
to use a wireless connection for transferring files and media. But what if
you have to reinstall applications available only on disc? If you need to
read or burn discs, you can buy a separate external USB SuperDrive for
about $80, or you can use the Remote Disc feature and share the drive
on another computer. (More on Remote Disc in the later section “Sharing
a CD or DVD drive.”) If you absolutely need an on-board optical drive,
your only choice is the MacBook Pro.

As you can see, these striking differences make the choice between a
MacBook, MacBook Air, MacBook Pro, and a MacBook Pro Retina easy
indeed. To wit:

v The MacBook and MacBook Air models are designed for the traveler

who appreciates minimum weight and size. These folks see a laptop

as a race car: nimble, with reduced weight and no unnecessary frills.
(Think of a typical NASCAR entry: Who needs an expensive stereo or air
conditioning?)

1 The MacBook Pro Retina is all about the brilliant Retina display, of

course, but it’s also designed to be somewhat slimmer and lighter
than a standard MacBook Pro. And it’s considerably faster than either
the MacBook or the MacBook Air. The Retina appeals to presenters,
graphics professionals, and video editors, who appreciate the higher-
resolution display and the direct HDMI output.

v | highly recommend that you stick with the more conventional MacBook

Pro if you don’t mind the extra weight and prefer its additional versatil-
ity, including the standard set of ports and built-in optical drive.

Look, Ma, no moving parts!

You’re probably familiar with the common species of usbius flashimus, more
commonly called the USB Flash drive. With one of these tiny devices, you get
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the equivalent of a 4-512GB hard drive that plugs into a USB 2.0 or 3.0 port,
allowing you to carry your data with you as you jet across the continents. But
have you ever asked yourself, “Self, why don’t they make internal drives that
use this same technology?”

Actually, dear reader, solid-state drives have been around for a number of
years (think iPod shuffle and iPod nano). Unfortunately, however, the solid-
state memory used in today’s flash drives gets pretty expensive as capacity
increases. In fact, cost has been the limiting factor, because a solid-state
drive offers a number of advantages that set it apart from a conventional
magnetic hard drive:

+ No moving parts: Unlike a typical magnetic hard drive, you find no
read-write heads and no magnetic platter — just gobs of happy silicon
memory chips. In effect, a solid-state drive works along the same lines
as your MacBook’s system RAM. Unlike your Mac’s RAM, though, a solid-
state drive doesn’t lose the data it stores when you turn off your laptop.
As you can imagine, no moving parts on a computer in motion is supe-
rior on two levels:

¢ The solid-state drive never wears out or needs replacing.

e If your laptop is accidentally abused (gets knocked off your desk),
it’s far less likely that you’ll lose a hard drive’s worth of priceless
data when it hits the ground.

v Speed: Oh my goodness, is this thing fast! Your MacBook will boot,
restart, or awaken in far less time, and everything you do on your laptop
will benefit from the speed boost. A solid-state drive can read data far
faster than a conventional magnetic hard drive.

v Power usage: Forget your hard drive spinning up from sleep mode. The
solid-state drive uses far less power than a conventional hard drive,
resulting in significantly longer battery life.

~ Blessed silence: The solid-state drive is completely silent. (No more of
that gargling noise while the disk is accessed. Sweet.)

All of Apple’s laptops are available with a solid-state drive, but do you need
the solid-state drive option for your MacBook Pro? The answer lies in your
bank account (as well as your need for elbow room). If you can afford the
extra expense of the solid-state drive, and you can fit all your applications
and data into the 128GB drive (or the even more expensive 256GB and 512GB
drives), I heartily recommend that you consider joining Buck Rogers with the
storage device of the future.

21
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If you’d rather save that coin for something else, or if you need a larger inter-
nal hard drive to hold things such as digital video and a massive collection of
digital images, stick with the tried-and-true 1TB magnetic hard drive.

What if | need that pesky optical drive?

Can a laptop survive in the jungle that is Real Life without a DVD drive? The
terse answer is no. I'll be honest: Ripping an audio CD or watching a DVD
movie without an optical drive is impossible. (Rather like a cheap sports car.)
And the wonders of digital media are a big part of the iWorld. So what was
Apple thinking?

First, a bit of explanation. Today’s DVD drives are thin, but not MacBook,
MacBook Air, and Retina thin. To create these stunning designs with truly
revolutionary dimensions, Apple engineers had to leave out the drive.
However, if you own a MacBook, MacBook Air, or MacBook Pro Retina, you
have two choices when it comes to reading the contents of a CD or DVD: Go
external, or find out how to share.

The external USB route

[ have no problem toting around an external USB DVD burner with a MacBook
Air. Heck, half the time you’re likely to leave it at home, because you don’t
install software every day. The folks at Cupertino want you to download your
movies from the iTunes Store and your software from the App Store, so if you
follow the Apple Path, you still don’t need an optical drive!

A USB SuperDrive from Apple costs a mere $80, and it can read and write
DVDs just as well as the built-in SuperDrive you find in the MacBook Pro.

You can also use any third-party USB DVD drive that’s compatible with
Apple’s laptops and OS X El Capitan.

Sharing a CD or DVD drive

The other option for installing software or reading a DVD on the MacBook,
MacBook Air, and MacBook Pro Retina is the CD/DVD Sharing feature within
El Capitan. Sharing is an option if you have a wired or wireless network (see
Chapter 11) with at least one of the following computers available:

v A Macintosh running OS X Tiger or later

v+ A PC running Windows XP, Vista, 7, 8 or 8.1, or 10 (and a Windows appli-
cation supplied by Apple with your MacBook)
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You can only read from a shared optical drive. You can’t write data to the
remote drive, even if that drive is a DVD recorder.

On the Mac computer with the optical drive, open System Preferences, click
the Sharing icon, and select the DVD or CD Sharing check box. Note that you
can set whether the Mac will request your permission when another com-
puter attempts to share the drive.

On a PC, display the Control Panel, click the DVD or CD Sharing icon, and
then select the Enable DVD or CD Sharing check box. Again, you can specify
that permission is required if security is a concern.

After you set up the shared drive, just load the disc and select the Remote
Disc item in any Finder sidebar. (Remote Disc appears under the Devices
heading in the sidebar.) Now you can access the drive as if it were directly
connected to your MacBook, MacBook Air, or Retina. Ah, technology!

Location, Location, Location!

\\3

If you choose the wrong spot to park your new laptop, I guarantee you’ll
regret it. Some domiciles and office cubicles don’t offer a choice. You have
one desk at work, for example, and nobody will hand over another one. But if
you can select a home for your MacBook, consider the important placement
points in this section:

1 Keep things cool. Your new laptop is silent, but that super-fast Intel
processor generates heat. Make sure that the location you choose is far
from heating vents and shielded from direct sunlight. I also recommend
a laptop cooling pad, which elevates the base of your laptop to allow air
to circulate underneath.

” Outlets are key! Your computer needs at least one nearby outlet, and
perhaps as many as two:

¢ A standard AC outlet (using a current adapter if you're traveling
abroad, if necessary)

¢ A nearby Ethernet jack (if you use the MacBook Pro’s built-in
Ethernet port for connecting to a wired Ethernet network, or an
Ethernet adapter)

If you prefer to send your data over the airwaves, consider wire-
less networking for your Mac. I discuss everything you need to
know in Chapter 11.
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1+ Don’t forget the lighting. Let me act as your mom. (I know that’s a
stretch, but bear with me.) She’d say, “You can’t possibly expect to work
without decent lighting! You'll go blind!” She’s right, you know. You need
a desk lamp or floor lamp at a minimum if you need to refer to books or
documents often in your work.

v Plan to expand. If your laptop hangs out on a desk, allow an additional
foot of space on each side. That way, you have room for external periph-
erals, more powerful speakers, and an external keyboard and mouse if
you need one.

If you want to keep an external keyboard handy, consider using a laptop
shelf. These Plexiglas or metal stands elevate your laptop several inches
above the desk, putting the screen at a better ergonomic position and
allowing you to park your keyboard and external mouse underneath.

Unpacking and Connecting
Vour Laptop

A\\J

You'll love the following sections. They’re short and sweet because configur-
ing a laptop on your desktop is a piece of cake. (Sorry about the cliché over-
load, but this really is easy.)

Unpacking for the road warrior

Follow these guidelines when unpacking your system:

1 Check for damage. I've never had a box arrive from Apple with shipping
damage, but I've heard horror stories from others (who claim that King
Kong must have been working for That Shipping Company).

Check all sides of the box before you open it. If you find significant
damage, take a photograph (just in case).

v Search for all the parts. When you’re removing those chunks o’ foam,
make certain that you’'ve checked all sides of each foam block for parts
snuggled therein or taped for shipment.

1 Keep all packing materials. Do not put the box and packing materials in
the trash. Keep the box and all packing materials for at least a year, until
the standard Apple warranty runs out. If you have to ship your laptop
to an Apple service center, the box and the original packing are the only
way for your machine to fly.
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And now, a dramatic Mark’s Maxim about cardboard containers:

+* Smart computer owners keep their boxes far longer than a year. If you
sell your laptop or move across the country, for example, you’ll want
that box. Trust me on this one.™

1 Store the invoice for safekeeping. Your invoice is a valuable piece of
paper.

Save your original invoice in a plastic bag, along with your computer’s
manuals, original software, and other assorted hoo-hah. Keep the bag on
a shelf or stored safely in your desk, and enjoy a little peace of mind.

v Read the Mac’s manual. “Hey, wait a minute, Mark. Why do [ have to
read the manual from Apple along with this tome?” Good question, and
here’s the answer: The documentation from Apple might contain new and
updated instructions that override what I tell you here. (For example,
“Never cut the red wire. Cut the blue wire instead.” Or something to that
effect.) Besides, Apple manuals are rarely thicker than a restaurant menu.

You can always download the latest updated manuals for Apple comput-
ers in electronic format from Apple’s website. (Adobe’s PDF format is the
standard for reading documents on your computer. You can open and
display any PDF document in El Capitan by using the Preview applica-
tion or the Quick Look feature.) I always keep a copy of the PDF manual
for my MacBook Air on my drive, just in case.

Connecting Cables 101

Your laptop makes all its connections simple, but your computer depends on
you to get the outside wires and thingamabobs where they go.

The absolutely essential connection

After your new Mac is resting comfortably in its assigned spot (I assume
that’s a desktop), you need to make just one required connection: the power
cable. First plug the cable into the corresponding MagSafe or USB-C port on
the MacBook, and then plug ’er into that handy AC outlet. After your battery
is completely charged, you can go mobile at a moment’s notice.

Adding the Internet to the mix

If you have high-speed Internet service, or if you're in an office or school with
a local computer network, you can probably connect through your MacBook
Pro’s built-in Ethernet port (or by using an adapter with your Thunderbolt or
USB-C port). You make two connections:

1. Plug one end of the Ethernet cable into the Ethernet port on the
MacBook Pro (or the adapter on a MacBook, MacBook Air, or
MacBook Pro Retina).
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2. Plug the other end of the Ethernet cable into the Ethernet port from
your network.

Your network port is probably one of the following: an Ethernet wall
jack, an Ethernet hub or switch, or a cable or DSL Internet router (or
sharing device).

Will you be joining a wireless network? If so, you can find the information you
need about configuring El Capitan for wireless networking in Chapter 11.

Great, a Lecture about
Handling My Laptop

Proper handling of your laptop is important, so take a moment to read the
Rules of Proper Laptop Deportment. Okay, perhaps I'm lecturing a bit, but
a little common sense goes a long way when handling any computer equip-
ment, and your laptop is no different. (Scolding mode off.)

Keep these rules in mind while opening and carrying your laptop:

v The cover is your friend. Open your laptop’s cover slowly, without
jerking or bending it.

v Close it before you move it. By closing your laptop, you put your OS X
operating system into sleep mode, and (if your MacBook uses a mag-
netic hard drive for storage) the hard drive automatically spins down,
making it safer to move. The laptop is still on; it will spring back to life
after you open the cover.

+ Don’t stack stuff on your laptop. You'd be surprised how many horror
stories I've heard about laptop owners piling a stack of books or
other heavy stuff on their computers. Remember that LED display?
Made of glass?

+ Be nice to your keyboard. Don’t press those keys too hard! Use the
same amount of pressure you use with a desktop computer keyboard.

1 Keep food and drinks far away. Care to turn your laptop into an expen-
sive doorstop? Go ahead and park your soda next to it. (Oh, and crumbs
are perfect if you're interested in buying replacement keyboards.)

1 Keep your laptop as level as possible. Using your laptop while it’s tilted
too far in any direction can eventually cause problems with your mag-
netic hard drive. [ kid you not. (If you choose a solid-state hard drive, of
course, this rule does not apply.)
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An Overview of Mac Software Goodness

The following sections answer the most common novice computer question:
“What the heck will I do with this thing?” You find additional details and excit-
ing factoids about the software you get for free, software you’ll want to buy,
and stuff you can do on the Internet.

What comes with my laptop?

Currently, Apple laptops ship with the following major software applications
installed and ready to use:

v OS X El Capitan: Naturally, your MacBook comes preloaded with
El Capitan.

v~ Apple’s digital lifestyle suite: You know you want these applications!
They turn your Mac into a digital hub for practically every kind of high-
tech device, including camcorders, digital cameras, tablets, portable
music players, and even smartphones.

Chapters 12 through 15 focus on the major applications that will appeal
to MacBook owners: iTunes, iPhoto, iMovie, and GarageBand.

v The iWork suite: Owners of new MacBooks can download all three
iWork applications — Pages, Numbers, and Keynote — for free, using
the App Store. Pages is a desktop publishing jewel, Numbers is a great
spreadsheet tool, and Keynote is a superb slideshow/presentation appli-
cation. Chapters 16 through 18 are your guides to the basic functions of
all three iWork applications. 'Nuff said.

The installed software on your MacBook might change as new programs
become available.

Connecting to the Internet from your lap

What is a modern computer without the Internet? Apple gives you great tools
to take full advantage of every road sign and off-ramp on the Information
Superhighway right out of the box:

1 Web surfing: [ use Apple’s Safari web browser every day. It’s fast and
well-designed, with features such as tabbed browsing and Facebook and
Twitter sharing.

If tabbed browsing sounds like ancient Aztec to you, don’t worry.
Chapter 8 is devoted to Safari.
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1 Web searches: Dashboard widgets can search the entire Internet for
stocks, movie listings, airline schedules, dictionaries, and foreign
language translations. I explain the Dashboard in Chapter 3.

v Instant messaging: Messages lets you use your MacBook to chat with
others around the world for free on the Internet — by keyboard, voice,
or full-color video. This is awesome stuff straight out of Dick Tracy and
Buck Rogers. If you've never seen a video chat, you'll be surprised just
how good your friends and family look! You can also use the FaceTime
application to video chat with folks who have an iPhone, iPad, or iPod

MBER
¢ touch, as well as another Mac.

S
Always wear a shirt when videoconferencing.

v+ Email: Soldier, Apple has you covered. The Apple Mail application is a
full-featured email system, complete with defenses against the torrent
of junk mail awaiting you. (Imagine a hungry digital predator with an
appetite for spam.) Send pictures and attached files to everyone on the
planet, and look doggone good doing it.

Applications that rock

Dozens of small applications are also supplied with OS X El Capitan. I men-
tion many of them in later chapters, but here are three good examples to
whet your appetite:

v DVD Player: If your MacBook has an internal or external DVD drive, put
all that widescreen beauty to work and watch your favorite DVD movies
with DVD Player! You have all the features of today’s most expensive
stand-alone DVD players, including a spiffy onscreen control that looks
like a remote.

v Contacts: Throw away that well-thumbed collection of fading addresses
on paper. Use the El Capitan Contacts application to store, search, and
recall just about any piece of information on your friends, family, and
acquaintances.

v Chess: This isn’t the chessboard your dad used! Play the game of kings
against a tough (and configurable) opponent — your MacBook — on a
beautiful 3D board. Heck, your Mac even narrates the game by speaking
the moves!
3
You can use the data you store in your Contacts in other Apple applications
included with El Capitan, such as Apple Mail and Messages.
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Boot Camp For Dummies

OS X El Capitan includes one particularly exciting feature for Windows
switchers: You can use the Apple Boot Camp utility and your licensed copy
of Windows 7, 8, or 10 to install and boot Windows on your Intel-based

Mac laptop!

Boot Camp creates a Windows-specific partition (or section) on your hard
drive, where all your Windows files are stored. Other than the slightly strange
key assignments you have to remember, Boot Camp is reliable and easy to
use. However, | strongly urge you to back up your laptop on a regular basis;
inviting Windows onto your Mac laptop invites potential viruses as well.

Apple’s Boot Camp Assistant provides step-by-step instructions, making it
easy to configure your laptop for Windows. To run the Boot Camp Assistant,
click the Launchpad icon in the Dock, click the Utilities folder icon, and then
click the Boot Camp Assistant application icon. You can also download a free
bonus chapter from www.dummies.com/extras/macbook (or my website,
www . mlcbooks . com) that explains how to use Boot Camp in more detail.

Other Stuff That Nearly Everyone Wants

No man is an island, and no computer is either. I always recommend the
same set of stuff for new PC and Mac laptop owners. These extras help
keep your new computer clean and healthy (and some make sure you'’re
happy as well):

v A laptop sleeve or case: Most laptop owners eschew the traditional
bulky laptop bag because a bag broadcasts the fact that you’re carrying
a valuable MacBook (and adds yet another item to carry on your trip).
On the other hand, if you pack your MacBook in a briefcase, book bag,
or backpack, you need to provide protection from bumps and scratches
(make sure that any sleeve or case you buy provides padding around
the entire computer, and not just on the top surface). That’s where a
laptop sleeve or thin case comes in. [ use the very cool BookBook hard-
back leather case from Twelve South (www. twelvesouth.com), which
looks — you guessed it — like an old-fashioned leather-bound book.

(I think it makes me appear scholarly while disguising my MacBook.) The
BookBook (shown in Figure 1-3) is available for all sizes of MacBooks,
costs about $80, and provides long-lasting, cushioned protection for
your expensive road warrior computer.
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v An external camera: Your MacBook has a built-in FaceTime camera,
but many folks prefer a stand-alone external camera they can pan, tilt,
and point where they like (especially moviemakers who need high-
resolution video clips of whatever’s happening around them). I carry the
stylish steel aGent V6 HD webcam from Liquid Digital Solutions (www .
ligquiddigital.com.au), shown in Figure 1-4, with my MacBook Air.
It provides full 1080p high-definition recording in iMovie and connects
to a USB port. You can choose to clip the webcam to your MacBook or
use the desktop stand on any flat surface. The video quality is excel-
lent, with auto exposure and low-light compensation for environments
with less-than-perfect illumination. The aGent V6 HD webcam costs
about $100.

v Surge suppressor: Even an all-in-one computer like your laptop can fall
prey to a power surge. | recommend using one of these:

o A basic surge suppressor with a fuse can help protect your MacBook
from an overload.

e A UPS (uninterruptible power supply) costs a little more but does a
better job of filtering your AC line voltage to prevent brownouts or
line interference from reaching your computer.
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Q\Q’N- ST"& Of course, your laptop’s battery immediately kicks in if you experience

a blackout, so a UPS is less important for your computer. However, any
computer tech will tell you that filtered AC current is far better for your
laptop, and your UPS can also provide power for external devices that
don’t have a battery.

v A laptop docking station: Will your MacBook often do double duty as
both a desktop computer and a mobile powerhouse? If so, a laptop dock-
ing station will prevent you from disconnecting a bird’s nest of USB and
Thunderbolt cables each time you hit the road. In essence, you need to
unplug only one connection between your MacBook and the docking
station, and all your external desktop peripherals — monitor, backup
hard drive, USB trackball, and such — remain blissfully in place. When
your MacBook returns to the desktop, you simply reconnect that one
Thunderbolt cable, and you’re back in business.

My docking station of choice is the excellent Thunderbolt Express Dock
from Belkin (www.belkin.com), shown in Figure 1-5. It requires only
one Thunderbolt cable connection to your MacBook. In turn, it provides
two Thunderbolt ports, three USB 3.0 ports, a wired Ethernet jack
(perfect for Air and Retina models), a FireWire 800 port, and even micro-
phone and headphone/speaker jacks! The Thunderbolt Express Dock is
about $200 online. As a MacBook owner who likes to “grab and go,” I say
it’s worth every penny.


http://www.belkin.com/
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* Screen wipes: Invest in a box of premoistened screen wipes to
keep your screen pristine. Your MacBook’s screen can pick up dirt,
fingerprints, and other unmentionables faster than you think.

Make sure your wipes are especially meant for LED, LCD, or laptop
computer screens.

v+ Blank CDs and DVDs: If you're using a MacBook with an internal or
external optical drive, you’ll want blank discs. Your choices are

® CD-R (record once) and CD-RW (record multiple times)
* DVD-R (record once) and DVD+RW (record multiple times)

1 Cables: Depending on the external devices and wired network
connectivity you'll be using, these are

¢ A standard Ethernet cable (for wired networks or high-speed
Internet)

¢ FireWire, Thunderbolt, or USB cables for devices you already have

1 Restraining cable: In case you're security conscious or often use
your laptop in public places, a standard Kensington laptop lock slot
is provided on the MacBook Pro case. (Sorry, MacBook, MacBook Air,
and Retina owners, but your case is too thin to sport a lock slot.) The
principle is the same as a bicycle cable lock: If your laptop is secured by
a cable to a sturdy fixture, it’s nearly impossible for it to walk off with
someone else.

v Wrist rest: You might have many reasons to buy a new Mac laptop, but I
know a bad case of carpal tunnel syndrome is not one of them. Take care
of your wrists by carrying a keyboard wrist rest in your laptop bag.



Chapter 2

Turning On Your Portable
Powerhouse

In This Chapter
Turning on your laptop
Checking your Mac for proper operation
Monitoring the battery and heat level
Setting up OS X El Capitan
Registering your MacBook
Using Migration Assistant

Copying information from a Windows PC

’ n Chapter 1, you got as far as unpacking your Mac laptop and connecting
a number of cables to it. But unless you bought this computer solely as a
work of modern art, it’s time to turn on your MacBook and begin living The
Good Life. (Plus, you still get to admire that Apple design while using iTunes.)
After you get your new beauty powered on, I show you how to run an initial
checkup of your laptop’s health. Then I wax enthusiastic on maintaining (and
even augmenting) your laptop battery.

[ also familiarize you with the initial chores you need to complete before
settling in with your favorite applications. These tasks include using the OS X
Setup Assistant and moving the data and settings from your existing com-
puter to your MacBook, MacBook Pro, MacBook Air, or MacBook Pro Retina.

In this chapter, I assume that either OS X El Capitan was preinstalled on your
Mac, or you just completed an upgrade to El Capitan from OS X Yosemite.
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Tales of the On Button

Your MacBook’s power switch is located on the right side of the keyboard.
Press it now to turn on your laptop. You hear the pleasant start-up tone
that’s been a hallmark of Apple computers for many years. Don’t be alarmed
if you don’t immediately see anything onscreen; it takes a second or two for
the initial Apple logo to appear.

In my experience, sometimes a quick press of the power button on some Mac
laptop models just doesn’t do it. Rather, you have to hold down the button
for a couple seconds before the computer turns on. However, if your Mac
laptop ever locks up tight, and you can’t quit an application (I discuss quit-
ting in Chapter 3), the power button gives you another option: Hold it down
for five seconds or so, and your MacBook shuts off completely, even if your
laptop is locked up tight.

As the Apple logo appears, you see a familiar progress bar indicator — that
indicator is the sign that your MacBook is loading El Capitan and checking
the internal hardware for problems. Sometimes the progress bar can take a
bit longer to disappear. As long as it’s moving, though, Something Good is
happening: Your laptop is busy loading certain file-sharing, networking, and
printing components (and so on). This process won’t take long.

At last, your five to ten seconds of patience is rewarded, and after a short
(but neat) video, you see the El Capitan Setup Assistant.

Mark’s Favorite Signs of
a Healthy Laptop

Before you jump into the fun stuff, don’t forget an important step — a quick
prelim check of the signs that your new mobile Mac survived shipment intact
and happy.

If you can answer “yes” to each of these questions, your MacBook likely made
the trip without serious damage:
1. Does the laptop’s chassis appear undamaged?

It’s pretty easy to spot damage to your MacBook’s svelte design. Look
for scratches and puncture marks.

2. Does the LED screen work, and is it undamaged?

Does the cover open smoothly? Are any individual dots (or pixels) on
the LED screen obviously malfunctioning? Bad pixels appear black or in
a different color than everything surrounding them. (Techs call these
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irritating anarchists dead pixels.) A 13-inch MacBook Pro Retina screen
has well over two million pixels, and, unfortunately, some new LED
screens include one or two dead ones.

3. Do the keyboard and trackpad work?

Check your MacBook’s built-in trackpad by moving your finger across its
surface; the cursor should move on the screen. To check the keyboard,
press the Caps Lock key on the left and observe whether the Caps Lock
light turns on and off.

If you do notice a problem with your laptop (and you can use your Safari
browser and reach the web), you can connect with an Apple support techni-
cian at www.apple. com. If your MacBook Pro remains dead — like an expen-
sive paperweight — and you can’t get to the Internet, you can check your
phone book for a local Apple service center, or call the AppleCare toll-free
number at 1-800-275-2273. Chapter 19 also offers troubleshooting information.

Vou Won’t Lecture Me about
Batteries, Will Vou?

\\3

No, this isn’t a lecture. In fact, the only lecture I put you through in this book
concerns backing up (which, naturally, you should do). Instead, consider
these tips as your rules of the road for monitoring and charging your battery:

1 Recharge your laptop in sleep mode or when powered off. The bat-
tery recharges faster when your laptop is off or in sleep mode. (I go into
more detail on sleep mode in Chapter 5.)

1 Keep your laptop plugged into an AC socket (or a car inverter, which
plugs into your car’s power outlet) when possible. I take every oppor-
tunity to top off my laptop’s battery, and so should you.

If you don’t have much time to charge your battery before you're away
from an AC socket — say, half an hour — don’t use your MacBook while
it’s plugged in and charging. That way, your battery will gain the maxi-
mum benefit from the charge time. (When you’re using your MacBook
while it’s charging, the charging process takes much longer.)

1 Save your juice. To get the most juice you can scavenge, here are some
easy tricks:

e Turn off your laptop, or leave it in sleep mode.

e Turn off unnecessary hardware. To conserve battery power as
much as possible, disconnect any unnecessary USB, Thunderbolt,
or FireWire devices. Also turn off your Wi-Fi and Bluetooth wireless
hardware if you're not connected to a network. (I cover Wi-Fi wire-
less networking in Chapter 11.)

35
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® Reduce the brightness of the display from your laptop’s keyboard by
pressing the FI key.

¢ Avoid using processor-intensive applications (for example,
Photoshop or iMovie).

e Remove CDs and DVDs from the optical drive. (MacBook, MacBook
Air, and MacBook Pro Retina owners: Don’t go hunting for a built-in
optical drive, because your laptop doesn’t have one.)

+* Monitor your battery level from the Finder menu. I love the battery-
monitoring system built in to El Capitan. Your laptop’s battery life can
be displayed in the Finder menu as either a simple battery icon or — my
favorite — as a percentage of power remaining (with a fully charged bat-
tery registering at 100%). To display the percentage, click the battery
icon on the Finder menu, and choose Show Percentage.

Keep in mind that the percentage shown is estimated by using your
current System Preferences settings and power usage. So if you change
your Energy Saver settings or remove a USB device that draws power
from your laptop, you see that change reflected in the battery meter.
Figure 2-1 shows the battery meter in Percentage view.

Battery Meter
Y0 $ & o) 100%EE Sat12:42PM Mark Chambers Q=

—

| -
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v~ Calibrate your battery. You can “train” your battery to provide the max-
imum charge by calibrating it, which Apple recommends doing monthly.
The process is a snap:

1. Charge your battery until the Finder menu battery meter indicates
that the unit is fully charged, at 100%.

2. Keep your laptop connected to an AC socket for another two hours to
ensure a maximum charge.

vww . allitebooks.cond
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3. Disconnect the power cord and use your laptop on battery power

until it is fully discharged and automatically switches to sleep mode.

Make sure you close all your applications when you see the low
battery warning dialog box so that you don’t lose anything.

4. Allow your laptop to sleep (or turn it off) for a full five hours.

5. Reconnect the AC cord and fully charge your battery.

+ Invest in an external battery. If you often find yourself running out of

battery power on the road without an AC socket handy, consider buying
an external battery. These handy units are specially designed to charge

your MacBook and other USB-powered devices when no other power

source is available. A rechargeable battery can power and charge your

MacBook, as well as an iPhone and other USB devices.

If your battery is no longer holding a charge — in other words, if you
fully charge it and unplug the AC adapter, only to discover that you have
only a few minutes of battery life — it’s time to invest in a replacement

battery. If you use an older Mac laptop with a replaceable battery, you
can buy a new battery (from Apple or an online vendor) and install it
yourself. Unfortunately, owners of current MacBook models must take

their computers in for servicing. Today’s Mac laptop is a sealed unit, and

you can’t replace the battery yourself.

Hot patootie! Is my laptop steam-powered?

Laptops generate heat. Today's super-fast
multicore processors can work up a head of
steam (pun intended) while you're using them.
Some of that heat radiates from the bottom
of the computer, even though most current
MacBook models have a fan.

What you might not realize, however, is just how
much heat your MacBook can produce. You
won't get burned if you shift your MacBook from
a desk to your lap (Apple dislikes lawsuits as
much as the next company), but that laptop will be
uncomfortably hot if you've been using it for hours!

To avoid that burning sensation, buy a laptop
stand or cooling pad for your desk. These nifty

metal or Plexiglas pedestals raise your laptop
off your desk, allowing air to flow under the
bottom of the computer for better cooling.
Also, a laptop stand elevates the screen to
a more ergonomic position. (The keyboard
might suddenly be harder to use, naturally, but
that's yet another reason why | recommend an
external keyboard when you're using your Mac
laptop at a semi-permanent desk location. The
other reasons are that an external keyboard
saves wear and tear on your laptop keyboard,
and you get the ease of using a full-size
keyboard.)

37
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Setting Up and Registering
Your Laptop

After your MacBook is running and you give it the once-over for obvious
shipping damage, your next chore is to set up your laptop. I won’t cover the
setup process step by step, unlike other tasks in this book. Apple tweaks the
questions you see during setup on a regular basis, and they are very easy to
answer. Everything is explained onscreen, complete with onscreen Help if
you need it.

However, I do want you to know what to expect, as well as what information
you need to have at hand. I also want you to know about support opportuni-
ties and neat features like Apple’s iCloud. Hence this section. Consider it a
study guide for whatever your MacBook’s setup procedure throws at you.

Your iCloud account is your friend

Remember when you were offered the chance to create an iCloud account
(also known as an Apple ID) during the initial setup of El Capitan? (If you
already had an iCloud account from an earlier version of OS X, or you created
an Apple ID while using your iPad or iPhone, you skipped ahead without a
second thought.) If you're careful about your online travels and you decided
not to supply your personal data, however, you may have passed up the
chance to immediately create your iCloud account during El Capitan setup,
most likely thinking that you could take care of it later.

Unfortunately, you’ve probably realized by now that all sorts of OS X features
and applications hinge on your iCloud account, including the App Store,
Messages, the iTunes Store, and FaceTime. If you haven’t created your iCloud
account yet, take care of that chore now. It’s free and painless and makes you
one of the In Crowd.

When you’re prompted for an iCloud password by one of the aforementioned
applications, click the Create Apple ID/iCloud Account button to start the
ball rolling. The application leads you through the process step by step. You
can also create your ID through the App Store or the iTunes Store. Click the
Account link in either of these applications, and you're prompted to create
your iCloud account.
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Setting up 0S X El Capitan

After you start your computer for the first time — or if you just upgraded
from OS X Yosemite — your laptop will launch El Capitan Setup automati-
cally. The setup process takes care of a number of tasks:

v Setup provides El Capitan with your personal information. As | men-
tion in Chapter 1, your Mac ships with a bathtub full of applications.
Many of them use your personal data (such as your address and tele-
phone number) to automatically fill out your documents.

If that stored personal information starts you worrying about identity
theft, I congratulate you. If you're using common sense, sharing your
personal data at any time should make you uneasy. However, in this
case, Apple doesn’t disseminate this information anywhere else, and the
applications that use your personal data won’t send it anywhere, either.
And Safari, the Apple web browser, fills out forms on a web page auto-
matically only if you give your permission.

1 Setup creates your user account. You're prompted for a username and
password, which Setup uses to create your administrator-level account.

v Setup configures your language and keyboard choices. OS X is a truly
international operating system, so you are offered a chance to configure
your laptop to use a specific language and keyboard layout.

1 Setup configures your email accounts in Apple Mail. If you already
have an email account set up with your ISP, keep handy the email
account information that the ISP provided to answer these questions.
The info should include your email address and your login name and
password. El Capitan can even automatically configure your email
account for you (including many web-based email services such as
Google Mail, Yahoo! Mail, and Outlook) if you supply your account ID
and password. Sweet.

v Setup allows you to open an iCloud account. Apple’s iCloud service
just plain rocks — especially the free storage. Take my word for it: Join
up, trooper, and create your iCloud account during setup. The standard
iCloud service is free, and upgrading to additional space is a breeze if
you decide you like the service benefits. I go into these benefits in detail
in Chapter 9, but for now, just sign up (or sign in, if you already have an
existing iCloud account) and take the opportunity to feel smug about
owning an Apple computer.

1 Setup sends your registration information to Apple. As a proud owner
of a MacBook, take advantage of the year of hardware warranty support
and the free 90 days of telephone support. All you have to do is register
to use '’em. Rest assured that all this info is confidential.
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1 Setup offers to launch Migration Assistant. This assistant guides you
through the process of migrating (an engineer’s term for moving) your
existing user data from your old Mac or PC to your laptop. Naturally, if
your MacBook is your first Macintosh computer, you can skip this step
with a song in your heart! (Read more on Migration Assistant in the later
section, “Importing Stuff from Another Mac.”)

Registering your MacBook

I'll be honest: Many people, myself included, don’t register every piece of
computer hardware they buy. For example, I didn’t register the wireless
Bluetooth adapter I bought for my older iBook because the expenditure was
only around $40, the gizmo has no moving parts, and I'm never likely to need
technical support to use it or get it fixed.

However, your MacBook is a different kettle of fish, so [ strongly recommend
that you register your purchase with Apple during the setup process. You
spent a fair amount on your computer, and your investment has a significant
number of very expensive parts. In fact, [ heartily advocate the purchase of
an AppleCare Protection Plan extended warranty with your new MacBook for
the ultimate in peace of mind — if you can invest a couple of hundred dollars
more, you'll have a full three years of service coverage from the

purchase date.

Even the hardiest of techno-wizards would agree with this important
Mark’s Maxim:

If you don’t register your new laptop, you can’t receive support.™

And rest assured that Apple is not one of those companies that constantly
pesters you with email advertisements and near-spam. I've registered every
Apple computer I've owned, and I've never felt pestered. (And I have an
extremely low tolerance for pester.)

Importing Stuff from Another Mac

If you're upgrading from an older Mac running OS X to your new Mac laptop,
I have great news: Apple includes Migration Assistant. This utility application
can help you copy (whoops — I mean migrate) all sorts of data from your
old Mac to your new machine. It does so via your laptop’s wired or wireless
Ethernet network connection or an existing Time Machine backup on an
external hard drive.
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As mentioned earlier, Setup launches Migration Assistant automatically if
you indicate that you want to transfer stuff during the setup process, but
you can always launch Migration Assistant manually at any time. Simply click
the Spotlight search icon (which looks like a magnifying glass) in the Finder
menu bar, then type Migration Assistant and press Return.

The list of stuff that gets copied includes the following:

v+ User accounts: If you set up multiple user accounts (so that more
than one person can share the computer), the utility ports them all to
your new Mac.

1 Network settings: Boy, howdy, this is a real treat for those with manual
network settings provided by an ISP or network administrator! Migration
Assistant can re-create the entire network environment of your old Mac
on your new laptop.

1 System Preferences settings: If you're a fan of tweaking and customizing
OS X so that it fits like a glove, rejoice. Migration Assistant copies all the
changes you’'ve made in System Preferences on your old Mac! (Insert
sound of angelic chorus: Hallelujah!)

v Documents: The files in your Documents folder(s) are copied to your
new MacBook.

v~ Applications: Migration Assistant tries its best to copy over third-party
applications you’ve installed in your Applications folder on the older
Mac. I say “tries its best” because you might have to reinstall some
applications. Some developers create applications that spread all sorts
of files across your hard drive, and Migration Assistant just can’t keep
track of those nomadic files. Other applications make the trek just fine,
but you might have to reenter their serial numbers.

By far, the easiest method of using Migration Assistant is over a wired or
wireless Ethernet network. Both computers should be connected to the same
network. (Because only the MacBook Pro still has an on-board Ethernet port,
you may require a Thunderbolt-to-Ethernet or USB-to-Ethernet adapter if you
decide to use a wired Ethernet connection.) Typically, you also have to run
Migration Assistant on the source computer. Or, if you're migrating data from
a PC, you must download and install the Windows Migration Assistant
(www.apple.com/migrate-to-mac).

If you've connected an external hard drive containing the Time Machine
backup files from your older Mac, just connect the drive to your new laptop.

After the two computers are connected (or you've connected the Time
Machine backup), simply follow the onscreen instructions displayed in the
Migration Assistant window. The application leads you through the pro-
cess step by step. If you need to return to the previous step at any time,
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click the Back button that appears at the bottom of the screen. Migration
Assistant may take an hour (over a wired connection) or even several hours
(over a wireless connection) to complete, depending on the amount of data
to be moved.

Importing Stuff from Windows
(If You Must)

If you're a Windows-to-Mac Switcher, you made a wise choice, especially if
you're interested in the creative applications in Apple’s digital lifestyle suite!
Although you could choose to start your Apple computing life anew, you
probably want to migrate some of your existing documents and files from
that tired PC to your bright, shiny new MacBook.

As mentioned in the preceding section, Windows Migration Assistant can
transfer much of the Windows data you want to take with you. If you find that
some files were left behind, you can move stuff manually as well. You can
copy your files to a USB flash drive or over a network. To make this manual
move more manageable, Table 2-1 covers a number of typical Windows file
locations in Windows 7, 8, and 10, their El Capitan counterparts, and the Mac
applications you’ll use to open them.

Table2-1  Moving Media and Documents betwixt Computers

File Type Windows Location =~ 0S X Location Mac Application

Music files My Music folder Music folder iTunes

Video and movie My Videos folder Movies folder QuickTime, DVD

files Player, iTunes

Digital photos My Pictures folder Pictures folder Photos

Office documents My Documents Documents folder Mac Office,
folder OpenOffice,

Pages, Numbers,
and Keynote

The OS X Help system contains an entire subsection on specific tricks you
can use when switching from Windows to Mac, including how to connect to a
Windows network and how to directly connect the two computers.
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Switching froma PC to ... an Apple PC?

With the El Capitan Boot Camp feature, you
can actually create a full Windows 7, 8, or 10
system on your Intel-based Mac laptop. Yup,
Windows and El Capitan coexist peacefully
on the same computer. However, you have to
reboot your computer to use your MacBook as
a Windows system.

This possibility brings a whole new meaning
to the term Switcher. Some Mac owners are
moving their stuff from Windows (running on
their old PC) to . . . well, Windows (running on
their new MacBook) rather than El Capitan. If
you decide to create a Windows system on your

MacBook with Boot Camp, the files and folders
on your existing PC can be copied directly by
using the Files and Settings Transfer Wizard
(in Windows XP), the Windows Easy Transfer
utility (in Windows Vista, 7, and 8). Windows 8.1
and 10 users will need a third-party application
to move files and folders, such as PCmover
Express from Laplink (www . laplink.com).
In effect, you're copying your settings and data
between your old PC and your new Apple-
based PC! (That sounds a little skewed, but die-
hard Apple apostles will have to forgive me.)

Manually moving existing Windows applications (such as PaintShop Photo
Pro) to your laptop’s drive usually doesn’t work even with Boot Camp —
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Apple’s dual-boot feature that allows you to run both El Capitan and Windows
7,8 or 8.1, or 10 on your MacBook. Most Windows software installs all sorts
of necessary files in several folders across your drive, and manually moving
applications doesn’t put those files where they should go. Instead, you have
to install Windows 7, 8, or 10 on your Mac laptop (using Boot Camp) and then
reinstall your Windows applications.

If you decide to run Windows on your laptop (using Boot Camp or an appli-
cation that creates a virtual computer), visit www.dummies.com/extras/
macbook or my website, www .mlcbooks . com, and download the PDF bonus
chapter “Running Windows on Your Mac.” You’ll be glad you did!

A\\S


http://www.dummies.com/extras/macbook
http://www.dummies.com/extras/macbook
http://www.mlcbooks.com/
http://www.laplink.com




Chapter 3

The MacBook Owner's
Introduction to OS X El Capitan

In This Chapter
Introducing OS X El Capitan Desktop
Coping with those missing trackpad buttons
Launching and quitting applications
Mastering Finder windows and shortcuts
Identifying and selecting items
Manipulating your Desktop with Mission Control and Dashboard
Storing everything in your Home folder
Customizing the Dock and Desktop
Taking care of the Trash (and rescuing precious stuff from it)
Printing your documents

Getting help while learning about El Capitan

A h, the Finder. Many admire its scenic beauty. But don’t ignore its
unsurpassed power or its many moods. And send a postcard while
you're there.

Okay, so the El Capitan Finder might not be quite as majestic as the mighty
Mississippi River, but it’s the basic toolbox you use every day while piloting
your MacBook. The Finder includes the most common elements of OS X:
window controls, common menu commands, icon fun (everything from
launching applications to copying files), keyboard shortcuts, and even emp-
tying the Trash. In fact, you could say that if you master the Finder and learn
how to use it efficiently, you’re on your way to becoming a power user!

This chapter is your Finder tour guide, and we’re ready to roll. [ satisfy your
curiosity about your new playground and introduce you to the basic ele-
ments of the El Capitan Desktop, and I outline the resources available if you
need help with OS X.
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Oh, and I promise to use honest-to-goodness English in my explanations,
with a minimum of engineer-speak and indecipherable acronyms. (In return,
promise that you will boast about El Capitan to your family and friends. Aunt
Harriet might not be as technologically savvy as we are.)

Vour Own Personal Operating System

A\

El Capitan is a special type of software called an operating system (or OS, as
in OS X). This means that El Capitan essentially runs your MacBook and also
allows you to run all your other applications, such as iTunes and Photoshop.
It’s the most important computer application — or software — that you run.

Think of a pyramid, with El Capitan as the foundation and other applications
running on top.

You're using the OS when you aren’t running a specific application, such as
these actions:

v Copying files from a USB flash drive to your laptop’s internal drive
v Navigating through files and folders on your drive
v Choosing a different screen saver

Sometimes, El Capitan even peeks through an application while it’s running.
For example, OS X controls application actions such as these:

v The Open, Save, and Save As dialogs you see when working with files
in Photoshop

v The Print dialog that appears when you print a document in Pages
(Apple’s desktop publishing application)

In the following sections, I escort you around the most important hotspots in
El Capitan, and you meet the most interesting onscreen thingamabobs you
use to control your laptop. (I told you I wouldn’t talk like an engineer!)

The El Capitan Desktop

The El Capitan Desktop isn’t made of wood, and you can’t stick your gum
underneath. However, this particular desktop does work much like the sur-
face of a traditional desk. You can store things there, organize things into
folders, and take care of important tasks such as writing and drawing (using
tools called applications). Heck, you even have a clock and a trash can.
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Gaze upon Figure 3-1 and follow along as you venture to your Desktop and
beyond. I discuss each of these Desktop elements in more detail later in
this chapter.

Finder window

Back & Forward buttons Finder menu bar
Finder Window toolbar Window Title Bar Hard Drive icons
® | Finder File Efit View Go Window Help u J (O] Z W) 31%W ) Wed11:30PM Mark fhambers Q=
eAe® iCloud Drive —
Bl=0wo = % T ) - i
iCloud Drive = &
Favorites Ludwig
£2 Dropbox
E) All My Files e &3 ./ =
€7 iCloud Drive k’ = L £ E
@ AirGrop
P Automator Documents Keynote Numbers Pages
A Applications
[ Desktop
M Documents [ 1
& Downloads { I
i Movies / f’
1 Music
I8 Pictures Script Editor sith TextEdit
75 mark
[ 1
Cloud Drive
[ . =\ ] - ; Uy A | @ e
k@R BD: FsCCLOOOR" ,

Dock Sidebar Folder icons Photo icon Trash Can

Meet me at the Dock

The Dock is a versatile combination: one part organizer, one part application
launcher, and one part system monitor. From the Dock, you can launch
applications — for example, the postage stamp icon represents the Apple
Mail application, and clicking the spiffy compass icon launches your Safari
web browser. Icons in the Dock also allow you to see what’s running, and
display or hide the windows shown by your applications.

Each icon in the Dock represents one of the following (many of which are
proudly displayed in Figure 3-2):

»* An application you can run (or that is running)

v An application window that’s minimized (shrunk)

b7
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v A web page URL link
v A document or folder on your system
v A network server, shared document, or shared folder

v Your Trash

Figure 3-2:
The Dock
can contain | [ IEpIMI T 11 1= Tes e SL O IQISI@IF |
all sorts of : :
exotic icons.
|

= .
H ¢

A\
The Dock is highly configurable:

v It can appear at different edges of the screen.
v~ It can disappear until you move the pointer to the edge to call it forth.

v You can resize it.

Dig those crazy icons
(== By default, El Capitan always displays at least one icon on your Desktop:

your Mac’s internal drive. To open a drive and view or use the contents, you
double-click the icon. Each icon is a shortcut of sorts that represents some-
thing, including
v CDs and DVDs (if you have an optical drive)
= v An iPod Classic
@\ v External hard drives, solid-state drives, and USB flash drives
w===  » Applications and documents
v~ Files and folders
1 Network servers you access
Note that an icon can represent applications you run and documents you

create. Sometimes you single-click an icon to watch it do its thing (as in the
Dock), but usually you double-click an icon to make something happen.
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There’s no food on this menu

The menu bar isn’t found in a restaurant. You find it at the top of the
Desktop, where you can use it to control your applications. Virtually every
application you run on your laptop has a menu bar.

To use a menu command, follow these steps:

1. Click the menu title (such as File or Edit).

2. Choose the desired command from the list that appears, as shown in
Figure 3-3.

Apple Menuicon

@ Keynote JIgld| Edit Insert Side Format Armange View Play Share Window Help 3 < 4 ) WedG:33PM_Mark Chambers Q=
® J New... BN Example Presentation 2
B~ em-| Open. #0 ) 3 B = = -l @ . =

Open Recent * [pa absle ar et Shape  Media Comment hare  Tips Format Animate Document
Close BwW

Save..

Duplicate

Rename...

Move To...

Revert To

PowerPaint...
QuickTime...
HTML...

Advanced

Set Password...

Images...
Change Theme... Keynote '03.
Save Theme...

Print...
I

Figure 3-3:
Clicking a
menu | - .
displays a MARK PRESENTS:
list of menu |- OUR FIRST KEYNOT
commands.
|

When you click a menu, it extends down so that you can see the commands
it includes. While the menu is extended, you can choose any enabled menu
item (just click it) to perform that action. You can tell that an item is enabled
if its name appears in black. Conversely, a menu command is disabled if it
appears grayed out. Clicking it does nothing.

«3‘& When you see a menu path printed in this book (such as Filew> Save), it’s just
a visual shortcut that tells you to click the File menu and then choose Save
from the drop-down menu that appears.
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Virtually every Mac application has some menus, such as File, Edit, and
Window. You're likely to find similar commands within these menus.
However, only two menus are in every OS X application:

v The Apple menu, which is identified with that jaunty Apple Corporation
icon, &. This is a special menu because it appears in both the Finder
menu bar and the menu bar in every application you run. It doesn’t
matter whether you’re in iTunes or Photoshop or Word. If you can see a
menu bar, the Apple menu is there. The Apple menu contains common
commands to use no matter where you are in El Capitan, such as
Restart, Shut Down, and System Preferences. Figure 3-3 proudly displays
the Apple icon at the upper left.

v The Application menu, which always bears the name of the active appli-
cation. For instance, the DVD Player menu group appears when you run
the El Capitan DVD Player, and the Word menu group appears when you
launch Microsoft Word.

You can also display a context or shortcut menu — which regular human
beings call a right-click menu — by right-clicking the El Capitan Desktop, an
application, a folder, or a file icon. (Because your MacBook is equipped with
a trackpad, you can right-click by tapping the trackpad with two fingertips. I'll
explain more on tapping later in this chapter.)

The Finder menu bar is your friend

Whenever the Finder itself is ready to be used (or, in Mac-speak, whenever
the Finder is the active application), the Finder menu bar appears at the top
of the screen. You know the Finder is active and ready when the word Finder
appears at the left of the menu bar.

There’s always room for one more window

You're probably already familiar with the ubiquitous window itself.
Both El Capitan and the applications you run use windows to display
things such as

v The documents you create

v The contents of your drive

For example, the window shown in Figure 3-1 is a Finder window, where

El Capitan gives you access to the applications, documents, and folders on
your system. You use Finder windows to launch applications, to perform
disk chores such as copying and moving files, and to navigate your

hard drive.
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It's Apple to the rescue!

UNIX is the established, super-reliable OS that
powers most of the high-performance servers
that make up the Internet. UNIX has built-in
support for virtually every hardware device
ever wrought by the Hand of Man (including all
the cool stuff that comes with your MacBook).
It's also well designed and highly efficient.

Unfortunately, standard UNIX looks as hideous
as old-fashioned character-based DOS,

ease of use for normal human beings like you
and me goes out the window. Enter the genius
types at Apple, who understood several years
ago that all UNIX needed was a state-of-the-
art, novice-friendly interface. To wit: 0S X was
developed with a UNIX foundation (or core), so
it shares the same reliability and performance
as UNIX. However, the software engineers at
Apple (who know a thing or two about ease of
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complete with a confusing command line. So s e o i) el el @y T

Wait a Second: Where the Heck
Are the Mouse Buttons?

El Capitan takes a visual approach to everything. What you see in Figure 3-1
is designed for point-and-click convenience, because the trackpad is your
primary navigational tool while you’re using your Mac laptop. You move your
finger over the surface of the trackpad, and the pointer follows like an obedi-
ent pup. The faster you move your finger, the farther the pointer goes. When
your pointer is over the desired item, you tap it (or click it, if you prefer the
more familiar term), it opens, you do your thing, and life is good.

\NG/
Vg‘“ Never use any object other than your finger on the trackpad! That means no
pencils (no, not even the eraser end), pens, or chopsticks; they can damage
your trackpad in no time.

If you've grazed on the other side of the fence — if you’re one of Those Who
Were Once Windows Users — you're probably accustomed to using a mouse
with at least two buttons. This brings up the nagging question: “Hey, Mark!
Where the heck are the buttons?”

In a nutshell, the buttons simply ain’t there if you’'re using your Mac laptop’s
trackpad. The entire surface of the trackpad can act as both buttons. To
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customize how the trackpad operates, click the System Preferences icon in
the Dock, and then click the Trackpad icon. From the Point & Click pane, for
example, you can

v Select the Tap to Click check box: Now, when you tap once quickly any-
where on the trackpad, your Mac laptop counts that as a click. Tap twice
quickly, and your MacBook recognizes that as a double-click.

1 Select the Secondary Click check box: A single tap with two fin-
gers displays the right-click menu (which I cover in more detail in a
page or two).

1 Select the Look Up & Data Detectors check box: If your Mac laptop is
equipped with a Force Touch Trackpad, you can choose how Force Click
operates (along with the Force Click and Haptic Feedback check box,
which provides physical feedback from the trackpad). Note that these
two checkboxes will not appear if your Macbook has an older trackpad.

+ Enable the Look Up check box: Tap the trackpad with three fingers to
look up a selected word in the Dictionary.

1+ Enable the Three Finger Drag check box: (Sounds like a dance from the
’60s, doesn’t it?) By using three fingers, you can drag around windows
on your Desktop to reposition them.

v Adjust your tracking speed and Force Click pressure: Click and drag
the Tracking speed slider to speed up or slow down the rate at which
the pointer moves. The Click pressure slider controls how hard you
must press to activate Force Click.

Apple has done a great job of illustrating each gesture available from the
Trackpad pane in System Preferences. A short video clip shows you both the
gesture itself and the effect of that gesture within OS X.

I'll be honest: When my laptop is on my desk at home, [ plug in a Logitech
optical trackball. This neat device has two buttons and a scroll wheel, saving
me wear and tear on my trackpad and offering even finer control in my appli-
cations. In fact, a new industry is springing up for tiny USB mousing devices
made especially for laptops. Some devices are smaller than a business card,
but they still carry a full complement of two buttons and a scroll wheel.

In this book I refer to the pointer whether you’re using the trackpad or a
mouse. So here’s a Mark’s Maxim [ think you’ll appreciate more and more as
you use your laptop.

If you can afford a USB or wireless Bluetooth mouse or trackball for your
laptop, buy it. You can thank me later with an email message sent to
mark@mlcbooks.com.™


http://mark@mlcbooks.com
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Doing the Multi-Touch and Force Click things

Today’s crop of MacBooks has the smartest
trackpads on the planet! That's because
Apple’s latest mice and trackpads include two
features. Multi-Touch allows you to control the
view of a document by using specific finger
motions on the trackpad surface, while Force
Click activates specific features if your fingers
press down harder on the trackpad surface.
(Your Macbook must be equipped with a Force
Touch trackpad to use a Force Click).

At the time of this writing, here’s the rundown:

v Two-finger scrolling: Move two fingers
over the surface of the trackpad at once
to scroll the contents of the active Finder
window or application in the same direc-
tion. For example, you can use the scroll
function to move up and down through the
pages of a document or to move up and
down through a long web page. Who needs
scroll bars?

v Two-finger zooming: Pinching your thumb
and forefinger toward each other on the
trackpad zooms in on a document or image.
The reverse (moving your fingertips away
from each other) zooms out.

v Two-finger Smart Zoom: Tap twice with two
fingers to zoom in, and double-tap again
with two fingers to zoom back out.

v+~ Two-finger rotating: Move your thumb and
forefinger in a circle on the trackpad to
rotate an image or document in the corre-
sponding direction.

v+~ Two-finger paging: Swipe your thumb and
forefinger to the left or right across the

trackpad to page through a document or to
move to the next or previous image in a set.

v~ Three-finger full-screen switching: Swipe
your thumb and first two fingertips to the
left or right across the trackpad to move
between open applications in full-screen
mode.

v Two-finger Notification Center display:
Swipe to the left with two fingers from the
right edge of the trackpad, and El Capitan
displays the Notification Center. To hide the
panel, reverse the gesture and swipe from
the left edge to the right using two fingers.

v Perform actions in Mission Control,
Launchpad, and your Desktop: Using the
combination of thumb and fingers you
specify, you can configure the display
and operation of these features within El
Capitan.

v~ Force Click data on your screen to display
additional information: You can Force Click
on a text or links in documents, web pages,
and email messages to display related data,
or Force Click on a document icon to dis-
play its contents without opening it. Other
Force Click functions vary by application,
but you can check the Help system within
any application to see if it offers Force Click
commands.

Note that not all Multi-Touch gestures work
with older MacBook trackpads, and you'll only
find Force Touch on the latest Mac laptops.
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If you tap the trackpad with two fingertips (or click the right mouse button
on a USB mouse), El Capitan performs the same default function that a right-
click does in Windows. Namely, with a right-click on most items — icons,
documents, even your Desktop — you get a shortcut menu of commands spe-
cific to that item.

Figure 3-4 shows a typical convenient right-click menu in a Finder window. I
have all sorts of cool items at my disposal on this menu because of the appli-
3 cations I've installed that make use of a right-click menu.

Visit the Mouse pane in System Preferences to configure your mouse, as well.
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Launching and Quitting Applications
with Aplomb

Now it’s time to pair your newly found trackpad acumen with the El Capitan
Finder window. Follow along with this simple exercise. Move the pointer over
the iTunes icon in the Dock. (This icon looks like a circle with a musical note
on it.) Then tap the trackpad once (see the preceding section for how to set
this preference). Whoosh! El Capitan launches (or starts, or runs) the iTunes
application, and you see a window much like the one shown in Figure 3-5.
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Click a Dock icon to launch application

If an application icon is already selected (which I discuss later in the chap-
ter), you can simply press 38+0 to launch it. The same key shortcut works
with documents, too.

Besides the Dock, you have a plethora of other ways to launch an application
or open a document in El Capitan:

+* From the Apple menu (&): You can launch a number of applications
from anywhere in El Capitan using the Apple menu. Click System
Preferences to change all sorts of settings, such as your display back-
ground and how icons appear. Click App Store to launch the OS X App
Store and display software that you can download for your laptop. (Most
are commercial applications that you have to pay for, but many great
free applications are available as well.) You can also use the App Store to
see whether update patches are available for your Apple software.

v From the Launchpad: Arrange all your application icons in a full-screen
display. (The Launchpad icon in the Dock bears a spiffy rocket.) If you
have more than one screen (or page) worth of applications, press the
arrow keys to move between Launchpad pages. Using the trackpad,
swipe two fingers to the left or right. To launch an application, just click
the icon. (If you're the proud owner of an iPhone, iPad, or iPod touch,
the Launchpad is familiar, because it corresponds directly to the i0S
Home screen on those devices.)
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Dig that crazy Launchpad!

You can customize your Launchpad display by
dragging icons to arrange them in the order you
prefer. (For example, | have all the applications |
use the most on the first Launchpad page.) Drag
an application icon to the right or left side of the
screen to move it to another page.

Launchpad, like a Finder window, allows
you to create folders to help organize your
applications. To create a folder in Launchpad,
drag one application icon on top of another, and
then add other icons by dragging them to the
folder (or remove them by dragging them out of
the folder). To run an application within a folder,
click the folder icon to display the icons within
it, and then click the desired application. To
change a folder name, click the folder to open

v From the Desktop: If you have a document you created or an application

it, click the folder name to display a text-editing
box, type the new moniker for the folder, and
press Return.

If you want to remove an application from
Launchpad — which also deletes the
application from your MacBook entirely —
click the icon and continue pressing the
trackpad until the icons start to wiggle. (Yes,
you read that correctly; | wrote wiggle. iPhone
and iPad owners know what | mean.) Click the
tiny delete (X) button that appears next to the
icon whose application you want to delete, and
the icon — and its application — disappear.
Press Esc to stop all that wiggling. (Note that
applications supplied with El Capitan can’t be
deleted this way.)

icon on your Desktop, you can launch or open it from the Desktop by
double-clicking that icon (tapping the trackpad twice with one finger in
rapid succession when the pointer is on top of the icon).

Double-clicking a device or network connection on your Desktop opens

the contents in a Finder window. This method works for CDs and DVDs
you've loaded, as well as external drives and USB flash drives. Just
double-click ’em to open them and display their contents in a Finder
window. Applications and documents typically launch from a CD, a DVD,
or an external drive just like they launch from your internal drive (the
one that’s typically named Macintosh HD). So you don’t have to copy
stuff from the external drive just to use it. Note, however, that running

an application directly from your optical or external drive usually causes
the application to run significantly slower. (Oh, and don’t forget that you
can’t change the contents of most CDs and DVDs; they're read-only, so
you can’t write to them.)

v+ From the Recent Items selection: When you click the Apple menu and
hover the pointer over the Recent Items menu item, the Finder displays
all the applications and documents you used over the past few comput-
ing sessions. Click an item in this list to launch or open it.
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v From the Login Items list: Login items are applications that El Capitan
launches automatically each time you log in to your user account. I
cover login items in detail in Chapter 10.

v+ From the Finder window: You can also double-click an icon within the
confines of a Finder window to open it (for documents), launch it (for
applications), or display the contents (for a folder).

The OS X Quick Look feature can display the contents of just about any docu-
ment or file — but without actually opening the corresponding application!
Sweet. To use Quick Look from a Finder window, click a file to select it, and
then press the spacebar.

3

After you finish using an application, you can quit that application to close
its window and return to the Desktop. Here are a number of different ways to
quit an application:

v Press 38+Q. This keyboard shortcut quits virtually every Macintosh
application. Just make sure that the application you want to quit is cur-
rently active first (the application name should appear immediately to
the right of the Apple [&] menu).

v Choose the Quit command from the application’s menu. To display
the Quit command, click the application’s named menu from the menu
bar. As I just mentioned, this menu is always to the immediate right of
the Apple (&) menu. For example, Safari displays a Safari menu, and that
same spot in the menu bar is taken up by Calendar when Calendar is
the active application. Refer to Figure 3-5, and look for the iTunes menu,
right next to @ at the very top of the figure.

v Choose Quit from the Dock. You can right-click an application’s icon in

\y
P the Dock and then choose Quit from the menu that appears.

A running application displays a small dot under its icon in the Dock.

+* Click the Close button in the application window. Some applica-
tions quit entirely when you close their window, such as the System
Preferences window or the Apple DVD Player. Other applications might
continue running without any window, such as Safari or iTunes; to close
these applications, you have to use another method in this list. (More on
window controls like Close in the next section.)

@‘“‘NG! v Choose Force Quit from the Apple menu. This is a last-resort mea-

S sure! Use this method only if an application has frozen and you can’t
use another method in this list to quit. Force-quitting an application

doesn’t save any changes to any open documents in that application!

57
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Performing Tricks with Finder Windows

3

In the following sections of your introduction to OS X, I describe basic win-
dows management in El Capitan: how to move things around, how to close
windows, and how to make windows disappear and reappear like magic.

Scrolling in and resizing windows

Can you imagine what life would be like if you couldn’t see more than a single
window’s worth of stuff? Shopping would be curtailed quite a bit — and so
would the contents of the folders on your MacBook’s drives!

That’s why El Capitan adds scroll bars that you can click and drag to move
through the window’s contents. (By default, scroll bars don’t appear in El
Capitan until you move the pointer close to them.) You can

v Click the scroll box and drag it. For the uninitiated, that means clicking
the darker portion of the bar and holding down your finger on the track-
pad while you move your finger in the desired direction.

v Click anywhere in the empty area above or below the scroll box to scroll
pages one at a time.

v+ Hold down the Option key and click anywhere in the empty area above
or below the bar to scroll to that spot in the document.

Of course, you can also drag two fingertips across the trackpad to scroll a
window’s contents (both vertically and horizontally). To control trackpad
behavior, open System Preferences and click the Trackpad pane. You can
read all about configuring trackpad settings in the earlier section “Wait a
Second: Where the Heck Are the Mouse Buttons?”

Figure 3-6 shows two horizontal scroll bars in a typical Finder window, as
well as the Sidebar and three Finder Tabs.

Often, pressing the Page Up and Page Down keys moves you through a docu-
ment one page at a time. Also, pressing the arrow keys moves the insertion
pointer one line or one character in the four compass directions.

You can also resize most Finder and application windows by enlarging or
reducing the window frame itself. Move the pointer over any corner or edge
of a window, and then drag the edge in any direction until the window is
the precise size you need. (More information on dragging pops up later in
this chapter.)



|
Figure 3-6:
A plethora
of helpful
window
controls.
|

Chapter 3: The MacBook Owner's Introduction to 0S X El Capitan

Close button
Minimize button
Zoom/Fullscreen button
Icons Toolbar

Sidebar Finder tabs

' X ) [ Applications
< oo e g TS a
Applu:lallnns mark
¢ iCloud Drive
@ AirDrop
| A Applcations
= Desktop
@ Documents
© Downloads
EI Movies
JJ Music
8 Pictures
ﬁj mark

Devices
3 SuperDragon

.+I

1
iCioud Drivel

E‘ /

Photo Booth Photos

Octagon Pages

Q

g

-

Eﬂ Wolfgang Preview QuickTime Player Reminders Safari
) Johann
[Z) Time Machine Backups = ‘
= ey
ke Games 5%’;& Foas
@ Red 1 M
Orange ——

Yellow Screen Utility SketchBook Snapz Pro X

Green

& Ludwig > [ Applications

52 items, 169.6 GB anwaple

Tags Scroll box Scroll bar

Minimizing and restoring windows

Resizing a window is indeed helpful, but maybe you simply want to banish
the doggone thing until you need it again. That’s a situation for the Minimize
button, which also appears earlier, in Figure 3-6. A minimized window disap-
pears from the Desktop but isn’t closed; it simply reappears in the Dock as

a miniature icon. Minimizing a window is easy: Move the pointer over the
Minimize button (the second of the three buttons at the upper-left corner

of the window) — a minus sign appears in the button to tell you you're on
target — and then click. Here’s a good shortcut: Double-clicking the window’s
title bar (the top frame of the window, which usually includes a document or
application name) minimizes the window.
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Hold down the Shift key while you minimize, and prepare to be amazed when
the window shrinks in slow motion like Alice in Wonderland!

To restore the window to its full size (and its original position on the
Desktop), just click its window icon in the Dock.

Moving and zooming window's

Perhaps you want to move a window to another location on the Desktop so
that you can see the contents of multiple windows at the same time. Click the
window’s title bar and drag the window anywhere you like. Then release the
button. (Don’t click the icon in the center of the title bar, though. You’ll move
just the icon itself, not the window.)

Many applications can automatically arrange multiple windows for
you (examples include Microsoft Word and PowerPoint). Choose
Window > Arrange All (if this option appears).

To see everything a window can show you, use the Zoom feature to expand
any Finder or application window to its maximum practical size. (Zooming

a Finder window is different from zooming with the Multi-Touch feature,
because you're expanding only the Finder window, not an image or docu-
ment.) Note that a zoomed window can fill the entire screen, or (if that extra
space isn’t applicable for the application) the window might expand to only a
larger part of the Desktop.

To zoom a window, move your pointer over the third button at the top-left
corner of the window. Again, refer to Figure 3-6, which struts its stuff and
illustrates the position. (Man, that is one versatile figure.) A double-arrow
icon appears on the Zoom/Full-Screen button. Click to expand your hori-
zons to full-screen, or hold down the Option key while clicking to zoom the
window to maximum size.

Speaking of full-screen operation, it comes in very handy on a smaller laptop
display — that’s where a single application fills the entire screen, without
displaying a window frame or traditional Finder menu bar. The method you
use to switch to full-screen mode varies depending on the application, so
there’s no One Menu Command or One Keyboard Shortcut that will always
do the deed. Most of the applications included with OS X El Capitan use
View> Enter Full Screen, and many applications have a button you can click
in the window to switch back and forth. A click on the Zoom/Full-Screen
button switches most Apple applications into full-screen. Finder windows can
also be switched to full-screen mode in El Capitan! To exit full-screen mode,
just press Esc.



Chapter 3: The MacBook Owner's Introduction to 0S X El Capitan

Toggling toolbars the El Capitan way

It's time to define a window control that's
actually inside the window for a change. A
toolbaris a strip of icons that generally appears
under the window's title bar (although toolbars
can appear in other locations as well). These
icons typically perform the most common
actions in an application; the effect is the same
as if you used a menu command or pressed a
keyboard shortcut. Toolbars are popular these
days. You see ‘em in everything from the Finder
window to most application windows.

You can usually banish a window's toolbar
to make extra room for icons, documents, or
whatever the window happens to be holding.
Just choose Viewr> Hide Toolbar. To restore
the toolbar to its original position, choose
View=> Show Toolbar. Nete: If you toggle the
Finder window toolbar off, you also lose the
Finder window sidebar.

So how do you switch between applications if they’re all in full-screen mode?

v Move your pointer to the bottom of the screen to display the Dock,
where you can click another application to switch to it.

v Invoke Mission Control and choose another application from there.
(More about Mission Control later in this chapter.)

1 Swipe three fingers to the left or right across the trackpad surface.

v From the keyboard, use the $8+Tab shortcut to cycle through the appli-

cations you have running.

Closing windows

When you’re finished with an application or you no longer need to have
a window open, move the pointer over the Close button at the upper-left

01

corner of the window (it’s the first of the three circular buttons). When the
X appears in the button, click it. (And yes, I can make one more reference to
Figure 3-6, which I'm thinking of nominating as Figure of the Year.)
o Perhaps you have more than one window open in the same application, and
you want to close ’em all in one fell swoop. Hold down the Option key while
you click the Close button in any of the windows.
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v The active window is on top of other win-
dows. (You can still use a window's Close,

Only one window can be active at once™

Here's a very special Mark’s Maxim in the 0S Minimize, and Zoom buttons when the
X universe: window is inactive.)

Only one application window can be 1~ Any inputyou make by typing or by moving
active in El Capitan at any time.™ your finger on the trackpad appears in the

active window.

You can always tell which window is active:

v 0S X dimsthe title bars of inactive windows
you haven't minimized.
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If you haven’t saved a document, and you try to close that application’s
window, the application gets downright surly and prompts you for confirma-
tion. “Hey, human, you don’t really want to do this, do you?” If you answer
in the affirmative — “Why, yes, machine. Yes, indeed, [ do want to throw this
away and not save it.” — the application discards the document you were
working on. If you decide to keep your document (thereby saving your pos-
terior from harm), you can cancel the action and then save the document
within the application.

Juaggling Folders and Icons

Finder windows aren’t just for launching applications and opening the files
and documents you create. You can also use the icons in a Finder window to
select one or more specific items or to copy and move items from place to
place within your system.

A field observer’s guide to icons

Not all icons are created equal. Earlier in this chapter, [ introduced you to
your MacBook’s drive icon on the Desktop. Here’s a little background on the
other types of icons you might encounter during your mobile Mac travels:

1 Hardware: These icons are your internal storage devices (such as your
hard drive and optical drive, if you have one) as well as external periph-
erals — like an external hard drive or a USB flash drive.
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v~ Applications: These icons represent the applications (or programs) you
can launch. Most applications have a custom icon that incorporates the
company’s logo or the specific application logo. Double-clicking an appli-
cation usually doesn’t load a document automatically; you typically get a
new blank document or an Open dialog box from which you can choose
the existing file you want to open.

+* Documents: Many of the files on your hard drive are documents that
can be opened in the corresponding application; the icon usually looks
similar to the application’s icon so they’re easy to recognize, as you can
see in Figure 3-7. Double-clicking a document automatically launches the
associated application (that is, as long as OS X recognizes the file type).
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v Files: Most of the file icons on your system are mundane things such as
preferences and settings files, text files, log files, and miscellaneous data
files. Yet most are identified with at least some type of recognizable icon
that lets you guess what purpose the file serves. You’'ll also come across
generic file icons that look like a blank sheet of paper (used when El
Capitan has no earthly idea what the file type is).

v~ Aliases: An alias acts as a link to another item elsewhere on your
system. For example, to launch Adobe Acrobat, you can click an Adobe
Acrobat alias icon that you can create on your Desktop instead of click-
ing the actual Acrobat application icon. The alias essentially acts the
same way as the original icon, but it doesn’t take up the same amount of
space — only a few bytes for the icon itself, compared with the size of
the actual application. Plus, you don’t have to go digging through folders
galore to find the original application icon. (Windows switchers know
an alias as a shortcut. The idea is the same, although Macs had it first.
Harrumph.) You can always identify an alias by the small curved arrow
at the base of the icon, and the icon might also sport the tag alias at
the end of its name.
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You have two ways to create an alias. Here’s one:
1. Select the item.
The following section has details about selecting icons.
2. Choose Filew> Make Alias, or press 38+L.

Figure 3-8 shows three aliases for OS X applications, complete with
that fashionable alias arrow.
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Here’s another way to create an alias:
1. Hold down $8+Option.
2. Drag the original icon to the location where you want the alias.
A\

Note that this funky method doesn’t add the alias tag to the end
of the alias icon name unless you drag the icon to another spot in
the same folder.

So why bother to use an alias? Two good reasons:

+* You can launch an application or open a document from anywhere on
your drive. For example, if you occasionally need to use another appli-
cation while working on a Pages project, you can add an alias and launch
the other application directly from the folder where you store those
Pages documents. Speed, organization, and convenience. Life is good.

+* You can send an alias to the Trash without affecting the original item.
When that school project is finished, you can safely delete the entire
folder without worrying about whether Pages will run the next time you
double-click the application icon!
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Selecting items

Often, the menu or keyboard commands you perform in the Finder need to
be performed on something. Perhaps you’re moving an item to the Trash,
getting more information on the item, or creating an alias for that item. To
identify the target of your action to the Finder, you need to select one or
more items on your Desktop or in a Finder window. In the following sections,
[ show you just how to do that.

Selecting one thing

El Capitan gives you a couple of options when selecting just one item for an
upcoming action:

1 Move the pointer over the item and click. A dark border (or highlight)
appears around the icon, indicating that it’s selected.

v If an icon is already highlighted on your Desktop or in a window,
move the selection highlight to another icon in the same location
by using the arrow keys. To shift the selection highlight alphabeti-
cally, press Tab (to move in order) or press Shift+Tab (to move in
reverse order).

Selecting items in the Finder doesn’t actually do anything to them by
itself. You have to perform an action on the selected items to make some-
thing happen.

Selecting a whole bunch of things

You can also select multiple items with aplomb by using one of these
methods:

v Adjacent items:

¢ Drag a box around them. If that sounds like ancient Sumerian,
here’s the explanation: Click a spot above and to the left of the first
item. Keep holding down your finger on the trackpad surface, and
drag down and to the right. (This is dragging in Mac-speak.) A box
outline like the one shown in Figure 3-9 appears, indicating what
you're selecting. Any icons that touch or appear within the box
outline are selected when you release the button.

e Click the first item to select it, and then hold down the Shift key while
you click the last item. El Capitan selects both items and everything
between them.

+* Nonadjacent items: Select these by holding down the 38 key while you
click each item.
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P Check out the status bar (which can appear at the top or bottom of a Finder

window, depending on whether the toolbar is hidden). It tells you how
much space is available on the drive you’re working in, as well as how many
items are displayed in the current Finder window. When you select items, it
shows you how many you highlighted. (If you don’t see a status bar, choose
View=>Show Status Bar.)

Copying items

Want to copy items from one Finder window to another, or from one location
(like a flash drive) to another (like your Desktop)? Trés easy. Just use one of
these methods:

»* On the same drive

¢ To copy one item to another location: Hold down the Option key
(you don’t have to select the icon first), and then click and drag
the item from its current home to the new location.
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To put a copy of an item in a folder, just drop the item on top of the
receiving folder. If you hold the item you're dragging over the des-
tination folder for a second or two, El Capitan opens a new window
so that you can see the target’s contents. (This is called a spring-
loaded folder. Really.) You can turn off this spring-loaded behavior
by choosing Finder = Preferences and clicking the Spring-loaded
Folders and Windows check box to disable it.

e To copy multiple items to another location: Select them all (see the
preceding section), hold down the Option key, and then drag-and-
drop one of the selected items where you want it. All the items
you selected follow the item you drag. (Rather like lemmings. Nice
touch, don’t you think?)

To help indicate your target when you're copying files, El Capitan high-
lights the location to show you where the items will end up. (This works
whether the target location is a folder or a drive icon.) If the target loca-
tion is a window, El Capitan adds a highlight to the window border.

v On a different drive

e To copy one or multiple items: Click and drag the icon (or the
selected items if you have more than one) from the original
window to a window you open on the target drive. (No need to
hold down the Option key while copying to a different drive.) You
can also drag one item (or a selected group of items) and simply
drop the items on top of the drive icon on your Desktop.

e The items are copied to the top level, or root, of the target drive.

If you try to move or copy something to a location that already has an item
with the same name, you see a dialog that prompts you to decide whether

to replace the file or to stop the copy/move procedure and leave the exist-
ing file alone. (Heck, you can even keep both — OS X performs the copy or
move, but also appends the word copy to the item being copied.) Good insur-
ance, indeed.

Moving things from place to place

Moving things from one location to another location on the same drive is
the easiest action you can take. Just drag the selected item or items to the
new location. The item disappears from the original spot and reappears in
the new spot.
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My, what an attractive sidebar . .. and so useful!

Have you noticed the sidebar that typically
occupies the left side of a Finder window?
It's a pane of links to common locations and
devices that you can use to jump like a flash to
a specific spot on your hard drive. For example,
you can click the Applications link under the
Favorites heading, and you're transported to
your Applications folder in an instant.

Here's a great example of sidebar magic: |
like as few icons on my Desktop as possible,
so each book I'm working on gets its own
folder. All the items for that project that might
otherwise end up on my Desktop are saved to

that folder instead. In fact, | make a point of
adding my current book project folder to my
Finder window sidebar so that it's available
immediately from any Finder window. To do
this, just drag the folder into the column at
the left side of the Finder window and drop
it on top of the Favorites heading in the
sidebar’s list.

You can configure the items that will appear
in your sidebar: Choose Finder=> Preferences,
and then click the Sidebar tab to display the list.
From here, you can select and deselect check
boxes to configure your sidebar to your liking.

<MBER

Duplicating in a jiffy

If you need more than one copy of the same item in a folder, use the El

Capitan Duplicate command. I use Duplicate often when I want to edit a docu-

ment but want to ensure that the original document stays pristine, no matter
what. I just create a duplicate and edit that file instead.

To use Duplicate, you can

v Click an item to select it and then choose File=> Duplicate.

v Right-click the item and choose Duplicate from the menu.

v Hold down the Option key and drag the original item to another spot in
the same window. When you release the trackpad button, the duplicate

file appears like magic!

The duplicate item has the word copy appended to its name. A second copy
is named copy?2, a third is copy3, and so on.

Duplicating a folder also duplicates all the contents of that folder. Therefore,

creating a duplicate folder can take some time if the original folder was

stuffed full (or contained files several hundred megabytes or larger in size).
The duplicate folder has copy appended to its name, but the contents of the
duplicate folder keep their original names.
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Using Finder Tabs

El Capitan includes a powerful feature you can use to display multiple loca-
tions in the same window. Finder Tabs work just like the tabs in Safari (as well
as other popular browsers for both Macs and PCs), allowing you to switch
between multiple locations on your Mac instantly by clicking a tab to switch
to that location. You can even drag files and folders from tab to tab!

To open a new tab in a Finder window, you have a wealth of choices:

v Click the desired location and press 38+T.
v Right-click the location and choose Open in New Tab.

v Select the location and click the New Tab button (which bears a plus
sign) at the right side of the window.

v Click the Action icon (which bears a gear icon) in any Finder window
toolbar, and choose New Tab.

For example, suppose you’'re working on an iMovie project. You might create
tabs using the Applications item in the Finder window sidebar and a folder
(or even a DVD or shared drive) named Work that contains your video clips.
The location appears as a new tab immediately under the toolbar. You can
open as many tabs as you like, and you can also drag the Finder Tabs them-
selves to reorder them. To close a tab, hover the pointer over it and click
the X button that appears. That hardworking Figure 3-6 (shown earlier in the
chapter) shows three Finder Tabs at work.

You can also set new folders to open in tabs instead of windows. Just click
the Finder menu at the top of the Desktop, choose Preferences, and then
select the Open Folders in Tabs Instead of New Windows check box to
enable it.

\\j

Keys and Keyboard Shortcuts
to Fame and Fortune

Your MacBook’s keyboard might not be as glamorous as the trackpad, but
any Macintosh power user will tell you that using keyboard shortcuts is usu-
ally the fastest method of performing certain tasks in the Finder, such as
saving or closing a file. | reccommend committing these shortcuts to memory
and putting them to work as soon as you begin using your laptop so that they
become second nature to you as quickly as possible.
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Special keys on the keyboard

The Apple standard keyboard has a number of special keys that you might
not recognize — especially if you've made the smart move and decided to
migrate from the chaos that is Windows to OS X! Table 3-1 lists the keys
that bear strange hieroglyphics on the Apple keyboard and describes

what they do.

Table 3-1 Too-Cool Function Keys

Action/Key Name Symbol Purpose

Media Eject ‘ Ejects a CD or DVD from

— your optical drive (if you

have one)

Audio Mute Mutes (and restores) all
sound produced by your
MacBook

Keyboard N 1 P Increases, decreases, or

lllumination N Py turns off the brightness
of your keyboard
backlighting

Volume Up Increases the sound

volume

Volume Down

O

Decreases the sound
volume

Ctrl Ctrl Displays the right-click/
Control+click menu with
the trackpad

Command ® Primary modifier for
menus and keyboard
shortcuts

Delete Delete Deletes selected text

Option Option Modifier for shortcuts

Using the Finder and application
keyboard shortcuts

The Finder is chock-full of keyboard shortcuts that you can use to take care
of common tasks. Some of the handiest shortcuts are listed in Table 3-2.
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Table 3-2 El Capitan Keyboard Shortcuts of Distinction

Key Combination  Location Action

38+A Edit menu Selects all items (works in the Finder, too)

38+C Edit menu Copies the selected items to the Clipboard

38+H Application menu Hides the current application window

98+M Window menu Minimizes the active window to the Dock
(also works in the Finder)

38+0 File menu Opens or launches an existing document,
file, or folder (also works in the Finder)

38+P File menu Prints the current document

38+Q Application menu Exits (quits) the application, and prompts
you to save any changes

$8+T File menu Opens a new Finder tab with the currently
selected location

98+V Edit menu Pastes the contents of the Clipboard at
the current pointer position

38+X Edit menu Cuts the highlighted item to the Clipboard

R+7 Edit menu Reverses (undoes) the effect of the last
action you took

38+7 Help menu Displays the Help system (works in the
Finder, too)

8+Tab Finder Switches between open applications

38+0ption+M Finder Minimizes all Finder windows to the Dock

$8+0ption+W Finder Closes all Finder windows

But wait; there’s more! Most of your applications also provide their own set
of keyboard shortcuts. While you're working with a new application, display
the application’s Help file and print a copy of the keyboard shortcuts as a
handy cheat sheet.

If you've used a PC before, you're certainly familiar with three-key shortcuts.
The most infamous is Ctrl+Alt+Delete, the beloved reboot/Task Manager
shortcut nicknamed the Windows three-finger salute. Three-key shortcuts
work the same way in El Capitan (but you’ll be thrilled to know you don’t
need to reboot by using that notorious Windows shortcut!). If you’re new

to computing, to use a three-key shortcut, hold down the first two keys and
then press the third key.
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You're not limited to the keyboard shortcuts I've listed. In System
Preferences, visit the Keyboard pane and then click the Shortcuts tab to
change an existing shortcut or add a shortcut.

Home, Sweet Home Folder
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Each user account you create in El Capitan is actually a self-contained uni-
verse. For example, each user has a number of unique characteristics and
folders devoted to just that person, and El Capitan keeps track of everything
that user changes or creates. (In Chapter 10, I describe the innate loveliness
of multiple users living in peace and harmony on your laptop.)

This unique universe includes a different system of folders for each user
account on your system. The top-level folder uses the short username El
Capitan assigns when that user account is created. Naturally, the actual
folder name is different for each person. Mac techno types typically call this
folder your Home folder. (On the sidebar, look for the teeny house icon under
the Favorites heading, marked with your account name.)

When you’re on the hunt for your Home folder, don’t look for a folder that’s
actually named Home. Instead, look for the short username that was assigned
when you created the user account.

Each account’s Home folder contains a set of subfolders, including

v Movies
v Music
v Pictures

v Downloads (for files you download by using Safari or through Apple Mail
attachments)

v Public (for files you want to share with others on your network)
v Sites (for web pages created by the user)
v Documents (for files created by the user)
Although you can store your stuff at the root (top level) of your drive — or

even on your Desktop — that gaggle of files, folders, and aliases can get
crowded and confusing quickly. Here’s a Mark’s Maxim to live by:

Your Home folder is where you hang out and where you store your stuff.
Use it to make your computing life much easier!™
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Create subfolders within your Documents folder to organize your files and
folders even further. For example, I create a subfolder in my Documents
folder for every book I write so that I can quickly and easily locate all the
documents and files associated with that book project.

A\\S

[ discuss security in your Home folder and what gets stored where in
Chapter 10. For now, remember you can reach your Home folder easily,
because it appears in the Finder window sidebar. One click of your Home
folder, and all your stuff is within easy reach. (If your Home folder doesn’t
appear in the sidebar, that’s easy to fix: Choose Finder = Preferences, click
the Sidebar tab, and then select the check box to display your Home folder.)

In addition to using the Finder window sidebar, you can reach your Home
folder in other convenient ways:

v From the Go menu: Choose Go=> Home to display your Home folder
immediately from the Finder window. Alternatively, you can press
38+Shift+H to accomplish the same thing.

v From the Open dialog: The El Capitan standard File Open dialog also
includes the same Home folder (and subfolder) icons as the Finder
window sidebar.

+ In any new Finder window you open: If you like, you can set every
Finder window you open to automatically display your Home folder:

a. Choose Finder=> Preferences and click the General tab.

b. Click the arrow button at the right side of the New Finder Windows
Show pop-up menu.

A menu pops up (hence the name).

c. Click the Home entry (with the house icon and your short username)
in the menu.

d. Click the Close button at the upper-left corner of the dialog.

You're set to go. From now on, every Finder window you open dis-
plays your Home folder as the starting location!

Here’s another reason to use your Home folder to store your stuff: default
locations! El Capitan expects your stuff to be there when you migrate your
files from an older Mac to a new MacBook, and all Apple applications can use
your Home folder when loading and saving projects.

A\\S
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Working with Mission Control,
Spaces, and Dashboard

For those power users that often work with a passel of applications, allow me
to turn your attention to one of the sassiest features in El Capitan: Mission
Control. Figure 3-10 shows off the Mission Control screen:

1 Press F3 (or Control+T, depending on your keyboard) to show all
open windows using Mission Control, grouped by application; then
click the one you want. Figure 3-10 illustrates the tiled All Windows
display on my MacBook Air after I press F3. Move the pointer on top
of the window you want to activate — the window turns blue when it’s
selected — and click once to switch to that window. You can specify
which keys you want to use in the Mission Control pane in System
Preferences.

1 Press Ctrl+F3 (or Control+{, depending on your keyboard) to show
all open windows from the application that you’re currently using;
click the one you want to activate. This Mission Control function is
great for choosing from all the images you’ve opened in Photoshop or all
the Safari web pages populating your Desktop!

Figure 3-10:
Mission
Control is
the desktop
manager in
El Capitan.
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Astute observers will notice that the application menu bar also changes to
match the now-active application.
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Besides the F3 and Control+F3 hot keys that I just discussed, Mission Control
provides one more nifty function: Press 38+F3, and all your open windows
scurry to the side of the screen. Now you can work with drives, files, and
aliases on your Desktop — and when you’re ready to confront those dozen
application windows again, just press the keyboard shortcut a second time.

Although the Mission Control screen appears automatically when necessary,
you can launch it at any time from your MacBook’s Launchpad display or by
pressing the Mission Control key on your keyboard. From the trackpad, dis-
play the Mission Control screen by swiping up with three fingers.

Switching Desktops with Spaces

Ah, but what if you want to switch to a different set of applications? For
example, suppose that you're slaving away at your pixel-pushing job — say,
designing a magazine cover with Pages. Your page design desktop also
includes Adobe’s Photoshop and InDesign, which you switch between often
using one of the techniques I just described. Suddenly, however, you realize
you need to schedule a meeting with others in your office, using Calendar,
and you want to check your email in Apple Mail. What to do?

Well, you could certainly open Launchpad and launch those two applica-
tions on top of your graphics applications and then minimize or close them.
But with Mission Control’s Spaces feature, you can press the Control+« or
Control+— sequences to switch to a different “communications” Desktop,
with Calendar and Apple Mail windows already open and in your favorite
positions! (I've also created a custom “music” Desktop for GarageBand and
iTunes.) Figure 3-10 illustrates multiple Spaces Desktops at the top of the
Mission Control screen.

When you've finished setting up your meeting and answering any important
email, simply press Control+« or Control+— again to switch back to your
“graphics” Desktop, where all your work is exactly as you left it! (And yes,
Virginia, Spaces does indeed work with full-screen applications.)

To create a new Desktop for use in Spaces, click the Launchpad icon on

the Dock and then click the Mission Control icon. Now you can set up new
Spaces Desktops. Move your pointer to the top right of the Mission Control
screen, and click the Add button (with the plus sign) that appears. (If you've
relocated your Dock to the right side of the screen, the Add button shows
up in the upper-left corner instead.) Spaces creates a new empty Desktop
thumbnail. Switch to the new Desktop by clicking the label at the top of

the Mission Control screen, and then open those applications you want to
include. (Alternatively, you can drag the applications from Mission Control
onto the desired Spaces label.) That’s all there is to it!

75



76

Part I: Tie Myself Down with a Desktop? Preposterous!

MBER
\‘&
&

To switch an application window between Spaces Desktops, drag the window
to the edge of the Desktop and hold it there. Spaces automatically moves

the window to the next Desktop. (Applications can also be dragged between
Desktops within the Mission Control screen.) You can also delete a Desktop
from the Mission Control screen. Just hover your pointer over the offending
Spaces label to display the thumbnail, and click the Delete button (with the
X) that appears.

You can jump directly to a specific Spaces Desktop by clicking its thumb-
nail in your Mission Control screen or by holding down the Control key and
pressing the number corresponding to that desktop. Finally, you can always
use the Control+« or Control+— shortcuts to move between Desktops and
full-screen applications.

Stick it on the Dashboard

Dashboard is a favorite feature of mine within El Capitan — I use it to hold
widgets and display them with the press of a button. (Okay, I know that
sounds a little wacky, but bear with me.) Widgets are small applications —
dubbed by some as “applets” — that typically provide only one function. For
example, Dashboard comes complete with a calculator, dictionary, clock,
weather display, and quick-and-simple calendar.

By default, Dashboard is turned off in El Capitan. To enable Dashboard, open
the Mission Control pane in System Preferences, click the Dashboard pop-up
menu and select As Space (which displays your widgets as a separate Space
in Mission Control). You can also choose overlay mode if you prefer your
widgets to “float” over your Desktop instead.

You can display and use these widgets at any time by pressing the
Dashboard shortcut; by default, that’s Function-F12 on current Apple laptop
keyboard models (hold down the FN key and press F12), but you can modify
the key on the Mission Control pane in System Preferences. Dashboard also
appears as a Desktop in the Spaces strip on the Mission Control screen and
as an icon in Launchpad.

You can add widgets to your Dashboard by clicking the Add button (which
bears a plus sign, naturally) at the lower-left corner of the Dashboard screen.
Then Dashboard displays your entire collection of widgets, and you can click
a widget to add it directly onto your Dashboard.

While you’re adding widgets, you can also click the More Widgets
button, which jumps directly to the widget download area on the Apple
website.

vww . allitebooks.cond
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Rearranging the widgets that are already populating Dashboard is easy: Drag
them to the desired spot. After you finish customizing your Dashboard dis-
play, click the Dashboard background to return to your Dashboard. When it’s
time to go back to work (or play), you can return to your El Capitan Desktop
by pressing the Dashboard key again.

Most widgets have an option button that allows you to change things, such
as borders, zip codes, display columns, and the like; look for a tiny circle
with a lowercase letter i. Click this information icon, and you can then tweak
whatever options are available for that widget.

To remove a widget from the Dashboard display, just click the Delete button
(which bears a minus sign) and you’ll notice that a tiny X button appears
next to each widget on your Dashboard. Click the X button next to the widget
you want to remove, and it vanishes from the display. Note, however, that
deleting a widget doesn’t remove it from your Mac entirely! You can add that
deleted widget back again at any time by clicking the Add button. To return
to your Dashboard, click the Delete button again.

Personalizing Your Desktop

W

Many folks put all their documents, pictures, and videos on their El Capitan
Desktop because the file icons are easy to locate! Your computing stuff is
right in front of you . . . or is it?

Call me a finicky, stubborn techno-oldster — go ahead, [ don’t mind — but I
prefer a clean OS X Desktop without all the iconic clutter. In fact, my Desktop
usually has just three or four icons even though [ use my MacBook several
hours every day, often on multiple book projects. It’s an organizational thing;
[ work with literally hundreds of applications, documents, and assorted
knickknacks daily. Sooner or later, you'll find that you're using that many,
too. When you keep your stuff crammed on your Desktop, you end up having
to scan your screen for a particular file, alias, or type of icon. You end up
taking more time to locate it on your Desktop than in your Documents folder!
And don’t forget, open windows hang out on your Desktop too. To find any-
thing, you have to close or move those windows!

Plus, you'll likely find yourself looking at old icons that no longer mean
anything to you or stuff that’s covered in cobwebs that you haven’t used in
years. Stale icons — yuck.

[ recommend that you arrange your Desktop so that you see only a few icons
for the files or documents you use the most. Leave the rest of the Desktop for
that cool image of your favorite actor or actress.
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Besides keeping things clean, I can recommend a number of other favorite
tweaks that you can make to your Desktop:

1 Keep Desktop icons arranged as you like.

1. Choose Finder= View=> Show View Options.

2. From the Sort By pop-up menu, choose the criteria that El Capitan
uses to automatically arrange your Desktop icons, including the item
name, the last modification date, or the size of the items.

I personally like things organized by name, but many MacBook
owners prefer to see things organized by date (putting the most
recently modified item at the top, for example).

v Choose a favorite background.

1. Rightclick any open spot on your Desktop and choose Change
Desktop Background.

The Desktop & Screen Saver pane appears, as shown in Figure 3-11.

2. Browse through the various folders of background images that Apple
provides, open a folder of your own images, or use an image from
your Photos library.
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1~ Display all the peripherals and network connections on your system.
1. Choose Finderw> Preferences.

2. Make sure that all four of the top check boxes are selected: Hard
Disks; External Disks; CDs, DVDs, and iPods; and Connected Servers.
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If you're connected to an external network, or if you've loaded

an external hard drive or device, these external storage locations
show up on your Desktop. You can double-click that Desktop icon
to view your external stuff.

Customizing the Dock

RS

In terms of importance, the Dock — the quick-access strip for applications
and documents that appears on your Desktop — ranks right up there with
the command center of a modern nuclear submarine. As such, it had better
be easy to customize, and naturally, OS X doesn’t let you down.

Adding applications and
extras to the Dock

Why be satisfied with just the icons that Apple places on the Dock? You can
add your own applications, files, and folders to the Dock as well:

v+ Adding applications: You can add any application to your Dock by drag-
ging its icon into the area to the left side of the Dock (that’s to the left
side of the vertical line on the Dock). You’ll know when you’re in the
proper territory because the existing Dock icons obligingly move aside
to make a space for it.

Attempting to place an application directly on the right side of the Dock
sends it to the Trash (if the Trash icon is highlighted when you release
the button), so beware. Note, however, that you can drop an application
icon inside a Stack (more on that in a bit) or a folder that already exists
at the right side of the Dock. (If you've repositioned the Dock to the left
or right side of the screen, consider the top of the Dock as the “left side”
and the bottom of the Dock as the “right side.”)

v+ Adding individual files and volumes: Individual files and volume icons
can be added to the Dock by dragging the icon into the area to the right
side of the Dock. (Attempting to place these to the left side of the Dock
opens the application associated with the contents, which typically isn’t
what you intended.) Again, the existing Dock icons move aside to create
a space when you’re in the right area.

To open the Dock item you've added in a Finder window, right-click
the icon to display a Dock menu, where you can open documents, run
applications, and have other assorted fun, depending on the item you
choose.
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v Adding several files or a folder: El Capitan uses a feature called Stacks,
which I discuss in a few paragraphs, in the next section, “Keeping track
with Stacks,” to handle multiple files or add an entire folder to the Dock.

v Adding websites: You can drag any URL from Safari directly into the
area at the right of the Dock. Clicking that icon automatically opens your
browser and displays that page.

To remove an icon from the Dock, just click and drag it off the Dock. Note,
however, that the original application, folder, or volume is not deleted — just
the Dock icon itself is permanently excused. If you like, you can delete almost
any of the default icons that OS X installs on the Dock; only the Finder and
Trash icons must remain on the Dock.

Keeping track with Stacks

El Capitan offers Stacks, which are groups of items (documents, applications,
and folders) that you want to place on the Dock for convenience — perhaps
the files needed for a project you're working on, or your favorite game appli-
cations. For example, | have a Stack named Wiley on my Dock that holds all
the project files I need for the book I'm currently writing.

To create a Stack, just select a folder containing the items and drag the folder
to the right side of the Dock. As always, the Dock opens a spot on the right
side of the Dock to indicate you’re in the zone.

To display the items in a Stack, just click it:

v~ If the Stack holds relatively few items, they’re displayed in a really
cool-looking arc that Apple calls a fan, and you can click the item
you want to open or launch. Figure 3-12 illustrates a typical Stack
unfurled as a fan.

v~ If the Stack is stuffed full of many items, the Stack opens in a grid dis-
play, allowing you to scroll through the contents to find what you need.

El Capitan provides a number of display and sorting options for a Stack.
Right-click the Stack icon, and you can choose to sort the contents by name,
date created or added, date modified, or file type. If you'd prefer a grid dis-
play (no matter how many items the Stack contains), you can choose Grid
mode. Choose List to display the Stack’s contents in much the same way as
List view mode in a Finder window. List view mode also allows you to view
folders in a Stack as nested menu items. Choose Automatic to return to the
default view mode.
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When set to Display as Stacks, the Stack icon is displayed using icon images
from the contents of the folder; if security is an issue, however, choose
Display as Folder from the right-click menu to display the Stack as a plain
folder icon instead.

You can remove a Stack from the Dock by right-clicking the Stack icon and
choosing Options from the menu that appears. Choose Remove from Dock
from the submenu that appears. Alternatively, just drag that sucker right
off the Dock.

You can also display the contents of a Stack in a Finder window. Right-click
the Stack icon, and choose the Open item at the bottom of the pop-up menu.

If you add a folder full of items, the Stack is named after the folder; otherwise,
El Capitan does the best job it can in figuring out what to name the Stack.

Apple provides a Stack already set up for you: The Downloads folder, situ-
ated next to the Trash, is the default location for any new files that you down-
load using Safari or receive in your email. El Capitan bounces the Download
Stack icon to indicate that you've received a new item.

Resizing the Dock

You can change the size of the Dock from the Dock settings in System
Preferences — but here’s a simpler way to resize the Dock, right from
the Desktop.
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Move your pointer over the vertical solid line that separates the left side of
the Dock from the right side; the pointer turns into a funky vertical line with
arrows pointing up and down. This is your cue to click and drag while moving
up and down, which expands and shrinks the Dock, respectively.

You can also right-click when the funky line pointer is visible to display a
menu of Dock preferences. This allows you to change your Dock prefer-
ences without the hassle of opening System Preferences and displaying the
Dock settings.

What's with the Trash?
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Another sign of a Mac laptop power user is a well-maintained Trash can. It’s
a breeze to empty the discarded items you no longer need, and you can even
rescue something you suddenly discover you still need!

The translucent El Capitan Trash icon resides in the Dock, and it works just
like the Trash has always worked in OS X: Simply drag selected items to the
Trash to delete them.

Note one very important exception: If you drag a Desktop icon for an exter-
nal device or a removable media drive to the Trash (such as an iPod, DVD,
or external hard drive), the Trash icon turns into a giant Eject icon, and the
removable device or medium is ejected or shut down — not erased. Repeat,
not erased. (That’s why the Trash icon changes to the Eject icon — to remind
you that you’re not doing anything destructive.)

Here are other ways to chuck items you select to go to the wastebasket:

v Choose File=> Move to Trash.

v Click the Action button on the Finder toolbar, and choose Move to Trash
from the list that appears.

v Press 38+Delete.

v Right-click the item and choose Move to Trash from the menu
that appears.

You can always tell when the Trash contains at least one item, because the
basket icon is full of crumpled paper. However, you don’t have to unfold a
wad of paper to see what the Trash holds. Just click the Trash icon in the
Dock to display the contents of the Trash. To rescue something from the
Trash, drag the item(s) from the Trash folder to the Desktop or any other
folder in a Finder window. (If you're doing this for someone who’s unfamiliar
with El Capitan, remember to act like it was a lot of work, and you’ll earn big-
time DRP, or Data Rescue Points.)
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When you’re sure that you want to permanently delete the contents of the
Trash, use one of these methods to empty the Trash:

v Choose Finder = Empty Trash.

v Choose Finder = Secure Empty Trash.

If security is an issue around your laptop, and you want to make sure
that no one can recover the files you've sent to the Trash, use the Secure
Empty Trash command. It takes a little time but helps ensure that no
third-party hard drive repair or recovery program can resuscitate the
items you discard.

v Press 38+Shift+Delete.

v Right-click the Trash icon in the Dock and choose Empty Trash from the
menu that appears.

All YVou Really Need to
Know about Printing

3

Since we’re near the end of this chapter, I turn now to a task that most
MacBook owners need to tackle soon after buying their laptop or installing El
Capitan: printing documents. Because basic printing is so important (and in
most cases, so simple), allow me to demonstrate how to print a document.

Most of us have a Universal Serial Bus (USB) printer — the USB being the
favored hardware connection in OS X — so as long as your printer is sup-
ported by OS X, setting it up is as easy as plugging it into one of your
MacBook’s USB ports.

Before you print, preview! Would you jump from an airplane without a para-
chute? Then why would you print a document without double-checking it
first? Most applications now have their own built-in Preview thumbnails in
the Print sheet, as shown in Figure 3-13 — this is definitely A Good Thing,
since you see what the printed document will look like, possibly saving you
both paper and some of that hideously expensive ink or toner.

To print from any application using the default page characteristics —
standard 8% x 11” paper, portrait mode, no scaling — follow these steps:

1. In your application, choose File= Print or press the 38+P keyboard
shortcut.

In most applications, OS X displays the simple version of the Print sheet.
(To display all the fields you see in Figure 3-13, click the Show Details
button at the bottom of the sheet.) Some applications use their own
custom Print dialogs, but you should see the same general settings.
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2. Click in the Copies field, and enter the number of copies you need.

You can also enable or disable collation, just as you can with those oh-
so-fancy copiers.

3. Decide what you want to print.

e The whole shootin’ match: To print the entire document, use the
default Pages radio button setting of All.

e Anything less: To print a range of selected pages, select the From
radio button and enter the starting and ending pages (or, if the
application allows it, a selection of individual pages).

4. (Optional) Choose application-specific printing parameters.

Each OS X application provides different panes so you can configure set-
tings specific to that application. You don’t have to display any of these
extra settings to print a default document, but the power is there to
change the look dramatically when necessary. To display these settings,
open the pop-up menu in the center of the Print sheet and choose one
of these panes. For example, if you're printing from Contacts, you can
choose the Contacts entry from the pop-up menu and elect to print a
phone list, an envelope, mailing labels, or an email list.

5. When everything is go for launch, click the Print button.

Of course, there are more settings and more functionality to the printing
system in OS X. However, I can tell you from my experiences as a consultant
and hardware technician that this short introduction to printing will likely
suffice for 90 percent of the Mac owners on Earth. 'Nuff said.
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And Just in Case You Need Help . . .

You can call on the resources described in this section if you need additional
W help while you're discovering how to tame El Capitan.
Some of the help resources are located on the Internet, so your Safari web
browser will come in handy when you search for answers.

The El Capitan built-in Help system

Sometimes the help you need is as close as the Help menu on the Finder
menu bar. You can get help for either of the following:

v A specific application: From the application, just click Help. Then click
in the Search box and type a short phrase that sums up your query
(such as startup keys). You see a list of help topics on the menu. Just
click a topic to display more information.

1 General topics: Click a Finder window, and then click Help on the menu
bar. Again, you see the Search box, and you can enter a word or phrase
to find in the Help system. To display the Help Center window, click the
Help Center item under the Search box.

The Apple web-based support center

Apple has online product support areas for every hardware and software
product it manufactures. Visit www.apple.com and click the Support tab at
o the top of the web page.
The Search box works just like the OS X Help system, but the knowledge base
that Apple provides online has a lot more answers.

Magazines

Many magazines and publications (both in print and online) offer tips and
tricks on using and maintaining OS X El Capitan.

My personal online favorites are Macworld (www.macworld. com) and the
Wiley For Dummies website (www . dummies . com).


http://www.apple.com/
http://www.macworld.com/
http://www.dummies.com/
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Mac support websites

A number of private individuals and groups offer support forums on the web.
You can often get help from other Mac owners on these sites within a few
hours of posting a question.

I'm very fond of CNET’s MacFixIt (www.macfixit.com) and Mac OS X Hints
(http://forums.macosxhints.com).

Local Mac user groups

I'd be remiss if [ didn’t mention your local Mac user group. Often, a user
group maintains its own website and discussion forum. If you can wait until
the next meeting, you can even ask your question and receive a reply from a
real live human being. This is quite a thrill in today’s web-centric world!

To locate a local user group using your Internet connection, launch Safari,
click in the Address box, and type

Mac User Group location
Instead of location, type the desired spot on the map, like
Mac User Group Columbia Missouri

Don’t forget to press Return!


http://www.macfixit.com/
http://forums.macosxhints.com/
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In this part . . .

Learn more about the new features within OS X El Capitan.

Use System Preferences to fine-tune how El Capitan
works.

Keep track of practically everything using Notes, Maps, and
Reminders.

Use Spotlight to search your entire system in seconds.




Chapter 4

What's New in 0S X El Capitan?

In This Chapter
Using Split View to divide your screen
Locating your pointer with a shake
Adding third-party extensions to Photos
Finding friends from the Notification Center
Hiding your Finder menu bar

Browsing attachments in Notes

Hwe you upgraded to El Capitan from the previous version of OS X,
Yosemite? If so, you've opened the door to a number of new features,
and this chapter was written especially for you. (And if you're not rubbing
your hands together with gleeful anticipation, you should be — I know I am.)
Here you'’ll find descriptions of my favorite new features that ship with the
latest version of OS X.

Note that a number of other new El Capitan features appear elsewhere in the
book — for example, the discussion of pinned tabs appears within the Safari
chapter. The new features you find here, however, are what [ consider the
real standouts, so they’'re showcased separately.

Let the fun begin!

Hey, Did You Just Split YVour View?

I'm a huge fan of full-screen view, but from time to time it drove Mac owners
bonkers — that’s because full-screen view restricted you to displaying a
single application window. Sure, you could open multiple applications and
put each in full-screen view, but many tasks (especially those that involved
comparison or collaboration) required the constant use of 38+Tab to switch
between windows. Power users simply had to resign themselves to using
full-screen view with one application.
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Apple must have heard those cries of frustration, because the arrival of

El Capitan introduces Split View, which allows you to display and use two
applications simultaneously in full-screen view! To activate Split View, follow
these steps:

1. Move your pointer over the Zoom/Full-Screen button in one of the
desired application windows and click and hold.

El Capitan switches to full-screen view as usual, but you’ll notice that the
left half of the screen is highlighted in blue — this indicates the side of

BE the screen that this application window will occupy.
CMBER - . o ,
> Application windows that have been minimized to the Dock can’t be

used in Split View. You also can’t use application windows that are
already set to full-screen view (go figure).

R,

If you’d rather park the application in the other half of the screen,
A\\J just move the pointer and drag the window to the right side. (At this
moment, you're still holding down on the mouse or trackpad surface.)

2. Lift your finger from the mouse or trackpad to “drop” the window into
the desired half of the screen.

3. Click on the desired application that should share the other half of the
full-screen view.

The available application windows (which are not currently minimized
or in full-screen view) are shown as thumbnails, as you can see in
Figure 4-1 — click a thumbnail, and the window expands to fill the other
half of the Split View screen.
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Once your Split View screen has been set up, you can switch between the
two applications by simply clicking on the desired window. If you need to
resize one of the windows to make it larger, just move your pointer over the
center line until it changes into a double-arrow icon, then click and drag the
line to the desired spot.
M You can display the menu bar for the currently active window just like an
application in traditional full-screen view — just move your pointer to the top
of the screen.

To exit Split View:

v Display the application menu and click the Zoom/Full-Screen button.

v Display the application menu and choose the View = Exit Full
Screen item.

1 Press the Exit Full Screen shortcut §8+Control+F.

Unfortunately, not all applications currently support Split View, but look for
this functionality to be added to a growing number of applications in the
near future.

Lost Vour Pointer? Give It a Shake!

Here’s the scenario: You're right in the middle of editing an image in Photos on
your MacBook Pro Retina, and suddenly there’s a knock at your door. After you
handle the door-to-door vacuum salesperson, you return to your editing — but
you can’t find your pointer in the midst of all those high-definition pixels! In
order to find your pointer, you've got to move it to one of the edges of the
screen so you can catch sight of it again and get back to work, and sometimes
that can take a few seconds.

Every computer owner has suffered from LPS (Lost Pointer Syndrome) at one
time or another, and one of the software designers at Apple finally decided

to do something about it. In El Capitan, if you lose sight of your pointer, just
shake your finger rapidly from side to side on your trackpad (or shake your
mouse back and forth), and the pointer temporarily expands to a much larger
size! (Kind of like a perturbed puffer fish.) Figure 4-2 shows the pointer in its
superhero state.

[ agree, the Puffer Fish Pointer isn’t a revolutionary feature — Split View is
certainly more impressive — but wait until you've lost your pointer, and
you’ll agree that it’s pretty doggone cool!
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Adding Functionality to Photos

Although El Capitan’s Photos application contains the common image editing
functions that most MacBook owners will use the most — such as cropping,
rotating, and applying filters — amateur and professional photographers will
find that Photos lacks the more powerful features available in applications
like Aperture, Photoshop, and Photoshop Elements. When Photos was origi-
nally released, there was no way to add functionality to the application.

With the debut of El Capitan, Apple now allows other third-party software
developers to add features to Photos using extensions. Extensions are
common in the world of image editing applications, providing add-ons like
advanced filters, textures, and borders to the editing tools that Photos
already provides. Extensions can be purchased through the Apple Store. To
add extensions, load any photo in Edit mode, then click the button bearing
three dots at the right side of the Editing pane and click Extensions.

Another “new” feature in Photos is actually the return of a familiar face:
Photos once again allows you to enter location data for an image (also called
geotagging). Today’s iOS devices — like the iPad and iPhone — can add loca-
tion information automatically (as can many high-end digital cameras), but
now you can manually add a location to an image. With the desired photo in
the viewer, click the Get Info button on the Photos toolbar, and then click the
Add a Location button.
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If you've used the Find My Friends app on your iPhone or iPad, you know
that it allows you to share your current location instantly with other folks
who use iOS devices (as well as displaying their locations on a map on
your device).

If you use Find My Friends, you’ll be happy to know that the functionality of
this popular app is now available within El Capitan — specifically, it can be
added to the Notification Center as a widget.

To add the Find My Friends widget, click on the Notification Center icon in
the Finder menu bar, then click the Edit button at the bottom of the pane.
(Figure 4-3 illustrates the widget list that appears at the right.) Click the Add
icon next to the Find My Friends item to add it to your Notification Center.

Notifications Items (3)

. Find My Friends
Q Sacial

@ iTunes

Cupertino

Calendar

Weather

11:49 PM . 2
New York 73
10:48 PM 730
Baton Rouge

10:48 PM o o
New Orleans 79
10:48 PM 730
Morgan City

Calculator

N

App Store

Banishing the Menu Bar

This feature might seem somewhat unsettling to long-time OS X power users:
El Capitan allows you to automatically hide the menu bar, just like the Dock’s
auto-hide functionality. Why is this unnerving? It’s because the menu bar has
been a rock-solid part of OS X since the very first version (called Cheetah,

which was introduced way back in 2001), and power users just expect it to be
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there! However, the idea behind a hidden menu bar is the same as the hidden
Dock: You gain additional screen real estate for your applications, which can
make a significant difference on smaller MacBook screens.

“But Mark, isn’t the menu bar technically ‘hidden’ in full-screen view?” Yes,
dear reader, that is true, but full-screen view is a special case — in El Capitan,
you can banish the menu bar from your Deskfop, which is a completely differ-
ent kettle of fish!

I've already turned the menu bar auto-hide feature on, as you can see
from Figure 4-4. To hide the menu bar on your MacBook, click the
System Preferences icon in the Dock, click the General icon, and click the
Automatically Hide and Show the Menu Bar check box to enable it.

To display your menu bar at any time, just bump the top of your screen with
your pointer. As soon as the pointer moves away from the menu bar, it scur-
ries away until you need it again.

[ ] < 5 General

Appearance: [l Blue d For Buttons, Menus, and Windows

Use dark menu bar and Dock
Automatically hide and show the menu bar

Highlight calor: Blue wa
Sidebar icon size: = Medium d
Show scroll bars: Automatically based on mouse or trackpad
When scrolling
O Always

Click in the scroll bar to: ) Jump to the next page
Jump to the spot that's clicked

Default web browser: @ Safari | T}

Ask to keep changes when closing documents
Close windows when quitting an app

When selected, open documents and windows will not be restored
when you re-open an app.

Recent items: | 50 ancumems,Apps‘and Servers

Use LCD font smoothing when available

Browsing Attachments within Notes

As a long-time Notes user, I appreciate the “look-and-feel” updates made to
this popular OS X application in El Capitan — however, I'm happiest about
the new Notes Attachment Browser, which allows you to display all of the
attachments you’ve added to your Notes from a single pane!
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Why so gleeful? Older versions of the application required you to view each

Note to find a specific attachment you had added, including

v Photos and videos

v Maps

v Website links

v Audio clips

v+ Documents
[ use Notes as a simple database, holding dozens of those “snippets” of infor-
mation for later use in manuscripts and on Facebook, so as you can imagine,
opening and checking each Note would often take considerable time. Now
I can click the Attachment Browser button on the Notes toolbar (display-

ing the pane you see in Figure 4-5), click the desired file type, and see every
attachment of that type at one time.

Chapter 4: What's New in 0S X El Capitan?

ece o 6

nms " Photos & Videos | eos Sketches Maps  Websites Audic  Documents

To open the item, just double-click on it. You can display the Note that con-
tains the selected attachment by right-clicking on the selection and choosing
Go to Note from the menu that appears.
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Chapter 5

A Nerd's Guide to System
Preferences

In This Chapter
Navigating System Preferences
Locating specific controls
Customizing El Capitan from System Preferences

R emember the old TV series Voyage to the Bottom of the Sea? You always
knew you were on the bridge of the submarine Seaview because it had
an entire wall made up of randomly blinking lights, crewmen darting about
with clipboards, and all sorts of strange and exotic-looking controls on

every available surface. You could fix just about anything by looking into the
camera with grim determination and barking an order. After all, you were On
the Bridge. That’s why virtually all the dialog and action inside the sub took
place on that one (expensive) set: It was the nerve center of the ship, and

a truly happenin’ place to be. (Just like the bridge of your favorite starship
from an entire host of TV shows and movies.)

In the same vein, [ devote this chapter to the System Preferences window and
the most commonly used settings within it. After all, if you want to change
how El Capitan works or customize the features in our favorite operating
system, you should head toward System Preferences. This one window is

the nerve center of OS X and a truly happenin’ place to be. (Sorry, no built-in
wall of randomly blinking lights — but you do find exotic controls just about
everywhere.)
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An Explanation — without
Jargon, No Less

The System Preferences window, shown in Figure 5-1, is a self-contained
beast. You can reach it in a number of ways:

v Click the Apple menu (&) and choose System Preferences.

v Click the System Preferences icon in the Dock — it’s a collec-
tion of gears.

v Click the Apple menu (&), choose Dock, and then choose Dock
Preferences.

v Click the Time and Date display in the menu bar, and then choose Open
Date and Time Preferences. (In fact, you can also click most of the other
menu status icons — including Bluetooth and Wi-Fi — and then choose
Open Preferences.)

v Right-click any uninhabited area of your Desktop and choose Change
Desktop Background.

v Last, but not least, click the Launchpad icon in the Dock, and then click
the System Preferences icon.

[ ] < t System Preferences
= - s @
e @ M g o @
General Desktop & Dock Mission Language Security Spotlight  Notifications
Screen Saver Control &Region  &Privacy
= = = N\
Displays Energy Keyboard Mouse Trackpad Printers & Sound
Saver Scanners
@ b
— » @ @ o ®
. iCloud Internet  Extensions  Metwork  Bluetooth  Sharing
F|gure 5-1: Accounts
The power-
A L DN
houseof | b @ @ ¢ & A& @ @
1 Users & Parental App Store Dictation ~Date & Time  Startup Time Accessibility
settlngs and Groups Controls & Speech Disk Machine
switches:
System
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When the System Preferences window is open, you can click any of the icons
to switch to that pane. The entire window morphs to display the settings

for the selected pane. For example, Figure 5-2 shows the Sound pane, which
allows you to set a system alert sound, configure your MacBook’s built-in
microphone, and choose from several different output options.

Many panes also include a number of tabbed buttons at the top — in this
case, Sound Effects, Output, and Input. You can click these tabs to switch to
another section in the same pane. Many panes in System Preferences have
multiple sections. This design allows our friends at Apple to group a large
number of related settings in the same pane (without things getting too
confusing).

ee < = Sound

Output  Input
Select an alert sound:

Name Type
Bottle Buit-in

Frog Built-in

Funk Built-in
Glass Built-in
Play sound effects through: | Internal Speakers ]
Alert volume: o ‘J)}
) Play user interface sound effects
Play feedback when volume is changed
Output volume: #{ 13)) Mute

4 Show volume in menu bar

To return to the top-level System Preferences pane from any other pane, just
click the Show All button (at the upper left) or press 38+L. You can also click
the familiar Previous and Next buttons to move backward through the panes
you've already visited and then forward again, in sequence. (Yep, these but-
tons work just like the browser controls in Safari. Sometimes life is funny
that way.)

Although the System Preferences panes are arranged by category when you
first install El Capitan, you can also display the panes in alphabetical order.
To arrange the panes in this way, choose View=> Organize Alphabetically.
Note that you can also select any pane directly from the View menu.
Choose View=> Customize, and you can hide specific icons from the System
Preferences window. Just deselect the check box next to each icon you
want hidden, and then click Done. You can still reach hidden icons from the
System Preferences View menu, so they’re not banished forever.
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Hey, | have bonus icons in my window!

Some third-party applications and media plug-  Naturally, | cant document these invited guests
ins can actually install their own panes in your in this chapter, but they work the same way as
once-pristine System Preferences window. You  any other pane in System Preferences. Click the
see them arranged at the bottom of the window. icon, adjust any settings as necessary, and then
(For example, Adobe’s Flash Player adds an close the System Preferences window to save
icon that you see at the bottom of Figure 5-1.)  your changes.
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In fact, you can right-click the System Preferences icon in the Dock to jump to
any pane from the shortcut menu. Wowzers!

You won'’t find an OK button that you have to click to apply any System
Preferences changes. Apple’s developers do things the right way. Your
changes to the settings in a pane are automatically saved when you click
Show All or when you click the Close button in the System Preferences
window. You can also press 38+Q to exit the window and save all your
changes automatically. This is one of my favorite shortcuts.

If you see an Apply button in a pane, you can click it to immediately apply
any changes you made, without exiting the pane. This is perfect for settings
you might want to try before you accept them, like many of the controls in
the Network pane. However, if you're sure about what you changed and how
those changes will affect your system, you don’t have to click Apply. Just exit
the System Preferences window or click Show All as you normally would.

Locating That Certain Special Setting

Wouldn't it be great if you could search through all the different panes in
System Preferences — with those countless radio buttons, check boxes,
and slider controls — from one place, even when you'’re not quite sure what
you’re looking for?

Figure 5-3 shows exactly that kind of activity taking place. Just click in the
System Preferences Spotlight Search box (at the upper right, with the magni-
fying glass icon), and type just about anything. For example, if you know part
of the name of a particular setting you need to change, type that. El Capitan
highlights the System Preferences panes that might contain matching set-
tings. And if you're a switcher from the Windows world, you can even type
what you might have called the same setting in Windows XP, Vista, 7, or 8!
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The System Preferences window dims, and the icons that might contain what
you're looking for stay highlighted. Slick.

You can also search for System Preferences controls by using the Spotlight
menu and Spotlight window. Find more on this cool feature in Chapter 6.

If you need to reset the Search box to try again, click the X icon that appears
at the right side of the box to clear it.

Popular Preferences Panes Explained

It’s time to get down to brass tacks: Open the most often-used panes in
System Preferences to see what magic you can perform. I won’t discuss every
pane, because [ cover many of them in other chapters. (In fact, you might
never need to open some System Preferences panes, such as the Language &
Region pane.) However, this chapter covers just about all the settings you're
likely to use on a regular basis.

The Displays pane

If you're a heavy-duty gamer, or you work with applications such as Keynote
or Photoshop, you probably switch your monitor’s characteristics regularly.
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To switch easily, visit the Displays pane, shown in Figure 5-4. It includes
two sections:

v~ Display: To allow El Capitan to choose the best resolution for your dis-

play, select the Default for Display radio button. To manually select a
resolution, select the Scaled radio button, and then click the resolution
you want to use from the Resolutions list that appears. (In most cases,
you want to use the highest resolution.) Move the Brightness slider to
adjust the brightness level of your MacBook’s display. If you like, you
can enable the Automatically Adjust Brightness check box to allow your
MacBook to select a brightness level. To automatically adjust the bright-
ness to match the ambient light around you, enable the Ambient Light
Compensation check box.

Ready to stream content to your TV directly from your MacBook —
without cables? You can use El Capitan’s wireless AirPlay Mirroring
feature to send the display from your MacBook to your HD-TV. AirPlay
Mirroring requires an Apple TV unit that supports this feature. You can
also send the audio from your MacBook directly to an AirPlay-enabled
receiver or speaker system. To make it easier to control AirPlay mirror-
ing, select the Show Mirroring Options in the Menu Bar When Available
check box. (Note that the icon will only appear in your menu bar when
you have an Apple TV unit within range.)

AirPlay Display: = Off

¥ Show mirroring options in the menu bar when available

< i Built-in Display

Color

- Resolution: _ Default for display
D Scaled
1440 x 900
1280 x 800
 —mrerrorEr— oo

1152 x 720
1024 x 840

Brightness: -
) Automatically adjust brightness

& Ambient light compensation

v Color: Click a display color profile to control the colors on your

screen. To load a profile, click the Open Profile button. To create a
custom ColorSync profile and calibrate the colors that you see, click
the Calibrate button to launch the Display Calibrator. This easy-to-use
assistant walks you step by step through creating a ColorSync profile
matched to your MacBook’s gamma and white-point values.
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The Desktop & Screen Saver pane

No offense to the awesome El Capitan “sunlit peaks” background, but who
doesn’t want to choose his or her own background? And what about that
nifty screen saver you just downloaded from the Apple website? You can
change both the background and screen saver by using these options in the
Desktop & Screen Saver pane.

The settings on the Desktop panel, shown in Figure 5-5, are

v Current Desktop picture: You can click a picture in the thumbnail list
at the right half of the screen to use it as your Desktop background. The
Desktop is immediately updated, and the thumbnail appears in the well
(the upper-left box in Figure 3-4). To display a different image collection
or open a folder of your own images, click the Add Folder button at the
lower left of the window (a plus sign) and browse for your heart’s desire;
then click Choose to select a folder and display the images it contains.

v Layout: You can tile your background image, center it, fill the screen
with it (cropping the edges if necessary), and stretch it to fill the screen
(without cropping). Note that filling the screen (in either case) may dis-
tort the image. The layout pop-up menu appears only when you’re using
your own pictures, so you don’t see it if you're using a Desktop image
supplied by Apple.

(X J < i Desktop & Screen Saver Q

Screen Saver

Solid White

¥ Apple

[ Desktop Pictures

< solid Colors

» Photas ey
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¥ Folders

5 Pictures

(7] Downloads i
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v Change Picture: Change the Desktop background automatically after the

delay period that you set, including each time you log in and each time
your Mac wakes up from sleep mode.

+* Random Order: To display screens randomly, enable the Random Order

check box. Otherwise, the backgrounds are displayed in the sequence in
which they appear in the thumbnail list.

The settings on the Screen Saver tab are

v Screen Savers: In the Screen Savers list at the left, click any screen

saver to preview (on the right). To try out the screen saver in full-screen
mode, click the Preview button. (You can end the test by moving the
cursor.) If the screen saver module you select has any configurable
settings, click the Screen Saver Options button to display them. (A
screen saver is not configurable if the Screen Saver Options button isn’t
enabled.) Choose the Random screen saver to display a different screen
saver module each time the screen saver is activated.

1~ Start After: Specify the period of inactivity that triggers the screen

saver. To disable the screen saver, choose the Never setting at the top
of the list. (Your Start After delay should be a shorter time than the
Display Sleep delay you set in the System Preferences Energy Saver
pane. Otherwise, you won'’t see the great screen saver at all. [ describe
the Energy Saver pane later in this chapter.)

v Show with Clock: If you want your selected screen saver to display the

time as well, select this check box.

+* Hot Corners: Click the Hot Corners button, and then click any of the

four pop-up menus at the four corners of the screen. Doing so desig-
nates that corner as an activation hot corner (immediately activates the
screen saver) or as a disabling hot corner (prevents the screen saver
from activating). As long as the cursor stays in the disabling hot corner,
the screen saver doesn’t kick in, no matter how long a period of inac-
tivity passes. Note that you can also set the Sleep, Mission Control,
Launchpad, Notification Center, and Dashboard activation corners from
here. (For the scoop on these features, see the next section.)

For additional security, check out the Security & Privacy pane in System
Preferences, where you find the Require Password After Sleep or Screen
Saver Begins check box. When you select this check box, El Capitan
requires your user account password before allowing anyone to turn off
the screen saver (a great idea when traveling, as you can imagine).
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Mission Control preferences

Figure 5-6 shows the Mission Control, Spaces, and Dashboard settings you
can configure in this group. You can use Mission Control to view all the appli-
cation windows you're using at one time so that you can select a new active
window. Or you can move all windows aside so that you can see the Desktop.
Dashboard presents a number of mini-applications (or widgets), which you
can summon and hide by pressing a single key.

[ X ] < i Mission Control

Mission Control gives you an overview of all your open windows, thumbnails of your full-
screen applications, and Dashboard, all arranged in a unified view.

¥ Automatically rearrange Spaces based on most recent use

) When switching to an application, switch to a Space with open windows for the application
Group windows by application

U/ Displays have separate Spaces

Dashboard: | As Space

I Keyboard and Meuse Shorteuts

With a single keystroke, view all open windows, windows of the current application, or hide windows to locate an

Figure 5'6: item on the desktop that might be covered up.
Set your Mission Cantrol: | ~ 1 B
Mission Application windows: | ~ | B
Show Desktop:  F11 B ~ B
Control pref- Show Dashboard: | F12 B - B
erences
here.

(fer additional choices press Shift, Contral, Option, or Command)

Hot Corners...

The settings are

v Automatically Rearrange Spaces Based on Most Recent Use: If this
check box is selected, Mission Control presents your most recently used
Spaces first in the thumbnails at the top of the screen.

+ When Switching to an Application: When selected, this check box
allows you to switch applications between Spaces desktops by using
the 38+Tab shortcut. Yosemite jumps to the Desktop that has an open
window for the application you choose, even if that Desktop is not cur-
rently active.

v Group Windows by Application: When selected, this check box auto-
matically arranges windows in the Mission Control screen by the appli-
cation that created them.

1+ Displays Have Separate Spaces: If you have multiple monitors con-
nected to your Mac, you can select this check box to create a separate
Spaces display for each monitor.
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To display your Dashboard as a Space (a virtual desktop) in the Mission
Control screen, click the Dashboard pop-up menu and choose the As
Space option. If you prefer your Dashboard widgets to appear as an
overlay over your Desktop, select the As Overlay option from the pop-up
menu.

1 Keyboard and Mouse Shortcuts: From each pop-up menuy, set the key
sequences (and mouse button settings) for Mission Control, Application
Windows, Show Desktop, and Show Dashboard.

You’re not limited to keyboard and mouse shortcuts in the pop-up
menus. Press the Shift, Control, Option, and 3§ keys while a pop-up menu
is open, and you see these modifiers appear as menu choices! (Heck,
you can even combine modifiers, such as $8+Shift+F9 instead of just F9.)

v Hot Corners: Click the button at the lower left to specify your hot
corner settings. These four pop-up menus operate just like hot corners
and active screen corners in the Desktop & Screen Savers pane, allowing
you to control the operation of the screen management features within
El Capitan. Click one to designate that corner as one of the following:

¢ A Mission Control corner displays the Mission Control screen.

e An Application Windows corner displays only the windows from the
active application.

¢ A Desktop corner moves all windows to the outside of the screen to
uncover your Desktop.

e A Dashboard corner displays your Dashboard widgets.
e A Launchpad corner activates the Launchpad screen.

¢ A Notification Center corner displays the Notification Center strip at
the right side of your Desktop.

Note that you can also set the Screen Saver Start and Disable corners
from here, as well as put your display to sleep.

The General pane

The talented General pane, shown in Figure 5-7, determines the look and
operation of the controls that appear in application windows and Finder
windows. It looks complex, but I cover each option here.



Chapter 5: A Nerd's Guide to System Preferences 7 0 7

ee < i General
Appearance: Graphite | For Buttons, Menus, and Windows
Use dark menu bar and Dock
Automatically hide and show the menu bar
Highlight color: Blue
Sidebar icon size: | Medium
Show scroll bars: Automatically based on mouse or trackpad

When scrolling
J Always

| Click in the scroll bar to: () Jump to the next page
Jump to the spot that's clicked
Figure 5-7:
Appear. Default web browser: | @ Safari
ances might
) Ask to keep changes when closing documents
not be Close windows when quitting an app
- When selected, open documents and windows will not be restored
everything, B e ey
.
but they re Recent items: | 30 [ Documents, Apps, and Servers
easy to flnd ¥ Allow Handoff between this Mac and your iCloud devices
here.

& Use LCD font smoothing when available

The settings are

1 Appearance: Choose a color to use for buttons, menus, and windows.
Click the Use Dark Menu Bar and Dock check box to switch to a dark
scheme for your Finder menu bar and Dock.

1~ Highlight Color: Choose a color to highlight selected text in fields and
pop-up menus.

v Sidebar Icon Size: Select the size of the icons in the Finder window
Sidebar. It’s the strip to the left of the Finder window that displays
your devices and favorite locations on your system. If you have a large
number of hard drives, or if you've added several folders to the Sidebar,
reducing the size of the icons allows you to display more of them with-
out scrolling.

1 Show Scroll Bars: Specify when El Capitan should display scroll bars in
a window. By default, they’re placed automatically when necessary, but
you can choose to display scroll bars always or only when you’re actu-
ally scrolling through a document.

v Click in the Scroll Bar To: By default, OS X jumps to the next or previ-
ous page when you click in an empty portion of the scroll bar. Select the
Jump to the Spot That’s Clicked radio button to scroll the document to
the approximate position in relation to where you click.

v Default Web Browser: Click this pop-up menu to specify which applica-
tion Yosemite should use to display web pages. By default, OS X uses the
Safari web browser.
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1 Ask to Keep Changes When Closing Documents: If you select this check
box, El Capitan prompts you for confirmation if you attempt to close
a document with unsaved changes. If the check box is deselected, El
Capitan allows the unsaved document to be closed without saving a
new version.

v Close Windows When Quitting an Application: If this check box is
deselected, the OS X Resume feature automatically saves the state of an
application when you quit. When you relaunch the application again,

El Capitan restores all application windows and opens the documents
you were working on when you quit. In effect, you can continue using
the application just as if you had never quit. If you select the check
box, El Capitan does not restore your work, and you have to reload
your document.

+* Recent Items: The default number of recent applications, documents,
and servers (available from the Recent Items item in the Apple menu [&])
is 10. To change the default, open the pop-up menus here and choose up
to 50. (1 like 20 or 30.)

v Allow Handoff Between this Mac and Your iCloud Devices: If this
check box appears within the General pane, you can enable it to turn
on Handoff functionality within El Capitan. (I discuss Handoff within the
confines of Chapter 9.) Note that this check box will not appear on older
MacBooks without compatible Bluetooth hardware.

v Use LCD Font Smoothing When Available: By default, this check box is
enabled, making the text on your MacBook’s display appear more like
the printed page. You can turn off this feature to speed up text
display slightly.

The Energy Saver pane

I’'m an environmentalist — it’s surprising how many techno types are colored
green — so the two sections on this pane are pretty doggone important.
When you use them correctly, you not only conserve battery power but also
invoke the Power of El Capitan to automatically start up and shut down your
laptop whenever you like!

Move the Computer Sleep slider, shown in Figure 5-8, to specify when El
Capitan should switch to sleep mode. The Never setting disables sleep mode.
To choose a separate delay period for blanking your screen, drag the Display
Sleep slider to the desired period. You can also power down the drive to
conserve energy and prevent wear and tear (an especially good feature for
laptops with magnetic hard drives).
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Figure 5-8:
Reduce your
MacBook
power con-
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Energy
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ee < HH Energy Saver

Power Adapter
Computer sleep:
1min 15 min The 3hrs Never
Display sleep:
1min 18 min 1hr 3hrs Never

2 Put hard disks to sleep when possible
& slightly dim the display while on battery power

) Enable Power Nap while on battery power
While sleeping, your Mac can periodically check for new email, calendar, and other iCloud updates

Current battery charge: 57% Estimated time remaining: 3:23 Restore Defaults

& Show battery status in menu bar Schedule...

Enable the Slightly Dim the Display While on Battery Power check box to save
additional power by reducing the brightness of your MacBook’s screen. (I can
hardly notice the difference, but your laptop’s battery will thank you!)

If you want to start up or shut down your laptop at a scheduled time, click
the Schedule button. Select the desired schedules (the Start Up or Wake
check box and the Shut Down/Sleep check box) to enable them. Then click
the up and down arrows next to the time display to set the trigger time. Click
OK to return to the Energy Saver pane.

Mac laptop owners can set two separate Energy Saver configurations by
clicking one of the two tabs at the top of the pane:

v Battery: Applies when the MacBook is running on battery power

1 Power Adapter: Kicks in when the laptop is connected to an AC outlet

Your MacBook automatically switches to the proper configuration when you
plug in or unplug your laptop.

Some of the settings can toggle events that control sleep mode in El Capitan,
including a Wi-Fi network connection (the Wake for Wi-Fi Network Access
check box, which appears on the Power Adapter section). You can also set
OS X to automatically update iCloud data while in sleep mode, using the
Enable Power Nap feature (supported only on all current MacBook models).

Naturally, MacBook owners will want to click the Show Battery Status in
Menu Bar check box to select it.
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The Dock pane

I'll come clean: I think the Dock is the best thing since sliced bread! (I wonder
what people referred to before sliced bread was invented?) You can use the
settings shown in Figure 5-9 to configure the Dock’s behavior until it fits your
personality like a glove:

[ X ] < = Dock

Size:
small Large

2 Magnification:
Min Max

Position on screen:

Left Bottom Right

Minimize windows using: Genie effect |4

¥ Double-click a window's title bar to | minimize [
Minimize windows into application icon

¥ Animate opening applications

) Automatically hide and show the Dock

T Show indicators for open applications

v~ Size: Pretty self-explanatory. Just drag the slider to change the
Dock’s scale.

v Magnification: When you select this check box, each icon in the
Dock swells like a puffer fish when you move the cursor over it. (The
Magnification slider determines just how much it magnifies.) I really like
this feature because I resize my Dock smaller, and I have a large number
of Dock icons.

v Position on Screen: Select a radio button here to position the Dock on
the left, bottom, or right edge of the Desktop.

»* Minimize Windows Using: El Capitan includes two cool animations that
you can choose from when shrinking a window to the Dock (and expand-
ing it back to the Desktop). Click the Minimize Windows Using pop-up
menu to specify the genie-in-a-bottle effect or the scale-up-or-down-
incrementally effect.

+* Double-Click a Window’s Title Bar to Minimize/Zoom: Select this check
box to minimize or zoom a Finder or application window by simply
double-clicking the window’s title bar.

v Minimize Windows into Application Icon: If this check box is not
enabled, minimized application windows appear as thumbnail icons on
the Dock. To minimize application windows into the application icon
on the Dock — which can save space on your Dock — select this check
box. (To restore a window that’s been minimized into the application
icon, right-click the icon on the Dock and choose Restore from the menu
that appears.)
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»* Animate Opening Applications: Active souls who like animation prob-
ably get a kick out of the bouncing application icons in the Dock, which
indicate that you've launched an application and that it’s loading. If
you find this effervescence overly buoyant or distracting, deselect this
check box.

v Automatically Hide and Show the Dock: Select this check box, and the
Dock disappears until you need it. (Depending on the size of your Dock,
the Desktop real estate you gain can be significant.) To display a hidden
Dock, move the cursor over the corresponding edge of the Desktop.

+* Show Indicators for Open Applications: OS X indicates which applica-
tions are running in the Dock with a small gray dot in front of the icon.
To disable these indicators, deselect this check box.

You can also change most of these Dock preferences settings from the
Apple menu (&).

The Sharing pane

So you're in a neighborly mood, and you want to share your toys with others
on your local wired or wireless network. Perhaps you’d like to start your
own website or protect yourself from the Bad Guys on the Internet. All these
fun diversions are available from the Sharing pane in System Preferences, as
shown in Figure 5-10.

o0 < = Sharing

Computer Name: AirDragon

Computers on your local network can access your computer at

AirDragon.local Edit...

On  Service File Sharing: Off

Screen Sharing File Sharing allows other users to access shared folders on this computer and
. allows administrators to access all volumes.

File Sharing
Printer Sharing Options...
Remote Login
Remote Management
Remote Apple Events

Shared Folders: Users:

' Mark C...Folder Mark Chambers Read & Write

Internet Sharing 2 staff Read Only j+]
Bluetooth Sharing Ideveryone Read Only P
+[— +
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Figure 5-11:
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Click the Edit button to change the default network name assigned to your
MacBook during the installation process. Your current network name is listed
in the Computer Name text field.

Each entry in the services list controls a specific type of sharing, includ-

ing DVD and CD Sharing (if you have an optical drive), Screen Sharing,

File Sharing (with other Macs and PCs running Windows), Printer Sharing,
Remote Login, Remote Management (using Apple Remote Desktop), Remote
Apple Events, Internet Sharing, and Bluetooth Sharing. To turn on any of
these services, select the On check box for that service. To turn off a service,
click the corresponding On check box to deselect it.

From a security standpoint, I highly recommend that you enable only the
services you actually use. Each service you enable automatically opens your
El Capitan firewall for that service. Here’s a Mark’s Maxim to remember:

Poking too many holes in your firewall is not A Good Thing.™

When you click one of the services in the list, the right side of the Sharing pane
changes to display the settings you can specify for that particular service.

The Time Machine pane

MacBook users are thrilled with the Time Machine automatic backup feature
that’s built in to El Capitan. It’s saved my stuff numerous times. You can easily
configure how Time Machine handles your backups from this pane, as shown
in Figure 5-11. Chapter 21 covers how to use Time Machine. Of course, you
need an external drive (or an AirPort Time Capsule wireless backup device)
for the best backup security. Note that Time Machine doesn’t work with a CD
or DVD rewriteable drive; you must use an external drive or a USB flash drive.

Time Machine

< i Q
T Magnum
22.6 GB of 62.9 GB available
Oldest backup: October 18, 2014
Latest backup: October 18, 2014

Select Disk... Next backup: When disk is connected

Time Machine

Time Machine keeps:
OFF ON

« Local snapshots as space permits

« Hourly backups for the past 24 hours

« Daily backups for the past month
+ Weekly backups for all previous months

The oldest backups are deleted when your disk becomes full.

& Show Time Machine in menu bar Options...
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To enable Time Machine, click the On toggle switch, and then select a disk

to hold your Time Machine backup data on the sheet that appears. Click Use
Disk to confirm your choice. (Your external backup drive should be at least
twice the capacity of your internal drive, thus ensuring that your backup files
have the elbow room they need.) If you have an external Time Capsule wire-
less unit, click Set Up instead.

By default, Time Machine backs up all the drives on your system; however,
you may not need to back up some folders on your MacBook. To save time
and backup drive space, Time Machine allows you to exclude specific fold-
ers from the backup process. Click Options, and then click the Add button
(with the plus sign) to select the drives or folders you want to exclude. They
appear in the Exclude These Items From Backups list.

To remove an exclusion, select it in the list and click the Delete button (with
the minus sign). Note that the Estimated Size of Full Backup figure increases,
and Time Machine adds the item you deleted from the list to the next backup.

If you enable the Show Time Machine in Menu Bar check box, you can elect
to back up your Mac immediately by clicking the Time Machine icon in the
Finder menu bar and then choosing Back Up Now.

By default, El Capitan warns you when deleting older backup files, but you
can turn this off from the Options sheet as well.

iCloud preferences

From the El Capitan iCloud Preferences pane, shown in Figure 5-12, you can
specify which types of data are automatically pushed to your MacBook and
iOS devices. If you haven’t created an iCloud account yet — or if you signed
out of an existing account earlier — System Preferences prompts you to
enter your Apple ID and password. Click Sign In to display the contents of the
iCloud pane.

El Capitan allows you to set up Family Sharing, where up to six accounts
can share photos, iTunes media and apps, and a common calendar — group
members can even display the current location of other members who are
carrying MacBooks or iOS devices! Click the Set Up Family button, and then
click Continue to launch the Family Sharing setup assistant.
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Control and
configure
your iCloud
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[ N ] < o iCloud

o ‘ iCloud Drive Options

= @ Photos Options
2 W v
8 ‘ Contacts
Account Details
& 117\ Calendars
Set Up Family
4 u Reminders

2 @ sotar

Notes

Mark Chambers

Sign Out Backup 3.87 GB Available Manage..

The check boxes for each category are

v iCloud Drive: Enable and disable iCloud Drive access for specific
applications.

+* Photos: Push the latest photos and video clips you've added in Photos
to other devices, and update your Photos library with photos and video
clips pushed from your iOS devices.

v Mail: Synchronize your Mail account settings between devices.

v Contacts: Push your Contact cards between devices.

v~ Calendars: Push your calendar events to and from your iOS devices.
v Reminders: Synchronize the reminders you've set between devices.
v Safari: Synchronize your Safari bookmarks.

+* Notes: Synchronize your Notes between devices.

1 Keychain: Share passwords for applications and websites between
your devices.

v Documents & Data: Automatically synchronize the documents you
create and your personal settings between your MacBook and other
iOS devices.

1 Back to My Mac: Control file and screen sharing across all the Macs
sharing this iCloud account. Back to My Mac must be enabled on all
computers that will use this feature.

v Find My Mac: Locate your MacBook from a web browser or your iOS
device. You can also choose to remotely lock your computer — or even
wipe your laptop’s hard drive completely to prevent someone from steal-
ing your data!
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Wiping your MacBook remotely is a drastic step that will prevent you from
locating it in the future!

To display the storage currently being used by your mail, backups, docu-
ments, and application data, click the Manage button at the lower right of the
pane. Apple provides each iCloud account 5GB of space for free, but you can
also elect to buy additional storage from this sheet.

Notifications preferences

The Notifications group is shown in Figure 5-13. Each application that can
display notifications appears in the list at the left of the pane.

Click the Do Not Disturb entry in the list at the left to set Do Not Disturb
mode, where Notification banners, alerts, and sounds are disabled. You

can specify a time period, turn on Do Not Disturb when your MacBook is in
sleep mode, or turn on Do Not Disturb when you’re mirroring (or sending)
the video from your MacBook to a TV or projector. You can also optionally
allow FaceTime calls from anyone while Do Not Disturb is active or just from
those you’'ve marked as Favorites in FaceTime. If you select Allow Repeated
Calls, a FaceTime caller can call a second time within three minutes without
being disabled.

[ N ] < i Netifications

Notification Center shows your alerts in the upper-right of your screen, without interrupting what you're
doing. Show and hide Notification Center by clicking its ican in the menu bar.

Do Not Disturb Facebaok alert style:
r‘:_q‘ Calendar
L)

@ Dropbox
None Alerts
TF Facebook

Banners Banners appear in the upper-right corner and go away
automatically. Alerts stay on screen until dismissed.
FaceTime

ot N
4 Show notifications on lock screen

; Game Center 2 Show in Notification Center: | 5 Recent ltems |2
= iTunes

@

@ Little Snitch Agent

% Mail

Notification Center sort order: Recents
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Click an application in the list at the left to configure its notifications.
Different applications display different options in the settings pane, but the
settings can include the following:

v~ Alert Style: These three buttons specify which type of alert should
appear under the Notification Center icon in the menu bar. You do not
need to display the Notification Center to see alerts, which appear on
your Desktop. Choose None to disable alerts for this application. Choose
Banners to display alert messages that automatically disappear after
a delay. Choose Alerts to display alert messages that remain onscreen
until you click the confirmation button in the Alert dialog.

+* Show Notifications on Lock Screen: Select this check box to allow notifi-
cations even if your MacBook is displaying the Lock screen.

+* Show in Notification Center: To display notification messages from this
application in the Notification Center, select this check box. You can also
specify how many recent messages from this application are displayed.

v Badge App Icon: This check box toggles on and off the display of this
application’s icon in alert boxes and in the Notification Center. It also
activates the numeric display of pending items on the icon itself (for
example, unread mail and messages).

v Play Sound for Notifications: To play a sound when alerts appear,
enable this check box.

You can change the order that notifications are sorted in the Notification
Center using the Notification Sort Order drop-down list box at the bottom of
the pane. The default sort is by the most recent, but you can choose Recents
by App to sort recent notifications grouped by applications. For the ultimate
in custom notifications, choose Manually by App from the drop-down list box
and drag the applications in the list at the left to your desired order!



Chapter 6

Sifting Through Your Stuff

In This Chapter
Mastering basic Spotlight searching skills
Selecting text and keywords for best results
Displaying results in the Finder search window

Customizing Spotlight within System Preferences

LVhat would you say if I told you that you could search your entire
system for all the data connected with a person — and in only the

short time it takes to type that person’s name? And I'm not just talking about
files and folders that might include that person’s name. [ mean every email
message and every Calendar event that references that person — and even
that person’s Contacts card to boot. Heck, how about if that search could dig
up every occurrence of the person’s name inside your PDF documents? What
if it could even search folders shared on other Macs across your network?

You’d probably say, “That makes for good future tech. I'll bet I can do that in
five or ten years. It’ll take Apple at least that long to do it — and just in time
for me to buy a new MacBook! (Harrumph.)”

Don’t be so hasty. You can do all this right now. (In fact, this functionality
has been part of OS X for a number of years.) The technology is the OS X fea-
ture named Spotlight, built into El Capitan. In this chapter, I show you how to
use it like a MacBook power guru. I also show you how to take advantage of
Internet search widgets you can display within the Dashboard. (From what I
hear, there’s good stuff on the Internet, too.)

Doing a Basic Search

Figure 6-1 shows the Spotlight search box, which is always available

from the Finder menu bar. Click the magnifying glass icon once (or press
38+spacebar), and the Spotlight search box appears on your Desktop, front
and center.
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Search box.
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To run a search, simply begin typing. (The words you type that you want

to match are called keywords.) Matching items appear as soon as you type,
and the search results are continually refined while you type the rest of your
search keywords. You don’t need to press Return to begin the search.

After a second or two, the Spotlight search box expands to display the
results of your search, and the list is updated automatically in real time
while you continue to type. The most-relevant items are grouped into
categories — such as Messages, Definitions, Documents, Folders, Images,
PDFs, and Contacts, right on the Spotlight search box. Spotlight takes a
guess at the item that’s most likely the match you’re looking for (based on
your Search Results list in System Preferences, which I cover later in the
chapter) and presents it first. To open the top item like a true El Capitan
power user, just press Return. (My brothers and sisters, it just doesn’t get
any easier than that.)

Although one or two keywords is typically enough to do the job, you can also
type phrases, such as emails from Mark Chambers or songs with sunshine
in the title.

Single-click any item in the list, and shazam! — Spotlight uses the Quick Look
technology built in to El Capitan to display the contents (such as a thumb-
nail image of a document or an album cover) or information on the item! For
example, if the item is an iTunes playlist, you'll see the song list in the results
pane on the right, and you can click one of the songs to open iTunes and play
it. If the item is a Mail message, click it once in the list to view the contents of
the message — without leaving the Spotlight box.

When you click an item in the list, Spotlight indicates which application will
be used to open the item by displaying the icon for that application in the
upper-right corner of the Spotlight box — for example, you’ll see the iTunes
icon for a song, and the Safari icon for a website.
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Literally, any text string is acceptable as a Spotlight search. However, here’s
a short list of the common search criteria [ use every day:

+ Names and addresses: Because Spotlight has access to the Contacts
application in El Capitan, you can immediately display contact informa-
tion using any portion of a name or an address.

v~ Email message text: Need to open a specific email message, but you'd
rather not launch Mail and spend time digging through the message
list? Enter the person’s email address or any text string contained in the
message you're looking for.

v File and folder names: A simple item name is the classic search favorite.
Spotlight searches your entire system for that one file or folder in the
blink of an eye.

+~ Events and Reminder items: Yep, Spotlight gives you access to your
Calendar events and those all-important Reminders you’ve created.

v Specific songs and playlists: Itching to hear “Rock Me Amadeus” by
Falco? With the power of Spotlight and your iTunes library, you can
satisfy your musical needs in seconds!

v System Preferences: Now things start to get really interesting! Try
typing the word desktop in the Spotlight field. At least one of the results
in the list will be a System Preference pane! That’s right: Every setting
in System Preferences is referenced in Spotlight. (For example, the
Desktop background setting resides in the Desktop & Screen Saver pane
in System Preferences.)

v Weather, stocks, and sports scores: Put Spotlight to work and you can
get instant displays of current weather and forecasts (type weather
followed by a town name), stock figures (type the desired stock abbre-
viation) and even sports scores (type your favorite team name).

1 Web pages: Whoa. Stand back, Google. You can use Spotlight to search
the web — and, if necessary, the web pages you’ve recently displayed
in Safari!

1 Metadata: This category is pretty broad, but it fits. If you're not familiar
with the term metadata, think of the information stored by your digi-
tal camera each time you take a photo — exposure setting, time and
date, and even the location where the photo was taken, which are also
transferred to iPhoto when you import. Here’s another example: I like to
locate Word documents on my system using the same metadata that’s
stored in the file, such as the contents of the Comments field in a Word
document. Other supported applications include Adobe Photoshop
images, Microsoft Excel spreadsheets, Keynote presentations, iTunes
media, and other third-party applications that offer a Spotlight plug-in.
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To reset the Spotlight search and try another text string, press 38+A to select
the entire contents, and then press Delete.

After you find the item you're looking for in the list at the bottom of
the Spotlight box, you can double-click the entry in the list to do any of
these things:

v Launch it (if the item is an application).

v Open it in System Preferences (if it’s a setting or description on a
Preferences pane).

v Open it within the associated application (if the item is a document,
website, or data item).

v Display it in a Finder window (if the item is a folder).

Here’s another favorite timesaver: You can display all the files of a particular
type on your system by using the file type as the keyword. For example, to
provide a list of all images on your system, just use images as your keyword —
the same goes for movies and audio, too.

How Cool Is That? Discovering
What Spotlight Can Do

Don’t get fooled into simply using Spotlight as another file-'n’-folder-name
search tool. Sure, it can do that, but Spotlight can also search inside PDFs,
Pages, Word documents, and HTML files, finding matching text that doesn’t
appear in the name of the file! To wit: A search for El Capitan on my system
pulls up all sorts of items with E/ Capitan not only in their names but also
files with El Capitan in them:

v Apple Store SF.ppt is a PowerPoint presentation with several slides con-
taining the text El Capitan.

v bk01ch03.doc is a rather cryptically named Microsoft Word file chapter
of this book that mentions El Capitan in several spots.

v Conference Call with Amy is a Calendar event pointing to a conference
call with my editor about upcoming El Capitan book projects.

Not one of these three examples has the words El Capitan occurring any-
where in the title or filename, yet Spotlight found them because they all
contain the text El Capitan therein. That, dear reader, is the true power
of Spotlight, and how it can literally guarantee you that you'll never lose
another piece of information that Spotlight can locate in the hundreds of
thousands of files and folders on your hard drive!
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Is Spotlight secure?

So how about all those files, folders, contacts,
and events that you don’t want to appear in
Spotlight? What if you're sharing your Mac as
a multiuser computer or accessing other Macs
remotely? Can others search for and access
your personal information through Spotlight?

Definitely not! The results displayed by
Spotlight are controlled by file and folder
permissions as well as your account login,
just as the applications that create and display
your personal data are. For example, you can't
access other users’ calendars using Calendar,
and they can't see your Mail messages. Only

you have access to your data, and only after
you've logged in with your username and
password. Spotlight works the same way. If a
user doesn’t normally have access to an item,
the item simply doesn’t appear when that user
performs a Spotlight search. (In other words,
only you get to see your stuff.)

However, you can hide certain folders and
disks from your own Spotlight searches if
necessary. Check out the final section of this
chapter for details on setting private locations
on your system.

Heck, suppose that all you remember about a file is that you received it in

your mail last week or last month. To find it, you can type time periods, such

as yesterday, last week, or last month, to see every item that you saved or

received within that period. (Boy, howdy, I love writing about TGIs — that’s

short for Truly Good Ideas.)

Be careful, however, when you’re considering a search string. Don’t forget
that (by default) Spotlight matches only those items that have all the
words you enter in the Spotlight box. To return the highest number of pos-
sible matches, use the fewest number of words that will identify the item;
for example, use horse rather than horse image, and you're certain to be
rewarded with more hits. On the other hand, if you're looking specifically

for a picture of a knight on horseback, using a series of keywords — such as

horse knight image — shortens your search considerably. It all depends on

what you’re looking for and how widely you want to cast your Spotlight net.

To allow greater flexibility in searches, Apple also includes those helpful
Boolean friends that you may already be familiar with: AND, OR, and NOT.
For example, you can perform Spotlight searches such as these:

1 Horse AND cow: Collects all references to both those barnyard animals

into one search

v Batman OR Robin: Returns all references to either Batman or Robin

v Apple NOT PC: Displays all references to Apple that don’t include any
information about dastardly PCs

121
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Expanding Your Search Horizons
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[ can just hear the announcer’s voice now: “But wait, there’s more! If you
double-click the Show in Finder menu item at the bottom of your search
results list, we’ll expand your Spotlight search box into the Finder search
window!” (Fortunately, you don’t have to buy some ridiculous house-
hold doodad.)

Keyboard mavens will appreciate the Finder search window shortcut
key, and I show you where to specify this shortcut in the final section of
this chapter.

Figure 6-2 illustrates the Finder search window. To further filter the search,
click one of the buttons on the search criteria bar to create your own custom
filter. Click the button with the + (plus) on the search criteria bar and then
click the pop-up menus to choose from criteria, such as the type of file, the
text content, or the location on your system (for example, your hard drive,
your Home folder, or a network server). You can also filter your results
listing by the date when the items were created or last saved. To add or
delete criteria, click the + (plus) and — (minus) buttons at the right side of
the search criteria bar. To save a custom filter that you've created, click the
Save button.
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Images appear as thumbnail icons, so you can use that most sophisticated
search tool — the human eye — to find the picture you're looking for. (If you
don’t see thumbnail images, click the Icon view button on the toolbar.) Don’t
forget that you can increase or decrease the size of the icons by dragging the
slider at the bottom right of the window.

To display the contents of an item in the list (without leaving the comfort-
able confines of the Finder search window), click the item to select it and
press the spacebar for a better view. Note that El Capitan must recognize the
format of the file, and it must be supported by at least one application.

A\

Again, when you're ready to open an item, just double-click it in the Finder
search window.

As I mention earlier, Spotlight can look for matching items on other Macs on
your network only if those remote Macs are configured correctly. To allow
another Mac to be visible to Spotlight on your system, enable File Sharing on
the other Mac. (Oh, and remember that you need an admin level account on
that Mac — or access to a good friend who has an admin level account on
that Mac.)

Follow these steps to enable file sharing on the other Mac:

1. On the Dock, click the System Preferences icon (it’s the one with the
gears).

2. Click the Sharing pane.

SISl 3. In the service list on the left side of the Sharing pane, select the On
check box next to the File Sharing item to enable it.

4. Click the Close button in the System Preferences window (or, if you're
a keyboard power user, simply press the $5+Q shortcut).

gMBER You can search only those items for which you have rights and permissions
to view on the remote Mac (such as the contents of the Public folders on that
computer). [ discussed more about these limitations earlier in this chapter, in
the “Is Spotlight secure?” sidebar.

Customizing Spotlight to VYour Taste

You might wonder whether such an awesome OS X feature has its own pane
in System Preferences — and you’d be right again. Figure 6-3 shows off the
Spotlight pane in System Preferences: Click the System Preferences icon on
the Dock, and then click the Spotlight icon to display these settings.
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¥ Calculator
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g Fonts
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¥ Movies

& Allow Spotiight Suggestions in Spatlight and Look up

Keyboard Shortcuts... About Spotlight Suggestions & Privacy

Click the Search Results tab to

v Determine which categories appear in the Spotlight search box. For
example, if you don’t use any presentation software on your Mac, you
can clear the check box next to Presentations to disable this category
(thereby making more room for other categories that you will use).

1 Specify the Spotlight search box and Finder search window key-
board shortcuts. You can enable or disable either keyboard shortcut
and choose the key combination from the pop-up menu. By default, the
menu keyboard shortcut is 38+spacebar, and the Finder search window
keyboard shortcut is 38+Option+spacebar.

Click the Privacy tab (shown in Figure 6-4) to specify disks and folders that
should never be listed as results in a Spotlight search. I know, I know — I
said earlier that Spotlight respected your security, and it does. However, the
disks and folders that you add to this list won’t appear even if you are the one
performing the search — a great idea for folders and removable drives that
you use to store sensitive information, such as medical records.
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. Spotlight helps you quickly find things on your computer and shows suggestions from the
Internet, iTunes, App Store, movie showtimes, locations nearby, and more.

Search Results

Prevent Spotlight from searching these locations:

Click the Add button, or drag a folder or disk into the list below.

Keyboard Shertcuts.. About Spotlight Suggestions & Privacy

To add locations that you want to keep private, click the Add button (a plus
sign) and navigate to the desired location. Click the location to select it, and
then click Choose. Alternatively, you can drag folders or disks directly from a
Finder window and drop them into the pane.
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Chapter 7

Using Reminders, Notes,
Notifications, and Maps

In This Chapter
Setting reminders
Making notes
Using the Notification Center
Navigating with Maps

A s I've said many times before in my books, “If it works in one place,

it’s likely to show up in another.” In this case, four popular time-saving
(and headache-preventing) apps have crossed over from the world of i0S
devices — the iPhone, iPad, and iPod touch — and have securely landed

on your El Capitan Desktop. These apps are Reminders, Notes, Notification
Center, and Maps, all taken from the iOS world.

That’s not the only good news, though: These four Mac applications work
seamlessly with an iCloud account. So if you also use an iOS device (with the
same Apple ID), much of the data you store — such as the notes you take and
the reminders you make — is automatically synchronized between all your
Apple computers and devices!

Because all four of these new applications have a similar goal — keeping you
in touch with the information, daily tasks, locations, and digital events that
matter to you — I decided to cover them in one shiny chapter. Consider this
chapter a guide that demonstrates how you can remind, note, notify, and
map like a mobile power user!

Remind Me to Use Reminders

You don’t need to look far to find the Reminders application on your Mac.
Just click the Reminders icon on the Dock to display the main window, as
shown in Figure 7-1.
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These are highlights of the Reminders window:

v Search box: Click here and type a phrase or name to search for it among
your reminders.

+* Reminders Sidebar: You can add as many separate Reminder lists as you
like in the application (one for work, for example, and another for your
Mac user group). In the Sidebar, you can switch quickly between your
lists. (Note that two lists, Reminders and Completed, already appear.)

You can hide or show the Reminders Sidebar at any time using the View
menu, or by pressing 38+Option+S. You save a significant amount of
screen real estate when the display is hidden.

v Calendar: This handy calendar indicates which days of the current month
already have reminders pending: They’re displayed with a dot under
the date. You can jump to any date by clicking it. To move forward and
backward through the months, click the Previous and Next buttons next
to the month name. (Note that this calendar does not sync or exchange
reminder dates with the Calendar.) To display the Calendar, click
View > Show Menu — to hide the Calendar, click View= Hide Calendar.
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v Add List button: Click this button to add a new Reminder list to the
Sidebar; from the keyboard, press $8+L. The list name is highlighted in a
text box, so you can simply type the new name and press Return.

+* Reminders: These entries are the reminders themselves. Each is pref-
aced by a radio button so you can select the radio button when the
reminder is complete, thereby moving that reminder automatically
to the Completed list. And yes, if you click the Show link next to the
number of completed reminders to display them and deselect the radio
button for a reminder, it returns (like a bad penny) to the original list.

+* Add Reminder button: Click this button to add a new reminder to the
currently selected list; from the keyboard, press 38+N. In its simplest
form, a reminder is just a short phrase or sentence. Press Return after-
ward to save it to your list.

.. Adding a reminder is straightforward. First, click a date in the calendar dis-
1/ play to jump to that date, and then click the Add Reminder button. Type
a few words and press Return to create a basic reminder. However, if you
hover your cursor over the reminder you just created, an Info button (the
lowercase i in a circle icon) appears next to the text. The game is afoot! Click
the Info button to display the settings you see in Figure 7-2.

Pick up soda at the market T

remind me On a Day
At a Location 11 Completed

Walmart Supercenter Pick up soda at the market
5411 2nd Ave, Kearney, NE 68847, + Arriving: Walmart Supercenter
United States Call Bob about iPac

© Arriving () Leaving
Figure 7-2: )
priority None

i— +
Editing a note

reminder. Done Check tire pressure
|

| Loat

Pick up birthday cake on the way home

These fields are on the Edit sheet:

»* Reminder text: Click this text to edit the reminder text itself.

v On a Day: Enable this check box if the reminder should appear in
Notification Center on a particular day. By default, the date is the one
selected when you created the reminder. You can click the Date and
Time fields to change them.
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1 At a Location: This is a powerful feature. Select the At a Location check
box, and a pop-up menu appears below the check box. Now you can
choose a card from your Contacts application that includes an address
(or simply type an address in the box). Reminders monitor your current
location on your MacBook, iPad, or iPhone using Location Services. They
notify you when you're leaving or arriving at that location (and, option-
ally, on the date and time you specify in the On a Day field). For example,
you could create a reminder that notifies you on your iPhone when
you’re arriving at the mall on September 15 to pick up the watch that’s
being repaired. Shazam!

1 Repeat: If you select the On a Day check box, you can also set this
reminder to automatically repeat every day, week, two weeks, month, or
year at the same time.

v Priority: You can assign one of four priorities to the reminder: Low,
Medium, High, or None. Assigning a priority prefaces the reminder text
with one (Low), two (Medium), or three (High) blue exclamation points
so the reminder stands out from the crowd.

+* Note: Click next to the Note field to enter a free-form text note along with
the reminder.

Click Done on the Edit sheet when you’ve finished making changes. You can
edit a reminder as often as you like. For example, | sometimes have to change
the date on a reminder multiple times as my schedule changes.

To delete a reminder from the list, right-click it and choose Delete from the
menu that appears.

iCloud connectivity allows Reminders to share information with other Macs
and iOS devices, as well as Microsoft Outlook on both PCs and OS X. To share
reminders, click the System Preferences icon on the Dock, click the Internet
Accounts icon and then click one of the accounts at the left of the pane. If an
account allows you to share data from the Reminders application — such

as the iCloud account — you’ll see a Reminders check box at the right side

of the pane.

Taking Notes the El Capitan Way

Imagine a notepad of unlimited pages that’s always available whenever you're
around your Mac, iPhone, iPod touch, or iPad — that’s the idea behind Notes,
and it’s superbly simple! To open the Mac version of the application, click the
Notes icon on the Dock. The window shown in Figure 7-3 appears.
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The salient stuff in the Notes window includes these items:

1 Search box: If you're hunting for a specific note, click in this box and
type a phrase or name to search for it.

+” Folders list: You can create new folders to hold specific kinds of notes.
In Figure 7-3, for example, [ added a Work folder. To add a new folder,
choose Filew> New Folder or press 38+Shift+N and type the new folder
name. To switch between folders, display the Folders list and click
the desired folder. You can display or hide the Folders list from the
View menu.

v Notes List: Each Note you create appears as a separate entry in the List.
You can click a Note in the list to switch to it immediately.

1 New Note button: Click this button to add a new Note. You can also
right-click the Notes List and choose New Note from the contextual
menu. Notes uses the first line of text you type as the title of the Note,
which appears in the list.
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1 Note Page: This free-form pane is where you type the body of your note.
You can also drag images from a Finder window and include them in the
body of the note, or embed PDF and audio files by dragging them from a
Finder window as well.

1+ Share Note button: Open this pop-up menu to share the contents of
the current note, just like the Share button that appears on the Finder
window toolbar. Sharing options can include a new email message, a
new message in the Messages application, and new postings to Twitter
and Facebook.

To edit a note, click it to select it in the Notes List, and then simply make
your changes or additions in the Note Page. You can format the text from
the Format menu — everything from different fonts and colors to inserting
bulleted and numbered lists.

To delete a note you no longer need, right-click it in the Notes List and
choose Delete from the menu that appears. The application prompts you for
confirmation before the deed is done.

Like Reminders, the Notes application can also share information with Macs
and iOS devices, as well as Outlook on both Macs and PCs. The process is
the same: Open System Preferences and click the Internet Accounts icon,
and then click the desired account at the left of the pane. Accounts that sup-
port sharing data from Notes will display a Notes check box at the right side
of the pane.

Staying Current with Notification Center

Unlike Reminders and Notes, Notification Center isn’t an application you
launch! Instead, the Notification Center icon appears at the far right side of
the Finder menu bar, and it’s always running.

Click the icon (or, if you're using a trackpad, swipe with two fingers from the
right edge to the left) to display your notifications. These notifications can be
generated by a whole host of El Capitan applications and functions, including
Calendar, Mail, FaceTime, Reminders, Game Center, Photo Stream, Messages,
Safari, Facebook, and even the Mac App Store. Third-party applications can
also generate notifications.

You can also click the Today button at the top of the Notification Center to
display all sorts of information that specifically applies to today’s date (as
shown in Figure 7-4), including things like Calendar events, Reminders, the
current weather, the OS X calculator and the latest stock figures. To switch
back to the Notifications view, click the Notifications button at the top of the
Notification Center.
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You can add applets called widgets to the Today view as well, allowing you to
customize the information you see there. Notification widgets are very simi-
lar to Dashboard widgets — you can download them from the App Store.

I love how Notification Center doesn’t interfere with open applications.

It simply moves the entire desktop to the left so you can see the Center.
You can close Notification Center at any time by clicking anywhere on the
Desktop to the left, clicking the Notifications icon on the Finder menu bar
again, or swiping in the opposite direction.

Notification entries that appear in the Notification view are grouped under
the application that created them. Many entries can be deleted from
Notification Center by clicking the Delete button that appears next to the
application heading (the button bears an X symbol). Other entries, such as
Calendar alerts, remain in Notification Center until a certain time has elapsed.

But wait, there’s more to Notification Center than just a strip of happenings!
Depending on the settings you choose, notifications can also appear without
Notification Center being open at all. These notifications are displayed as
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pop-up banners (which disappear in a few seconds) and alerts (which must be
dismissed by clicking a button). Figure 7-5 illustrates a typical alert notifica-
tion from iTunes.

A o)) Tue8:46PM MarkChambers Q =
. .

(@) Tennessee Waltz

Patti Page — Tennesse Waltz - 20 Smash Hits
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Figure 7-5:
An alert
notification —
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your “
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El Capitan can also allow actions in notifications. Depending on the application
or function that generates the notification, you may see buttons on a banner
or an alert that allow you to take care of business (without requiring the
application to be running). For example, if a new email message is received in
Apple Mail, you can choose to reply to or delete the message. Websites can
display updates as notifications, and you can answer a FaceTime or, via the
new Handoff feature, an iPhone call directly from the notification.

You can configure the notifications for all your applications from the
Notifications pane in System Preferences, which you can reach easily if
Notification Center is open. Just click the gears icon at the lower right of
the screen.

3

Introducing the Maps Application

If you own an iPad, iPhone, or iPod touch, prepare yourself for a joyful state:
your beloved Maps application also resides on your Dock! As long as you
have a connection to the Internet, Maps is ready to display locations, provide
directions, and even allow for informal views of important sites worldwide!
(Recognize the grand dame in Figure 7-6?)

Displaying an overhead view of an address is one of the simplest chores in
all of OS X — from the Maps window, just click in the Search box at the top of
the window, type the address, and press Return. Maps displays the address
with a red pushpin to help you locate it.
¥ Depending on the location you’ve chosen, you may also see a tiny Info icon
(which looks like a lowercase “i” within a circle) next to the name. To view
more information, click the Info icon.
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If you are in range of a Wi-Fi signal, and have turned Location Services on,
you can quickly map your current location — just click View= Go to Current
Location, or press $8+L.

Ah, but why stop with just a simple address? You can also enter the following
types of information:

v The name of a landmark, monument, or building (for example, Statue
of Liberty).

v The name of a business or restaurant (or even a genre of food, such as
Chinese) followed by the city name. Maps displays matching sites with
pushpins (complete with reviews), and you can click any of the push-
pins to find out more information on a location. Figure 7-7 illustrates a
search for pizza in my hometown of Columbia, Missouri — you can see
the Info pop-up that appears when I click the Info icon next to the restau-
rant name, complete with a link to their website and reviews a-plenty.

v Attractions and services, followed by the city name. You can search for a
gas station, movie theater, or local park.

If you need to zoom in or zoom out on a Maps display, use the scroll function
on your pointing device, click the plus and minus buttons at the bottom-right
corner of the Maps window, or use the 38+plus and 38+minus shortcuts.

To move around the Maps window, click and drag the map in the desired
direction.

Teachers and parents, take note: A virtual "flyby" of a famous site in Maps is
a valuable (and cool) resource.

135
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Switching Views in Maps

A traditional printed map offers you only one view, which may be perfectly
fine for determining a route but provides no visual interest. (The word banal
comes to mind.) Maps, on the other hand, offers three types of views, each of
which offers certain advantages:

v Standard (or Map) mode is a familiar line map, with streets and highways
marked. Standard mode is best for planning a road trip, just like your
father’s old-fashioned paper map.

v Satellite mode is a photographic overhead view without streets or high-
ways marked, which is great for panoramic views of your neighborhood
or a location and its surroundings.

v Transit mode displays public transportation routes and bus, subway and
train schedules. Note, however, that Transit information is not available
in every location.

To select your view, click one of the two buttons at the top of the Maps
window, or press 38+1 for Standard/Map, 38+2 for Transit, or 38+3 for
Satellite. Figure 7-6 shown earlier illustrates Satellite view mode, while
Figure 7-8 shows off Standard view.

Have you noticed the Show pop-up menu at the lower-left corner of the Maps
window? If you're using Satellite view, you can click the Show menu and
choose Show Labels to toggle street names on and off. The Show pop-up
menu also allows you to display traffic conditions and toggle the 3D map.
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“Wait, there’s a 3D map option?” Yes indeed, and no special glasses are
required! For additional visual thrills, you can angle the Maps display with

a slight 3D effect — nothing quite as grand as a 3D TV, but it does help add
depth to Satellite and Hybrid views. To toggle 3D on and off, press 3+0, click
the Show pop-up menu, or press the 3D button at the lower-left corner of

the window.

3

By default, Maps is oriented with north at the top of the screen, but if you
need to change the orientation, click the red compass arrow at the bottom-
right corner of the screen and drag in the desired direction. To immediately
return to north at the top of the screen, press T or click View= Snap to North.

\\3

Getting Directions Over Vonder

My primary use for a map is getting directions from one point to another, and
Maps doesn’t disappoint when it comes to navigation. Click the Directions
button to display the panel you see in Figure 7-9, and you’re ready to plot
your course.

Follow these steps to get directions between two addresses:

1. In the Start box, type the starting address.

As you type, Maps provides a pop-up list of suggestions taken from your
recent locations, as well as addresses from your Contacts database and
matching streets from around the globe. To choose one of these sugges-
tions, just click it. To clear the contents of the field, click the X button
that appears at the right side of the box.
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2. Press Tab to move to the End box.
3. In the End box, type the destination address.

Note that your destination doesn’t have to be a specific address — for
example, Memphis, TN works just fine.

4. Click the Driving button for road directions, or the Walking button for
walking directions.

5. Press Return to generate your directions.

Maps usually offers more than one route for your trip — the first route pro-
vided is typically the fastest or shortest, and it appears as a bright blue. To
view one of the other routes, just click a light blue line and it turns bright blue
to indicate it’s now the selected route. (You can see the approximate mileage
and time for the currently selected route at the top of the turn list.) The turn-
by-turn list provides approximate mileage for each leg of the journey.

You can easily print the route map and directions by choosing File= Print (or
by pressing 38+P), and then clicking the Show Details button at the bottom of
the Print sheet to display all the options.

If you’d rather create a PDF document with your map and directions, choose
Filew> Export as PDF.

Finally, Maps also allows you to share your maps and directions using Mail,
Messages, Twitter, or Facebook. Click the Share button at the top of the
window, and then select the desired sharing method.
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In this part . . .

v Surfthe web with ease using Apple’s Safari browser.
v Sync documents and data automatically using iCloud.
v~ Share your laptop with other users safely.

v Join or create a wireless network with your MacBook.




Chapter 8
Let's Go on Safan!

In This Chapter
Introducing the Safari window and controls
Visiting websites with Safari
Moving between sites
Creating and using bookmarks
Receiving files with Safari
Surfing with your tabs showing
Saving web pages to disk
Protecting your privacy on the web
Blocking those irritating pop-ups

’ proudly surf the web via a lean, mean — and fast — browser application.
That’s Safari, of course, and it keeps getting better with each new version
of OS X. Safari delivers the web the right way, without the wait. You'll find
that features have been added to Safari that no other browser offers, like the
Reading List, which allows you to easily select articles and pages for later
perusal.

If you need a guide to Safari, this is your chapter. Sure, you can start using
Safari immediately, but wouldn’t you rather read a few pages so that you can
surf like a power user?

Within these pages, | show you how to use those other controls and toolbar
buttons in Safari — you know, the ones in addition to the Forward and Back
buttons. You'll discover how to keep track of where you've been and where
you’d like to go.

Pretend You've Never Used This Thing

Figure 8-1 illustrates the Safari window. You can launch Safari directly from
the Dock, or you can click the Safari icon in Launchpad.
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Sidebar Content pane

These are the major sections of the Safari window:

+” The toolbar: Here are the most often-used commands for tasks such

as navigation, sharing content, and searching Google (or Yahoo!, or
DuckDuckGo, or Bing). Plus, here you can type or paste the address for
websites that you’d like to visit. You can easily hide the toolbar to pro-
vide more real estate in your browser window for web content. To toggle
hidden mode, choose View= Hide/Show Toolbar.

v The Favorites bar: Consider this a toolbar that allows you to jump

directly to your favorite websites with but a single click or two. I show
you later, in the section “Adding and Using Bookmarks,” how to add and
remove sites from your Favorites bar. For now, remember that you can
toggle the display of the Favorites bar by choosing View=>Hide/Show
Favorites Bar or by pressing 38+Shift+B.

v+ The Tab bar: This toolbar allows you to quickly switch between multiple

web pages that you’ve loaded, using what appear to be old-fashioned file
folder tabs. (Something familiar — familiar is good.) To hide or display
the Tab bar, press 38+Shift+T or choose View > Hide/Show Tab Bar. In El
Capitan, you can also pin sites to the Tab bar permanently (more on this
later in the chapter).



Chapter 8: Let's Go on Safari! 7 43

v~ The Safari Sidebar: The Sidebar pane allows you to organize and read
your bookmarks, reading list, and shared links. To hide or display the
Sidebar, press 38+Shift+L or choose View > Hide/Show Sidebar.

v+ The Content pane: Congratulations! At last, you've waded through the
pregame show and reached the area where web pages are displayed.
The Content pane can be scrolled, and when you minimize the Safari
window to the Dock, you get a thumbnail (minimized) image of the
Content pane.

The Content pane often contains underlined text and graphics that
transport you to other pages when you click them. These underlined
words and icons are links, and they zip you right from one area of a site
to another area (or to a different site altogether). You can tell when your
pointer is resting on a link because it changes to that reassuring pointing-
finger hand. Handy! (Sorry about that.)

\\3

v The status bar: The status bar displays information about what the
pointer is resting on, such as the address for a link or the name of an
image; it also updates you about what’s happening while a page is load-
ing. To hide or display the status bar, press $8+/ (forward slash) or
choose Viewr> Hide/Show Status Bar.

Visiting Websites

Here’s the stuff that virtually everyone over the age of five knows how to
do ... but I get paid by the word, and some folks might just not be aware
of the many ways to visit a site. You can load a web page using any of
these methods:

v Click in the Address box. If you're not viewing your Top Sites display,
just click once on the Address box to display a scrolling thumbnail list
of your Favorites and most frequently visited sites. Click a thumbnail to
jump immediately to that page. That’s about as simple as life gets!

1 Type (or paste) a website address in the Address box on the toolbar,
and press Return. If you're typing an address and Safari recognizes the
site as one that you’ve visited in the past, it “helps” by autocompleting
the address for you. Press Return if you want to accept the suggested
site. If this is a new site, just keep typing.

The Safari Address box also acts as a smart address field, displaying a
new pop-up menu of sites that match the text you enter. Safari does this
by using sites taken from your History file and your bookmarks, as well
as sites returned from Google, Yahoo!, DuckDuckGo, or Bing. If the site
you want to visit appears in the list, click it to jump there immediately.
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v Click a Bookmarks or Favorites entry. Bookmarks appear in the Sidebar
and the Bookmarks menu, while Favorites appear in the Favorites bar.

v+ Click a tab for a pinned site. Pinned tabs appear as icons at the left side
of the Tab bar.

v~ If the Home button appears on your toolbar, click the button to go
to the home page that you specify. Read more on this in the upcoming
section, “Setting Up Your Home Page.”

v~ If the Show Top Sites button appears on the toolbar, click it to open
the Top Sites display. Safari displays a wall of preview thumbnail pages
from your most frequently visited sites, and you can jump to a site just
by clicking the preview. You can anchor a thumbnail to keep it onscreen
permanently by hovering your pointer over the thumbnail and click-
ing the pin icon that appears, or you can delete a thumbnail by clicking
the X button that appears. Click the Favorites button (which bears a
star) at the top-right corner of the screen to switch to a display of your
favorites.

Because each thumbnail is updated with the most current content, the
Top Sites wall makes a great timesaver. Quickly make a visual check of
all your favorite haunts from one screen!

v Click an item you saved earlier in the Sidebar’s Reading List tab. To
display items in your list, click the button bearing the eyeglasses icon at
the top of the Sidebar.

v Click a link in the Sidebar’s Shared Links list. Shared links appear in
the Sidebar when you click the button bearing the “@” symbol.

v Click a page link in Apple Mail or another Internet-savvy application.
These links are typically highlighted or underlined to make them easier
to see.

v Click a page link in another web page. By default, Safari opens the new
page in a separate tab.

1 Select a web address in a document, click the Services menu, and
choose Open Page in Safari. Safari automatically loads and dis-
plays the page.

1 Type a search term in the Address box. By default, Safari uses Google
as a search engine, but you can also use Yahoo!, Bing, or DuckDuckGo if
you prefer. To set the default search engine, choose Safari=> Preferences;
then on the Search Engine tab, click the Search Engine drop-down menu.
(You can immediately switch to another engine by clicking the magnifying-
glass icon that appears as you're typing into the Address box.)

Click in the Address box, type the contents that you want to find, and
press Return. Safari presents you with the search results page on Google
for the text you entered. (In case you've been living under the Internet
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equivalent of a rock for the last several years, Google (www .google . com)
is the preeminent search site on the web. People use Google to find every-
thing from used auto parts to ex-spouses.)

1 Click a Safari page icon on the Dock or in a Finder window. Drag a
site from your Favorites bar (or drag the icon from the left side of the
Address box), and drop it on the right side of the Dock. Clicking the icon
that you add launches Safari and automatically loads that site.

This trick works only on the side of the Dock to the right of the vertical
line. More on that all-important divider in a bit.

If you minimize Safari to the Dock, you’ll see a thumbnail of the page with the
Safari logo superimposed on it. Click this thumbnail on the Dock to restore
the page to its full glory.

Speaking of full glory, Safari supports the same full-screen mode as many
other El Capitan applications. Click the Zoom/Full Screen button at the top-
left corner of the Safari window to switch to full-screen mode, or press the
Control+38+F shortcut (a good shortcut to memorize because it works with
virtually all El Capitan—compatible applications). To make things convenient
for you, the toolbar and Favorites bar remain. To exit full-screen mode, press
Esc or the Control+38+F shortcut again.

Navigating the Web

3

A typical web surfing session is a linear experience. You bop from one page
to the next, absorbing the information you want and discarding the rest.
However, after you visit a few sites, you might find that you need to return to
where you’ve been or head to the familiar ground of your home page. Safari
offers these navigational controls on the toolbar:

v Back: Click the Back button (the left-facing arrow) on the toolbar to
return to the last page you visited. Additional clicks take you to previous
pages, in reverse order. The Back button is disabled if you haven’t vis-
ited at least two sites.

v Forward: If you've clicked the Back button at least once, clicking the
Forward button (the right-facing arrow) takes you to the next page (or
through the pages) where you originally were, in forward order. The
Forward button is disabled if you haven’t used the Back button and
haven’t navigated to another page.

Safari supports a number of trackpad gestures. For example, you can
swipe in either direction with two fingers to move backward and forward,
just as you would move with the Forward and Back buttons. To zoom in
and out on the Content pane, you can either double-tap the trackpad or
pinch with two fingers — yes, just like an iPhone. (Ever get the notion that
someday we’ll just have a single box called “The Device” that does it all?)


http://www.google.com/
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v Home: Click this button (look for the little house) to return to your

home page.

Not all these buttons and controls must appear on your toolbar — you
may never see many of these toolbar controls unless you add them
yourself. To display or hide toolbar controls, choose View = Customize
Toolbar. The sheet that appears works just like the Customize Toolbar
sheet in a Finder window: Drag the control you want from the sheet to
your Safari toolbar, or drag a control that you don’t want from the tool-
bar to the sheet. As with most buttons and controls in Mac applications,
if you hover your pointer over an unfamiliar button on the toolbar, Safari
will display a tooltip to identify the button for you.

1 New Tab: Click this button (it looks like a little tab with a plus sign) to

open a new tab in the Tab bar. I'll get knee-deep into tabbed browsing
later in the chapter.

v+ Show All Tabs: A click on this toolbar button displays all the tabbed

sites you've opened, as well as the iCloud Tabs from Safari on your other
Macs, PCs, and iOS devices.

v AutoFill: If you fill out lots of forms online — when you’re shopping

at websites, for example — you can click the AutoFill button (which
looks like a little text box and a pen) to complete these forms for
you. You can set what information is used for AutoFill by choosing
Safari=> Preferences and clicking the AutoFill toolbar button.

To be honest, I'm not a big fan of automatically releasing any of my per-
sonal information to any website, so I don’t use AutoFill. If you do decide
to use this feature, make sure the connection is secure (look for the
padlock icon in the Address box) and read the site’s Privacy Agreement
page first to see how your identity data is treated.

v Top Sites: Click this button to display the Top Sites screen I discuss

earlier. If you're having trouble finding it, the button bears a tiny, fash-
ionable grid of squares.

v Text Size: Shrink or expand the size of text on the page, offering smaller,

space-saving characters (for the shrinking crowd) or larger, easier-to-
read text (for the expanding crowd) by clicking one of the Text Size
buttons, which are labeled respectively with a small and large letter A.
(From the keyboard, you can press 38+= (equal sign) to expand and
38+ (hyphen) to shrink.)

v~ Favorites bar: Click this button (which carries the Bookmarks symbol

sandwiched between two horizontal lines) to display or hide the
Favorites bar.

1 Stop/Reload: Click Reload (which has a circular arrow in the Address

box) to refresh (reload) the contents of the current page. Although most
pages remain static, some pages change their content at regular inter-
vals or after you fill out a form or click a button. By clicking Reload (look
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for the curved arrow in the Address box), you can see what’s changed
on these pages. (1 use Reload every hour or so with CNN.com, for
example.) While a page is loading, the Reload button turns into the Stop
button — with a little X mark — and you can click it to stop the loading
of the content from the current page. This feature is a real boon when

a download takes foorrevverr, which can happen when you're trying to
visit a popular or slow website. Using Stop is also handy if a page has a
number of very large graphics that are likely to take a long time to load.

v Sidebar: Click this toolbar button at the left side of the Address box to
hide or display the Safari Sidebar. You'll find the complete description of
the sidebar in an upcoming section.

v History: Click this button (which bears a clock symbol) to display or
hide the History list, which I discuss later in this chapter.

v Downloads: This toolbar button appears only if you're currently down-
loading a file (or if you’ve downloaded files that haven’t been cleared
yet). Click it to display the files you’ve downloaded recently, and click
the Clear button to clear the contents of the Download list. Note that
clearing the list does not delete the files you've downloaded; it simply
cleans things up. You can also double-click a completed download in the
list to open it immediately. (More on downloading in a couple pages.)

When you're downloading a file, a tiny progress bar appears in the
Downloads button on the toolbar to show you how much you’ve received.
Now that, good reader, is progress! (Let’s see whether my editor allows
such a horrible pun to remain.) Anyway, you can click the Downloads
button during the file transfer to pause or stop the download completely.

+* Open in Dashboard: Click this button to create a Dashboard widget using
the contents of the currently displayed web page. Safari prompts you
to choose which clickable section of the page to include in the widget’s
borders (such as the local radar map on your favorite weather website).
Click Add, and Dashboard loads automatically with your new widget.
(You learn more about widgets in Chapter 3.)

v Mail: Click this button (bearing an envelope icon) to send an email
message with a link to the current page, just as if you clicked the Share
button and chose Email This Page. Safari automatically opens Apple Mail
(or your default email application) and creates a new message with the
link already in the body. Shazam!

v~ Print: Click this convenient button to print the contents of the Safari
window. (Dig that crazy printer icon!)

v Share: If you have an iPhone, iPod touch, or iPad, you’re probably
already familiar with this button, which carries a rectangle and arrow
symbol. Click the Share button to send the current page (or a link to it)
to a number of different destinations, including your Reading List, an
email message, your Messages application, AirDrop, Facebook, LinkedIn,
or Twitter. You can also add a bookmark to the current page using the
Share button. Figure 8-2 illustrates the Share button in action.
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Setting Up VYour Home Page

3
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Choosing a home page is one of the easiest methods of speeding up your
web surfing. However, a large percentage of the MacBook owners whom I've
talked with have never set their own home page; instead, they simply use the
default home page provided by their browser. Declare your independence!
With Safari running, take a moment to follow these steps to declare your
freedom to choose your own home page:

1. In Safari, display the web page that you want to become your new
home page.

I recommend selecting a page with few graphics or a fast-loading
popular site.

2. Choose Safari> Preferences, or press 35+, (comma).
3. Click the General tab.
You see the settings shown in Figure 8-3.
4. Click the Set to Current Page button.
5. Click the Close button to exit the Preferences dialog.
Alternatively, open the New Windows Open With pop-up menu and choose

Empty Page if you want Safari to open a new window with a blank page. This
choice is the fastest one for a home page.

Visit your home page at any time by pressing the Home button on the
toolbar. If it doesn’t appear on your toolbar, you can add it by choosing
View=> Customize Toolbar.
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Adding and Using Bookmarks

No doubt about it: Bookmarks make the web a friendly place. As you col-
lect bookmarks in Safari, you're able to immediately jump from one site to
another with a single click of the Bookmarks menu or the buttons on the
Favorites bar.

To add a bookmark, first navigate to the desired page and then do any of the
following:

v Choose Bookmarks~> Add Bookmark.
1 Press the 38+D keyboard shortcut.

Safari displays a sheet where you can enter the name for the bookmark
and also select where it appears (on the Favorites bar, Top Sites display,
Bookmarks folder, or Bookmarks menu).

v Drag the icon next to the web address from the Address field to the
Favorites bar.

This trick also works with other applications besides Safari, including in
a Mail message or Messages conversation. Drag the icon from the Safari
Address field to the other application window, and the web page link is
added to your document.

You can also drag a link on the current page to the Favorites bar, but note that
doing this adds a bookmark only for the page corresponding to the link — not
the current page.
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To jump to a bookmark, do one of the following:

1 Choose it from the Bookmarks menu. If the bookmark is contained in a
folder, which I discuss later in this section, hover your pointer over the
folder name to show its contents and click the bookmark.

+* Click the bookmark on the Favorites bar.

If you've added a large number of items to the Favorites bar, click the
More icon on the edge of the Favorites bar to display the rest of the
buttons.

+* Click the Show Sidebar button on the Safari toolbar, click the
ﬂ Bookmarks button in the Sidebar, and then click the desired book-
mark. The Sidebar (shown in Figure 8-4) displays all your bookmarks,
allowing you to review each collection at your leisure.

v Click Bookmarks~ Edit Bookmarks (or press Option+35+B) to open
the Bookmark list. For those who prefer more information (and more
onscreen elbow room) while selecting or organizing their bookmarks,
the Bookmark list is the cat’s meow. It displays both the name and web
address for each bookmark in your collection.

The more bookmarks you add, the more unwieldy the Bookmarks
menu and the Sidebar can become. To keep things organized, choose
Bookmarks=>Add Bookmark Folder and type a name for the new
folder. With folders, you can organize your bookmarks into collections,
which appear in the column at the left of the Sidebar, as folders in the
Bookmark list, and as menus on the Bookmarks bar. (Collections also
appear as separate submenus in the Bookmarks menu on the Safari
menu bar.) You can drag bookmarks into the new folder to help reduce
the clutter.
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To delete a bookmark or a folder from any of these locations, right-click it
and choose Delete from the contextual menu.

Working with the Reading List and
Shared Links

Now that you know all about bookmarks, I'll introduce you to two other
methods of loading, saving, and retrieving specific pages in Safari — and
they’re both hiding in the now-familiar confines of the Safari sidebar! These
two Sidebar celebrities are the Reading List and Shared Links.

Saving pages for later with the
Reading List

The Sidebar’s Reading List tab allows you to save entire pages for later
perusal. From the keyboard, press $8+Shift+L to display the Sidebar, and
click the Reading List button. Click Bookmarks => Add to Reading List or press
38+Shift+D to add the current page to the list, or hover your pointer over the
left side of the Address box and click the circular icon with the plus sign that
appears. (Oh, and don’t forget that you can click the Sharing icon in the tool-
bar and choose Add to Reading List to achieve the same victory.)

Ah, but when you click one of those entries in the Reading List and then click
the Show Reader View icon (it looks like a paragraph) that appears at the

left side of the Address box, the real magic begins! If you click it, the Reader
panel appears to display text articles free of advertisements and silly pop-
ups. And if an article is continued over multiple web pages, the Reader panel
automatically stitches them together to form a continuous block of text.
(Think of an e-book displayed in iBooks on your MacBook, and you get the
idea.) You can also print or email the article from in the Reader panel.

To delete an item from the Reading List, right-click the item and click Remove
Item, or click the X icon that appears next to the title.

\‘@N\Bfﬁ If the Show Reader View icon appears in Safari’s Address box — and you're
& not using the Reading List — don’t panic! Because the page you're reading
contains text articles, Safari is offering to display it in the Reader panel. (If

a page has nothing to display in the Reader panel, the icon disappears.) To
display the page in the Reader panel, click the Show Reader View button in
the Address box. To return to your mundane browsing experience, click the
Reader icon again.
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Uisiting pages recommended by friends

If you're a fan of the Twitter, Facebook, or LinkedIn social media sites, listen
up: El Capitan introduces shared links to Safari! After you've added your
Twitter, Facebook, LinkedIn, and other social media account information

in the Internet Accounts pane in System Preferences, Safari automatically
adds links posted by your friends on both services on the Sidebar’s Shared
Links tab.

To visit a shared link, just click it. To search for a specific shared link, click in
the Search Links box at the top of the Shared Links list and type a portion of
the link (or just type the person’s name to see all the links they’ve posted).

The Shared Links tab doesn’t appear in the Sidebar unless you’ve success-
fully added your Twitter, Facebook, LinkedIn, or other account information in
System Preferences’ Internet Accounts pane. Additional social media connec-
tions can be added in the Extensions pane within System Preferences.

Downloading Files

A huge chunk of the fun you’ll find on the web is the capability to download
images and files. If you've visited a site that offers files for downloading,
typically you just click the Download button or the download file link, and
Safari takes care of the rest. While the file is downloading, feel free to con-
tinue browsing or even download additional files; the Downloads status list
helps you keep track of what’s going on and when everything will be finished
transferring. To display the Downloads status list from the keyboard, press
38+Option+L. You can also click the Download button at the upper-right
corner of the window to display the Download list.

By default, Safari saves any downloaded files to the Downloads folder on
your Dock, which I like and use. To specify the location where downloaded
files are stored — for example, if you’d like to scan them automatically with
an antivirus program — follow these steps:

1. Choose Safari=> Preferences, or press 38+, (comma).

2. Click the General tab (refer to Figure 8-3), and open the File Download
Location pop-up menu.

. Choose Other.
. Navigate to the location where you want the files stored.

. Click the Select button.

S U1 e W

. Click the Close button to exit Preferences.
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To download a specific image that appears on a web page, move your pointer
over the image, right-click, and choose Save Image As from the menu that
appears. Safari prompts you for the location where you want to store the file.

You can choose to automatically open files that Safari considers safe — things
like movies, text files, and PDF files that are very unlikely to store a virus or a
damaging macro. By default, the Open “Safe” Files after Downloading check
box is selected on the General pane of the Safari Preferences dialog. However,
if you're interested in preventing anything you download from running until
you’ve manually checked it with your antivirus application, you can deselect
the check box and breathe easy.

Luckily, Safari has matured to the point that it can seamlessly handle most
multimedia file types that it encounters. However, if you've downloaded a
multimedia file and Safari doesn’t seem to be able to play or display it, try
loading the file in QuickTime Player. QuickTime Player is the Swiss Army knife
of multimedia players, and it can recognize a huge number of audio, video,
and image formats. To launch the Player, click the Spotlight search icon and
type QuickTime Player.

Using Subscriptions and History

\\3

To keep track of where you’ve been, you can display the History list by click-
ing the History menu in Safari. To return to a page in the list, just choose it
from the History menu. Note that Safari also arranges older history items by
the date you visited a site so you can easily jump back a couple of days to
that page you forgot to bookmark!

Safari also searches the History list automatically, when it fills in an address
you're typing — that’s the feature [ mention in the earlier section, “Visiting
Websites.”

To view your Top Sites display, press 3+Option+1 or choose Show Top Sites
from the History menu. You can also click the Top Sites button at the far left
side of the Favorites bar or on the Safari toolbar (if you've added it).

You can add a site manually to your Top Sites by dragging a bookmark from
the Sidebar to the Top Sites icon in the Favorites bar, or by dragging a link or
URL address from another application to the Top Sites icon in the Favorites
bar. (You'll see a plus sign appear next to your pointer to indicate the addi-
tion.) To rearrange screens in the Top Sites display, just drag a screen
thumbnail to the desired location. If you prefer that a specific thumbnail
remain in the same place, hover your pointer over the thumbnail and click
the gray pushpin icon, which turns blue to indicate that the thumbnail is
pinned in place.
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If you're worried about security and would rather not keep track of where
you've been online, find out how to clear the contents of the History file in
the upcoming section, “Handling ancient history.”

Tabs Are Your Browsing Friends

W

3

Safari also offers tabbed browsing, which many folks use to display (and
organize) multiple web pages at one time. For example, if you're doing a bit
of comparison shopping for a new piece of hardware among different online
stores, tabs are ideal. (Heck, tabbed browsing is so popular that Apple added
tabs to Finder windows with the release of OS X Mavericks!)

When you hold down the 38 key and click a link or bookmark using tabs, a tab
representing the new page appears at the top of the Safari window. Just click
the tab to switch to that page. By holding down Shift+38, the tab is both cre-
ated and displayed. (If you don’t hold down g8, things revert to business as
usual, and Safari replaces the contents of the current tab with the new page.)

You can also open a new tab by clicking the plus sign that appears at the
upper-right corner of the Safari window or by pressing 3+T. To move
between multiple tabs, simply click on the desired tab header. If you're fin-
ished with a page, you can remove a tabbed page by hovering your pointer
over the tab and clicking the X button that appears.

Trackpad fans will appreciate Safari’s two gestures that control tabs. With
multiple tabs active, you can do these:

v Pinch to display them all in the All Tabs view display (as shown in
Figure 8-5).

v With the All Tabs view open, swipe with two fingers to move among tabs.

To display your tabs in All Tabs view without a trackpad, click the Show

All Tabs button that appears at the right side of the Safari toolbar. From the
All Tabs view, you can click any tab thumbnail to switch immediately to that
tab. (Note that the iCloud Tabs shared from your other Macs and iOS devices
appear at the bottom of the All Tabs view display.) To close a tab in All Tabs
view, move your pointer over the thumbnail and click the X button that
appears. To close the All Tabs view display, click the Hide All Tabs button at
the right side of the Safari toolbar.

The All Tabs view also displays the iCloud Tabs you’ve set on your other
Macs (running OS X Lion or later) and iOS devices (running iOS 7 or later).
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To fine-tune your tabbed browsing experience, choose Safari=> Preferences
to display the Preferences dialog, and click Tabs. From here, you can specify
whether a new tab or window automatically becomes the active window

in Safari.

A\

If you open a page that plays audio — either as background music, or as part

of a video shown on the page — you can click the speaker icon that appears
in the tab header to mute that audio. (Think really, really irritating video
advertisements.) To unmute the audio, click on the speaker icon again.

With the arrival of 0S X El Capitan, Safari has
gained a new type of tab, called a pinned
tab, which allows you to immediately jump
to a specific page! Pinned sites hang out at
the left side of the Tab bar, usually sporting
a recognizable symbol (taken from the site
itself). Unlike standard tabs that | discuss in
this section, however, pinned tabs are updated
automatically in the background from the
moment you launch Safari, which is perfect for

Power users pin sites!

sites like your Facebook page or Twitter feed
that are constantly changing.

To set a pinned tab, navigate to the page you
want to pin, and click Window=>Pin Tah. The
pinned tab is added at the far left of the Tab bar,
and you can click it at any time to immediately
return to that page.

To remove a pinned tab, click the tab to switch
to that page, then click Window=> Unpin Tab.
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Printing Web Pages

3

3

If you've encountered a page that you’d like to print, follow these steps:

1. Display the desired page.
2. Choose File= Print, or press 38+P.

3. Select the number of copies, and specify whether you’d like to print
the entire page, only the current page, or a range of pages.

4. Click Print.

A quick word about printing a page in Safari: Some combinations of back-
ground and text colors might conspire to render your printed copy worth-
less. In a case like that, use your printer’s grayscale setting (if it has one), or
click the Show Details button at the bottom of the Print sheet and deselect
the Print Backgrounds check box (which can save you quite a bit of ink or
toner). Alternatively, you can simply click and drag to select the text on the
page, press 38+C to copy it, and paste the text into TextEdit, Word, or Pages,
where you can print the page on a less offensive background (while still keep-
ing the text formatting largely untouched). You can also save the contents of
a page as an electronic PDF file by clicking File=> Export as PDF or by clicking
the PDF pop-up menu at the bottom of the Print sheet.

If you’d rather mail the contents of a web page to a friend, click the Share
button and choose Email This Page. (If you've added the Mail button to your
toolbar, one click does the job.) Mail loads automatically, complete with a
prepared email message. Just address it to the recipients, and click Send.

Protecting Vour Privacy

No chapter on Safari would be complete without a discussion of security,
against both outside intrusion from the Internet and prying eyes around your
laptop. Hence this last section, which covers protecting your privacy.

Although diminutive, the padlock icon that appears at the left side of the
Address box when you’re connected to a secure website means a great deal!
A secure site encrypts the information you send and receive, making it much
harder for those of unscrupulous ideals to obtain private data, such as credit
card numbers and personal information. You can click the padlock icon (next
to the site name) to display the security certificate in use on that particular
site. A secure site web address begins with the prefix https: instead of
http:. (The extra s stands for secure. A Good Thing.)
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Ves, there are such things as bad cookies

First, a definition of this ridiculous term: A cookie, a small file that a website
automatically saves on your Mac’s drive, contains information that the site
uses on your future visits. For example, a site might save a cookie to preserve
your site preferences for the next time or — like shopping at Amazon.com —
to identify you automatically and help customize the offerings that you see.

In and of themselves, cookies aren’t bad things. Unlike a virus, a cookie file
isn’t going to replicate itself or wreak havoc on your system, and only the
original site can read the cookie that it creates. However, many folks don’t
appreciate acting as a gracious host for a slew of little snippets of personal
information. (Not to mention that some cookies have highly suggestive
names, which can lead to all sorts of conclusions. End of story.)

You can choose to accept some or all cookies, or you can opt to disable
cookies altogether. You can also set Safari to accept cookies only from the
sites you choose to visit. To change your Cookie Acceptance Plan (or CAP,
for those who absolutely crave acronyms), follow these steps:

1. Choose Safari=> Preferences.

2. Click the Privacy tab.

3. Choose how to block cookies and website data via these radio button
choices:

® Always Block: Block cookies entirely.

e Allow from current website only: Restrict cookies to the website
you're currently visiting.

e Allow from websites I visit: | use this option, which allows sites such
as Amazon.com to work correctly without allowing a barrage of
superfluous cookies.

e Always Allow: Accept all cookies.
4. To view the cookies currently on your system, click the Details button.

If a site’s cookies are blocked, you might have to take care of things man-
ually, such as by providing a password on the site that used to be read
automatically from the cookie.

5. Click the Close button to save your changes.

Feeling nervous about the data stored by the websites you visit? You can
always delete all that stored information with a single click. From the Privacy
pane in the Safari Preferences dialog, click the Remove All Website Data
button. You'll be asked to confirm your draconian decision.



’58 Part lll: Connecting and Communicating

The Privacy pane also includes the Ask websites not to track me check box,
which works . . . sometimes. Unfortunately, it’s up to a particular website
whether to honor Safari’s request for privacy. (Also, some sites — such as
Amazon.com — use tracking legitimately, to keep track of your likes and
purchases each time you return.) If you're especially worried about leaving a
trail of breadcrumbs behind you on the web, however, | recommend selecting
this check box.

Finally, you can also limit the access that websites have to your MacBook’s
location services, which can pinpoint your current location. (For example,
Facebook’s website uses location services if you allow it.) Access can be set
through prompting (either once a day or just the first time you visit the site),
or you can deny access to location services completely for all websites.

Banishing pesky iCloud Keychain
passwords

I am the world’s biggest critic of keychains, which El Capitan uses to auto-
matically provide all sorts of login information throughout the system. In
Safari, for example, the password information is automatically entered for
you whenever a website you’ve approved requires you to log in.

To be more specific, I'm sure many readers will adopt iCloud Keychain,
which stores password and credit card information for Safari and wirelessly
distributes that information automatically to other Macs and iOS devices
using the same Apple ID. (Apple even says that the passwords generated by
iCloud Keychain are more complex and harder to crack, which sounds more
secure, right?)

I'd rather keep a pet piranha in a cereal bowl than use this feature! Why?
Whenever you're logged in, anyone using your MacBook gets control of your
online persona (in the form of your passwords to secure websites). Safari,
like an obedient puppy, automatically provides access to sites with stored
keychain passwords.

s‘gN\BEH If you'd like to take the far-less-convenient-but-much-safer, old-fashioned

& route of remembering your passwords yourself, follow my lead: Visit the
iCloud pane in System Preferences, and deselect the Keychain check box to
turn the iCloud Keychain feature off.

Now that I've warned you thoroughly, I feel better about mentioning the
Passwords tab in Safari Preferences for those who do decide to use iCloud
Keychain. From the Passwords tab, you can view the iCloud Keychain
information that Safari uses, and either remove a specific password (or all
passwords) from your iCloud Keychain.
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Handling ancient history

As you might imagine, your History file leaves a very clear set of footprints
indicating where you’ve been on the web. To delete the contents of the
History menu, choose History=> Clear History (at the very bottom of the
History menu).

Safari also allows you to specify an amount of time to retain entries in your
History file. Open the Safari Preferences dialog, click the General tab (refer to
Figure 8-3), and then click the Remove History Iltems pop-up menu to specify
the desired amount of time. Items can be rolled off daily, weekly, biweekly,
monthly, or yearly.

Setting notifications

In El Capitan, Safari can allow websites you’'ve approved to send you mes-
sages using Notification Center — you can control which sites have been
given this functionality from the Notifications tab in Safari’s Preferences
dialog. To prevent a website from sending notifications, click the Deny button
next to the offending site in the list. You can also remove a website from the
list completely by clicking it and clicking the Remove button.

Avoiding those @*!"%$ pop-up ads

[ hate pop-up ads, and I'm sure you do, too. To block many of those pop-up
windows with advertisements for everything from low-rate mortgages to
“sure-thing” Internet casinos, open the Safari Preferences dialog, click the
Security tab, and verify that Block Pop-Up Windows is selected.






Chapter 9

ICloud Is Made for MacBooks

In This Chapter
Introducing iCloud
Using your iCloud Drive
Sharing documents with iOS devices using Handoff
Setting iCloud preferences
Managing iCloud storage

R eaders often ask me to name my favorite reasons why they should
switch platforms. In other words, why should a Windows user who
thinks all is well move to the Apple universe? I always mention the supe-

rior hardware and that El Capitan is a much better operating system than
Windows 10. My favorite selling point is innovation. Apple comes up with the
best ideas first, and everyone else plays catch-up.

Here’s the perfect example: The folks at Apple got tired of constantly
synchronizing their i0OS devices with their computers over a USB cable.
Remember those archaic days? When you took a photo with your iPhone or
created a new document with your iPad, your new additions just sat there in
their original locations until you had a chance to sync your device with your
MacBook. But with Apple’s iCloud functionality, your stuff gets automatically
synchronized and backed up across the Internet!

In this chapter, [ save you the trouble of researching all the benefits of
iCloud. Heck, that’s one of the reasons you bought this book, right?

So How Does iCloud Work, Anyway?

Today’s i0S devices can all display or play the same media: photos, music,
books, TV shows, and such. Heck, iOS devices (your iPhone, iPad, and iPod
touch) can even share applications. Therefore, it makes sense to effortlessly
share all your digital media across these devices, and that’s what iCloud is all
about. Apple calls this synchronization “pushing.”
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Here’s how the pushing process works. Imagine that you just completed a
Pages document on your MacBook (an invitation for your son’s birthday
party), but you're at the office, and you need to get the document to your
family so they can edit and print it using your son’s iPad.

Before iCloud, you had to attach the document to an email message or upload
it to some type of online storage such as Dropbox or Microsoft’s OneDrive,
and then a family member had to download and save the document to the
iPad before working with it. With iCloud, you simply save the document on
your MacBook to the Pages folder on your iCloud Drive, and OS X automati-
cally pushes the document to the iPad (using the same Apple ID). Your docu-
ment appears on the iPad, ready to be opened, edited, and printed — and it
appears on any other devices using the same Apple ID as well. Figure 9-1 gives
you an idea of what’s happening in the background when one of your devices
pushes data using iCloud.

T @

Anew Pages Uploaded Stored in iCloud Pushed to other The Pages

document you've i0S devices such as document

created and saved on your iPhone automatically

your Mac and iPad appears on your
iPad

iCloud isn’t limited to just digital media, though. El Capitan can also auto-
matically synchronize your email accounts, Calendar, and Contacts entries
with other iOS devices across the Internet, so staying in touch is much
easier (no matter where you are or which device you happen to be using at
the moment).

Apple also throws in 5GB of free online storage that you can use for all sorts
of things — not only digital media files but also documents you’d like to save
online for safekeeping. Items you buy through the iTunes Store, iBooks Store,
or App Store — music, video, podcasts, books, and applications — do not
count against your 5GB limit. (More on how you can expand that 5GB limit
later in the chapter.)

To join the iCloud revolution, you need an Apple ID. If you didn’t create
one during the initial El Capitan setup, you can create an Apple ID from the
App Store.

You can also access your documents through the web at www. icloud.com.
Log in with your Apple ID and password to send mail, access your contacts
and calendar, edit your notes and reminders, locate your devices, and use
online versions of Pages, Numbers, and Keynote.
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Moving, Saving, and Opening
iCloud Documents

iCloud online storage for your documents is definitely neat; your iCloud
Drive functions much like other popular online storage services like Dropbox
and Microsoft OneDrive, allowing you to save documents, load documents,
and move files to and from your MacBook’s drive with ease, using a Finder
window. In fact, iCloud Drive keeps things tidy for you: If you move a file from
your iCloud Drive to your local drive, it’s also deleted automatically from
iCloud Drive on your other Macs and iOS devices that use the same Apple ID.
(El Capitan prompts you for permission first, of course.)

Figure 9-2 illustrates my iCloud Drive in action; you can access your iCloud
Drive from the Finder window Sidebar. Note that iCloud folders are auto-
matically created for supported applications, allowing you to click the cor-
responding iCloud folder from the application’s Open dialog. (In other words,
both your iCloud Drive and the application-specific iCloud folder are available
within the application’s Open dialog. It’s about as convenient as you can get!)
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Putting Handoff to Work

If you're like me, your favorite moment in a team track event is the all-
important handoff of the baton from one runner to the next — making Handoff
the perfect name for this El Capitan feature, because it actually transfers what
you're doing on your iOS devices to matching applications on your Mac!
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As an example, let’s suppose you're using Maps on your iPhone, and you
realize you'd rather view the location on your MacBook’s larger screen (as
well as print it from the USB printer connected to the laptop). If you're within
Bluetooth signal range of your MacBook, Handoff is ready to go: An icon for
the OS X version of Maps automatically appears at the left side of the Dock
in El Capitan. One click on that icon, and your MacBook opens Maps and
displays the same location!

You're not restricted to just one application, either — each time you open an
application that Handoff supports (like Safari and Mail), El Capitan offers you
the chance to open the matching application on your MacBook and displays
the current data from the iOS app. All this is completely trouble-free: There’s
nothing to configure or set.

Caveats? Only three at the time of this writing:

v Bluetooth is required: Bluetooth networking must be turned on for both
the iOS device and the MacBook for Handoff to work, and the iOS device
must be within a 30-foot radius of your laptop. (That’s the distance limit
that Bluetooth hardware can broadcast; walls and other obstructions
reduce that range.)

+* You'll need the right hardware: In order to use Handoff, you’ll need an
iPhone 5 (or later), a fourth-generation iPad (or later), any iPad mini, or
a fifth-generation iPod Touch (or later). On the computer side, you must
have a 2012 model MacBook (or later) that includes Bluetooth LE hardware.

v i0S 8 is a must: Handoff is compatible only with iOS devices running
iOS 8 or later.

Handoff works in the other direction as well, allowing you to pick up where
you left off on your MacBook application by transferring the active session
to your iPhone, iPad, or iPod touch. Swipe the icon that appears on your iOS
device to start the ball rolling.

Configuring iCloud

You control all the settings for iCloud from El Capitan’s iCloud pane in
System Preferences (shown in Figure 9-3). Click the System Preferences icon
on the Dock, and then click the iCloud icon. At the sign-in prompt, enter your
Apple ID and your password. System Preferences then guides you through
basic iCloud configuration.

Most of the check boxes on the iCloud Preferences pane control whether a
particular type of data — such as a Contacts entry, password, Mail message,
or calendar in Calendar — is pushed to all your iOS devices. (Alternatively,
you can specify which applications will have access to your iCloud Drive by
clicking the Options button.)
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Note, however, that you can enable three other unique features from this
pane as well:

v+ Photos: Click the Options button and enable the My Photo Stream check

box to allow your MacBook to automatically receive photos from your
iOS devices. Take a photo with your iPhone, for example, and that image
is immediately pushed to your laptop, iPad, and iPod touch. On the
MacBook, however, Photo Stream goes one step further: The photos
appear automatically in Photos in a special album titled Photo Stream.
You can also enable iCloud Photo Sharing, which allows you to share
photos with others from Photos.

To turn on My Photo Stream or iCloud Photo Sharing in Photos, choose
Photos = Preferences, click the iCloud button, and select the desired
check boxes.

+ Back to My Mac: If you enable Back to My Mac, you can remotely con-

trol your MacBook from another Mac computer (or vice versa) using

El Capitan’s Screen Sharing feature. You can also transfer files between
the two computers. Back to My Mac works over both a broadband
Internet connection and a local network. Available Mac computers show
up in the Shared section of the Finder window sidebar. Note that you
must manually turn on Screen Sharing in the System Preferences Sharing
pane before you can remotely control another Mac.

v+ Find My Mac: Talk about Buck Rogers! Imagine locating a lost or stolen

MacBook from your iPhone or iPad. Now think about this: With Find
My Mac, you can even lock or completely wipe your Mac’s hard drive
remotely, preventing unauthorized use and erasing your private data!
After you access your MacBook from another iOS device, you can play
a sound, send a message to be displayed onscreen, remotely lock the
machine, or remotely wipe the drive.

After you wipe the drive, though, you can’t locate your MacBook again.
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You can also enable Family Sharing from the iCloud pane, which allows you
to share purchased media and apps with as many as six users’ accounts.
Participants can share a special Photo Stream, apps, and media (purchased
from the iTunes Store, iBooks Store, or App Store), common reminders and a
common calendar — and no, they don’t actually need to be members of the
same family. To launch the Family Sharing Setup assistant, click the Set Up
Family button and follow the onscreen instructions.

Managing Your iCloud Storage

|
Figure 9-4:
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Apple knows that you’re curious about how much space you’ve taken up
in your personal iCloud. To monitor your iCloud storage, click the Manage
button at the bottom-right corner of the iCloud System Preferences pane.
From the sheet that appears — as shown in Figure 9-4 — you can see how
much space you're using for document and data storage.
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Click the data type in the left column, and iCloud displays the amount of
storage space that’s being used for that data. For instance, in Figure 9-4, I'm
checking the amount taken by my iPhone backup. (I set my iPhone to back up
wirelessly to my iCloud storage.) Other items that might appear in this sheet
include Mail and selected iPad and iPhone apps that support iCloud.

If you find yourself running out of iCloud storage space, delete any stored
item by selecting it in the list at the right side of the sheet and click Delete.

And if you need more elbow room than 5GB, Apple is happy to provide 50GB,
200GB, or even a whopping 1TB of additional storage for a monthly subscrip-
tion fee of $0.99, $2.99, or $9.99, respectively. Click the Manage button on
the iCloud pane in System Preferences, and then click the Buy More Storage
button to subscribe.



Chapter 10
Your Laptop Goes Multiuser

In This Chapter
Enjoying the advantages of a multiuser MacBook
Understanding access levels
Adding, editing, and deleting user accounts
Restricting access for managed accounts
Configuring your login window
Sharing files with other users

Securing your stuff with FileVault

Everybody wants a piece — of your laptop, that is.

Perhaps you live in a busy household with kids, significant others, grandpar-
ents, and a wide selection of friends, all of them clamoring for a chance to
spend time on the Internet, take care of homework, or enjoy a good game.

On the other hand, your MacBook might occupy a college classroom or
boardroom at your office. Suddenly your classmate or coworker wants his
own Private iDaho on-the-road warrior, complete with a reserved spot on the
drive and his own attractive, handpicked Desktop background. (Even flying at
30,000 feet, your coworker will be eyeing your MacBook.)

Before you throw up your hands in defeat, read this chapter and take heart!
Here you find all the step-by-step procedures, explanations, and tips to help you
build a safe multiuser MacBook that’s accessible to everyone with clean hands.

Oh, and you still get to use it too. And, no, that’s not being selfish.

Once Upon a Time (An Access Fairy Tale )

Okay, so you don’t have Cinderella, Snow White, or that porridge-loving kid
with the trespassing problem. Instead, you have your brother Bob.
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Every time Bob visits your place, it seems he needs to do “something” on the
Internet, or he needs a moment with your MacBook Air to bang out a quick
message, using his web-based email application. Unfortunately, Bob’s forays
onto your laptop always end up changing stuff, such as your Desktop set-
tings, Contacts database, and Safari bookmarks.

What you need, good reader, is a visit from the Account Fairy. Your prob-
lem is that you have but a single user account on your system, and OS X El
Capitan thinks that Bob is you. By turning your MacBook into a multiuser
system and giving Bob his own account, El Capitan can tell the difference
between the two of you, keeping your druthers separate!

With a unique user account, El Capitan can track all sorts of things for Bob,
leaving your computing environment blissfully pristine. A user account keeps
track of stuff such as

v Contacts cards
v~ Safari bookmarks and settings

v Desktop settings (including background images, screen resolutions, and
Finder tweaks)

v~ iTunes Libraries, just in case Bob brings his own music (resigned “sigh™)

Plus, Bob gets his own reserved Home folder on your laptop’s hard drive, so
he’ll quit complaining about how he can’t find his files. Oh, and did [ men-
tion how user accounts keep others from accessing your stuff? And how you
can lock Bob out of where-he-should-not-be, such as certain applications,
Messages, Mail, and websites (including that offshore Internet casino site
he’s hooked on)?

User accounts affect just about everything you can do in El Capitan and on
your laptop. The moral of my little tale? A Mark’s Maxim to the rescue:

Assign others their own user accounts, and let El Capitan keep track of
everything. Then you can share your MacBook with others and still live
happily ever after!™

Big-Shot Administrator Stuff

Get one thing straight right off the bat: You are the administrator of your
MacBook. In network-speak, an administrator (or admin for short) is the one
with the power to Do Unto Others — creating new accounts, deciding who
gets access to what, and generally running the multiuser show. In other
words, think of yourself as the Monarch of OS X. (The king or queen, not the
butterfly.)
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I always recommend that you have only one (or perhaps two) accounts

with administrator-level access on any computer. In this way, you can be
assured that no one can monkey with your laptop while you're away from
the keyboard. So why might you want a second admin account? Well, sup-
pose you're away from your laptop — think “daughter takes it with her on a
trip to Europe.” You might need to assign a second administrator account to
a trusted individual who knows as much about your road warrior as you do.
(Tell ’em to buy a copy of this book.) That way, if something breaks or an
account needs to be tweaked in some way, the other person can take care of
it while you're absent (but without getting access to your personal data). If
necessary, don’t forget you can always log in to your second admin account
and change the password to guarantee security!

In the following sections, I explain the typical duties of a first-class MacBook
administrator.

Deciding who needs what access

The three most common user account levels are

»* Admin (administrator): See the preceding section.

v+~ Standard level: Perfect for most users, these accounts allow access to
just about everything but don’t let the user make drastic changes to
El Capitan or create new accounts.

1 Managed with parental controls level: These accounts are standard
accounts with specific limits assigned by you or another admin account.

Another Mark’s Maxim is in order:

Assign other folks standard-level accounts, and then decide whether each
new account needs to be modified to restrict access as a managed account.
Never assign an account admin-level access unless you deem it truly
necessary.™

Standard accounts are quick and easy to set up, and I think they provide the
perfect compromise between access and security. You'll find that standard
access allows your users to do just about anything they need to do, with a
minimum of hassle.

Managed accounts (with parental controls) are highly configurable, so you
can make sure that your kids don’t end up trashing the hard drive, sending
junk mail, or engaging in unmonitored chatting. (Note: Attention, all parents,
teachers, and anyone designing a single public access account for a library or
organization: This means you.)
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Adding users

All right, Mark. Enough pregame jabbering. Show this good reader how to
set up new accounts! Your laptop already has one admin-level account set
up for you (created during the initial El Capitan setup process). You need
to be logged in to that account to add a user. To add a new account, follow
these steps:

1.

In the Users & Groups pane (from System Preferences), click the New
User button (plus sign) at the bottom of the accounts list to display the
empty user record sheet shown in Figure 10-1.

+

Full Name: jord...

! ? Cancel
m Login

Users & Groups
New Account: | Standard
Account Name:

Gues
Enablf This will be used as the name for your home foider.

Password: Use iCloud password
Use separate password

An Internet connection will be required when this
user logs in to the system for the first time.

*

Click the lock to prevent further changes.

If the New User button is disabled and you can’t click it, click the pad-
lock at the bottom left of the System Preferences pane, and provide your
password to unlock the Users & Groups pane.

. Select the access level for this user from the New Account pop-up

menu.

By default, the user receives a standard-level account. You can also
choose an administrator account, a managed standard account with
parental controls already enabled, or a sharing-only account.

The sharing-only account allows the user to copy or open shared files
from your MacBook remotely (from another computer), but that user
can’t directly log in to your laptop.

. In the Full Name text box, type the name you want to display for this

account (both in the Current User list and on the Login screen). Then
press Tab to move to the next field.
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OS X automatically generates an account name in the Account Name
field for use as your screen and buddy name in Messages and various
network applications. The account name is also the name of the folder
that OS X creates on the computer’s hard drive for this user. You can
keep the default account name or type a new one, but it cannot contain
any spaces.

. Choose to use either an iCloud password (also known as an Apple ID

password) or a separate password you create for this account.

If you choose to use an existing iCloud password, enter the desired
iCloud ID (Apple ID).

. If you choose Use Separate Password, type the password for the new

account.

Click the button with the key icon next to the Password field, and El
Capitan is happy to display Password Assistant, complete with a sugges-
tion. Click the Suggestion pop-up menu to see additional suggestions.
You can choose the password’s length and select from among several
types: letters and numbers, numbers only, memorable, completely
random, or even FIPS-181 compatible (government-quality). Password
Assistant automatically copies the current password you're considering
into the Password and Verify text boxes.

As always, when you enter a password or its verification, OS X displays
bullet characters for security.

. Press Tab, type the password in the Verify text box, and press Tab

again.

. (Optional) If you decide to use the password hint feature, you can

enter a short sentence or question in the Hint text box.

The hint is displayed after three unsuccessful attempts at entering the
account password.

From a security standpoint, password hints are taboo. (Personally,
never use 'em. If someone is having a problem logging in to a computer
[ administer, you better believe [ want to know why.) Therefore, despite
the recommendation that El Capitan shows here, I strongly recommend
that you skip this field. If you decide to offer a hint, keep it vague! Avoid
hints like “Your password is the name of the Wookiee in Star Wars.” And
don’t embed the password in the hint!

. Click the Create User button to finish and create the account.

The new account shows up in the Current User list and in the Login
screen.

Each user’s Home folder has the same default subfolders, including Movies,
Music, Pictures, and Sites. A user can create new subfolders within his or her
Home folder at any time.

171
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Here’s one more neat fact about a user’s Home folder: No matter what the

account level, most of the contents of a Home folder can’t be viewed by other
users. (Yes, that includes admin-level users. This way, everyone using your
MacBook Pro gets his or her own little area of privacy.) In the Home folder,
only the Sites and Public folders can be accessed by other users — and only

in a limited fashion. (Read all about Home folders in Chapter 5.)

Modifying user accounts

Next, consider the basic modifications you can make to a user account, such
as changing existing information or selecting a new picture to represent that

user’s unique personality.

To edit an existing account, log in with your admin account, display the

System Preferences window, and click Users & Groups to display the account

list. Then follow these steps:

1. In the list to the left of the window, click the account you want to

change.

If the accounts in the list are disabled and you can’t select one, you must
unlock the Users & Groups pane. Click the lock at the bottom left of the
System Preferences pane (and type your password, if prompted).

. Edit the settings you need to change.

Examples include temporarily enabling administrator rights for an
account (by selecting the Allow User to Administer This Computer
check box) and changing the account password (by clicking the Change
Password button).

. Click the round picture well (the circle that displays the image) to

specify the thumbnail image that appears in the Login list next to the
account name.

Apple provides a number of good images in the preview collection. Just
click a thumbnail to select it.

. To replace your account image, drag a new image from a Finder

window or the iPhoto window and drop it into the picture well.

Note that some of these choices are available only when you're using an
Admin-level account:

e To choose an image from the default set of El Capitan icons: Click
the picture well, click the Defaults tab (see Figure 10-2), click the
desired image, and then click Done.

e To choose an icon image from those you’ve recently used: Click the
Recents tab, click the desired image, and then click Done.
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® To choose an image from your iPhoto Faces collection: Click the
Faces tab, click the desired image, and then click Done.

e To choose an icon image from your iCloud Photo Stream: Click the
iCloud tab, click the desired image, and then click Done.

Alternatively, you can click the picture well and click the Camera tab to
grab a picture from your MacBook’s built-in FaceTime HD camera. When
you're set to take the photo, click the camera icon, and then click Done
to accept it. Most cool.

ee < P Users & Groups Ter

Login ltems

Mark Chambe
@ Mark Chambers Change Password...

Guest User

Defaults

Recents

iCloud Photos
Faces
Camera

&

Linked 1sing Apple ID

13} Login

+ F- Edit Cancel Done

N pmputer

oen Parental Controls...

[&] Ciick the lock to prevent further changes.

5. After you make your changes, press 38+Q to save them and close the
System Preferences window.

Standard-level users have some control over their accounts — they’re not
helpless, after all. Standard users can log in, open System Preferences, and
click Users & Groups to change the account password or picture as well

as the My Card assigned to them in the El Capitan Contacts application. All
standard users can also set up login items, which I cover later in this chap-
ter. Note, however, that managed users might not have access to System
Preferences, so they can’t make changes. (Read about this in the upcoming
section “Managing an account’s access settings.”)

| banish thee, mischievous user!

Not all user accounts last forever. Students graduate, coworkers quit, kids
move out of the house (at last!), and Bob might even find a significant other
who has a faster cable modem. We can only hope.
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Figure 10-3:
This is your
last chance
to save the
stuff from a
deleted user
account.
|
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Anyway, no matter what the reason, you can delete a user account at any
time. Log in with your admin account, display the Users & Groups pane in
System Preferences, and then follow these steps to eradicate an account:

1. In the user list at the left of the window, click the account you want to

delete.
2. Click the Delete User button (which bears the Minus Sign of Doom).

OS X displays the confirmation sheet shown in Figure 10-3.

° Users & Groups
Are you sure you want to delete the user account "Ben
1 Franklin"?
=3 ”AJ'da" To delete this user account, select what you want to do with the heme a
oL | folder for this account, and then click “Delete User"; go--
0
) Save the home folder in a disk image
Star| The disk image is saved in the Deleted Users folder (in the Users

Gue folder).
b | Don’t change the home folder
The home folder remains in the Users folder.

Delete the home folder

Erase home folder securely

Cancel

Allow user to administer this computer
{2} Login Options
+-[

Enable parental controls | Open Parental Controls...

[l Ciick the lock to prevent further changes.

Note that the contents of the user’s Home folder can be saved in a disk

image in the Deleted Users folder (just in case you need to retrieve

something). Alternatively, you can choose to leave the deleted user’s
Home folder as is, without removing it (but naturally you won’t regain
any space, even though the user account is deleted).

If you're absolutely sure you won’t be dating that person again, select
the Delete the Home Folder radio button (which doesn’t save anything
in the Deleted Users folder). You regain all the drive space that was
being occupied by the contents of the deleted user’s Home folder. As an
extra measure of protection, you can also choose to securely erase the
contents of the deleted user’s Home folder.

3. To delete the account, click Delete User. If you’re not sure, click the

Cancel button to abort and return to the Accounts list.

Time once again for a Mark’s Maxim:

Always delete unnecessary user accounts. Otherwise, you’re leaving holes

in your laptop’s security.™
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Working with the Guest account

The Guest account is a convenient method of
granting someone temporary access to your
MacBook. In fact, your guest doesn’t even
need a password to log in. Your Guest account
has all the attributes of a standard account,
so the visitor has little chance of accidentally
(or purposefully) damaging your system.
Nevertheless, after the guest user logs out, the
Guest account is “flushed,” and all the data
and files that person created using the account
are deleted automatically. (This allows the next
guest to start with a clean slate.)

By default, the Guest account is disabled. To
turn on this feature, open System Preferences,

click Users & Groups, and then click the Guest
User entry in the list. (You may have to click
the Lock icon at the lower-left corner of the
Users & Groups pane and provide your admin
password before you can continue.) Click the
Allow Guests to Log In to This Computer check
box to enable it.

Oh, and don't forget that you can enable
specific parental controls for the Guest
account, justas you canfor any other standard-
level account. This feature should come in
handy if your child has a slumber party coming
up this weekend.

Setting up login items and

parental controls

Every account on your MacBook can be customized. Understandably, some

settings are accessible only to admin-level accounts, and others can be
adjusted by standard-level accounts. In the following sections, I introduce
you to the things that can be enabled (or disabled) in a user account.

Automating with login items

175

Login items are applications or documents that can be set to launch or load
automatically as soon as a specific user logs in — for example, Apple Mail or
Contacts. In fact, a user must be logged in to add or remove login items. Even
an admin-level account can’t change the login items for another user.

<MBER

K A user must have access to the Users & Groups pane in the System
Y

Preferences window to use login items. As you can read in the following sec-
tion, a user can be locked out of System Preferences, which makes it more
difficult for login items to be deleted for that account. (Go figure.) Therefore,
if the account is managed and access to System Preferences has been
turned off, an administrator must enable the account’s access to System
Preferences, allowing the managed user to delete login items.
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|
Figure 10-4:
Add apps to
your Login
Items list.
|
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To set login items for your account, follow these steps:
1. Click the System Preferences icon in the Dock, and then click the
Users & Groups icon.
2. Click the Login Items tab to display the settings shown in Figure 10-4.

It bears repeating: You can change the Login Items for only the account
that’s currently logged in, so be sure that the desired account appears
under the Current User heading in the list at the left.

[ X ) < Hif Users & Groups
Password
1y Mark Chambers These items will open automatically when you log in:
&‘; i o y y £l
Hide Item Kind
? Ben Franklin ¥) (O)iTunesHelper Application

& SpeechSynth Application

;uem Usi 12 Dropbox Application

To hide an application when you log in, select the checkbox in the Hide
column next to the application

{2} Login Options +
+ =*

[l] Ciick the lock to prevent further changes.

3. Click the Add button (with the plus sign) to display a file selection
sheet.

4. Navigate to the application you want to launch each time you log in,
click it to select it, and then click Add.

If you're in the mood to drag and drop, just drag the applications you
want to add from a Finder window, and drop them directly into the list.

5. Press 35+Q to quit System Preferences and save your changes.

If the application is running at the moment, you can take an easy shortcut
and avoid these steps: Simply right-click the application icon in the Dock and
choose Options= Open at Login from the pop-up menu that appears.

Login items are launched in the order in which they appear in the list, so feel
free to drag the items into any order you like.

Managing an account’s access settings

A standard-level account with restrictions is a managed account. (You can
read about these accounts earlier in this chapter.) With these accounts, you
can restrict access to many different places in El Capitan and your laptop’s



Chapter 10: Your Laptop Goes Multiuser 7 77

applications by using parental controls. (Naturally, admin-level accounts don’t
have parental controls, because an admin account has no restrictions.)

\‘&\\RBER In short, parental controls come in handy in preventing users — family
& members, students, coworkers, friends, or the public at large — from dam-
aging your files, your software, or El Capitan itself. If an account has been
restricted with parental controls, the account description changes from
Standard to Managed in the Accounts list.

To display the parental controls for a standard account, start here:

1. Log in with an admin-level account.
2. Open System Preferences and click Users & Groups.

3. Click the desired Standard account in the list, and then select the
Enable Parental Controls check box.

If necessary, click the Lock icon at the lower-left corner to confirm your
access.

Now click the Open Parental Controls button to display the five categories
(tabs) shown in Figure 10-5:

v Apps: These settings (which I discuss in more detail in a second) affect
what the user can do in El Capitan, as well as what the Finder itself looks
like to that user.

1 Web: El Capitan offers three levels of control for websites:

e Allow Unrestricted Access to Websites: Select this radio button to
allow unfettered access for this user.

e Try to Limit Access to Adult Websites: You can allow Safari to auto-
matically block websites it deems adult. To specify particular sites
that the automatic “adult filter” should allow or deny, click the
Customize button.

e Allow Access to Only These Websites: Choose this radio button to
specify which websites the user can view. To add a website, click
the Add (plus sign) button, and respond to the El Capitan prompt
for a title and the website address.

1 Stores: You can specify whether the user can use the iTunes Store and
the iBooks Store, as well as restrict access within both stores to music,
movies, TV shows, apps, and books by age or rating.

v Time: Parents, click the Time button, and you’ll shout with joy! Check
out the options in this pane, shown in Figure 10-6. You can limit an
account to a certain number of hours of usage per weekday (Weekday
Time Limits) and per weekend day (Weekend Time Limits). You also
can set a bedtime computer curfew time for both weekdays (called
“Bedtime” here) and weekend days.
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Figure 10-5:
You can
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access to
many func-
tionsina
Standard
account.
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Allowed Apps: Q
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v Privacy: From this tab, you can individually configure the user’s ability
to launch apps or access social media. Use the convenient check boxes
to allow or prevent changes to the settings used by Location Services,
Contacts, Calendars, Reminders, Twitter, Facebook, and Diagnostic
Apps. For even more control, click the Manage Privacy button to jump
immediately to the Privacy tab of the Security & Privacy pane (allowing
you to fine-tune which apps can access specific data).

v Other: These settings control the Dictionary and hardware devices such
as your printer and DVD burner. They include

Turn Off Dictation: Enable this check box to turn off the Dictation
feature in El Capitan.

Disable Editing of Printers and Scanners: With this check box
selected, the user cannot modify the printers and printer queues
in the Print & Scan pane in System Preferences. If this option is
enabled, the user can still print to the default printer and switch to
other assigned printers but can’t add or delete printers or manage
the OS X print queue. (If the print job encounters a problem, that
user has to bug you to fix things.)

® Block CD and DVD Burning in the Finder: Select this check box to

prevent the user from recording CDs or DVDs via the built-in disc-
recording features in OS X. (Note, however, that if you load a third-
party recording program, such as Toast, the user can still record
discs with it — unless you also disable access to that program in
the Apps section.)

e Restrict Explicit Language in Dictionary: With this check box

selected, profane terms in the Dictionary are hidden for this user.



Figure 10-6:
El Capitan
keeps track
of your kid's
computer
usage so
that you
don't

have to.
|

\\3

CMBER
)

Chapter 10: Your Laptop Goes Multiuser 7 79
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¢ Prevent the Dock from Being Modified: Select this check box, and
the user can’t remove applications, documents, and folders
from the Dock in the full Finder. (This is a great choice if you don’t
want the contents of the Dock changing according to the whims of
otherusers.).

e Use Simple Finder: 1 discuss the Simple Finder later in this section;
it’s a great idea for families and classrooms with young children.

You might want to create a single standard-level account for an entire group
of people to use. For example, maybe you want to leave the laptop in kiosk
mode in one corner of the office, or perhaps everyone in a classroom will use
the same account on the MacBook. Keep your one admin-level account close
to your bosom, and create a standard-level account for the Unwashed Horde.

El Capitan keeps a number of different types of text log files. They track where
the user goes on the Internet, the applications launched by the account, and
the contents of any Messages conversations in which the user participated.
Click the Logs button on any Parental Controls screen to monitor all the logs
for a particular account.

You can always tell whether an account has been assigned parental controls,
because the account description changes from Standard to Managed in the
User list.

Of particular importance are the Finder and the applications controls. Click
the Apps tab (refer to Figure 10-5) to modify these settings:

v Allow Use of Camera: Specify whether the account has access to your
MacBook’s built-in camera. (Note that an external USB Web camera is
unaffected by this setting.)
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\\3

\\3

v Allow Joining Game Center Multiplayer Games/Allow Adding Game
Center Friends: These two check boxes allow or disable the user’s
access to the multiplayer games in Game Center and allow or prevent
the user from adding friends in Game Center.

v~ Limit Mail to Allowed Contacts: Select this check box to specify the
e-mail addresses that this user can communicate with. (Note that this
feature affects only Apple Mail; other mail clients, web-based mail,
instant messaging applications, and audio/video chat applications
aren’t controlled.) To add an address to which the user can email, click
the Manage button, then click the familiar Add button bearing the plus
sign. To delete an address, click the Manage button, select the offending
address, and click the Delete button (bearing the minus sign).

If you want a notification if the user is attempting to send an email to
someone not on the list, select the Send Requests To check box, and
then type your email address in the text box.

v Limit Applications on this Mac: When this option is selected, you can
choose which specific applications the user sees. These restrictions are
in effect whether the user has access to the full Finder or just the Simple
Finder. Click the triangle icon next to the desired group heading to
expand the list. To locate a specific application, click in the Search box
and type the application name:

¢ To allow access to all applications: Simply disable the Limit
Applications on this Mac check box.

¢ To allow or restrict access to all the applications of a specific
type: Enable or disable the check box next to the desired group
heading — for example, clicking the Other Apps check box to dis-
able it will prevent the user from launching any of the applications
in that group.

¢ To allow or restrict access to an individual application: Select the
check box next to any application to select or deselect it.

To add a new application to the Allowed Apps list, drag its icon from
the Finder and drop it in the list in the Other Apps group. After you add
an application, it appears in the Other Apps group, and you can toggle
access to it just like the applications in the named groups.

These settings can work hand in hand with the El Capitan Gatekeeper
feature, which prevents anyone from launching applications that were
not downloaded from the App Store (or are not Apple-approved).

You can restrict your standard-level users even further by assigning them
the Simple Finder set of limitations. The Simple Finder is a highly simplified
version of the regular OS X Finder. It has a basic Dock that contains only the
Finder icon, the Trash icon, and the folders for the user’s approved applica-
tions, documents, and shared files.
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The Simple Finder is the network administrator’s idea of a foolproof interface
for OS X: A user can access only the system files and resources needed to do
a job, with no room for tinkering or goofing off.
P A Simple Finder user can still make the jump to the full version of the Finder
by clicking the Finder menu, choosing Run Full Finder, and entering an
admin-level username and password.

Would you like to set up a public-access MacBook? You can also change the
Automatic Login account from the Users & Groups pane. Click the Login
Options button under the User list, and then click the Automatic Login pop-
up menu to choose the account that automatically logs in when OS X starts.
On the confirmation sheet that appears, enter the account password, and
click OK. I've made it clear elsewhere that Automatic Login is not a good
security feature in many cases, such as with a laptop on the road. However, it
can be a good feature if you're preparing a MacBook for public use. If you set
the Automatic Login to your public standard-access account, OS X automati-
cally uses the correct account if the Mac is rebooted or restarted.

3

SMBER
)

& You can always choose Log Out from the Apple menu (¢) to log in under

your own account, or use the fast user switching feature I describe in the
next section.

Mundane Chores for the
Multiuser Laptop

After you’re hip to user accounts and the changes you can make to them, you
can turn to a number of topics that affect all users of your MacBook. These
topics include how they log in, how a user can share information with every-
one else on the computer, and how each user account can be protected from
unscrupulous outsiders with state-of-the-art encryption. (Suddenly you're
James Bond! I told you El Capitan would open new doors for you.)

Logging in and out in El Capitan
For Dummies

Hey, how about the login screen itself? How do your users identify them-
selves? Time for another of my “Shortest books in the For Dummies series”
special editions. (The title is practically longer than the entire book.)
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Exploring your login options
El Capitan offers four methods of logging folks in to your multiuser laptop, all
of which are available from the Login Options button on any admin account:

v The username and password login: This screen is the most secure type
of login screen you’'ll see in El Capitan, because you have to type your
account username and password. (A typical hacker won’t know all the
usernames on your MacBook.) Press Return to complete the process.

When you enter your password, you see bullets rather than your pass-
word because El Capitan displays bullet characters to ensure security.
Otherwise, someone could simply look over your shoulder and see your
password.

Keep your laptop secure: Use a username and password login, and
always choose a password that’s tough to guess.™

v The list login: This login screen offers a good middle of the road
between security and convenience. Click your account image in the list,
and type your password when the login screen displays the password
prompt. Press Return to continue.

v Fast user switching: This feature allows another user to sit down and
log in while the previous user’s applications are still running in the
background. This is perfect for a fast email check or a scan of your eBay
bids without forcing someone else completely off the MacBook. When
you turn on Fast User Switching, El Capitan displays the currently active
user’s name at the right side of the Finder menu bar.

To switch to another account:
1. Click the current user’s name in the Finder menu (see Figure 10-7).

2. Click the name of the user who wants to log in.

kO = o) %@} Thu12:33 AM
Ve 3

Guest User

il

Login Window...

il

Users & Groups Preferences...

Figure 10-7:
The Fast
User
Switching
menu,
unfurled for
all to see.
|

@
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El Capitan displays the login window, just as if the laptop had been

V?‘NNG! rebooted.
S
The previous user’s stuff is still running, so you definitely shouldn’t
reboot or shut down the computer!

To switch back to the previous user:
1. Click the username again on the Finder menu.
2. Click the previous user’s name.
For security, El Capitan prompts you for that account’s login password.

v Auto login: This option is the most convenient method of logging in but
offers no security whatsoever. El Capitan automatically logs in the speci-
WING/ fied account when you start or reboot your MacBook.
QUING!
¥ [ strongly recommend that you use auto login only if
* Your laptop is in a secure location, such as your home or a locked
office. If you're on the road, you and your data need the protection

of a username and password login!

¢ You can guarantee that you're the only one using your laptop.
Period.

® You're setting up a public-access laptop kiosk, in which case you
want your MacBook to immediately log in with the public account.

Working in a public environment? Never set an admin-level account as
the auto login account. This is the very definition of an SDI, or Supremely
Dumb Idea.

Changing your login settings

To set up a username/password or list login, open System Preferences, click
the Users & Groups icon, and then display the Login Options settings, as
shown in Figure 10-8. (If necessary, click the Lock icon at the lower-left corner
to confirm your access.) Here’s a rundown of key login settings:

v Automatic Login: To set Auto Login, click the Automatic Login pop-up
menu and choose the account that El Capitan should use.

1+ Display Login Window As: Select the List of Users radio button for a list
login screen, or select the Name and Password radio button to require
your users to type their full username and password.

v Show Fast User Switching Menu As: Select this check box to enable
fast user switching. Click the pop-up menu to specify how accounts
should appear in the Finder menu (as full names, short names, or
account icons).
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Figure 10-8:
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8] Ciick the lock to prevent further changes.

Logging out

Logging out of El Capitan all the way (without fast user switching) is a cinch.
Just click the Apple menu (&) and then choose Log Out. (From the keyboard,
press 38+Shift+Q.) A confirmation dialog appears that automatically logs
you off in one minute. And that one minute is important, because if someone
walks up and clicks Cancel, he’ll be using your laptop with your account!
Therefore, it’s a good idea to bypass the confirmation dialog by pressing
Option while choosing Log Out (or by combining it with the keyboard short-
cut). Your MacBook returns to the login screen, ready for its next victim.
Heed this Mark’s Maxim:

Always click the Log Out button in the Logout Confirmation dialog

before you leave your MacBook (or use the Option key to bypass the
confirmation dialog), and double-check to make sure the logout completes
successfully.™

Interesting stuff about sharing stuff

You might wonder where shared documents and files reside on your
MacBook. That’s a good question. Like just about everything in El Capitan,
the answer is simple. The Users folder on your laptop has a Shared folder
within it. To share a file or folder, place it in the Shared folder.

You don’t have to turn on file sharing in the Sharing pane of System
Preferences to use Shared folders on your laptop. File sharing affects only
network access to your machine by users of other computers.
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Each user account on your MacBook also has a Public folder in that user’s
Home folder. The Public folder is a read-only folder that other users on
your laptop (and across the network) can access. They can only open and
copy the files it contains. (Sorry, no new documents or changes to existing
documents from other users.) Every user’s Public folder contains a Drop
Box folder, where other users can copy or save files but can’t view the con-
tents. Think of the Drop Box as a mailbox where you drop off stuff for the
other user.

Encrypting your Home folder can be fun

Allowing others to use your Mac laptop always incurs a risk — especially if
you store sensitive information and documents on your computer. Although
your login password should ensure that your Home folder is off-limits to
everyone else, consider an extra level of security to prevent even a dedicated
hacker from accessing your stuff. All it takes is a forgetful moment in an air-
port or classroom, and your personal and business data is suddenly within
someone else’s reach. Adequate security is a Supremely Good Thing!

To this end, El Capitan includes FileVault, which automatically encrypts

the contents of your MacBook’s drive. Without the proper key (in this case,
either your login password or the FileVault recovery key), the data stored on
your drive is impossible for just about anyone to read. (I guess the FBI or CIA
would be able to decrypt it, but they’re not likely a worry at your place!)

The nice thing about FileVault is that it’s completely transparent to you and
your users. In other words, when you log in, El Capitan automatically takes
care of decrypting your files and folders. You won’t know that FileVault is on
the job (which is how computers are supposed to work).

To turn on FileVault protection for a specific account, follow these steps:

1. Click the System Preferences icon in the Dock, and then click the
Security & Privacy icon.

2. Click the FileVault tab, and then click the Turn On FileVault button.

3. Specify whether your iCloud (Apple ID) account can be used to reset
your password and unlock your disk, and then click Continue.

For most MacBook owners, the Allow My iCloud Account to Unlock My
Disk option is probably just fine, but if you're security-conscious (or
you’ve shared your iCloud account information with others), click the
Create a Recovery Key and Do Not Use My iCloud Account radio button.
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4. If you decide to create a separate recovery key, write down the
FileVault recovery key displayed by El Capitan, and store it in a safe
place.

To avoid mistakes, you can capture an image of your screen by pressing
38+Shift+3. The screenshot appears as an image file on your Desktop.
From there, you can open it and print a copy, or even copy the image
file to a USB flash drive or another computer on your network for
safekeeping.

@‘“‘NG! Personally, I love the FileVault feature. I use it on all my Macs running

S El Capitan. Yet a risk is involved (insert ominous chord here). To wit:
Do not forget your login and iCloud account passwords (or make
DOGGONE sure that you or your Admin user have access to a copy of
that all-important FileVault recovery key)! OS X displays a dire warn-
ing for anyone who'’s considering using FileVault: If you forget these
safeguards, you can’t retrieve any data from your MacBook’s drive. Even
the smartest Apple support technician will tell you that nothing can be
done. As Jerry Reed used to say, “It’s a gone pecan” (with pecan pro-
nounced Southern style, as “puh-kahn™).

5. If necessary, click Enable User, provide the login password for each
user on your account, and then click Continue.

é&\l\BEﬂ Each user on your MacBook has to be enabled to use your laptop after
3y FileVault has been turned on. If you don’t know the login passwords for
the other user accounts on your system, you have to ask each person to
provide his or her password to continue. (If an account is not enabled,
that person can no longer access anything on the hard drive after it has
been encrypted.)

6. Click the Restart button on the confirmation screen.

Your MacBook automatically reboots and begins the encryption process.
You can continue to use your laptop normally during the encryption.

You’'re done!



Chapter 11

Working Well with Networks

In This Chapter

Considering the benefits of a network

Choosing between wired and wireless networks
Sharing an Internet connection

Gathering the stuff you need to network
Making the network connection

Using your network

Protecting your MacBook with a firewall

’ n my opinion, network access ranks right up there with air conditioning
and the microwave oven. Like other “I can’t imagine life without them”
kinds of technologies, it’s hard to imagine sharing data from your laptop with
others around you without a network. I guess you could still make use of a
sneakernet (the old-fashioned term for running back and forth between com-
puters with a floppy disk), but these days, Apple computers don’t even have
floppy drives. (Even with a high-capacity USB 3.0 flash drive, a sneakernet is
still a hassle.)

Nope, networking is here to stay. Whether you use a network to share an
Internet connection, challenge your friends to a relaxing game of WWII
battlefield action, or stream your MP3 collection to other computers that use
iTunes, you’ll wonder how you ever got along without one. In this chapter, I
fill you in on all the details you need to know to get your road warrior hooked
up to a new (or existing) network.

What Exactly Is the Network Advantage?

If you have other family members with computers, or if your MacBook is in
an office with other computers (including those rascally PCs), here’s just a
sample of what you can do with a network connection:

v Share an Internet connection: This is the major reason why many
families and most small businesses install a network. Everyone can
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simultaneously use the same digital subscriber line (DSL) or cable
Internet connection on every computer on the network.

v~ Share a printer: You say your fellow employee — or, even worse, your
big sister — has a great printer connected to her computer? Luckily, that
printer can be shared with anyone across your network.

1 Copy and move files of all sizes: Need to get a Keynote presentation
from one Mac to another? With a network connection, you can accom-
plish this task in just seconds. Otherwise, you’d have to copy that file
to a USB flash drive, burn it to a DVD-R, or use an external hard drive.
A network connection makes copying as simple as dragging the project
folder from one Finder window to another.

1 Share documents across your network: Talk about a wonderful col-
laboration tool! For example, you can drop a Word document or Keynote
presentation file in your Public folder (or save it in your iCloud Drive)
and ask for comments and edits from others in your office (or around
the planet).

v Stream music and video: With iTunes, you can share your audio and
video media collection on your MacBook Pro with other Macs and PCs
(and even devices such as an Apple TV or an AirPlay speaker system)
on your network. Your eyes and ears can’t tell the difference! Using a
network connection, you can also watch streaming TV and movies from
services like Netflix and Hulu.

1+ Play multiplayer games: Invite your friends over and tell ’em you're
hosting a LAN party (the techno-nerd term for a large gathering of game
players, connected through the same network, all playing the same mul-
tiplayer game). You'll see firsthand just how devious a human opponent
can be. Each participant needs to buy a copy of the same game, natu-
rally, but the fun you’ll have is worth every cent you spend. Don’t forget
the chips!

If your laptop isn’t within shouting distance of an existing network, or you
don’t plan on buying any additional computers, you may not need to create a
network. A lone MacBook hanging out in your home with no other computers
around should need a network only for Internet access.

If you have just your Mac laptop and an Internet connection through a high-
speed DSL/cable modem, and you have no plans to add another computer,

wireless equipment, a network printer, or a mobile device, a network prob-

ably isn’t necessary.
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Should You Go Wired or Wireless?

After you decide that you indeed need a network for your home or office, you
have another decision to make: Should you install a wired network (running
cables between your computers) or a wireless network? Heck, should you
throw caution to the wind and build a combination network with both
wireless and wired hardware?

Your first instinct is probably to choose a wireless network for convenience.
After all, this option allows you to eliminate running cables behind furniture,
in the walls, or in your office ceiling. Ah, but I must show you the advantages

of a wired network as well. Table 11-1 gives you the lowdown to help you

make up your mind.

Table 11-1 Wireless versus Wired Networks

Factor Wireless Networks Wired Networks
Speed Moderate Much faster
Security Moderate Better

Convenience Better Worse

Compatibility Confusing standards Easier to understand
Cables Few (or none) Required

Grafting wireless access to a wired network

Maybe you're caught in the middle when
trying to choose between wired and wireless
networking. Or perhaps you're already using
a wired network but are thrilled by the idea of
sitting on your deck in the sunshine, checking
your email on your laptop, untethered. By
combining both technologies, you can get the
faster transfers of a wired network between all
the computers in your office and the freedom
you crave.

In my home office, | use a wireless base station
that also includes a built-in wired switch, a
common feature in today’s wireless routers
and base stations. My family gets all the
convenience a wireless network offers, and
everyone can connect to the Internet from
anywhere in our house. On the other hand, my
office computers have the faster performance
and tighter security of a wired network.
Sassyindeed!
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As I see it, here are the advantages of choosing a wired versus a wireless
network setup:

v Wired: Using a wired network offers two significant perks over a
wireless network:

e Faster speeds: In general, wired networks that are compatible
with your MacBook are many, many times faster than the fastest
802.11ac or 802.11n wireless connections.

@‘“‘NG! The performance of a wireless connection can be compromised
S by interference (from impeding structures, such as concrete walls,
and from household appliances, such as some wireless phones
and microwave ovens) and by distance. Wired networks have
no such problems (as long as you keep your cables to lengths of
25 feet or less).

e Better security: A wired network doesn’t broadcast a signal that can

NG be picked up outside your home or office, so it’s more secure.
NG/
$ Hackers can attack through your Internet connection, though,

even if you're using a wired network. Hence the final section of this
chapter, “USE YOUR FIREWALL!”

v Wireless: A wireless connection really has only one advantage, but it's a
big one: convenience (which, in this case, is another word for mobility for
all your networked devices). Laptop owners crave this independence —
a freedom that desktop computer owners can only dream about.

Accessing your network anywhere within your home or office — without
cables — is so easy. Connecting a wireless printer is a breeze. And when
using an AirPort Express mobile Base Station, even your home stereo
can get connected to your MP3 collection on your MacBook. Read more
about base stations later.

Be a Pal: Share Vour Internet!

It’s time to see what’s necessary to share an Internet connection. In the fol-
lowing sections, I cover two methods of connecting your network to the
Internet. (And before you open your wallet, keep in mind that you might
be able to use your laptop to share your broadband connection across
your network!)

Using your MacBook as a sharing device

You can use your MacBook to provide a shared Internet connection across a
simple wireless network, using a broadband DSL or cable connection.
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It is possible to use an El Capitan-compatible external USB dial-up modem to
share a dial-up modem Internet connection, but I would consider it only if you
have absolutely no other option. A dial-up modem connection really can’t
handle the data transfer speeds for more than one computer to access the
Internet at one time. (In plain English, an external USB modem that you add
to your MacBook isn’t fast enough for both you and your significant other

to surf the web at the same time.) Sharing a dial-up connection just isn’t
practical.

Because your MacBook has built-in AirPort Extreme wireless hardware, it’s
easy to share your cable/DSL broadband connection wirelessly with other
computers in your home or office.

When your laptop is functioning as an Internet-sharing device, your
MacBook uses El Capitan’s built-in Internet-connection-sharing feature to
get the job done, but your MacBook must remain turned on to allow Internet
sharing. 1 show you how to do this in the later section “Network Internet
connections.”

Using a dedicated Internet-sharing
device

You can also choose to use a dedicated Internet-sharing device (often called
an Internet router) to connect to your cable or DSL modem. You do have

to buy this additional hardware, but here’s the advantage: Your MacBook
doesn’t have to remain turned on just so everyone can get on the Internet.

As I mentioned, Internet routers usually include either wired or wireless
network connections, and many include both.

Setting up an Internet router is usually a simple matter, but the configuration
depends on the device manufacturer and usually involves a number of differ-
ent settings in System Preferences that vary according to the router model.
Grab a diet cola, sit down with the router’s manual, and follow the installa-
tion instructions you find there. (In some cases, you must set up your cable
or DSL modem as a bridge between your ISP and your router, which should
be covered in your modem and router manuals as well.)

Most Internet routers offer a DHCP server, which automatically assigns
Internet protocol (IP) addresses, and I strongly recommend that you turn on
this feature! (You can read more about DHCP later in this chapter, in the side-
bar “The little abbreviation that definitely could.”)

191
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What Do | Need to Connect?
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Most normal folks — whom I define as those who have never met a network
system administrator, and couldn’t care less — think that connecting to a
network probably involves all sorts of arcane chants and a mystical symbol
or two. In the following sections, I provide you with the shopping list you
need to set up a network — or connect to a network that’s already running.

Wireless connections

Today’s Mac laptops come complete with built-in AirPort Extreme wireless
hardware, so if you already have an AirPort Extreme or Express Base Station,
you're all set. Otherwise, hold on tight while I lead you through the hardware
requirements for wireless networking.

The maximum signal range — and effectiveness — of any wireless network
can be impeded by intervening walls or electrical devices, such as microwave
ovens and some wireless phones, all of which can generate interference.

Connecting a MacBook to an existing wireless network

Connecting a MacBook to an existing wireless network requires no extra
hardware, because your hardware is already built in. (Whew. That was easy!)

Using a base station to go wireless

If you decide that you want to build your own wireless network, you eschew
cables, or you want to add wireless support to your existing wired network,
you need a base station. (If you do have an existing wired network, the base
station can act as a bridge between computers using wireless hardware and
your wired network, allowing both types of computers to talk to each other.)
Such a wireless base station will have either

v A port that can connect to your existing wired network’s switch
v A full built-in switch for wired connectivity (which means you can sell

your old wired Ethernet switch to your sister in Tucson)

And, of course, a base station can simply act as a central switch for your
wireless network (with no support for a wired network).

You can use either a cool Apple Base Station or a boring 802.11ac or 802.11n
generic wireless base station; however, the Apple hardware requires less
configuration and tweaking. (Sounds like a Mark’s Maxim!)



Chapter 11: Working Well with Networks 7 93

<MBER
)

If you don’t want the hassle of tweaking PC hardware to accommodate
your MacBook, buy Apple hardware and software.™

Apple Base Station models

As listed in the upcoming Table 11-2, your MacBook can work with four Apple
Base Station models for wireless networking:

v AirPort Extreme: | recommend using AirPort Extreme if your network
needs an enhanced antenna, which provides greater range. You can read
about connectivity ranges in Table 11-2.

v AirPort Time Capsule: Apple’s Time Capsule unit (an external wireless
backup unit) isn’t just a wireless remote hard drive. It can also act as
a full AirPort Extreme Base Station. In fact, the wireless specifications
for a Time Capsule unit and an AirPort Extreme Base Station are almost
identical.

v AirPort Express: | recommend using AirPort Express if you want to

e Carry your wireless base station with you. Express is much smaller
than the other Apple Base Station models. (Think “party on the
patio” or a LAN gaming get-together at a friend’s house.)

e Extend the range of your existing wireless network. If your network
signal fades by the pool or potting shed, consider adding an
AirPort Express at the edge of your current range to extend the
reach of your wireless network.

e Connect your home stereo or speakers for wireless music streaming
using AirPlay. You can connect a pair of speakers to your AirPort
Express and use AirPlay to play music from your MacBook’s iTunes
library. (Heck, you're not limited to playing the music on your
laptop. You can also stream music from your iPhone, iPad, or iPod
touch!)

v AirPort (discontinued): You might find an 802.11g AirPort Base Station
on eBay or at a garage sale. Go ahead and pick it up if you want to save
cash, unless you're considering doing multiplayer gaming or performing
high-speed file transfers over your wireless network.

The latest 802.11ac standard used by the AirPort Extreme Base Station
and AirPort Time Capsule delivers a connection that’s several times
faster than the old AirPort Base Station’s 802.11b/802.11g/802.11n
standards. 802.11ac is also compatible with all the older standards —
802.11b/a/g/n — so I highly recommend that you stick with 802.11ac in
the future. It plays well with others, and at warp speed to boot!

The names of the Apple Base Stations are irritatingly similar; Apple usu-
ally does a better job of differentiating its product names. Jot down the
name of your model on a Post-it Note on your laptop’s desktop so you don’t
get confused.
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Table 11-2 Apple Wireless Network Base Stations
Feature AirPort Extreme/AirPort AirPort
Time Capsule Express
Price $199/$299/$399 $99
Users (maximum) 50 50
802.11ac support Yes No
802.11n support Yes Yes
802.11g support Yes Yes
802.11b support Yes Yes
LAN Ethernet jack (high-speed Internet Yes Yes
connection)
WAN Ethernet jack (wired computer Yes Yes
network)
Stereo mini-jack No Yes
USB printer port Yes Yes

Installing an Apple Base Station is simple. Follow these steps:
1. If you have a DSL or cable modem, connect it to the WAN (wide-area
network) port on the base station with an Ethernet cable.

2. If you have an existing wired Ethernet computer network with a
switch or router, connect it to the Ethernet LAN port on the base

&QN\BEH station with an Ethernet cable.
€ Only the AirPort Extreme and AirPort Time Capsule stations have
a WAN port.
3. If you have a USB printer, connect it to the USB port on the base
\3 station.

I cover the steps to sharing a printer in the later section “Sharing a
network printer.”

4. Connect the power cable.
5. Switch on your base station.

6. Run the installation software provided by Apple on your laptop.
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Using non-Apple base stations

If any company other than Apple manufactured your wireless base station,
the installation procedure is almost certainly the same. (Naturally, you
should take a gander at the manufacturer’s installation guide just to

make sure, but [ have added many brands of these devices, and I used the
same steps for each one.)

However, I should note that Apple wireless hardware uses a slightly differ-
ent security encryption standard than most PC wireless hardware. This fact
creates an extra hurdle when you connect to a non-Apple base station or
access point with your laptop. (More on this in the next section. For now,
just remember that I recommend using Apple wireless hardware with your
MacBook whenever possible because the installation process is easier!)

Joining a wireless network

As far as I'm concerned, the only two types of base stations are Apple and
non-Apple (which includes all 802.11ac, 802.11n, and 802.11g base stations
and access points). In the following two sections, I relate what you need to
know to get onboard with either type of hardware.

Apple AirPort Base Stations

To join a wireless network that’s served by any flavor of Apple Base Station,
follow these steps on each Mac with wireless support:

. Click the System Preferences icon in the Dock.
. Click the Network icon.

. From the Connection list on the left, click Wi-Fi.

1
2
3
4. Select the Show Wi-Fi Status in Menu Bar check box.
5. Click the Apply button.

6. Press 38+Q to quit System Preferences and save your settings.
7

. Click the Wi-Fi status icon (which looks like a fan) on the Finder menu
bar, and choose an existing network connection you’d like to join.

The network name is the same as the network name you chose when
you set up your AirPort Base Station.

8. If you set up a secure network, enter the password you assigned to the
network during setup.

By the way, security is always A Good Thing. I strongly recommend that you
enable the password encryption features of your Apple Base Station while
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installing it. (Luckily, the Apple Base Station setup application leads you
through this very process.) In the words of an important Mark’s Maxim:

Keep uninvited guests out of your network! Use your base station’s security
features and encrypt your data by using WPA2 encryption!™

Some wireless networks might not appear in your Wi-Fi menu list. These are
closed networks, which can be specified when you set up your AirPort Base
Station. You can’t join a closed network unless you know the exact network
name (which is far more secure than simply broadcasting the network name).
To join a closed network, follow these steps:

1. Click the Wi-Fi status icon (which looks like a fan) on the Finder menu
bar and choose Join Other Network.

2. Type the network’s name.

3. If the network is secured with WPA, WPA2, WEP, or LEAP encryption —
the security standards for protecting your data through encryption —
click the Security pop-up menu and choose which type of encryption
is being used.

I recommend avoiding WEP encryption whenever possible. Your best
bet is WPA2 encryption, which is the current standard for home wire-
less networks.

4. Enter the network password if required.

To disconnect from a Wi-Fi network, click the Wi-Fi menu and either choose
Turn Wi-Fi Off or connect to another wireless network. In other words, if
you choose another available wireless network from the Wi-Fi menu, your
MacBook automatically drops the previous connection. (You can be con-
nected to only one wireless network at a time, which makes Good Sense.)

Using non-Apple Base Stations

If you're using your MacBook to connect to a non-Apple base station at your
office, you might need to follow a specific procedure that takes care of the
slightly different password functionality used by standard 802.11b/g/n/ac
hardware.

El Capitan can take care of many potential wireless “language barriers”
caused by security encryption. The two most common forms are WPA2 and
WEP. So whether you need to modify your password to connect to your
non-Apple base station depends on the specific hardware and encryption
system it uses.

To read or print the latest version of this procedure, fire up Safari, visit
http://kbase.info.apple.com/index.html, and type HT1126 in the
search field. The article provides the details on how to convert a standard
wireless encrypted password to a format your AirPort Extreme hardware can
understand.


http://kbase.info.apple.com/index.html
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Transferring files the easy AirDrop way

AirDrop is the local Mac-to-Mac file transfer
feature built in to 0S X El Capitan, and it
couldn’t be easier to use. No setup and no
passwords are involved! However, it comes
with three caveats:

v AirDrop works only with Macs running
Lion and later, and only with specific
models: MacBook Pro (late 2008 or newer),
MacBook Air (late 2010 or newer), and
MacBook (late 2010 and newer). The
17-inch MacBook Pro (late 2008) doesn’t
support AirDrop.

v~ AirDrop uses the Wi-Fi hardware built in to
today’s Mac laptops and desktops, so don't
forget to turn on Wi-Fi first. (If you're dis-
playing the Wi-Fi status icon on your Finder
menu bar, click the icon and choose Turn
Wi-Fi On.)

v+ You have to be within Wi-Fi signal range of
another Mac to use AirDrop. Note, how-
ever, that the two computers don’t have
to be using the same Wi-Fi network. (For
example, my iMac uses a wired connec-
tion to my network, but because the iMac

has internal Wi-Fi hardware, | can use
AirDrop to send files to my MacBook Air.)
Because AirDrop uses a Wi-Fi connection,
file transfers are significantly slower (and
less secure) than they would be over a
wired Ethernet network.

To use AirDrop to transfer files to another Mac,
both users should click the AirDrop icon in
any Finder window sidebar to join the AirDrop
group. After a short delay, you see the account
pictures for all Macs within signal range and
with AirDrop open. Just drag the files you want
to transfer to the person’s picture. Both you
and the recipient are prompted for confirmation
before the transfer begins. After the transfer is
complete, the files you sent are saved in the
recipient’'s Downloads folder.

When you're done using AirDrop, just close the
Finder window displaying the account pictures
(or click another location in the Finder window
sidebar) to exit the AirDrop group. (Don't forget
that you have to reopen AirDrop if someone
wants to send you files. | leave my AirDrop
Finder window open and minimized to the Dock.)

Wired connections

If you're installing a wired network, your non-Retina MacBook Pro already
comes with most of what you need for joining your new cabled world. You
just connect the hardware and configure the connection. Don’t forget that
you also need cables and an inexpensive Ethernet switch. (If you're using an
Internet router or other hardware sharing device, it almost certainly has a

built-in four- or eight-port switch.)

If you own a MacBook Retina, MacBook Air, or MacBook Pro Retina laptop,
your machine doesn’t come from Apple with a wired Ethernet port onboard.
But you can add a Thunderbolt or USB-to-Ethernet connector that allows you
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to use a wired network. After you add the connector to your system, you can
follow along without any problem.

Connecting a Non-Retina MacBook Pro to a wired network

Your Ethernet 10/100/1000 port (which looks like a slightly oversized tele-
phone/modem jack) is located on one side of your non-Retina MacBook Pro.
It’s ready to accept a standard Ethernet Cat5/Cat5E/Cat6 cable with RJ-45
connectors. (If you've connected a Thunderbolt- or USB-to-Gigabit-Ethernet
adapter to your MacBook Retina, MacBook Pro Retina or MacBook Air, you're
also in business.)

If you're connecting to an existing wired network, you need a standard Cat5/
Cat5E/Cat6 Ethernet cable of the necessary length. I recommend a length of
no more than 25 feet, because longer cables are often subject to line interfer-
ence (which can slow or even cripple your connection). You also need a live
Ethernet port from the network near your laptop. Plug the cable into your
MacBook, and then plug the other end into the network port.

Wired network hardware

If you don’t know your switch from your NIC, don’t worry. Here I describe the
hardware you need for your wired network.

Wired network components

If you're building your own wired network, you need

v A switch: This gizmo’s job is to provide more network ports for the
other computers in your network. Switches typically come in four- and
eight-port configurations.

As mentioned earlier in this chapter, most Internet routers (sometimes
called Internet-sharing devices) include a built-in switch. So if you've
already invested in an Internet router, make doggone sure it doesn’t come
equipped with the ports you need before you go shopping for a switch!

v A number of Ethernet cables: Exactly how many cables you need is
determined by how many computers and other devices (such as a
network printer) you're connecting. If you're working with a Gigabit
Ethernet system, you need Cat5E or Cat6 cables. Cat6 cables provide
better performance but are more expensive.

Naturally, if you're using a broadband Internet connection, you also have a
DSL or cable modem. These boxes always include a port for connecting to
your wired Ethernet network. (If you have one of the new breed of wireless
modems — which acts as a wireless base station — don’t panic. It should
also have a wired port for connecting to your existing switch.)
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Wired network connections

After you assemble your cables and your router or switch, connect the
Ethernet cables from each of your computers to the router or switch, and
then turn on the device. (Most need AC power to work.) Check the manual
that comes with your device to make sure that the lights you're seeing on the
front indicate normal operation. (Colors vary by manufacturer, but green is
usually A Good Color.)

Next, connect your cable or DSL modem’s Ethernet port to the WAN port on
your switch with an Ethernet cable. If your modem isn’t already on, turn it on
now, and check for normal operation.

When your router or switch is powered on and operating normally, you're
ready to configure OS X for network operation. Just hop to the upcoming
section “Connecting to the Network.” (How about that? Now you can add
network technician to your rapidly growing computer résumé!)

Joining a wired Ethernet network

After all the cables are connected and your central connection gizmo is
plugged in and turned on, you’'ve essentially created the hardware portion of
your network. Congratulations! (Now you need a beard and suspenders.)

With the hardware in place, it’s time to configure El Capitan. In this section, I
assume you're connecting to a network with an Internet router or switch that
includes a DHCP server. (Jump to the later sidebar “The little abbreviation
that definitely could” for more on DHCP.)

Follow these steps on each Mac running OS X that you want to connect to
the network:

1. Click the System Preferences icon in the Dock.

2. Click the Network icon.

3. From the Connection list on the left, choose Ethernet.

The entry may also be named Ethernet 1, depending on the Mac model
you’re configuring. (Make sure you select the Ethernet entry that does
not carry the Wi-Fi fan symbol.)

4. Click the Configure IPv4 pop-up menu and choose Using DHCP, as
shown in Figure 11-1.
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5. Click the Apply button.

The Apply button is grayed out in the figure because my status (in this
dialog) is Connected.

Enjoy the automatic goodness as OS X connects to the DHCP server to
obtain an IP address, a subnet mask, a gateway router IP address, and

a Domain Name System (DNS) address. (Without a DHCP server, you'd
have to add all this stuff manually. Ugh.)

A few seconds after clicking the Apply button, you should see the infor-
mation. You might also notice that the DNS Server and Search Domains
fields are empty. Fear not. OS X is really using DNS server and domain
information provided by the DHCP server.

6. Press 38+Q to quit System Preferences and save your settings.

You're on!

Connecting to the Network

All right! The hardware is powered up, the cables (if any) are installed and
connected, and you have configured El Capitan. You're ready to start (or
join) the party. In the following sections, [ show you how to verify that
you're connected, as well as how to share data and devices with others on
your network.
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The little abbreviation that definitely could

You know, some technologies are just peachy.
(So much for my iiber-tech image.) Anyway,
these well-designed technologies work
instantly, you don’t have to fling settings around
like wrapping paper on Christmas day, and
every computer can use them: Mac, Windows,
Linux, and even the laptops used by funny-
looking creatures from Roswell, New Mexico.

Dynamic Host Configuration Protocol, or DHCP
for short, is about as peachy as it gets. This
protocol enables a computer to automatically
get all the technical information necessary
to join a network. Let me hear you say, “0Oh
yeah!” Virtually all network devices can use
DHCP these days, including Internet routers,
switches, and (go figure) 0S X. Today's
networking hardware and operating systems
provide a DHCP server, which flings the proper
settings at every computer on the network all by

itself. Your MacBook just accepts the settings
and relaxes in a placid networking nirvana.

In this book, you can bet the farm that | assume
you want to use DHCP and that your network
hardware supports it (which is a virtual
certainty with today’s hardware). That way, |
won't spend 30 pages leading you through the
twisting alleyways of manual network settings.

If you're connecting to an existing network,
tell the network administrator you're taking
the easy route and using DHCP. A warning,
however: Adding more than one DHCP server
on a single network will cause a civil war,
and your system will lock up tight. Therefore,
before adding hardware with a DHCP server
to an existing network, ask your network
administrator to ensure that you aren’t making
a mistake.

Verifying that the contraption works

After you have at least two computers on a wired or wireless network, test
whether they’re talking to each other over the network by pinging them. (No,
[ didn’t make up the term. Honest.) Essentially, pinging another computer is
like yelling “Are you there?” across a crevasse.

To ping another computer on the same network from any Mac running

El Capitan, follow these steps:

1. Click the Spotlight search icon in the Finder menu bar and type
Network Utility in the Spotlight search box.

2. Click the Network Utility entry in the Spotlight list to launch the

application.

3. Click the Ping tab, as shown in Figure 11-2.
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[ JoN ) Network Utility

Info  Netstat | Ping | Lookup  Traceroute Whois Finger  Port Scan

Enter the netwerk address to ping.

192.168.0.102 (ex. 10.0.2.1 or www.example.com)

Send an unlimited number of pings
©sendonly 5 pings [ Ping |
Ping has started.

PING 192.168.0.102 (102.168.0.102): 56 data bytes

64 bytes from 192.168.8.182: icmp seq=0 tt1=128 time-8.564 ms
64 bytes from 192.168.0.102: icmp_seq=1 ttl=128 time=e.463 ms
| 64 bytes from 192.168.8.182: icmp_seq=2 ttl=128 time=B.678 ms

64 bytes from 192.168.8.182: icmp_seq=3 tt1=128 time=8.585 ms

. . 64 bytes from 192.168.8.102: icmp_seq=4 tt1=128 time=B.683 ms
Figure 11-2:
-— 182.168.0.102 ping statistics -——
LOOk Ma 5 packets transmitted, 5 packets received, 8.8% packet loss
’ ’ round-trip min/avg/max/stddev = 8.463/8.579/0.683/8.089 ms
’ L.
I’'m pinging!
|

4. In the Enter the Network Address to Ping text field, enter the
IP address of the computer you want to ping:
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e [f you're pinging another Mac running OS X, you can get that
machine’s IP address by simply displaying its Network pane in
System Preferences, which always displays the IP address.

e [f you're trying to ping a PC running Windows, and you don’t know
that machine’s IP address, follow these steps:

e Click Start and right-click Network (under Windows 7) and then
choose Properties. Under Windows 8, 8.1, or 10, display the Control
Panel and then click Network and Sharing Center.

e Click Change Adapter Settings, then right-click your Local Area
Network connection icon and choose Status from the menu that
appears.

e Click the Details button.
The IP address of that computer is proudly displayed.
5. Select the Send Only x Pings radio button, and enter 5 in the text field.
6. Click the Ping button:

e Yay!: If everything is working, you should see results similar to those
shown in Figure 11-2, in which I'm pinging my Windows server at
IP address 192.168.0.102 across my wired Ethernet network.

The address 192.168.0.xxx is a common series of local network IP
addresses provided by Internet routers, hubs, and switches with DHCP
servers, so don’t freak if you have the same local IP address. Similarly,
Apple tends to use the form 10.0.1.xxx for local networks.
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®

Sharing

® Nay: If you don’t get a successful ping, check your cable connec-
tions, power cords, and OS X settings. If you're using a wireless
connection, you might have to move closer to the network base
station to connect successfully, especially through walls.

Sharing stuff nicely with others

It works! By golly, it works! Okay, now what do you do with your all-new
shiny chrome network connection? Ah, my friend, let me be the first to
congratulate you and the first to show you around! In the following sections,
I cover the most popular network perks. (The good news is that these perks
work with both wired and wireless connections.)

Network Internet connections

If your DSL or cable modem plugs directly into your MacBook (rather than
into a dedicated Internet-sharing device or Internet router), you might
ponder just how the other computers on your network can share that spiffy
high-speed broadband connection. If you're running a wireless network, it
comes to the rescue!

Follow these steps to share your connection wirelessly:

()

. Click the System Preferences icon in the Dock.

N

. Click the Sharing icon.

3. Click the Internet Sharing entry in the Services list to the left of the
pane.

4. From the Share Your Connection From pop-up menu, choose Ethernet.
5. Select the Wi-Fi check box (in the To Computers Using list).

6. Select the On check box next to the Internet Sharing entry in the
Services list:

El Capitan displays a warning dialog stating that connection sharing
could affect other computers on your network. If you intend to share the
Internet connection provided on an existing network at your home or
office that you didn’t set up, contact your network administrator first!
(It’s best to avoid sowing chaos and disorder.)

7. Click Start in the warning dialog to continue.

8. Click the Close button to exit System Preferences.
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Sharing an Internet connection (without an Internet router or dedicated
hardware device) through OS X requires your computer to remain on con-

tinuously. Remind others in your office or home that the svelte laptop must
remain on, or they’ll lose their Internet connection! Naturally, when you take

off on your next trip with your road warrior, the folks left at your home or
office will be without an Internet connection until you return.

Don’t forget, you don’t need to configure Internet sharing if your DSL or cable
modem connects to a dedicated sharing device or router. That snazzy equip-

ment automatically connects your entire network to the Internet.

Network file sharing
You can swap all sorts of interesting files with other Macintosh computers

on your network. When you turn on file sharing, El Capitan allows all Macs on

the network to connect to your MacBook and share the files in your Public

folder. (Note that sharing across a network is different from sharing a single
computer between several people. I cover that environment in Chapter 10.)

Follow these steps to start sharing files and folders with others across
your network:

1. Click the System Preferences icon in the Dock.

2. Click the Sharing icon.

3. Select the On check box next to the File Sharing service entry to
enable the connections for Mac and Windows sharing.

Other Mac users can connect to your computer by clicking Go in the
Finder menu and choosing the Network menu item. The Network
window appears, and your laptop is among the choices. If the other

Macs are running El Capitan, your MacBook’s shared files and folders
appear in a Finder window, and they’re listed under the Shared heading
in the sidebar.

Windows XP users should be able to connect to your Mac from their My
Network Places window. Vista/Windows 7 users can use the Network
window. Windows 8, 8.1, and 10 users should head to the Network panel.
Those lucky Windows folks also get to print to any shared printers
you’ve set up. (The following section covers shared printers.)

4. Click the Close button to exit System Preferences.

El Capitan conveniently reminds you of the network name for your MacBook
at the top of the Sharing pane.
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Sharing a network printer
I love describing easy procedures, and sharing a printer on a Mac network
ranks high on the list! You can share a printer that’s connected to your
laptop (or your AirPort Extreme, AirPort Time Capsule, or AirPort Express
Base Station) by following these simple steps:

1. Click the System Preferences icon in the Dock.

2. Click the Sharing icon.

3. Select the On check box next to the Printer Sharing service entry.

4.

From the list at the right of the System Preferences window, select the
check box next to the printer you want to share.

5. Click the Close button to exit System Preferences.

A printer you share automatically appears in the Print dialog on other
computers connected to your network.

USE YOUR FIREWALL!

o

Security
&Privacy

Yep. That’s the only heading in this entire book that’s all uppercase. It’s that
important.

The following Mark’s Maxim, good reader, isn’t a request, a strong recom-
mendation, or even a regular Maxim. Consider it an absolute command (right
up there with Pay your taxes).

Turn on your firewall now.™

When you connect a network to the Internet, you open a door to the outside
world. As a consultant to several businesses and organizations in my home-
town, I can tell you that the outside world is chock-full of malicious individu-
als who dearly love to inflict damage on data and would like to take control of
your MacBook for their own purposes. Call ’em hackers, call ’em delinquents,
or call ’em something [ can’t repeat, but don’t let them in!

El Capitan comes to the rescue again with the built-in firewall in OS X. When
you use the firewall, you essentially build a virtual “brick wall” between you
and the hackers out there (both on the Internet and within your local net-
work). Follow these steps:

1. Click the System Preferences icon in the Dock.

2. Click the Security & Privacy icon.
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. Click the Firewall tab.
. Click the Turn On Firewall button to activate your firewall.

. Click the Firewall Options button.

S U1 e W

. Select the Automatically Allow Signed Software to Receive Incoming
Connections check box.

7. Select the Enable Stealth Mode check box.

This important feature prevents hackers from trolling for your MacBook
on the Internet — or, in normal-speak, searching for an unprotected
computer — so it’s much harder for them to attack you. (Stealth mode
also prevents other computers from pinging you, so don’t be surprised if
your MacBook suddenly clams up if you try to ping it.)

8. Click OK.

9. Click the Close button to exit System Preferences.

El Capitan even keeps track of the Internet traffic that you do want to reach
your laptop, such as web page requests and file sharing. When you acti-
vate one of the network features described in the section “Sharing stuff
nicely with others,” El Capitan automatically opens a tiny hole (called a
port by net types) in your firewall to allow just that type of communication
with your Mac.

For example, if you decide to turn on printer sharing (as described in the pre-
ceding section), El Capitan automatically allows incoming print jobs over the
network from other computers.

You can also add ports for applications that aren’t on the firewall’s Allow
list, such as third-party instant messaging clients and multiplayer game serv-
ers. Depending on the type of connection, El Capitan often displays a dialog
prompting you for confirmation before allowing certain traffic, so you prob-
ably won’t need to do anything manually.

However, you can manually add a program to your list of allowed (or
blocked) firewall ports. Follow these steps:
1. Click the System Preferences icon in the Dock.
2. Click the Security & Privacy icon.
3. Click the Firewall tab, and then click the Firewall Options button.
4. Click the Add button (which carries a plus sign).

El Capitan displays a standard file-browsing sheet.
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. Browse to the application that requires access to the outside world — or
the application that you want to block from outside communication —
and click it to select it.

. Click the Add button in the File sheet.

The application appears in the Firewall list. By default, it’s set to Allow
Incoming Connections.

. If you want to block any communications coming into the application,
click the Allow Incoming Connections pop-up menu and choose Block
Incoming Connections instead.

. Click the Close button to exit System Preferences.






PartIV
Living the iLife

iPhoto -

Cats and More Cats + Quick Fixes Effects Adjust

55 Rotate

N+ Enhance

*  Fix Red-Eye

(=) straighten

], Grop

™, Retouch

Revert to Original

web™ Find out how to stream music using AirPlay and iTunes at www . dummies . com/
Y] cxtras/macbook.



http://www.dummies.com/extras/macbook
http://www.dummies.com/extras/macbook

In this part . . .

v Build the digital media library of your dreams with iTunes.
v Create slideshows and photo books with iPhoto.
v Put your moviemaking talents to work with iMovie.

v Use GarageBand to compose and record your own music.




Chapter 12
The Multimedia Joy of iTunes

In This Chapter
Playing music with your MacBook
Arranging and organizing your music collection
Tuning into the world with Internet radio
Sharing your songs across a network
Creating eye candy with Visualizer
Buying the good stuff from the iTunes Store

Sometimes, words just aren’t enough. iTunes is that kind of perfection.

To envision how iTunes changes your laptop, you have to paint the picture
with music — music that’s easy to play, search for, and transfer from device to
device. Whether it be classical, alternative, jazz, rock, hip-hop, or folk, I guaran-
tee you won't find a better application than iTunes to fill your life with music.
And podcasts. And video. And TV shows. And online education. And Internet
radio. (See how hard it is to pin down this wonderful application? Along with
your MacBook, iTunes really does form the hub of your digital lifestyle.)

In this chapter, I lead you through all the features of my absolute favorite
Apple application. (It will be pretty doggone obvious how much I appreciate
this piece of software.)

What Can | Play on iTunes?

Simply put, iTunes is a media player that plays audio and video files. These
files can be in any of many different formats. iTunes supports these common
audio formats:

v MP3: The small size of MP3 files has made them popular for file trading
on the Internet. You can reduce MP3 files to a ridiculously small size
(albeit at the expense of audio fidelity), but a typical CD-quality, three-
minute pop song in MP3 format has a size of 3-5MB.
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v AAC: Advanced Audio Coding is an audio format that’s similar to MP3.
AAC files typically offer better recording quality at the same file sizes.
However, this format is less compatible with non-Apple MP3 players and
software. (Luckily, you can still burn AAC tracks to an audio CD, just
as you can MP3 tracks.) The tracks that you download from the iTunes
Store are in AAC format.

1~ Apple Lossless: Another format direct from Apple, Apple Lossless format
(also known as ALAC) provides the best compromise between file size
and sound quality. These tracks are encoded without loss of quality,
although Apple Lossless tracks are somewhat larger than AAC. This
format is generally the favorite of discerning audiophiles.

v AIFF: This standard Macintosh audio format produces sound of the
absolute highest quality. This high quality, however, also means that the
files are pretty doggone huge. AIFF recordings typically require about
10MB per minute of audio.

1 WAV: Not to be outdone, Microsoft created its own audio file format
(WAV) that works much like AIFF. It can reproduce sound at a higher qual-
ity than MP3, but the file sizes are very large, similar in size to AIFF files.

v CD audio: iTunes can play audio CDs. Because you don’t usually store
CD audio anywhere but on an audio CD, file size is no big whoop — but
again, 10MB of space per minute of music is a good approximation.

v MP2: A close cousin of the far more popular MP3 format, MP2 is the pre-
ferred format in radio broadcasting and is a standard audio format for
HDV camcorders. It produces file sizes similar to MP3 format.

v Movies and video: You can buy and download full-length movies, TV
shows, music videos, and movie trailers from the iTunes Store . .. and,
with an Apple TV unit connected to your home theater system, you can
watch those movies and videos from the comfort of your sofa on the
other side of your living room (or even from your bedroom on the other
side of your house).

v+ Podcasts: These audio downloads (typically in MP3 format) are like
radio programs for your iOS devices, but iTunes can play and organize
them, too. Some podcasts include video and photos to boot.

v iTunes U: iTunes offers educational materials (think slideshows, presen-
tations, and class recordings) from a wide variety of colleges and techni-
cal institutions — and virtually all free for the download.

v Ringtones: iPhone owners, rejoice! iTunes automatically offers to create
ringtones for your iPhone (and iPad and iPod touch) from the tracks
you bought from the iTunes Store or tunes you composed. You can even
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use these ringtones on your MacBook, with the FaceTime and Messages
applications.

v Audiobooks: You no longer need cassettes or audio CDs to enjoy your
spoken books. iTunes can play them for you, or you can send them to
your iPod for listening on the go.

1 Streaming Internet radio: You can listen to a continuous broadcast
of songs from one of tens of thousands of Internet radio stations, with
quality levels ranging from what you’d expect from FM radio to the full
quality of an audio CD. You can’t save the music in iTunes, but streaming
radio is still great fun. (I run my own station . . . more on MLC Radio later
in this chapter.)

I’Iaqu an Audio CD

If you have an optical drive (either internal or external), playing an audio CD
in iTunes is simple. Just insert the CD in the drive, start iTunes by clicking its
icon on the Dock, and click the Play button. (Note that your MacBook might
be set to automatically launch iTunes when you insert an audio CD.) The
iTunes interface resembles that of a traditional CD player. The main playback
controls of iTunes are Play, Previous, Next, and the Volume slider, as shown
in Figure 12-1.

Click the Play button to begin listening to a song. While a song is playing, the
Play button toggles to a Pause button. As you might imagine, clicking that
button again pauses the music. If you don’t feel like messing around with a
mouse or trackpad, you can always use the keyboard. The spacebar acts as
the Play and Pause buttons. Press the spacebar to begin playback; press it
again to stop.

Click the Next button to advance to the next song on the CD. The Previous
button works like the Next button but with a slight twist: If a song is currently
playing and you click the Previous button, iTunes first returns to the begin-
ning of the current song (just like an audio CD player). To advance to the pre-
vious song, double-click the Previous button. To change the volume of your
music, click and drag the volume slider.

As with other Mac applications, you can control much of iTunes with the key-
board. Table 12-1 lists some of the more common iTunes keyboard shortcuts.
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Figure 12-1:
The main
playback
controls:

Play,
Previous,
and Next.

|

Play Volume slider

Previous | Next
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1 ~ Something for Everybody - iTunes LP =} Devo ‘Something for Eve... Alternati
24 o Fresh = 3:00 Devo Something for Eve... Alterna
3 % WnatweOo 317 Devo Sometning for Eve... Alternati
a4 “ Please Baby Please 2:41 Devo ‘Something for Eve... Alternati
5 @ Don't Shoot (I'm a Man) 3:26 Devo Something for Eve... Alternati
6« Mind Games 2:30 Devo Something for Eve... Alterati
7 @ Human Rocket 3:23 Deve Something fer Eve... Alternati
8 « Sumtin 2:46 Devo Something for Eve... Alternati
9 v Seplp 3:01 Devo Something for Eve... Alternati
10 @ Cameo 2:50 Deve Sometning for Eve...  Alternati
1 « Later Is Now 3:52 Devo ‘Something for Eve... Alternati
12 % NoPlace Like Home 3:18 Devo Something for Eve...  Alternati
13 @ MarchOn 3:51 Deve Something for Eve...  Alternati
14 ~ Wateh Us Work It (Bonus Track) 2:15 Devo Something for Eve... Alternati
15« Signal Ready (Bonus Track) 207 Devo Something for Eve...  Alternati
186 “ Let's Get to It (Bonus Track) 2:56 Devo ‘Something for Eve... Alternati
17 % Knock Boots (Bonus Track) 3:38 Devo Something for Eve... Alternati
18« Fresh = 3:03 Devo Something for Eve... Alternati

Table 12-1

Common iTunes Keyboard Shortcuts

Press This Key or Key Combination To Do This

Spacebar

Play the currently selected song if
iTunes s idle.

Spacebar Pause a playing song.
- Advance to the next song.
«— Go back to the beginning of a song.

Press a second time to return to the
previous song.

38+T

Increase the volume of the music.

38+l

Decrease the volume of the music.

98+0ption+!

Mute the audio if any is playing.
Press again to play the audio.

Playing Digital Audio Files

In addition to playing audio CDs, iTunes can play the digital audio files that
you download from the Internet or obtain from other sources in the WAV,
AAC, Apple Lossless, AIFF, MP2, and MP3 file formats.
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Figure 12-2:
The Music
Library
keeps track
of all your
audio files.
|

Enjoying a digital audio file is just slightly more complicated than playing a
CD. After downloading or saving your audio files to your laptop, open Finder
and navigate to wherever you stored the files. Launch iTunes and click on the
Music icon at the left, then click on the My Music tab near the top center of
the window. Now you can simply drag the music files (or an entire folder of
music) from the Finder window to the My Music list. The added files appear
in the Music section of your iTunes Library. You can also drag a song file
from a Finder window and drop it on the iTunes icon on the Dock, which
adds it to your Music Library as well.

If you click the Playlists tab, iTunes displays the sidebar at the left of the
window, and you can drop the file on top of a playlist name in the list, iTunes
adds it to that particular playlist as well as the main Library. (More about
playlists in a bit.) If you drop a folder of songs on top of the Playlists header
in the sidebar, iTunes creates a new playlist using the name of the folder and
adds all the songs in the folder to the new playlist.

Think of the Library as a master list of your audio and video media. To view
the Music Library, select the Music icon (which looks like a musical note)
under the Play, Previous, and Next controls, and click the My Music tab near
the top center of the iTunes player, as shown in Figure 12-2. (Go figure.) In

a similar manner, you can view your movies and TV shows by clicking their
icons under the Play, Previous, and Next controls — right now, however,
the focus is on music, so I'll discuss playing video in more depth later in

this section.

°ce WP — - I phyz. ot ok 0n 4 122 e = @ - a- <
1t
NEBoODEmEAR MyMusic  Playlists Match Radio  iTunes Store Songs v

¥ Name ) Time Artist Album ~ Genre Rating Plays
« | Do, | Do, | Do, 1 Do, 1 Do 3118 ABBA ABBA Gold Britburn
« The Real World 3:35 Owl City All Things Bright And Beautiful Alternative
“ Angels 3:40 Owl City All Things Bright And Beautiful  Alternative
“ Dreams Don't Turn To Dust 3:45 Owl City All Things Bright And Beautiful  Alternative
« Kamikaze 3:28 Owl City All Things Bright And Beautiful  Alternative
« Galaxies 4:03 Owl City All Things Bright And Beautiful Alternative
# Hospital Flowers 3:39 Owl City All Things Bright And Beautiful Alternative
« The Yacht Club 4:33 0wl City All Things Bright And Beautiful  Alternative

W @ I've Got The World On A String 2:14 Frank Sinatra The Best Of The Capitol Years  Easy Listening
« South Of The Border 2:53 Frank Sinatra The Best Of The Capitol Years Easy Listening
= | Get A Kick Out Of You 2:55 Frank Sinatra The Best Of The Capitol Years Easy Listening
% Young At Heart 261 Frank Sinatra Tne Best Of The Capitol Years  Easy Listening
« Three Coins In The Fountain 3907 Frank Sinatra The Best Of The Capitol Years Easy Listening
% WhatIs This Thing Called Love 2:34 Frank Sinatra The Best Of The Capitol Years  Easy Listening
I The s Smat Hours O T o So1 Fanksnan e bestot e Coptiews sy Liening
# Leamin’ The Blues 3:04 Frank Sinatra The Best Of The Capitol Years Easy Listening
« (Love Is) The Tender Trap 3:01 Frank Sinatra The Best Of The Capitol Years Easy Listening
# You Make Me Feel 5o Young 2:50 Frank Sinatra The Best Of The Capitol Years  Easy Listening
« I've Got You Under My Skin 3:46 Frank Sinatra The Best Of The Capitol Years Easy Listening 1
« (How Little It Matters) How Little We Know 2:40 Frank Sinatra The Best Of The Capitol Years Easy Listening 1

To play a song, just double-click it in the Music list. Alternatively, you can use
the playback controls (Play, Previous, and Next) that I discuss earlier in this
chapter (refer to Figure 12-1).
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& The iTunes window can play media from a surprising number of possi-

ble sources:

v~ Library: The icons at the left of the screen can display Music, Movies,
TV Shows, Podcasts, iTunes U, Apps (for iPhone, iPod touch, and iPad),
Audiobooks, and Tones (ringtones for both mobile devices and your
laptop). If you don’t see all of these choices, click the ellipses icon
(which bears three dots) to display additional Library categories.

v Store: | discuss this music source in the final section “Buying Digital
Media the Apple Way.”

v Shared: If another Mac or PC on your local network is running iTunes
and is set to share part or all of its library, you can connect to the other
computer for your music.

v Devices: If an iPod is connected, it appears as an icon. (And yes,
Virginia, other models of MP3 players from other companies also appear
in the list if they are supported in iTunes.) If you connect an iPhone or
iPad to your Mac, it shows up here as well.

v Genius: Click Store Turn On Genius from the iTunes menu to allow
iTunes to automatically create playlists from songs in your iTunes Music
Library. You can also allow Genius to recommend music, movies, and
TV shows based on the titles you already have in your iTunes Library.
(More on this feature later in the chapter.)

v+ Audio CD: A standard audio CD ... anything from the Bee Gees to
Justin Timberlake shows up in as an icon if you load the CD into your
optical drive.

+* Home Sharing: You can turn on Home Sharing to share your Mac’s
media library across your wireless network with up to five other Mac
computers, as well as iPhones, iPads, and the iPod touch. (More on
Home Sharing later in this chapter.)

v~ Playlists: Think of playlists as folders you use to organize your music.
(More on playlists later in this chapter.)

\3
P If you've invested in an Apple TV, it appears in the list as well, allowing
iTunes to share media with your Apple TV, which in turn sends it to your HD-
(high definition) TV.

You can browse your Music Library in a number of ways: first, click the
Music icon to display your music. By default, the application uses Songs view
mode (active in Figure 12-2), where each song is one entry. Then click the
View Options pop-up menu at the upper-right corner of the window (directly
under the Search box) to display your music in different formats:

v Browse your Library by albums
v Group tracks by artists
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v Group tracks by composers

v Browse by musical genres

From the Music Library, you can also view your iTunes Radio stations, visit
the iTunes Store or see your iTunes Match library in iCloud. All three modes
require an Internet connection, and I cover them later in the chapter.

If you're using the Songs view mode, the Music Library may display informa-
tion for each song that you add to it, including these items:

v Name: The title of the song
v Time: The length of the song
v Artist: The artist who performs the song

v Album: The album on which the song appears

If any song you're adding doesn’t display anything for the title, album, or
artist information, don’t panic; most MP3 files have embedded data that
iTunes can read. If a song doesn’t include any data, you can always add the
information to these fields manually. I show you how later, in the section
“Setting or changing the song information manually.”

Clicking any column heading in Songs view mode causes iTunes to reor-

der the Library according to that category. For example, clicking the Name
column heading alphabetizes your Library by song title. I often click the Time
heading to sort my Library according to the length of the songs. Oh, and

you can drag column titles to reorder them any way you like (except for the
check box column at the far left, which remains fixed).

Browsing the Library

After you add a few dozen songs to iTunes, viewing the Library can become a
task. Although a master list is nice for some purposes, it becomes as cumber-
some as an elephant in a subway tunnel if the list is very long. To help out,
iTunes can display your Library in another format, too: namely, browsing
mode. To view the Library in browsing mode, click the View Options pop-up
menu and select Songs view mode, then click View= Column Browser => Show
Column Browser. (Keyboard mavens can simply press the 38+B keyboard
shortcut to switch to browsing mode.)

The Browse mode of iTunes displays your library in a compact fashion, orga-
nizing your tunes into up to five sections:

v Genres
1V Artists

Chapter 12: The Multimedia Joy of iTunes 2 ’ 7
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Will | trash my Count Basie?

Novice iTunes users, take note: iTunes watches
your back when you trash tracks.

To illustrate: Suppose you delete a song from
the Library that’s located only in the iTunes
music folder (which you didn’t copy into iTunes
from another location on your hard drive). That
means you're about to delete the song entirely,
and there’ll be no copy remaining on your
MacBook. Rest assured, though, that iTunes
prompts you to make sure you really want to
move the file to the Trash. (I get fearful email

messages all the time from readers who are
loath to delete anything from iTunes because
they're afraid they’ll trash their digital music
files completely.)

Remember:|f you delete a song from the Library
that also exists elsewhere on your hard drive
(outside the reach of the iTunes music folder),
it isn't deleted from your hard drive. If you
mistakenly remove a song that you meant to
keep, just drag it back into iTunes from Finder,
or even from the Trash. ‘Nuff said.

v Albums
v Composers

v Groupings

Selecting an artist from the Artist list in Browse mode causes iTunes to dis-
play that artist’s albums in the Album list. Select an album from the Album
list, and iTunes displays that album’s songs in the bottom section of the
Browse window. (Those Apple software designers . . . always thinking of you
and me.) You can also specify which sections you want included in Browse
mode from the View=> Column Browser menu — click a section name to
toggle the display of that section on or off. (For example, the display of the
Composers and Groupings sections is toggled off by default.)

Finding songs in your Music Library

After your collection of audio files grows large, you might have trouble locat-
ing that Swedish remix version of “I'm Your Boogie Man.” To help you out,
iTunes has a built-in Search function. To find a song, type some text into the
Search box of the main iTunes window. While you type, iTunes tries to find
a selection that matches your search text. The search is thorough, showing
any matching text from the artist, album, song title, and genre fields in the

results. For example, if you type Electronic into the field, iTunes might return

results for the band named Electronic or other tunes that you classified as
electronic in the Genre field. (The section “Know Your Songs,” later in this
chapter, tells you how to classify your songs by genre, among other options.)
Click the magnifying glass at the left side of the Search field to restrict the
search even more: by Artists, Albums, Composers, and Songs.
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Removing old music from the Library

After you spend some time playing songs with iTunes, you might decide that
you didn’t really want to add 40 versions of “Louie Louie” to your Library.

(I prefer either the original or the cast from the movie Animal House.) To
remove a song from the Library, click the song to select it and press the
Delete key on your keyboard, or right-click the song entry and choose Delete
from the menu.

You can also remove a song from the Library by dragging it to the Trash
on the Dock.

Watching Video

==

Watching video in iTunes is similar to listening to your music. To view your
video collection, click the Movies or TV Shows icons at the upper left of
the iTunes window. iTunes displays your videos as thumbnails or in a list,
depending on the View Options setting. Music videos appear as a Smart
Playlist within the iTunes sidebar. (Read more about these in the section,
“Some playlists are smarter than others.”)

From your collection, you can do the following:

v Double-click a video thumbnail or an entry in the list.

v Drag a QuickTime-compatible video clip from the Finder window to
the iTunes window. (These clips typically include video files ending in
.mov, .mv4, or .mp4.)

iTunes plays video in the box below the Source list, within the iTunes
window or in full-screen mode, depending on the settings you choose from
the View=> Video Playback menu. In full-screen mode, move your mouse to
display a control strip at the bottom of the screen, sporting the standard
slider bar that you can drag to move through the video (as well as a volume
control and Fast Forward/Reverse buttons). You can also pause the video by
clicking the Pause button.

Keeping Slim Whitman and Slim Shady
Apart: Organizing with Playlists

As I mention earlier, the iTunes Music Library can quickly become a fear-
somely huge beastie. Each Library can contain thousands upon thousands of
songs: If your Library grows anywhere near that large, finding all the songs in
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your lifelong collection of Paul Simon albums is not a fun task. Furthermore,
with the Library, you're stuck playing songs in the order that iTunes
lists them.

To help you organize your music into groups, use the iTunes playlist feature.
Typically, a playlist is a collection of some of your favorite songs from the
Library, but playlists can also include media like movies and audiobooks.
You can create as many playlists as you want, and each playlist can contain
any number of items. Whereas the Music Library lists all available songs, a
playlist displays only the items that you add to it. Further, any changes you
make to a playlist affect only that playlist, leaving the Library untouched.

To create a playlist, you can do any of the following:

v Choose File> Newr> Playlist.
v Press 38+N.

v Choose File = New=> Playlist from Selection. This creates a new playlist
and automatically adds any tracks that are currently selected.

1 Right-click a song, and click Create Genius Playlist from the menu
that appears. iTunes builds a playlist of songs that are similar in some
way (typically by matching the genre of the selection or the beats per
minute, but also based on recommendations from other iTunes mem-
bers). Note that your MacBook needs an Internet connection to create
a Genius playlist, and the larger your music library, the longer it takes
iTunes to build your playlist. You also need to turn on the Genius feature
by clicking Store= Turn on Genius and entering your Apple ID. (Note
that Genius playlists can sometimes mix tracks containing explicit con-
tent with less objectionable material — especially in the comedy and
rap genres.)

v Drag a folder containing audio files from a Finder window onto the
Playlists heading in the sidebar.

v Click the New button in the iTunes window (the plus sign button in
the lower-left corner), and choose New Playlist. You get a newly cre-
ated empty playlist (the toe-tappin’ untitled playlist).

All playlists appear in the iTunes sidebar, which you can always display in
your Music Library by clicking the Playlists tab near the top of the screen.

To help organize your playlists, it’s a good idea to . . . well, name them.
(Aren’t you glad now that you have this book?) For example, suppose that
you want to plan a party for your polka-loving friends. Instead of running

to your computer after each song to change the music, you could create a
polka-only playlist. Select and start the playlist at the beginning of the party,
and you won’t have to worry about changing the music the whole night. (You
can concentrate on playing the accordion.) To load a playlist, select it in the
Source list; iTunes displays the songs for that playlist.



actual songs, movies, or TV shows themselves. Add and remove them at will
to or from any playlist, secure in the knowledge that the items remain safe in
your Library. Removing a playlist is simple: Select the playlist in the sidebar,
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iTunes can display a playlist in three ways. By default, the application uses
the List view, in which each song is one entry. If you've selected a playlist in
the sidebar, you can click the View Options pop-up menu at the upper right

A\
of the iTunes window and choose to display the contents of the playlist by
Album, Artists, Composers, or Genres as well.
The same items can appear in any number of playlists because the items in
a playlist are simply pointers to the media in your Music Library — not the
\‘&MBER and press Delete.
Y

Removing a playlist does not delete any songs from your Library.

Some playlists are smarter than others

You can create a Smart Playlist in the iTunes
sidebar by choosing File> New Smart Playlist,
or by clicking the Add button (a plus sign) at the
bottom of the Source list and selecting New
Smart Playlist.

The contents of a Smart Playlist are auto-
matically created from a specific condition
or set of conditions that you set via the Smart
Playlist dialog: You can limit the track selection
by mundane things, such as album, genre, or
artist; or you can get funky and specify songs
that were played last, or by the date you added
tracks, or even by the sampling rate or total
length of the song. For example, iTunes can
create a playlist packed with songs that are
shorter than three minutes, so you can fill your
iPod Shuffle with more stuff! If you want to add
another criterion, click the plus sign at the right
side of the dialog and you get another condition
field to refine your selection even further.

You can choose the maximum songs to add to
the Smart Playlist, or limit the size of the playlist
by the minutes or hours of play or the number of
megabytes or gigabytes the playlist will occupy.

(Again, this is great for automatically gathering
as much from your KISS collection as will fit
into a specific amount of space on a CD or your
iPod.) Mark the Live Updating check box for the
ultimate in convenience. iTunes automatically
maintains the contents of the Smart Playlist to
keep it current with your conditions at all times
in the future. (If you remove tracks manually
from a Smart Playlist, iTunes adds other tracks
that match your conditions.)

Now think about what all these settings mean
when combined . . . whoa. Here's an example
yanked directly from my own iTunes library.
| created a Smart Playlist that selects only
those songs in the Rock genre. It's limited to
25 songs, selected by least often played, and
live updating is turned on. The playlist is named
Tracks I've Gotta Hear because it finds the 25
rock songs (from my collection of more than
10,000 songs) that I've heard least often! After |
listen to a song from this Smart Playlist, iTunes
automatically “freshens” it with another song,
allowing me to catch up on the tracks I've
been ignoring.

221
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Know Your Songs

Besides organizing your music into Elvis and non-Elvis playlists, iTunes
gives you the option to track your music at the song level. Each song you
add to the Music Library has a complete set of information associated
with it. iTunes displays this information (see upcoming Figure 12-3) on the
Details tab:

+* Song Name: The name of the song

v Artist: The name of the artist who performed the song

v~ Album Artist: The name of the artist responsible for a compilation or
tribute album

v Album: The album where the song appears

v Grouping: A group type that you assign

»* Composer: The name of the astute individual who wrote the song
+ Comments: A text field that can contain any comments on the song
v Year: The year the artist recorded the song

v Track: The position of the song on the original album

1 Genre: The classification of the song (such as rock, jazz, or pop)
v Disc Number: The original disc number in a multi-CD set

v BPM: The beats per minute (indicates the song’s tempo)

You can display this information by clicking a song name and pressing 38+I1.
The fields appear on the Details tab.

Setting the song information
automatically

Each song you add to the iTunes Music Library might have song informa-
tion included with it. If you add music from a commercial audio CD, iTunes
connects to a server on the Internet and attempts to find the information for
each song on the CD. If you download a song from the Internet, it often comes
with some information embedded in the file already; the amount of included
information depends on what the creator supplied. (And it’s often misspelled
as well — think Leenard Skeenard.) If you don’t have an Internet connection,
iTunes can’t access the information and displays generic titles instead.
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Figure 12-3:
View and
edit song

information

here.
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Setting or changing the song
information manually

If iTunes can’t find your CD in the online database or someone gives you an
MP3 with incomplete or inaccurate information, you can change the informa-
tion yourself — believe me, you want at least the artist and song name! To
view and change the information for a song, follow these steps:

1. Select the song in either the My Music list or a playlist.

2. Press 38+1, or choose File > Get Info.

3. Click a field to edit the song’s information on the Details tab, as shown
in Figure 12-3.

You can move to the next or previous tracks in the Music Library list or play-
list by clicking the Next or Previous buttons at the bottom left of the dialog.

< II »> . Up from the QF::. 1V Ar ns?.zl"ﬂ f‘l‘n Rig In One Swift Bite = @ Mark ~
A BEBOwEA W -
+ Name el Up ItArose and Ate... Plays
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“ 1Want A New Duck ‘The Essential George Duke 1
“ Cne More Minute 1
“ Yoda QEEEEN Anwork  Lyrcs  Options  Sorting  File
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| CLaC Gt A e i 5 4123 Up from the Sea It Arose and Ate Rio In One Swift E
« Girls Just Want To Have Lunch 2:49 Gaorge Duke
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+ cabe v P Tha Essantial George Duke
« Hooked On Polkas 352 Gearge Duke 2
“ 'Seuse Me Miss 333 G, Duke 2
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« Sweet Baby 3:48 George Duke The Essentlal George Duke Jazz 1
# | Just Want t0 Love You 3:52 George Duke &S.. The Essential George Duke Jazz
“ You 4:39 George Duke The Essential George Duke Jazz

The more work you put into setting the information of the songs in your
Music Library, the easier it is to browse and use iTunes. Incomplete song
information can make it more difficult to find your songs in a hurry. If you
prefer, you don’t have to change all information about a song (it just makes
life easier later if you do). Normally, you can get away with setting only a
song’s title, artist, and genre. The more information you put in, however, the
faster you can locate songs and the easier they are to arrange. iTunes tries to
help by automatically retrieving known song information, but sometimes you
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have to roll up your sleeves and do a little work. (Sorry, but some things just
can’t be automated.)

“What about cover art, Mark?” Well, I'm overjoyed that you asked! iTunes
can try to locate artwork automatically for the tracks you select. (Note that
embedding large images can significantly increase the size of the song file.)
Follow these steps:

1. Select the desired songs from the track list.
2. Choose File= Library=> Get Album Artwork.

You can set iTunes to automatically attempt to add album artwork every
time you rip tracks from an audio CD (as described in the next section),

or when you add songs without artwork to your Music Library. Select
iTunes ™ Preferences = Store, and select the Automatically Download Album
Artwork check box. (By the way, if you buy tracks or an album from the
iTunes Store, Apple includes album covers automatically!)

Want to manually add album covers to your song info? If you select just one
song in the track list, display the Info dialog and click the Artwork tab. If
you select multiple songs from the same album, display the Info dialog. Now
launch Safari, visit Amazon.com, and do a search on the same album (or
search an online artwork library, such as AllICDCovers.com). Drag the cover
image from the web page right into the Info dialog, and drop it on top of the
“sunken square” Artwork image well. When you click OK, the image appears
in the Artwork tab of the Info dialog.

Ripping Audio Files

You don’t have to rely on Internet downloads to get audio files: You can
create your own MP3, AAC, Apple Lossless, AIFF, and WAV files from your
audio CDs with iTunes. The process of converting audio files to different for-
mats is ripping. (Audiophiles with technical teeth also call this process digi-
tal extraction, but they’re usually ignored at parties by the popular crowd.)
Depending on what hardware or software you use, each has its own unique
format preferences.

The most common type of ripping is to convert CD audio to MP3 (or AAC)
format. To rip MP3s from an audio CD, follow these simple steps:
1. Launch iTunes by clicking its icon on the Dock.

Alternatively, you can locate iTunes in your Applications folder or in
Launchpad.
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2. Choose iTunes~ Preferences.
3. In the Preferences dialog that appears, click the General tab.

4. Click the Import Settings button that appears at the bottom of the

Preferences dialog.

5. Choose MP3 Encoder from the Import Using pop-up menu.
6. Choose High Quality (160 Kbps) from the Setting pop-up menu, and

click OK to return to the Preferences dialog; click OK again to return
to iTunes.

This bit rate setting provides the best compromise between quality (it
gives you better than CD quality, which is 128 Kbps) and file size (tracks
you rip will be significantly smaller than audiophile bit rates such as 192
Kbps or higher).

. Load an audio CD into your Mac’s optical drive.

The CD title shows up in the iTunes Source list (under the Devices head-
ing), which is on the left side of the iTunes window. The CD track listing
appears on the right side of the window.

If iTunes asks whether you want to import the contents of the CD into
your Music Library, you can click Yes and skip the rest of the steps; how-
ever, if you've disabled this prompt, just continue with the remaining
two steps.

. Clear the check box of any song you don’t want to import from the CD.

All songs on the CD have a check box next to their title by default.
Unmarked songs aren’t imported. The Browse button changes to
Import CD.

. Click the Import CD button.

Tweaking the Audio for Your Ears

Besides the standard volume controls that [ mention earlier in this chapter,
iTunes offers a full equalizer. An equalizer permits you to alter the volume of
various frequencies in your music, allowing you to boost low sounds, lower
high sounds, or anything in between.

To open the Equalizer, choose Window=>Equalizer or press 38+Option+2.
Use the leftmost slider (Preamp) to set the overall level of the Equalizer.
The remaining sliders represent various frequencies that the human ear can
perceive. Setting a slider to a position in the middle of its travel causes that
frequency to play back with no change. Move the slider above the midpoint
to boost that frequency; conversely, move the slider below the midpoint to
reduce the volume of that frequency.
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Continue adjusting the equalizer sliders until your music sounds the way you
like it. In case you prefer to leave frequencies to the experts, the iTunes Equalizer
has several predefined settings to match most musical styles. Open the pop-up
menu at the top of the Equalizer window to choose a genre. When you close the
Equalizer window, iTunes remembers your settings until you change them again.

A New Kind of Radio Station

Besides playing back your favorite audio files, iTunes can also tune in
Internet radio stations from around the globe. You can listen to any of a large
number of preset stations, seek out lesser-known stations not recognized

by iTunes, or even add your favorite stations to your playlists. You can also
use the iTunes Radio feature to create a custom station dedicated to just the
genres and artists you prefer. This section shows you how to do it all.

Internet Radio

Although it’s not a radio tuner in the strictest sense, iTunes can locate virtual
radio stations all over the world that send audio over the Internet — a pro-
cess usually dubbed streaming. iTunes can track down hundreds of Internet
radio stations in a variety of styles with only a few mouse clicks.

To begin listening to Internet radio with iTunes, click the Internet Radio
button located at the top of the window. The result is a list of more than 20
types of radio stations, organized by genre.

When you expand an Internet category by clicking its disclosure triangle,
iTunes queries a tuning server and locates the name and address of dozens
of radio stations for that category. Whether you like Elvis or not-Elvis (those
passing fads, such as new wave, classical, or alternative), something’s here
for everyone. The Internet also offers news, sports, and talk radio.

When choosing an Internet radio station, you can listen to stations broadcasting at 128
keep your Internet connection speed in mind.  Kbps (or even higher). The higher the bit rate,
If you're using a broadband DSL or cable the betterthe music sounds. At 128 Kbps in AAC
connection — or if you're listening at work format, for example, you're listening to sound
over your company'’s high-speed network —  that's as good as an audio CD.

What's with the numbers next
to the station names?
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After iTunes fetches the names and descriptions of radio stations, double-
click one that you want to hear. iTunes immediately jumps into action, loads
the station, and begins to play it.

Tuning in your own stations

Although iTunes offers you a large list of popular radio stations on the web,
it’s by no means comprehensive. Eventually, you might run across a radio
station that you’d like to hear, but don’t find listed in iTunes. Luckily, iTunes
permits you to listen to other stations, too. To listen to a radio station that
iTunes doesn’t list, you need the station’s web address.

In iTunes, choose File=> Open Stream (or press 38+U). In the Open Stream
dialog that appears (as shown in Figure 12-4), enter the URL of your desired
radio station and click OK. In seconds, iTunes tunes in your station.

Radio stations in your playlists

If you find yourself visiting an online radio station more than once, you’ll be
glad to know that iTunes supports radio stations in its playlists. To add a
radio station to a playlist from the Radio list, follow these steps:

1. Open the category that contains the station you want to add to your
playlist.

2. Locate the station you want to add to your playlist, and drag it from
the Radio list to the desired playlist on the left.

If you haven'’t created any playlists yet, see the section “Keeping Slim
Whitman and Slim Shady Apart: Organizing with Playlists” earlier in this
chapter to find out how.

Have an itch to hear “Kung Fu Fighting”?

This particular technology author has a
preference for a certain hot jam spot: MLC
Radio, the Internet radio station I've been
running for several years now. | call my station
a '70s Time Machine because it includes
hundreds of classic hits from 1970-1979. You
hear everything from “Rock and Roll Hoochie
Koo” by Rick Derringer to “Moonlight Feels

Right” by Starbuck. (Hey, I'm summing up a
decade here, so be prepared for both Rush and
the Captain & Tennille.) The station broadcasts
at 128 Kbps (audio CD quality), so you need
a broadband connection to listen. For the
station’s Internet address or to ask for help
connecting to MLC Radio, visit my website at
www . mlcbooks . com!
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Figure 12-4:
Tuning into
MLC Radio,
my Internet
radio
station.
|
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You can also follow the same steps to add a radio station that doesn’t appear
in the Radio list! iTunes allows you to load a radio station URL manually by
choosing File=> Open Stream, and any station that you play using the Open
Stream command is automatically added to your My Music list. Therefore,
you can drag the station from the My Music list to any playlist.

Creating a custom iTunes Radio station

The recent addition of iTunes Radio makes it possible for you to listen to

the artists, songs, and genres that you prefer in iTunes, without selecting a
specific Internet radio station! To use iTunes Radio, click the Radio button at
the top of the iTunes window, and type the artist name, song name, or genre
you’d like to add to your station.

As you download new music from the iTunes Store (and add new artists and
genres in iTunes Radio), the service learns more about your musical tastes
and can automatically play and recommend new music, much like the Genius
feature I discussed earlier in this chapter.

Like Internet radio, the iTunes Store, and Apple’s iTunes Match subscription
service (described in the next section), iTunes Radio requires an Internet
connection and an Apple ID.

Your iTunes Radio station is automatically shared among all your Macs
running OS X Lion or later (as well as any devices you own running iOS 7
or later).
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iTunes and iCloud Together
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iTunes is connected closely with the Apple iCloud service, allowing you to
share music betwixt all your Macs and iOS devices. But how do you pull
your audio and video out of that floating nimbus? Try this: choose

iTunes = Preferences, click the Store tab, click the Show iTunes in the Cloud
Purchases check box to enable it, and click OK. Now sign in with your Apple
ID for a surprise. Bam — all the audio and video you’ve purchased from the
iTunes Store appears in your Library! Note, however, that those items don’t
exist on your local drive. Consider those entries placeholders for the stuff
you can download, allowing you to see (and search for) what’s available
through iCloud. (And if you’ve purchased as much from the iTunes Store as
[ have, you'll save many gigabytes of storage space on your laptop’s drive by
downloading only certain songs.)

To download a local copy of any iCloud item, simply click the iCloud icon
next to the item. After the local copy has been saved to your Mac’s drive, the
iCloud icon disappears and you're ready to listen or watch your purchase.

To hide the iCloud placeholder entries from your Library and display just the
stuff you’ve got on your Mac’s drive, click View = Hide Music in the Cloud.

Apple’s iTunes Match subscription service builds on this same functionality,
allowing you to store all your music in iCloud (including the songs you’ve
ripped from audio CDs and downloaded from other sources) and listen to it
on any of your Macs, PCs or iOS devices! When you join iTunes Match, all the
songs that aren’t available from the iTunes Store are automatically uploaded
to iCloud.

At the time of this writing, the service is $25 a year and is limited to a maxi-
mum of 10 devices and 25,000 songs (note that purchases you make from the
iTunes Store don’t count toward that 25,000-song limit).

To subscribe to iTunes Match or manage your Match storage, click the Match
button at the top of the iTunes window.

iSending iStuff to iPod, iPhone, and iPad

If you're cool enough to own an iPod, you’ll be happy to know that iTunes
has features for your personal audio and video jukebox as well. iPods, Apple’s
multimedia players, comprise an entire family of portable devices ranging
from $49 to about $249. They can hold anywhere from several hundred to lit-
erally thousands of songs, as well as podcasts, photos, and video. This great
gadget and those like it have become known worldwide as the preferred por-
table digital media players.
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If you own an iPod touch, iPhone, or iPad, you probably already know that
these devices can act as your music player as well. You can buy all sorts of
applications for these devices at the iTunes Store. iTunes even keeps track of
these applications as part of your iTunes Library.

In order to sync correctly, both your computer and the device must share the
same Apple ID!

You connect your iPod to any Macintosh or Windows PC that has USB 2.0 ports
using the included cable. After the iPod is connected, you can synchronize it
with iTunes. By default, this process is automatic: The iPod and the iTunes soft-
ware communicate with each other and figure out what items are in your iTunes
Library (as compared to the iPod Library). If they discover songs, podcasts, and
video in your iTunes Library that are missing from your iPod, the items auto-
matically transfer to the iPod. Conversely, if the iPod contains stuff that’s no
longer in iTunes, the iPod automatically removes those files from its drive.

Go back and reread that last sentence about how the iPod automatically
removes files from its drive. (I'll wait.) Apple added this feature in an effort

to be responsive to copyright concerns. The reasoning is that if you connect
your iPod to your friend’s computer, you can’t transfer songs from the iPod
to that computer. Of course, you could always look at it from the marketing
perspective as a feature that makes sure your MacBook and iPod are always
in total sync. Whatever the case, pay close attention and read all warning dia-
logs when connecting to a computer other than your own, or you might wipe
out your iPod’s library.

You can change your settings on the device’s Summary pane so iTunes auto-
syncs only selected playlists (click on the device icon at the upper left of the
window to display the Summary pane). Or, if you're really nervous, you can
choose to manually manage the contents of your iPod with iTunes from the
Summary pane.

Sharing Your Media Across Your Network

Ready to share your music, podcasts, and video — legally, mind you — with
other folks on your local network? You can offer your digital media to other
iTunes users across your home or office. Follow these steps:

1. Choose iTunes~ Preferences to open the Preferences dialog.

2. Click Sharing.

3. Select the Share My Library on My Local Network check box.
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4. Specify whether you want to share your entire library or only selected
playlists and files.

Sharing selected playlists is a good idea for those Meatmen and Sex
Pistols fans who work at a cubicle farm in a big corporation.

5. If you want to restrict access to just a few people, select the Require
Password check box; then type a password in the text box.

6. Click OK.

Your shared folder appears in the sidebar for all iTunes users who enable the
Shared Libraries check box on the General pane of their iTunes Preferences
dialog. Note that the music you share with others can’t be imported or
copied, so everything stays legal.

Want to change that frumpy default name for your shared media library
to something more exotic, like “Dan’s Techno Beat Palace”? No problem.
Display the Preferences dialog again, click the General tab, and click in the
Library Name text box. Edit your network entertainment persona to your
heart’s content.

3

You can also share your media library using Home Sharing, which allows
others join in the fun — including up to five Mac computers and iOS devices
(your iPad, iPhone, and iPod touch, running iOS 4.3 or later). Home Sharing
requires a network connection for all your devices, and you have to enter
the same Apple ID information on each device. To turn on Home Sharing

in iTunes, click iTunes = File> Home Sharing, and choose Turn On Home
Sharing. (Don’t forget to repeat this setup on each computer and iOS device.)
After Home Sharing is enabled, a Shared Libraries pop-up menu appears next
to the Music icon — click the menu to switch between libraries.

Sending music elsewhere with AirPlay

If you're using an AirPort Express portable
wireless Base Station, you can ship your songs
right to your Base Station from iTunes, and from
there to your home stereo or hoombox! Pick up
an AirPlay-enabled sound system, and you can
eliminate the stereo or boombox and the AirPort
Express device entirely. (I get into some serious
discussion of AirPort Express in Chapter 11.)

After your AirPort Express Base Station
is plugged in and you connect your home

stereo (or a hoombox or a pair of powered
stereo speakers) to the stereo minijack on
the Base Station, you see a Speakers pop-
up list button appear at the bottom of the
iTunes window.

Click the Speakers button, and you can
choose to broadcast the music you're playing
in iTunes across your wireless network. Ain't
technology truly grand?
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Burning Music to Shiny Plastic Circles
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Besides being a great audio player, iTunes is adept at creating CDs, too. (Of
course, your MacBook must have either an internal SuperDrive or an external
optical drive to record them.) iTunes makes the process of recording songs
to a CD as simple as a few mouse clicks. Making the modern version of a
compilation (or mix) tape is easier than getting a kid to eat ice cream. If you
have an internal or external optical drive, iTunes lets you burn CDs in one of
three formats:

v Audio CD: This format is the typical kind of commercial music CD you
buy at a store. Most typical music audio CDs store up to 800MB of data,
which translates into about 80 minutes of music.

v Data CD or DVD: A standard computer CD-ROM or DVD-ROM is
recorded with the audio files. This disc can’t be played in any standard
audio CD player (even if it supports MP3 CDs, which I discuss next).
Therefore, you can listen to these songs only by using your Mac and an
audio player, such as iTunes or a PC running Windows.

v MP3 CD: As does the ordinary computer CD-ROM that [ describe, an
MP3 CD holds MP3 files in data format. However, the files are arranged
in such a way that they can be recognized by audio CD players that sup-
port the MP3 CD format (especially boomboxes, DVD players, personal
CD players, and car stereos). Because MP3 files are so much smaller
than the digital audio tracks found on traditional audio CDs, you can fit
as many as 160 typical four-minute songs on one disc. These discs can
also be played on your Mac via iTunes.

Keep in mind that MP3 CDs aren’t the same as the standard audio CDs you
buy at the store, and you can’t play them in older audio CD players that don’t
support the MP3 CD format. Rather, this is the kind of archival disc that you
burn at home for your own collection or for use in a CD/DVD player or car
audio system that supports MP3 discs.

To begin the process, build a playlist (or select an existing playlist that you
want to record). If necessary, create a new playlist and add to it whatever
songs you would like to have on the CD. (See the earlier section, “Keeping
Slim Whitman and Slim Shady Apart: Organizing with Playlists,” if you need
arefresher.) With the songs in the correct order, right-click the playlist and
choose Burn Playlist to Disc to commence the disc-burning process. Click
the desired recording format (again, usually Audio CD) in the Burn Settings
dialog that appears.
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To save yourself from sonic shock, [ always recommend that you enable the

Sound Check check box before you burn. iTunes adjusts the volume on all
the songs on your audio CD so they play at the same volume level.

Ready to go? Click Burn, and load the blank disc. iTunes lets you know when
the recording is complete.

Feasting on iTunes Uisuals

By now, you know that iTunes is a feast for the ears, but did you know that
it can provide you with eye candy as well? With just a click or two, you can
view mind-bending graphics that stretch, move, and pulse with your music.

To begin viewing iTunes visuals, choose View = Show Visualizer (or press
38+T). Immediately, most of your iTunes interface disappears and begins
displaying groovy lava lamp-style animations (like, sassy, man). To stop the
visuals, choose View=> Hide Visualizer (or press 38+T again). The usual sunny
aluminum face of iTunes returns.

You can also change the viewing size of the iTunes visuals in the View menu.
Select View > Enter Full Screen (or press 38+Control+F). To escape from the
Full Screen Visuals mode, press Esc, or simply press 38+Control+F again.
» You can still control iTunes with the keyboard while the visuals are zooming
around your screen. See Table 12-1 earlier in this chapter for a rundown on
common keyboard shortcuts.

Exercising Parental Authority

Do young children use your Mac? I'll be honest here: A large amount of con-
tent in the iTunes Store, including audio, movies, and even apps, is stuff [
don’t consider suitable for kids. And what about the media that others in the
family may decide to share? Such is the world we live in today, and the good
folks at Apple recognize that you may not want to inadvertently allow your
kids to have access to explicit content.

Luckily, you can use the Parental settings in iTunes to build a secure fence

around content that’s for grown-ups only. Heck, you can even banish items
from the Source list entirely. Figure 12-5 illustrates the Parental Preferences
pane in the iTunes Preferences dialog.
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Figure 12-5:
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You must log in with an Administrator account to change these settings, just
like with the Parental Controls in the System Preferences dialog. If the set-
tings are locked — the padlock icon at the bottom of the dialog is closed —
click the padlock and supply your administrator password to unlock them.
(Read more about Parental Controls in Chapter 10.)

To enable parental control, follow these steps:

1. Choose iTunesr> Preferences.
2. Click the Parental tab.

3. Select any of the Disable check boxes to prevent access to those
features.

Disabling features in iTunes applies to all user accounts — no matter
who is logged in! Notice that any features you disable disappear com-
pletely from the Source list at the left side of the iTunes window after
you click OK at the end of these steps.

4. Click the Ratings For pop-up menu, and choose your country.

Because Apple maintains separate iTunes Stores for different nations,
you can choose which country’s iTunes Store to monitor. If you like, you
can disable the display of content ratings in your iTunes library by dese-
lecting the Show Content Ratings in Library check box.



Chapter 12: The Multimedia Joy of iTunes 235

5. To restrict specific content in the iTunes Store, select the check box
next to the source, and make choices from the corresponding pop-up
menu to choose the restriction level.

Note that these restrictions apply only to content in the iTunes Store,
content that can be downloaded through iCloud, and media shared with
your Mac. Content in your iTunes library is never restricted.

- 6. Click the padlock icon at the bottom of the dialog to close it and
53] prevent any changes.

7. Click OK.

Buying Digital Media
the Apple Way

The hottest spot on the Internet for buying music and video is the iTunes
Store, which you can reach from the cozy confines of iTunes. (That is, as long
as you have an Internet connection. If you don’t, it’s time to turn the page to
a different chapter.)

Click the iTunes Store tab near the top of the window, and after a few
moments, you're presented with the latest offerings. Click a link in the store
list to browse according to media type, or click the Power Search link to
search by song title, artist, album, or composer. The Back and Forward but-
tons at the top of the iTunes Store window operate much the same as those
in Safari, moving you backward or forward in sequence through pages you’ve
already seen. Clicking the Home button (which, through no great coinci-
dence, looks like a miniature house) takes you back to the Store’s main page.

To display the details on a specific album, track, video, podcast, or audio-
book (whew), just click it. If you're interested in buying just certain tracks
(for that perfect road warrior mix), you get to listen to 90 seconds of any
track — for free, no less, and at full sound quality. When you’re ready to buy,
click the Buy Now button. (At the time of this writing, tracks are usually 99
cents a pop, and an entire album is typically $9.99 . . . what a bargain!)

The iTunes Store uses your Apple ID to identify you, and it keeps secure
track of your payment information for future purchases. After you use the
iTunes Store once, you rarely have to log in or retype your credit card infor-
mation again.

The tracks and files that you download are saved to a separate playlist called
Purchased. After the download is finished, you can play them, copy them to
other playlists, burn them to CD or DVD, share ’em over your network, or
ship them to your iOS devices using iCloud, just as you can any other item in
your iTunes Library.
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iTunes can automatically download the media you purchase on another
iCloud device (including another Mac and your iPhone, iPad, or iPod touch).
To set up automatic downloading, choose iTunes = Preferences to open

the Preferences dialog, and click the Store tab. After you're signed in at the
iTunes Store, you can choose to download music or app purchases, and you
have the option to check for new downloads automatically. Click OK to save
your changes.



Chapter 13
Focusing on Photos

In This Chapter
Importing pictures from your hard drive or digital camera
Organizing images with Photos
Tweaking the appearance of photographs

Sharing photos with your friends

F)r decades now, the Mac has been the choice of professional photogra-
phers for working with digital images — not surprising, considering the
Mac’s graphical nature. Apple continues this tradition with Photos, its photog-
raphy tool for the home user that can help you organize, edit, and even pub-
lish your photographs. (It sports more features than a handful of Swiss army
knives.) After you shoot your photos with a digital camera, you can import
them into Photo, edit them, and publish them. You're not limited to photos
that you take yourself, either; you can edit, share, and organize all kinds of
digital image files, as well as video clips. You can even create a photo album
and use the Photos interface to order a handsome soft-bound or hard-bound
copy shipped to you, or create a slideshow that you can upload to YouTube.

In this chapter, [ walk you through an overview of what Photos can do. After
that, I give you a brief tour of the controls in Photos so that you can see what
features are available to you, including those for managing, printing, and
publishing your photos.

Delving into Photos

Figure 13-1 shows most of the major controls Photos offers. (Other con-
trols appear automatically when you enter different modes; I cover them in
upcoming sections.)
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Figure 13-1:
Photos
greets you
with an
attractive
window.
|
Sidebar Viewer

These controls and sections of the window are covered in more detail in the
following sections. For now, here’s a quick rundown of what you see when
you launch Photos and click the Photos mode button at the top center of
the screen:

v Toolbar: This group of controls determines how many images the
Photos Viewer will display, and allows you to perform a number of
actions with selected photos.

¢ You can click on the Back and Forward buttons to display photos
by moment (photos taken around the same time and at the same
location), collection (a group of related moments, like each day of
a family reunion) or year (the year the photos were taken). As you
click the Back button, you'll see more images at once. To zoom in
on a specific photo, just click the desired thumbnail.

® You can create new albums, slideshows and print projects (like
books, calendars and cards) using your photos. These new thumb-
nails appear when you click the Albums and Projects mode but-
tons in the Toolbar, which makes it much easier to organize your
photos.
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¢ You can share selected photos in a slew of different ways, includ-
ing Apple Mail, Messages and AirDrop networking, as well as popu-
lar online sites like Facebook, Twitter, and Flickr. If you've enabled
iCloud Photo Sharing, you can also share photos to your other
Macs and iOS devices.

* You can search for specific images. Just click in the box and start
typing to search by description and title, or even Faces and key-
words (which I cover later in the chapter).

v Viewer: This pane displays the images from your Photos Library.

You can click and drag or Command-+click to select photos in the Viewer
for further tricks, such as assigning keywords and image editing.

v~ Split View: If you're displaying a single image from your Library, you
can click the Split View button in the toolbar (or press Option+S) to
open and close the Split View pane. The Split View pane allows you to
quickly switch to another image by clicking on the desired thumbnail —
I find Split View very helpful when I'm editing a number of images taken
around the same time.

v Full Screen: Click the Full Screen/Maximize button at the upper-left
corner of the window to switch to a full-screen display of your photos.
In full screen mode, you can double-click a thumbnail to view the image
using your Mac’s entire screen real estate. (The toolbar is still available
at any time: just move your pointer to the top of the screen to display
it.) Press Esc to return to windowed mode.

Click View=> Always Show Toolbar in Full Screen to prevent the toolbar
from disappearing in full screen mode.

v Zoom: Drag this slider to the left to reduce the size of the thumbnails in
the Viewer. This allows you to see more thumbnails at one time, which
is convenient for quick visual searches. Drag the slider to the right
to expand the size of the thumbnails, making it easier to differentiate
details between similar photos in the Viewer. You can also use the Zoom
slider when a single image is displayed in the Viewer.

v Play Slideshow: Select an album or project (or select multiple images)
in the Viewer and click this button (which bears the familiar Play icon)
to start a full-screen slideshow.

v Add To Favorites: This toolbar button (which bears a heart icon)
appears in the toolbar only while you're viewing or editing a single
image. Click the Add to Favorites button to add the item that’s currently
displayed in the Viewer as a Favorite. (When viewing your Library as
moments or collections, you can also hover your pointer over an item
and click the heart symbol that appears at the top left corner of the
photo.) You can search for Favorite photos using keywords, which I'll
discuss later in the chapter.
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v Info: Again, you'll see this button in the toolbar only while you're view-
ing or editing a single item. Click this button to display information on
the item that’s currently displayed in the Viewer.

v Add To: Click this button to add the currently selected photos to an
existing album, slideshow, or printing project.

v~ Share: Click this button to share the currently selected photos on
Flickr, Twitter, or Facebook. Choose iCloud Photo Sharing to send the
selected photos to your iPhone, iPad, or iPod touch (they’ll appear in
the Photo Stream albums on those devices) or to another Mac. If you
use Apple’s Aperture application to edit or organize photos, you can add
the selected photos to your Aperture library. You can also order prints,
attach the photos to a text message, or email them. (Heck, if you've
got a printer connected to your Mac, you can even produce your own
glossies.)

v~ Edit: Here’s another button that’s displayed in the toolbar only when
you view a single image. Click this button to switch to the editing con-
trols within Photos and make changes to the current image. (I cover
editing in depth later in the chapter.)

v Search: Click within the familiar confines of the Search box to filter
the photos displayed in the Viewer by keyword, description, file-
name, or date.

If you've been using iPhoto for years (as | have) and you miss the familiar
sidebar list of albums and projects, click View> Show Sidebar to toggle your
old friend on and off as needed. Note that the Photos, Shared, Albums, and
Projects buttons disappear from the toolbar when the sidebar is displayed.

Working with Images in Photos

Even a superbly designed image display and editing application such as
Photos would look overwhelming if everything were jammed into one
window. Thus, Apple’s developers provide different operational modes (such
as editing and book creation) that you can use in the one Photos window.
Each mode allows you to perform different tasks.

In this section, I discuss three of these modes — import, organize, and edit —
and what you can do when you'’re in them.

lmport images 101

In import mode, you're ready to download images and video clips directly
from your digital camera — and you’re not limited to cameras, of course.
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You can also import items from a folder on your hard drive, a memory card
reader (such as the SDXC card slot sported by many current Mac models) or
even a Kodak PhotoCD.

Follow these steps to import images directly from your camera:

1

. Connect your digital camera to your Mac.

Plug one end of a USB cable into your camera and the other end
into your computer’s USB port, and prepare your camera to down-
load images.

. Prepare your camera to download files.

The procedure for downloading images and video varies by camera,
but the process usually involves turning on the camera and choos-
ing a “Download” or “PC” mode. Check your camera’s user guide for
more details.

. Launch Photos.

Your Mac probably launches Photos automatically when your camera
is detected, but you can always launch Photos manually by clicking
the Photos icon on the Dock (or clicking on the Photos icon within
Launchpad).

. Click the Import button on the Photos toolbar.

Photos displays all of the images and video clips currently stored on
your camera in the Viewer.

. (Optional) To have Photos automatically separate images into differ-

ent Events based on the date they were taken, select the Split Events
check box.

. Click the Import All New Photos button to import all new files from

the camera.

To select specific images to import, hold down the 38 key and click
each desired photo; then click Import Selected instead of Import All
New Photos.

The images and clips initially appear within the Last Import album in
your Photos Library, where you can organize them as you want.

. Specify whether the images and clips you’re importing should be

deleted from the camera afterward.

If you don’t expect to download these items again to another computer
or another device, you can choose to delete the files from your camera
automatically. This saves you a step, frees space for new photos and
video, and helps eliminate the guilt that can crop up when you nix your
pix. (Sorry; I couldn’t resist.)

241
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Importing images from your hard drive to Photos

Adding items stored on your hard drive, a CD,
a DVD, an external drive, or a USB flash drive
is easy. If the images and clips are in a folder,
just drag that folder from a Finder window and
drop itinto the Viewer. (Heck, you can even drag
items directly to the Photos icon in the Dock!)
Photos automatically creates a new album using
the folder name, and you can sit back while the
images are imported into that new album.

If you have individual images, you can drag
them as well. Select the images in a Finder

window, and drag them into the desired
album in the Albums display. To add them to
the album currently displayed in the Viewer,
drag the selected photos and drop them in the
Viewer instead.

Ifyou'd ratherimportimages by using a standard
Mac Open dialog, choose File= Import.
Simplicity strikes again!
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Note that Photos automatically groups imported images and video into
moments and collections (using the date, time, and location where the files
were created, if your camera stores this information with each file). For exam-
ple, if you want to see photos from your son’s graduation, they’ll appear as a
separate moment. Think about that. It’s pretty tough to arrange old-fashioned
film prints by the moment in time they document, but Photos makes it easy
for you to see which photos are part of the same group.

Don’t be surprised if Photos automatically appears when you connect your
iPhone or iPad to your MacBook! This gives you a convenient opportunity to
import photos with a single click.

Organize mode: Organizing and
sorting your images

In the days of film prints, you could always stuff another shoebox with your
latest photos or buy another sticky album to expand your library. Your
digital camera, though, stores images as files instead, and many folks don’t
print their digital photographs. Instead, you can keep your entire collection
of digital photographs and scanned images well ordered and easily retrieved
within Photos — then you can display them in a slideshow, email them, print
them, use them as Desktop backgrounds, or burn them to an archive disc.

A new kind of photo album

The most familiar method of organizing images in Photos is the album. Each
album can represent any designation you like, be it your pets, a vacation,
your daughter, or your daughter’s ex-boyfriends. Follow these steps:




3

Figure 13-2:
Adding a
new album
in Photos.
|
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1. Create a new album.

You can choose Filew>New Album, press 38+N, or click the Add button in
the toolbar, which bears a plus sign. If you've selected any item thumb-
nails in the Viewer, they are added to the new album automatically.

2. Type the name of your new photo album into the Album Name text
box (Figure 13-2).

Note that you can also choose to add the items to an existing album
(or an existing Event you created using iPhoto). Click the Album drop-
down list box and click either an album name or the desired iPhoto
Event. The Album Name text box disappears if you choose an existing
album or Event.

3. Press Return.
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Photos also offers a special type of album called a Smart Album, which you
can create from the File menu. (For even faster action, press Option+38+N.)
If you're familiar with the Smart Folders you can use within the Finder and
the Smart Playlists within iTunes (see Chapter 12), you've figured out this
one already. A Smart Album contains only photos that match certain criteria
you choose, including the keywords you assign your images. Other criteria
include text in the photo filenames, the dates the images were added to
Photos, a specific Face you’'ve identified, and any description you might have
added (as well as camera-specific data, such as ISO and shutter speed). Now
here’s the really nifty angle: Photos automatically builds and maintains Smart
Albums for you. It adds new photos that match the criteria and deletes those
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you remove from your Photo Library (and also removes the photos that no
longer match the Smart Album’s criteria)! Smart Album icons carry a gear
symbol in the Photos sidebar.

You can display (or edit) information about the currently selected item —
just right-click on the item and choose Get Info from the menu that appears.
Click the Add a Title heading in the dialog to display a text edit box, and you
can simply type a new value. You can also type a short note or description
in the Add a Description box that appears in the Info dialog, or click Add a
Keyword to use keywords to help organize your photos.

You can copy selected items from the Viewer into any album you choose.
Select the desired items, then click the Add button that appears at the right
side of the Photos window (which works the same as the Add button in the
toolbar). If the sidebar is displayed, you can copy selected items to an album
by dragging them from the Viewer to the desired album in the sidebar.

To remove a photo or video clip that has fallen out of favor, follow
these steps:

1. Click the Albums button in the toolbar, then click on the desired
album to display it. (From the sidebar, click on the the desired album.)

2. In the Viewer, click the item you want to remove to select it.

3. Press Delete.

When you remove a photo or clip from an album, you don’t remove the actual
file from your collection (represented by Photos button in the toolbar or

the Photos entry at the top of the sidebar). An album is actually just a group
of links to the images in your collection, just like how a playlist in iTunes is

a group of links to songs in your Music Library. If you want to completely
remove an offending photo from Photos, click the Photos button in the tool-
bar (or the Photos entry at the top of the sidebar) to display your entire col-
lection of photos and clips and delete the item there. The item disappears
from all albums with which it is associated.

To remove an entire album, click the Albums button in the toolbar to display
your album thumbnails in the Viewer, then right-click on the doomed thumb-
nail and choose Delete Album. (As | mentioned earlier, if you're using the
sidebar the Albums button doesn’t appear in the toolbar; instead, right-click
the offending album name in the sidebar and choose Delete Album.)

To rename an album from the Viewer, click the album name under the
desired thumbnail and type the new name in the text box that appears, then
press Return. To rename an album from the sidebar, click the entry under the
Albums heading in the list to select it, and click again to display a text box.
Type the new album name, and press Return.



Hey, what happened to my Events?

In iPhoto — the predecessor to Photos —
an Event was a group of images you shot or
downloaded at the same time (much like a
collection in Photos). Now that iPhoto has bit
the dust, you may be mourning the loss of your
Events . .. don’t worry, they're still available!
You'll find that Photos includes a special album

an entry in the sidebar list). Double-click on
this album thumbnail in the Viewer (or click the
iPhoto Events entry in the sidebar), and your
existing Events will appear like magic!

Note that you can no longer create Events
within Photos, as collections now handle the
same chore!
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named iPhoto Events (which is available from
both the Albums display in the Viewer and as

Change your mind? Photos comes complete with a handy-dandy Undo
feature. Just press 38+Z, and it’s as though your last action never happened.
(A great trick for those moments when you realize you just deleted your
only image of your first car from your Library.) For an extra level of backup
protection, you can invest in an external hard drive and use the awesome
Yosemite Time Machine backup feature.

You can quickly jump to the Albums display in the Viewer by pressing the
Command+3 keyboard shortcut.

Working with Faces

Photos includes a powerful organizational tool called Faces, which appears
as a separate item within the sidebar.

Faces is a sophisticated recognition system that automatically recognizes
human faces within the photos you add to your Photos Library. (I don’t know
whether it works well with pets, but you can try.) Naturally, you have to
identify — tag — faces before Photos can recognize them.

To tag a face, follow these steps:

1. In the Viewer, double-click the photo with a person you want to tag.

2. Click the Info button on the Photos toolbar at the top of the window.
Photos displays the Info pane.

3. Click the Add Faces link.

Note that Photos indicates each person’s face in the photo with a label.
3 If a face has already been tagged, the label matches the person’s face.

To set Photos to always show labels — so that you don’t have to click
the Add Faces link — click View = Show Face Names.
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4. Click the unnamed label under the person’s face to open a text box,
as shown in Figure 13-3.
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5. Type the person’s name and press Return.

If the name appears on a Contacts contact card — or is recognized as an
existing Faces name, or as one of your Facebook friends — you can click
the matching entry that appears to confirm the identity. Wowzers!

To delete an unnecessary Face recognition outline, click the X button
that appears at the left side of the circle.

Photos might not recognize the face if the person is turned at an angle to
the camera or is in a darker area of the photo. If so, display the Info pane
and click the Add Faces link to display a “floating” outline, then click the
outline and drag the circle over the person’s face. If necessary, you can
resize the box using the handle that appears at the right side of the circle.
Now you can click the Click to Name label and type the person’s name.

After you tag an image, it appears in your Faces collection, which you
can view by clicking the Faces entry in the sidebar. You can double-click
a portrait in your Faces collection to see all the images that contain

that person.




Time to go shopping for faces!

Notice the Suggested Faces thumbnail strip
across the bottom of the Photos window?
Double-click on a thumbnail that you recognize,
and Photos prompts you to enter the person’s
name. (You'll also see a pop-up list of folks that
have already been identified, as well as names
with matching characters from Facebook and
Contacts list. If you see the person’s name in
the list, just click on it.)

Click Continue, and Photos displays other
photos with faces that contain that person. If

Photos makes a mistake in identifying a face in
animage, just click the image to deselectit, and
the blue check mark in the lower-right corner
of the thumbnail disappears. When all of the
thumbnails correctly identify the person, click
Add and Continue, and POW — those photos
get added to your Faces collection.

As you might expect, the more photos you add
for a specific person, the better Photos gets at
recognizing that person!

Organizing with keywords

“Okay, Mark, albums and Faces are great ideas, but there has to be a way to
search my Library by category!” Never fear, good Mac owner. You can also

assign descriptive keywords to items to help organize your Library and locate

certain pictures and video clips fast. Photos comes with a number of stan-
dard keywords, and you can create your own as well.
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To illustrate, suppose you’d like to identify your images according to special
events in your family. Birthday photos should have their own keyword, and
anniversaries deserve another. By assigning keywords, you can search for
Elsie’s birthdays or your silver wedding anniversary (no matter what collec-
tion or album they’re in), and all related photos with those keywords appear
like magic!

Photos includes a number of keywords that are already available:

v Favorite

v Family

v Kids

»* Vacation

v Birthday

1 RAW

+* Photo Booth
v+ Photo Stream
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Figure 13-4:
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v Movie
v Check mark

What’s the check mark all about, you ask? It’s a special case: the check mark
keyword comes in handy for temporarily identifying specific items, because
you can search for just your check-marked photos and clips.

To assign keywords to images (or to remove keywords that have already
been assigned), select one or more photos in the Viewer. Choose
Window=> Manage My Keywords or press 38+K to display the Keyword
Manager window, as shown in Figure 13-4.

B —E Moments + [}

[E] Photos Apr 10

Albums
[ All Photos
@ Faces
O Last Import
O Videos

Missouri Apr11> >+
ece - Keymards
Quick Group
8 cats ond Drag Keywords here to place them in your quick-pick list and
1 iphota Even automatically assign them a keybaard shorteut.
8 Jui 6, 201 ¥ Keywords
Wreos 2 v Birthday Famity
Flagged Kids. Vacation

Edit Keywords

Missouri - Biscayne Heights W Ash St - Apr 12

Drag the keyword buttons that you use the most to the Quick Group section
of the Keyword Manager window, and Photos automatically creates a key-
board shortcut for each keyword in the Quick Group. Now you don’t even
need to display the Keywords window to get business done!

Click the buttons for the keywords you want to attach to the selected images
to mark them. Or click the highlighted buttons for the keywords you want to
remove from the selected items.



You need your own keywords

| bet you take photos and video clips of
things other than just kids and vacations.
That's why Photos allows you to create your
own keywords. Display the Photos Keyword
Manager window by pressing 38+K, click the
Edit Keywords button, and then click Add (the
button with the plus sign). Photos adds a new
unnamed keyword to the list as an edit box,
ready for you to type its name.

You can rename an existing keyword from this
same window, too. Click a keyword to select it,
and then click Rename. Remember, however,
that renaming a keyword affects all the images

that were tagged with that keyword. That
might be confusing when, for example, photos
originally tagged as Family suddenly appear
with the keyword Foodstuffs. (I recommend
applying a new keyword and deleting the old
one if this problem crops up.)

To change the keyboard shortcut assigned to a
keyword, click the Shortcut button. To remove
an existing keyword from the list, click the
keyword to select it and then click the Delete
button, which bears a minus sign. After your
keywords are picture-perfect (pun grudgingly
intended), click OK to save them.

Digging through your library with keywords

Behold the power of keywords! To sift through your entire collection of
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images by using keywords, click the Search button on the toolbar at the top
right of the Photos window and type one or more keywords. For example, to
see all of the items you’ve flagged as Favorites that include kids, you'd type

Favorite Kids.

The images that remain in the Viewer after a search must have all the key-
words you specified. For example, if an image is identified by only three of
four keywords you chose, it isn’t a match and doesn’t appear in the Viewer.
(You can create a Smart Album with specific keywords to get around this
limitation.)

To search for a photo by words in its description, just click in the Search box
and start typing. You can click that same magnifying glass by the Search box
to search through your images by date and rating as well.

Searching by locations where photos were taken

Photos can also track the location where photos were taken automati-

cally, but this feature requires a digital camera that includes GPS tracking
information in the image metadata for Photos to do so without your help.
(Older camera models are unlikely to support GPS tracking. Naturally, newer
iPhones and iPads support this feature.) You don’t have to turn anything on
to view photos by location.
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Figure 13-5:
Photos is
now in Edit
mode.
Watch out,
image
problems!
|

When you're viewing photos by moments and collections, you'll notice that
Photos includes the location name to identify where the photos were taken.
To search for all images taken at a specific location, type the location name
into the Search field.

If you right-click a specific photo (that includes location information) to
select it and then click Get Info, you see a close-up map of the location where
the photo was taken.

Edit mode: Removing and fixing
stuff the right way

Not every digital image is perfect — just look at my collection if you need
proof. For shots that need a pixel massage, Photos includes a number of
editing tools you can use to correct common problems.

The first step in any editing job is to select the image you want to fix (double-
click on a Moments thumbnail, and it should fill the Viewer). Then click the
Edit button on the Photos toolbar (or simply press Return) to display the
Edit mode controls at the right side of the window, as shown in Figure 13-5.
Now you’re ready to fix problems, using the tools I discuss in the rest of

this section.
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If you display a video clip in the Viewer, you can play it by hovering your
pointer over the clip and pressing the Play button that appears. However,
you can only edit photographs, so the Edit button is disabled when you’re
viewing a video clip.

While you're editing, you can press the left and right arrow keys to move to
the next image (or back to the previous image). This trick works whether you
were browsing the Library or displaying the contents of an album. You can
also display the Split View pane in Edit mode.

If you prefer to edit images while using more of your screen real estate,
click the Full Screen/Maximize button at the upper-left corner of the Photos
window. To switch back to the standard window arrangement, simply press
the Esc key.

When you’re finished with Edit mode, click the (wait for it) Done button again
to return to the Viewer.

Rotating tipped-over shots

If an image is in the wrong orientation and needs to be turned to display cor-
rectly, click the Rotate button to turn it once in a counterclockwise direction.
Hold down the Option key while you click the Rotate button to rotate in a
clockwise direction.

Crop till you drop (and a whole lot more )

Does that photo have an intruder hovering around the edges of the subject?
You can remove some of the border by cropping an image, just as folks once
did with film prints and a pair of scissors. (We’'ve come a long way.) With
Photos, you can remove unwanted portions from the edges of an image; it'’s a
great way to get Uncle Milton’s stray head (complete with toupee) out of an
otherwise perfect holiday snapshot.

While you're in Editing mode, follow these steps to crop, flip and straighten
an image:

1. Click the Crop button.
2. Select the portion of the image you want to keep.

In the Viewer, click and drag the handles in the corners of the rectangle
to outline the part of the image you want. Whatever is outside this
rectangle disappears after the crop is completed.

When you drag a corner or edge of the outline, a semi-opaque grid
(familiar to amateur and professional photographers as the nine rectan-
gles from the Rule of Thirds) appears to help you visualize what you're
claiming. (Check it out in Figure 13-6.)



252

Part IV: Living the iLife

Figure 13-6:
Select the
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You can expand the outline to the image’s full dimensions at any time by
clicking the Reset button.

See that attractive-looking Auto button that appears at the lower right-
hand corner of the Photos window when you're in crop mode? A single
click of the Auto button and Photos will take its best shot at producing
the ideal cropping and straightening job for you! If you don’t like the
results, just use Photos’s Undo feature (38+Z) to return the photo to its
previous appearance.

Photos features multiple Undo levels, so you can press 38+Z several
times to travel back through your last several changes. Alternatively,
you can always return the image to its original form (before you did any
editing at all) by clicking the Revert to Original button that appears at
the top right of the Photos window.

. (Optional) Choose a preset aspect ratio.

You might want to force your cropped selection to a specific aspect
ratio, such as 4x3 or 16x9 for a widescreen desktop background, or 4x6
or 5x7 to match the dimensions of photo paper. If so, click the Aspect
link and select that ratio from the pop-up menu that appears. (Pick the
Square menu item for the perfect Facebook profile image, and Freeform
to allow any aspect ratio after your cropping is done.)

. (Optional) Flip your photo horizontally.

A click of the Flip link gives you the mirror image of your original photo.
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5. (Optional) Straightening what’s crooked.

Was your camera slightly tilted when you took the perfect shot? Never
fear! Click on the circular angle control at the right edge of the image
and drag in the desired direction. (Besides straightening the subject,
you can do some truly wild camera angles this way, just like the 60’s
Batman TV series!)

6. Click the Done button.

Enhancing images to add pizzazz

If a photo looks washed out, click the Enhance button to increase (or
decrease) the color saturation and improve the contrast. Enhance is auto-
matic, so you don’t have to set anything — but be prepared to use Undo if
you're dissatisfied with the changes.

Removing rampant red-eye

Unfortunately, today’s digital cameras can still produce the same “zombies
with red eyeballs” as traditional film cameras. Red-eye is caused by a cam-
era’s flash reflecting off the eyes’ interior surface, and it can occur with both
humans and animals. (I'm told pets get green-eye or blue-eye, but Photos can
handle them, too!)

Photos can remove that red-eye and green-eye and turn frightening zombies
back into your family and friends. In Editing mode, click the Red-Eye button
and click the Auto button at the lower-right corner of the window, and Photos
automatically attempts to remove any red-eye effect it detects in the photo.
(If you don’t see the Red-Eye button, press E to display it.)

If Photos can’t fix a demonized eyeball automatically, hover your pointer
over the photo to display the circular red-eye tool. (You can change the
size of the tool by dragging the Size slider to adjust the dimensions.) Once
the red-eye tool is the right size, simply move the circle to the center of the
eyeball and click. To complete the process, click the Done button.

Retouching like the pros

The Photos Retouch feature is perfect for removing minor flecks or lines in
an image (especially those you've scanned from prints). Click Retouch and
hover your pointer over the photo to display the circular retouch tool. As
with the red-eye tool, you can drag the Size slider to change the size of the
retouch tool. Drag the pointer across the imperfection and click Done when
you're finished touching up. Don’t forget to take a moment and marvel at
your editing skill!
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Using filters and adjustments to add a mood

Wondering whether a particular photo in your Library would look better as

a black-and-white (grayscale) print? Click the Filters button to display a strip
of different effects that you can apply to the photo, including different black-
and-white effects, enhanced color levels and subtle shading. Click any thumb-
nail in the strip to apply the filter.

If you’d like more precise manual control over your image attributes —
including sharpness, color levels, shadows and white balance — click the
Adjust button. You can click one of the preset thumbnails to apply a set of
attributes, or click Add to display additional controls that you can use to
create a different look.

Producing VYour Own Coffee-Table
Masterpiece

A\

Projects mode unleashes what I think is probably the coolest feature of
Photos: the chance to design and print a high-quality bound photo book. First
you complete an album by editing all the images just the way you want and
placing in the album all the photos you want to include in your book. Photos
can send your images as data over the Internet to a company that prints and
binds your finished book. (No, they don’t publish For Dummies titles, but then
again, I don’t get high-resolution color plates in most of my books, either.)

At the time of this writing, you can order many different sizes and bindings.
The largest size is a 113-by-10-inch hardcover book (complete with a dust
jacket) with 20 double-sided pages for about $50 — extra pages cost $1.50
each. Smaller sizes include a 10-by-10-inch hardcover book with 20 double-
sided pages for about $40 and a softcover 8-by-8-inch album with 20 double-
sided pages for about $15. Extra pages can be added at $1.00 and $.80 a pop,
respectively.

Photos can also produce and automatically order calendars and cards
(both the postal and greeting varieties) using a process similar to the one

[ describe in this section for producing a book. Who needs that stationery
store in the mall anymore? (You can even order old-fashioned photo prints
from the Share toolbar menu.)

If you decide to create a photo book, make sure the images have the high-
est quality and highest resolution. The higher the resolution, the better the
photos look in the finished book. I always try to use images of more than
1,200 pixels in the shortest dimension. You should also make sure you've
added enough images to the album you’ll be using, because you need to pop-
ulate the entire book. (You can add extra pages later, but each book requires
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a minimum number of pages.) Don’t forget to include a good mix of landscape
and portrait shots.

To create a photo book, follow these steps:
1. Click the Album button in the toolbar and click the desired album

thumbnail to select it.

Make sure no individual photos are selected in the Viewer. This way,
Photos uses all the images in the chosen location.

2. Click the Add To toolbar button and click Book from the pop-up
menu.

3. Select the type of book (Square, Classic, or Softcover).
Your choice determines the number of pages and the size of the book.
4. Click a theme thumbnail.

The theme you choose determines both the layout scheme and the
background graphics for each page.

5. Click Create Book.

If you've displayed the sidebar, Photos adds your new book project
under the Projects heading (using the name of the album or Event where
the photos were located), and you see the layout and controls shown in
Figure 13-7.

Photos  Shared  Albums m (2| m| CJ BuyBook

20 Pages - $24.98

| g 5 6 7
Figure 13-7:
Preparing to Fp— GH E
publish my ﬂ'{, ﬂ = ;
own
coffee-table | “™=™ ~ prose Unussaoos S Ac s
masterpiece. Drag ot hret s o nctrer ayut
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10.

11.

12.

In Book mode, the Viewer displays a collection of thumbnail images,
each of which represents a portion of your book — the front cover, inter-
nal pages, or back cover. Photos automatically fills as many pages as it
can with images that best fit your layout — any extra images appear in
the photo strip along the bottom of the window. You can drag any image
thumbnail into one of the photo placeholders to add it (or replace the
existing photo).

It’s easy to switch to another theme at any time. Click the Change
Settings button in the toolbar (which bears a book icon), then click the
Change Theme button that appears.

. (Optional) Rearrange the page order to suit you by dragging the

thumbnail of any page from one location to another.

If you prefer a book without page numbers, click the Change Settings
button and click Show Page Numbers to toggle it off.

. (Optional) To change the look of the selected cover or page, click the

Layout Options button on the toolbar to change the color and design
layout for that element.

Clicking a design thumbnail automatically updates the page display.

. Double-click a page to edit captions and short descriptions.

Click any of the text boxes in the page display, and begin typing to add
text to that page. (Note that some themes don’t have caption or descrip-
tion text boxes.)

After you're finished editing, click the Back button at the top of the
window to return to your full spread.

. (Optional) To add pages to your book, click the Add Page button on

the toolbar.

As mentioned earlier, the price of additional pages varies according to
the size and type of binding you choose.

To view the book at any time, right-click any open spot in the Photos
Viewer and choose Preview Book.

After a short wait, the OS X Preview application opens, and you can
scroll through the contents of your book (or even print a quick copy).
To close the Preview window, choose Preview > Quit Preview.

When you're ready to publish your book, click the Buy Book button at
the upper-right corner of the window.

In a series of dialogs that appears, Photos guides you through the final
steps to order a bound book.

Note that you are asked for credit card information, so have that plastic
ready.
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Why limit yourself to paper copies of your publishing success? You can
also right-click any open spot in the Viewer and choose Save Book as PDF to
create a snazzy electronic version of your book.

| really need a slideshow

You can use Photos to create slideshows by
following these steps:

1. Click the Album button on the toolbar and

click the desired thumbnail (or click the
album you want to use in the sidebar),
then click the Add To button, and choose
Slideshow.

. Choose New Slideshow.

. Just like creating a new album, type the

name of the slideshow in the text box and
press Return. Photos adds a slideshow
thumbnail in the Projects view, and adds a
new entry under Slideshows in the sidebar.

A scrolling thumbnail strip appears at the
bottom of the Viewer, displaying the images
in the album.

. Click and drag the thumbnails to appear in

the desired order.

After creating your slideshow, you can
customize it with the controls that appear at
the right side of the Photos window:

+* Themes: Click the Theme Picker button to

choose the theme for your slideshow. The
theme you choose controls the animation,
transition type, and screen layout that
Photos uses — everything from the classic
Ken Burns “moving photo” animation to a
nifty Sliding Panels layout.

v Music: Click the Music button to display

Apple’s theme music as well as the tracks
from your iTunes Library. To choose a stan-
dard theme, open the Source pop-up menu
and choose Theme Songs; click that per-
fect song to select it. To choose songs from
your iTunes Library, open the Source pop-
up menu and click iTunes, then click the
songs you want in the order you want them.

Duration: Click the Duration Settings
button, and you can choose to fit the display
of images to the length of the music you've
chosen, or you can set individual timings
for the slide thumbnails you've selected.
If you want your slideshow to loop after it
finishes, click the Loop icon that appears
at the lower-right corner of the Viewer to
toggle it on (the icon turns blue).

v Preview: To display a quick preview of

your slideshow without leaving the Photos
window, click the Preview button at the
lower-left corner of the Viewer; this is a
handy way of determining whether the
theme and music you've selected are really
what you want. When you're ready to play
your slideshow, click the Play button that
appears under the Viewer, and Photos
switches to full-screen mode. To create a
movie file from your completed slideshow,
click Export on the Photos toolbar.
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Introducing iCloud Photo Library

Yes, Apple has decided that everything except the kitchen sink should

be stored online in iCloud: first it was your iTunes music library, then

your Pages, Numbers, and Keynote documents, and now it’s your photo-
graphs and video clips! To turn the iCloud Photo Library feature on, click
Photos = Preferences, click the iCloud tab, and click the iCloud Photo Library
check box to enable it.

With iCloud Photo Library, your entire Photos Library is actually stored
online, and everything in your Library is also accessible from other Macs
and iOS devices like your iPad and iPhone. (Think “central storage house for
everything visual that you can reach from anywhere with an Internet connec-
tion.”) If you take a photo with your iPhone, for example, you’ll see it appear
automatically within Photos — and if you’ve recently cropped and edited a
photo to perfection with Photos, you’ll be able to retrieve that photo on any
of your i0OS devices or another Mac.

From the same iCloud pane in the Preferences dialog, you can choose to

 store copies of the full-size images and full-resolution videos on your
MacBook’s local hard drive (allowing you to edit or view the originals
even when you're not connected to the Internet).

1 store smaller size images and smaller-resolution videos on your laptop,
but with the ability to retrieve the originals from the iCloud at any time
(if you're connected to the Internet).

Naturally, if you're a photographer that needs constant, instant access to
your original images, the first option is preferable (choose the Download
Originals to this Mac option in the iCloud pane). However, if your MacBook’s
drive is nearly full and you’d like to conserve space, the second option is
very attractive (choose the Optimize Mac Storage option in the iCloud pane).

All this goodness is handled automatically, but there’s a catch: your entire
Photos Library needs to fit within your free 5GB of iCloud storage, or you’ll
have to pay a monthly subscription to get additional elbow room! (Storage
subscriptions range from $0.99 a month for 20GB of space to $19.99 a month
for a whopping 1TB of space.) If you have only 3GB of photos, you may be
able to use iCloud Photo Library without spending anything extra, but since
my Photos Library is nearing 10GB in size [ would probably need to subscribe
to take full advantage of the feature. The choice is yours, dear reader: if you
decide not to use the iCloud Photo Library, rest assured that Photo Stream
will still work as it did in iPhoto.



Chapter 13: Focusing on Photos 259

Putting My Photo Stream and
Shared Albums to Work

Like iPhoto before it, Photos includes the My Photo Stream feature that auto-
matically shares the photos you take among your Macs, your PCs, and any
Apple device running iOS 5.0 or later. Unlike iCloud Photo Library, however,
your images and videos are stored on your Mac’s local hard drive and not
in your iCloud storage. (The images and videos are also always full-size and
full-resolution.)

To turn on My Photo Stream, choose Photos> Preferences and click the
iCloud toolbar button, then select the My Photo Stream check box. Once
the feature is turned on, Photos should automatically import My Photo
Stream photos taken with iOS devices and other Mac computers to your
Photos Library.

Once the My Photo Stream feature is turned on, it’s a cinch to share images
and videos across your Apple computers and devices — simply copy the
items into the My Photo Stream album! Photos automatically sends the
selected images to all compatible devices over your Wi-Fi connection. (Note
that all devices using My Photo Stream must be configured using the same
Apple ID.)

You can also choose to share specific photos by using iCloud Photo Sharing,
which can be turned on from the Photos Preferences dialog. (Yes, I agree,
Apple seriously needs to work on choosing more discrete names for these
features.) Choose Photos=> Preferences, click the iCloud tab on the toolbar,
and select the iCloud Photo Sharing check box.

To subscribe to a shared album invitation from another person, click the
Shared button on the toolbar (or the Shared entry in the sidebar) and click
on the Activity album. Click the desired shared album, and click Accept.

To create your own shared album, select the images you want to share,
click the Share button on the toolbar, click the iCloud Photo Sharing item,
and New Shared Album. Photos prompts you for the album name and the
email addresses of the folks you want to invite to your shared album. After
you have entered each email address, click the Create button in the dialog
to start the ball rolling. You can also add or delete items from your shared
album in the same way that you would with a regular Photos album.
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Is that Facebook, Twitter, and Flickr | spy?

Indeed itis! Photos includes direct connections
to both your Facebook and Twitter social
networking accounts (www . facebook . com
and www.twitter.com) and your Flickr
online gallery account (www . f1ickr.com).
You can simply select one or more photos
and send them automatically to any of these
services. Click the Share button on the toolbar
to select the type of account.

The first time you select photos in the Viewer
(or an album) and choose either option,

Photos prompts you for permission to set up
your connection. (Of course, this requires you
to enter your Facebook, Twitter, and Flickr
account information — hence the confirmation
request.) Click Set Up, and provide the data
each site requires.

After you set up your accounts, simply select
your photos or albums, click the Share toolbar
button, and choose the menu item for the
desired service. Apple, you absolutely rock!
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Chapter 14

Making Film History with iMovie

In This Chapter
Taking stock of the iMovie window
Importing and adding media content
Using transitions in your movie
Putting text titles to work
Adding animated maps
Creating a movie trailer

Sharing your movie with others

Remember those home movies you used to make in high school? They
were entertaining and fun to create, and your friends were impressed.
In fact, some kids were so downright inspired that you're not surprised when
you discover at your high school reunion that they turned out to be graphic
artists, or got involved in video or TV production.

iMovie, part of Apple’s digital lifestyle suite, makes moviemaking as easy

as those homemade movies. Apple simplifies all the technical stuff, such as
importing video and adding audio, leaving you free to concentrate on your
creative ideas. In fact, you won'’t find techy terms such as codecs and key-
frames in this chapter. [ guarantee you’ll understand what’s going on at all
times. (How often do you get a promise like that with video-editing software?)

With iMovie, your digital video (DV) camcorder, and the other applications
that Apple provides, you can soon produce and share professional-looking
movies, with some of the same creative transitions and titles used by Those
Hollywood Types every single day. All on your MacBook, all by yourself.

If you turn out to be a world-famous Hollywood-Type Director in a decade
or so, don’t forget the little people — like computer book authors —
along the way!
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Shaking Hands with the iMovie Window

If you've ever tried using a professional-level video-editing application, you
probably felt as though you were suddenly dropped into the cockpit of a
jumbo jet. In iMovie, though, all the controls you need are easy to use and
logically placed.

ﬁ To launch iMovie, click the iMovie icon on the Dock or within Launchpad.

P (It looks like a star on the Hollywood Walk of Fame.) You can also click the
Applications folder in any Finder window Sidebar and then double-click the
iMovie icon.

To follow the examples [ show you here, take these strenuous steps and
create a new movie project:

1. Choose File=> New Movie (or press 38+N).

Alternatively, you can click the New button on the iMovie toolbar and
choose the Movie entry from the pop-up menu. No matter how you get
there, iMovie displays the window shown in Figure 14-1.
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Figure 14-1:
Creating a
new movie

project
within
iMovie.
|

You can also create movie frailers (short previews or teasers) within
iMovie, as [ demonstrate later in this chapter. Generally, however,

you should create your trailer project after your movie is completed
(unless, of course, you're specifically creating just a trailer). Why? For
the same reason that studios create trailers after the filming is finished:

a\\J
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Figure 14-2:
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After you complete your movie, all the clips will be imported already,
and you’ll have a better idea of what you want to include while “teasing”
your audience!

. Click a Theme thumbnail to select a theme to apply to your finished

movie.

To preview the appearance of a theme, hover your cursor over the
thumbnail and click the Play button that appears.

iMovie automatically adds the transitions and titles that correspond to
that theme.

Normally, this is what you want to do. However, you can add transitions
and titles manually, as I show you later in this chapter. So if you decide
not to use a theme out of the gate, click the No Theme thumbnail.

3. Click the Create button.
4. Type a name for your project.
5. Click OK.

iMovie adds the new project to the thumbnail list in the Project Library
pane, and you're on your way! Check out Figure 14-2: This is the whole
enchilada, in one window.

Event/Project Library pane

Libraries list Toolbar Viewer

My Epic Example Movie 05

Playhead Project pane

Content Library
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You'll use these controls and displays most often:

v Viewer: Think of this as being just like your TV or computer monitor.
Your video clips, still images, and finished movie play here. You also
crop and rotate your video within the Viewer.

+ Content Library: This row of buttons allows you to add effects such as
transitions, titles, music, and sound effects.

v~ Libraries list: This list allows you to display your photos (from your
Photos, iPhoto, and Aperture libraries) as well as all the video clips
you can add to your project from events you've imported. You can also
select an existing iMovie project from the iMovie Library. To hide the
Libraries list and make more room for the Event/Project Library pane,
click the Hide button that appears near the top-left corner of the iMovie
window. (To display the Libraries list again, click the same button, which
now reads Show.)

v Event/Project Library pane: If you select an event from the All Events
entry in the Libraries list, iMovie displays a thumbnail of that event’s
content in the Event pane. (Move the mouse over the Event thumbnail
to see previews of the clips.) If you decide you want to include a clip,
double-click the Event to display the clips and add the desired clip to
your project. This pane also acts as the Project Library pane, where
you can display your iMovie projects; click the All Projects entry in the
Libraries list to display your projects as thumbnails. To load a project,

&&N\BEH just double-click the thumbnail and it appears in the Project pane.
<

The Event/Project Library pane displays different content, depending on
the entry you select in the Library list.

v Project pane: This pane is where most of your work gets done within
iMovie, displaying the elements you added to that specific project
(such as video clips, still photos, and audio clips). Your movie appears
as a linear strip of thumbnails, making it easy to select, insert, and
delete elements.

v+ Playhead: The white vertical line you see in the Event and Project panes
is the playhead, which indicates the current editing point while you're
browsing your clips or creating your movie. When you’re playing your
movie, the playhead turns orange and moves to follow your progress
through the movie.

v+ Toolbar: This strip of buttons allows you to import video, share your
completed movies, enhance and adjust video clips, and switch between
the iMovie Library and iMovie Theater. (More on iMovie Theater later in
the chapter.)

Those are the major highlights of the iMovie window. A director’s chair and
megaphone are optional, of course, but they do add to the mood.
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A Bird’s-Eye View of Moviemaking

[ don’t want to box in your creative skills. After all, you can attack the mov-
iemaking process from a number of angles. (Pun, unfortunately, intended.)
However, I've found that my movies turn out best when I follow a linear
process. So before I dive into specifics, allow me to give you an overview of
moviemaking with iMovie.

Here’s my take on the process, reduced to seven basic steps:

1.

Import your video clips from your camcorder, your MacBook’s FaceTime
HD camera, your Photos Library, or your hard drive.

. Drag your new selection of clips from the Event pane to the Project

pane, and arrange them in the desired order.

. Import or record audio clips (from iTunes, GarageBand, or external

sources, such as audio CDs or audio files you’ve recorded yourself), and
add them to your movie.

. Import your photos (directly from Photos, iPhoto, Aperture, or your

hard drive), and place them where needed in your movie.

. Add professional niceties, such as voiceovers, transitions, effects, and

text, to the project.

. Preview your film, and edit it further if necessary.

7. Share your finished film with others through the web, email, your Apple

3

TV, or an iOS device (an iPhone, iPad, or iPod touch), or within iMovie
Theater. If you have a MacBook with an optical drive — or an external
USB optical drive — you can also use a DVD recording application to
create a DVD movie disc using your exported movie. | use (and recom-
mend) Toast 14 from Roxio, at www.roxio.com.

Wondering how you save your project in iMovie — especially when the File

menu has no Save item? iMovie automatically saves your project as you
work, leaving you free to concentrate on your moviemaking art.

Importing the Building Blocks

Sure, you need video clips to create a movie of your own, but don’t panic if
you have a small supply. You can certainly turn to Apple’s other digital media
applications for additional raw material. (See, I told you that whole “integra-
tion” thing would come in handy.)


//In-ftp/FTP%20Info/Editorial_Transfer/385395/www.roxio.com
http://www.roxio.com
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Along with video clips you import from your DV camcorder, your MacBook’s
trusty built-in FaceTime HD camera (or an external webcam), and your hard
drive, you can call on Photos, iPhoto, and Aperture for still images (think
credits) and iTunes and GarageBand for background audio and effects. In this
section, | show you how.

Pulling in video clips

Your MacBook comes equipped with extras that come in handy for video
editing — a large hard drive and ports to connect stuff. Depending on the
MacBook model you're using and your external devices, you may use a
USB or FireWire connection. Today’s mass-storage camcorders, tablets,
and smartphones use a USB connection to transfer clips. I cover both older
tape-based camcorders and USB/Thunderbolt mass-storage devices in

this section.

Oh, and don’t forget that your MacBook has a FaceTime HD camera on board,
ready to record clips. Heck, you're a self-contained movie studio!

Here’s the drill if your clips are on your FireWire mini-DV camcorder or mass-
storage USB video device:

1. Plug the proper cable into your MacBook.

2. Set the camcorder to VIR (or VCR) mode.
Some camcorders and digital cameras call this Play mode.

3. Click the Import button on the toolbar (refer to Figure 14-2).
iMovie opens the Import window.

4. Open the Import To pop-up menu at the top of the Import window,
and choose the destination for your new video clips.

To create a new event for the imported clips, choose New Event.
Alternatively, you can import into an existing Event or iMovie project. If
your family reunion spanned more than one day, you can create a new
Event for each day. (How do they think up these things?)

5. Click the desired video source in the Source list at the right of the
Import window.

If you're using a tape-based camcorder, playback controls appear
under the Camera Import window, mirroring the controls on your cam-
corder. This allows you to control the unit from iMovie. Keen! If you're
using a mass-storage camcorder connected by USB, you instead get

an Import All button beneath the thumbnails of available clips. (Note
that this button changes to Import Selected if you select one or more of
the clips.)
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If you choose your FaceTime HD camera from the list, you see a real-time
preview and a big red Record button. Click the Record button to start
and stop recording. (You can skip the rest of the steps in this section,
which deal only with USB and FireWire camcorders.)

6. To import selected clips from your FireWire DV camcorder, advance
the video to a couple of seconds before the point where you want to
start your capture; then click Import.

7. Click OK, and admire your handiwork.

iMovie begins transferring the footage to your drive and automatically
adds the imported clips to the specified destination.

\3
P If your clips are already on your drive, rest assured that iMovie can import
them, including those in high-definition video (HDV) format. iMovie also rec-
ognizes a number of other video formats, as shown in Table 14-1.

Table 14-1 Video Formats Supported by iMovie
File Type Description

DV Standard 4:3 digital video

DV widescreen Widescreen 16:9 digital video

MQV QuickTime movies

HDV and AVCHD High-definition (popularly called widescreen) digital video, in
720p and 1080i

MPEG-2 Digital video format used for DVD movies

MPEG-4 A popular format for streaming Internet and wireless digital
video, as well as handheld i0S devices such as the iPad,
iPhone, and iPod touch

To import a movie file, follow this bouncing ball:

1. Click the Import button on the toolbar.

2. Click the drive that stores your clips in the Sidebar, and navigate to
their location.

3. Select the desired clips in the list.

4. From the Import To pop-up menu at the top of the Import window,
choose the destination within iMovie.

5. Click Import.

Alternatively, you can also drag a video clip from a Finder window and
drop it in the Project pane.
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Making use of still images

Still images come in handy as impressive-looking titles or as ending credits
to your movie. (To be truly professional, make sure you list a gaffer and

a best boy.) However, you also can use still images to introduce scenes,
close scenes, and separate clips. For example, I use stills when delineating
the days of a vacation within a movie or different Christmas celebrations
over time.

Here are two methods of adding stills to your movie:

1 Adding images and video clips from Photos, iPhoto, or Aperture: Click
the Photos, iPhoto, or Aperture Library entries in the Libraries list to
access your images, right from iMovie (as shown in Figure 14-3). When
you find the image you want to add, just drag it to the right spot in the
Project pane.

+» Importing images from your hard drive: If you're a member of the
International Drag-and-Drop Society, you can drag TIFF, JPEG, GIF, PICT,
PNG, and PSD images directly from a Finder window and drop them into
the Project pane.

My Epic Example Movie 0s

Figure 14-3:
Pulling still
images from
Photos is
child’s play.
|
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Figure 14-4:
Calling on
my iTunes
Library to

add

Satchmo to

my iMovie.
|

Importing and adding audio
from all sorts of places

You can pull in everything from Wagner to Weezer as both background music
and sound effects for your movie. In this section, I focus on how to get those
notes into iMovie and then how to add them to your movie by dragging them
to the Project pane.

You can add audio from a number of sources:

v Adding songs from iTunes and GarageBand: Click the iTunes button
in the Content Library (or press 38+4) to display the contents of your
iTunes Library. Click the desired song in the scrolling list (which dis-
plays all your music). To display a playlist or Smart Playlist, click the
Music drop-down list box above the waveform display. Figure 14-4 illus-
trates the dynamite wedding ceremony playlist [ selected for this proj-
ect. You can add a track to your movie by dragging any song entry from
the list to the desired spot in the Project pane.

You're not limited to iTunes for ear candy, however. If you exported any
original music you’ve composed in GarageBand to your iTunes Library,
you can use those songs in your movie. Click the GarageBand button in
the Content Library to view your GarageBand music, and then drag and
drop to your heart’s content.

My Epic: Example Movie

3.28 - My Epic Example Movie 4.1s - DIRECTED BY
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v Adding sound effects: If you need the sound of a horse galloping for
your Rocky Mountains vacation clips, click Sound Effects in the Content
Library. iMovie includes a number of top-shelf audio effects you can
use in the sound effects audio track in the Project pane. This way, you
can add sound effects even when you’ve already added a background
song. Again, to add a sound effect, drag it to the perfect spot in the
Project pane.

<P If you have several gigabytes of music in your iTunes Library, it might be
more of a challenge to locate Janis Joplin’s rendition of “Me and Bobby
McGee,” especially if she’s included in a compilation. Let your super-
computer do the digging for you! Click in the Search box above the track
list, and begin typing a song name. iMovie narrows down the song titles
displayed to those that match the characters you type. To reset the
search box and display all your songs in the Library or selected playlist,
click the X icon that appears to the right of the box.

1 Recording directly from a microphone: Yep, if you're thinking
voiceover narration, you've hit the nail on the head. Check out the fol-
lowing sidebar for the scoop.

Narration the easy way

Ready to create that award-winning nature 5. Click in the desired spot within your movie
documentary? You can add voiceover narration in the Project pane where the narration
to your iMovie project that would make should begin.

e e Cous:teau proud. e e, yo a6 Click the Start Recording button.

record your voice while you watch your movie
playing, allowing perfect synchronization with iMovie prompts you with three tones before
the action! To add narration, follow these steps: the playhead reaches the selected spot in
your movie, so make sure you begin speak-

1. Press V to display the Voiceover controls ing after the third tone.

under the Viewer.

1. Watch the video while you narrate so you
can coordinate your narration track with
the action.

2. Click the Voiceover Options button, and
select the input device.

Today’s MacBook models sport a decent
internal microphone, but you can always
add a USB microphone to your system.

8. Click the red Stop Recording button to stop
recording.

iMovie adds an icon to the Project pane

3. Drag the input volume slider to a comfort- under the video with the voiceover.

able level.
9. Click the Close button in the Voiceover

4. To mute the audio from your movie (which
controls.

may make it easier to concentrate on
your narration), select the Mute Project
check box.
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You can fine-tune both the audio within a video clip or an audio clip you add
to your project. With the desired audio or video selected in the Event pane,
click the Adjust button at the top of the window, and then click one of the
buttons that appear above the Viewer. These buttons provide audio controls
that allow you to change the volume of the selected clip. You can even add
effects to your audio, such as Shortwave Radio or Cathedral, and you can use
iMovie’s built-in Equalizer to fine-tune the audio. When you're finished tweak-
ing, click the Adjust toolbar button again. (Oh, and don’t forget that you can
always return the clip to its original settings; just click the Reset Clip button
at the far right side of the Adjust toolbar, which looks like an arrow curving
to the left.)

A\\S

Building the Cinematic Basics

It’s time to dive in and add the building blocks to create your movie. Along
with the video clips, audio tracks, and still images you’ve imported, you can
add Hollywood-quality transitions, optical effects, and animated text titles. In
this section, I demonstrate how to elevate your collection of video clips into
a real-life, honest-to-goodness movie.

Adding clips to your movie

You can add clips to your movie via the Project pane and Event/Project
Library pane (refer to Figure 14-2). The Dynamic Duo works like this:

v Project pane: This displays the media you've added to your project
so far, allowing you to rearrange the clips, titles, transitions, and still
images in your movie.

v+ Event/Project Library pane: This pane acts as the source repository for
all your clips, displaying them arranged by Event (the date they were
shot or imported) or by Project (media you’'ve added to existing iMovie
projects).

Typically, you add a clip to your movie from an Event. Follow these steps:

1. Click the All Events entry in the Libraries list.

2. Move the cursor across clips in the Event pane to watch a preview of
the video.

3. When you’ve decided what to add to your project, either add the
entire clip or a selection:

e To select an entire clip: Right-click the clip’s thumbnail and choose
Select Entire Clip from the menu that appears.
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e To select a portion of a clip: Click and hold, and then drag the
cursor across the thumbnail. A yellow frame appears around your
selection. To change the length of the selected video, hover the
cursor over either end of the clip and drag the handle that appears
on either side. If you make a mistake while selecting video, just
click any empty space within the Event pane to remove the selec-
tion frame and try again.

4. Drag the selection from the Event pane to the spot where it belongs in
the Project pane.

Alternatively, you can press the E key.
Preview your work — and do it often.™

iMovie includes a Play Full Screen button, which appears when you move the
cursor to the Viewer. (Alternatively, press 38+Shift+F or choose Viewr> Play
Full Screen to watch the selection.) Press the spacebar to pause, and press
Esc to return to iMovie. Of course, you can also move the cursor across the
filmstrip in the Edit pane to quickly browse your project.

To play a selection from the beginning, press \ (the backslash). If you've ever
watched a director at work on a movie set, you may have noticed that he or
she constantly watches a monitor to see what things will look like for the
audience. You have the same option in iMovie!

Matrking clips

While you're watching video in the Event/Project Library pane, you may
decide that a certain clip has a favorite scene or that another clip has mate-
rial you don’t want, such as Uncle Ed’s shadow puppets. (Shudder.) iMovie
features Favorite and Rejected frames, allowing you to view and use your best
camera work (and ignore the worst stuff).

To mark a great video clip as a Favorite, select and right-click a range of
frames or the entire clip in the Event/Project Library pane, and then select
the Favorite menu item (or press F). To mark clips that are subpar, select the
offending clip in the Event/Project Library pane and press Delete (or right-
click and choose Reject). Clips marked as Favorites have a green line on top
of the clip, and clips marked as Rejected have a red line.

You can use the Search Filter option to specify which types of marked clips
are shown: Click the pop-up menu next to the Search field at the top of the
Event/Project Library pane. Your options include displaying all clips, display-
ing just Favorite clips, hiding Rejected clips, or displaying just Rejected clips.

If you decide that a Rejected clip isn’t so bad after all or that a Favorite really
isn’t your best work, no problem. Unmark any selected Favorite or Rejected
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scene in the Event/Project Library pane by choosing Mark Unrate (or
just press U).

Removing clips from your movie

Don'’t like a clip? Bah. To banish a clip from your movie, follow these steps:

1. Click the offending clip in the Project pane to select it.

Alternatively, you can select a portion of a clip by holding down the
mouse button and then dragging the selection box that appears.

2. Press Delete.
This deletes the clip from the Project pane, but the clip is still available
if you choose All Events or the iMovie Library from the Libraries list.

If you remove the wrong clip, don’t panic. Instead, use iMovie’s Undo feature
(press 38+Z) to restore it.

Reordering clips in your movie

If Day One of your vacation appears after Day Two, you can easily reorder
your clips and stills by dragging them to the proper space in the Project
pane. When you take your finger off the mouse (or trackpad), iMovie
automatically moves aside the rest of your movie with a minimum of fuss
and bother.

Editing clips in iMovie
If a clip has extra seconds of footage at the beginning or end (as it should, to
ensure you get all the action), you don’t want that superfluous stuff in your
masterpiece. Our favorite video editor gives you the following functions:

v Crop: Removes unwanted material from a video clip or still image

1 Rotate: Rotates a clip or image on its center axis

v Trim: Trims frames from a video clip
Before you can edit, however, you have to select a section of a clip:

1. Click a clip or image in either the Project pane (where changes you
make are specific to this project) or the Event pane (where edits you
make are reflected in any project using that footage).

iMovie displays the clip or image in the monitor.
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2. To select the entire clip or image, simply click it.

3. Drag the cursor across the thumbnail to select the section of the media
you want to edit.

Some editing functions, such as Crop and Rotate, automatically apply to
the entire clip.

The selected region is surrounded by a yellow frame. You're ready to
edit that selected part of the clip.

When you move the cursor to the beginning or end of the selection, handles
appear. You can make fine changes to the selected section by dragging
the handles.

v To crop: Click the Adjust button at the top of the screen to display the
editing controls in the Viewer, and then click the Crop button. Drag the
edges of the frame using the handles to select the section you want to
keep. To preview your selection, click the Play button that appears when
you move the cursor into the Viewer pane. When you're ready, click
the Done button (which bears a check mark), and everything but the
selected region is removed.

v To rotate: Click the Adjust button, and then click the Crop button. Now
you can click one of the two rotation buttons that appear at the right
side of the Viewer (both of which carry a box and curved arrow icon).
Each click rotates the media 90 degrees in the indicated direction. Click
the Done button (with the check mark) when the clip or image is prop-
erly oriented.

v To trim: Right-click the selection, and choose Trim to Playhead from the
context menu. iMovie removes the frames up to the playhead position
from the selected video.

Edits you make to one clip or still image can actually be copied to multiple

items. Select the edited clip and choose Edit= Copy from the iMovie menu.
Now you can select one or more clips and choose Edit=> Paste Adjustments
to apply Video, Audio, or Crop edits. (To apply all three types of edits, just

choose All.)

Transitions for the masses

Many iMovie owners approach transitions as visual bookends: They merely
act as placeholders that appear between video clips. Nothing could be fur-
ther from the truth, though, because judicious use of transitions can make
or break a scene. For example, which would you prefer after a wedding
ceremony — an abrupt, jarring cut to the reception, or a gradual fadeout
to the reception?
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Because today’s audiences are sensitive to transitions between scenes, you
should try not to overuse the same transition. Pick two or three that match
the mood of your film and the scenes between which you’re transitioning.
Also carefully weigh the visual impact of a transition. You might even decide
that having no transition is the most effective (directors call this deliberate
lack of a transition a jump cuft).

iMovie includes a surprising array of transitions, including old favorites
(such as Fade In and Dissolve) and some nifty stuff that you might not be
familiar with (such as Cube and Page Curl). To display your transitions col-
lection (see Figure 14-5), click the Transitions entry in the Content Library
(or press 38+1).

My Epic Example Movie 7s
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To see what a particular transition looks like, move the cursor over the
thumbnail to display the transition in miniature.

Adding a transition couldn’t be easier: Drag the transition from the thumb-
nail list, and drop it between clips or between a clip and a still image in the
Project pane. In iMovie, transitions are applied in real time.

Even Gone with the Wind had titles

The next stop on the iMovie Hollywood Features Tour is the Titles list, shown
in Figure 14-6. You find it by clicking the Titles entry in the Content Library
or by pressing 38+2. You can add a title with a still image, but iMovie also
includes everything you need to add basic animated text to your movie.
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My Epic Example Movie 7<

Figure 14-6:
Add titles
for your next
silent film.
|

Most of the controls you can adjust are the same for each animation style.
You can change the font, the size of the text, and the color of the text. To add
a title manually, follow these steps:

1. Select a Title animation thumbnail from the Titles list, and drag it to
the desired spot in the Project pane.

Note that the title is displayed in the Viewer as well as in the
Project pane.

2. Select the Title, and click the Adjust button at the top of the window.

3. Click the Title Settings button (which bears a capital T symbol) to
make any changes to the fonts or text attributes.

4. Click in the text box within the Viewer to delete the default text and
type your own titles.

5. Click the Done button to save your changes.
6. Click the Play button in the Viewer to preview your title.

iMovie displays a preview of the effect in the monitor with the settings
you choose.
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Adding maps and backgrounds

iMovie includes easy-to-use animated maps — think Indiana Jones traveling
by airplane from place to place — and static backgrounds that can be used
with your titles. To display them, click the Maps & Backgrounds entry in the
Content Library (or press 38+3).

To use an animated map, follow these steps:

1. Drag one of the globe or map thumbnails to the Project pane.

2. After the globe or map is created, select it and click the Adjust button
to display the controls above the Viewer.

3. Click the Map Settings button (which bears a globe icon), and then
click the Start Location button (and, optionally, the End Location
button) to enter the start and stop points for the animation.

Type a city or place name to see your choices. (Heck, you can even type
an airport code or decimal coordinates to specify the spot.)

4. Click Done, and watch as iMovie animates your location (or your trip)

in seconds!

To add a static background from the browser, drag it to the desired spot

within the Project pane.

Have a seat in the iMovie Theater

After you produce a great movie, what's the
easiest way to watch it? Or how can you quickly
and easily share that movie with your other
i0S devices and your Apple TV? The answer
is iMovie Theater mode, where you can add
completed movies, trailers, and individual video
clips — and everything is shared automatically
using iCloud! (Any Mac or i0OS device with
iMovie installed also includes its own iMovie
Theater, and the stuff you add appears there.)

Suppose you just want to present your content
on your own MacBook — or on a projector
or external monitor you've connected to your

computer. One click of the Theater button at the
top of the iMovie window displays thumbnails
of the content you've shared to the Theater.
You don't have to load a finished movie project
in Library mode. Double-click any thumbnail to
view that item. To switch back to Library mode
and work on your current iMovie project, click
the Library button at the top of the window.

To add a movie, trailer, or video clip in the
Event/Project Library pane, click the item to
select it, click the Share button on the toolbar
at the top of the iMovie window, and click the
Theater button.
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Creating an Honest-to-Goodness
Movie Trailer

Yes, friends, you read that correctly: iMovie includes a Trailer feature that
can turn your film clips into a Hollywood-class preview, complete with genre
transitions and background music.

To create a trailer project, follow these steps:

1. Click the New button on the iMovie toolbar, and choose Trailer from
the pop-up menu.

2. Click a Movie Trailer thumbnail to select it.

If you hover the cursor over the thumbnail and click the Play icon that
appears, iMovie displays a nifty preview of the trailer style you selected.
You can click different thumbnails to preview their look before you
decide. Naturally, you want to choose a trailer style that most closely
matches the mood you want to project with your movie.

Note that each trailer has a suggested number of cast members. This
number reflects the number of people who will appear in the clip place-
holders during the editing process. (More on this in a moment.)

3. Click Create.

4. Type a name for your project, and click OK.

iMovie replaces the Project pane with the Trailer pane, as shown in
Figure 14-7. You can fine-tune your trailer with the Outline, Storyboard, and
Shot List tabs:

v+ Outline: On the Outline tab, you can edit the titles used in the trailer,
as well as pop-up lists of information, such as the gender of the star(s)
and the logo style you want for your “studio” at the beginning of the
trailer. To change a text field, click in it and type the new text. You see
the changes you make in the Trailer display appear in the monitor in
real time.

1 Storyboard: After you complete your edits to the titles, click the
Storyboard tab. Now you can edit the text for each transition: Simply
click the text to display the edit box, and type. You can also drag clips
from the Event pane (or from a Finder window) to fill the storyboard’s
placeholders for video clips. To delete a clip from the storyboard, click
it to select it, and press Delete.
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<P To preserve the look and feel of the trailer storyboard, try to match your
clips with the description and suggested activity indicated by the place-
holder. (In other words, don’t stick a wide-angle video clip of the family
dog cavorting in the yard into a placeholder marked “Closeup.” You get
the idea.)
<P v The Storyboard tab may not look like an editing timeline, but you can

move the cursor anywhere within the storyboard to preview your trailer.
The playhead indicator appears wherever the cursor appears, allow-

ing you to watch the clip or transition it’s resting on. You’ll soon be
sweeping the mouse to the left or right to move through each section of
your trailer.

v~ Shot List: For an overall listing of each clip required for the full trailer,
click the Shot List tab. On this tab, clips are organized by type. For
example, all the action clips appear in one section, and all the landscape
and close-up clips are grouped as well. If necessary, you can also add,
delete, or swap video clips from the Shot List.

To preview your trailer in its entirety, move the cursor inside the Viewer and
click the Play button (or the Play Full-Screen button at the far right of the
Viewer controls). Naturally, any storyboard placeholder you haven't filled
with a clip displays just the placeholder.
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Note that iMovie displays your trailer when you click the Updated
Projects entry in the Libraries list, and it now appears in the Event/Project
Library pane.

[ bet all those hard-working Hollywood video editors are fuming at how easy
it is to create a trailer in iMovie!

Sharing Vour Finished
Classic with Others

CMBER

Your movie is complete, and iMovie has saved it automatically to your drive.

Now you’re wondering where to go from here. Select your movie in the Event/
Project Library pane, and click Share on the toolbar at the top of the window.
iMovie can unleash your movie on your unsuspecting family and friends (and
even the entire world) in a number of ways:

v iTunes: Send your movie to your iTunes Library as a movie.
v Theater: Add your movie to the iMovie Theater on your MacBook.

+* YouTube/Facebook/Vimeo/CNN iReport: Why, certainly you can send
your iMovie directly to any of these websites! Can it get any more conve-
nient than that? (I think not.)

v~ File: Create a copy of your movie on your hard drive in one of four reso-
lutions (from Standard Definition to High Definition).

v Email: Send your movie as an email message attachment.

When you choose a sharing option, iMovie displays the video quality for the
option and makes automatic changes to the movie attributes. (For example,
choosing Email reduces the finished movie as far as possible in file size.)

If you're worried about permanently reducing the quality of your proj-
ect by sharing it in a smaller size, fear not! When you choose a sharing
option to export your movie, your original project remains on your hard
drive, unchanged, so you can share a better-quality version at any time in
the future.



Chapter 15

Recording Your Hits
with GarageBand

In This Chapter
Navigating the GarageBand window
Adding tracks and loops to your song
Repeating loops and extending your song
Building arrangements
Adding effects to instruments
Exporting your work across the globe

Burning your song to an audio CD

Do you dream of making music? I've always wanted to join a band, but

I never devoted the time to learning to play the guitar. You know the
drill: Rock stars struggle for years to master an instrument, practice for
untold hours and memorize chords. Wait a second, I almost forgot. You don’t
need to do any of that now!

Apple’s GarageBand lets a musical wannabe (like yours truly) make music
anywhere with a MacBook — complete with a driving bass line, funky horns,
and perfect drums that never miss a beat. In fact, the thousands of prere-
corded loops on tap in this awesome application allow you to design your
music to match that melody running through your head, from techno to jazz
to alternative rock.

This chapter explains everything you need to know to create your first song.
[ also show you how to import your hit recording into iTunes so that you can
listen to it on your iPhone with a big silly grin on your face (as I do) or add it
to your next iMovie project or Photos slideshow.

Don’t be too smug when you think of all that practicing and hard work you
missed out on. What a shame!
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Shaking Hands with Your Band

As you can see in Figure 15-1, the GarageBand window isn’t complex, and
that’s good design. In this section, I list the most important controls so you
know your Play button from your Loop Browser button.

New Track button

Library button
Smart Controls Go to Beginning Media Browser
Move Play button View/Hide Loop Browser
Backward/
Forward Loop Time/Tempo Display Loop Search box

. Classic Electric Piano

Figure 15-1:
The Garage-
Band
window,
edged in
wood grain,
no less.
|

Track list Playhead Timeline

Your music-making machine includes

v Track list: In GarageBand, a track is a discrete instrument you set up
to play one part of your song. For example, a classical piece for string
quartet would have four tracks — one each for violin, viola, cello, and
bass. The Track list contains all the tracks in your song, arranged so
you can easily see and modify them, like the rows in a spreadsheet. A
track begins in the list, stretching out to the right all the way to the end
of the song. In the upper left of Figure 15-1, [ already have one track
defined — a Classic Electric Piano.
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v Timeline: This scrolling area holds the loops (see the next bullet) you
add, compose, or record, allowing you to move and edit them easily. When
a song plays, the Timeline scrolls to give you a visual look at your music.
(Bear with me; you’ll understand that cryptic statement in a page or two.)

v Loop: Loops — prerecorded clips of an instrument being played in a
specific style and tempo — are the building blocks of your song. Most
are five seconds in length, and others are even shorter. You can drag
loops from the Loop Browser to a track and literally build a bass line or
guitar solo. (It’s a little like adding video clips in iMovie to build a film.)
Loops can also be repeated within a track, which I discuss further in a
page or two.

v+~ Playhead: This vertical line is a moving indicator that shows you the
current position in your song while it scrolls by in the Timeline. You can
drag the playhead to a new location at any time. The playhead also acts
like the insertion cursor in a word processing application: If you insert
a section of a song or a loop from the Clipboard, it appears at the play-
head’s current location. (More on copying and inserting loops later, so
don’t panic.)

1 New Track button: Click this button to add a new track to your song.

v+ View/Hide Loop Browser button: Click the button with the loop icon to
display the Loop Browser at the right side of the window (as shown in
Figure 15-1); click it again to close it. You can see more of your tracks’
contents at one time without scrolling by closing the Loop Browser.

1 View/Hide Media Browser button: Click this button (which bears icons
of a filmstrip, camera, and musical note) to display the Media Browser
at the right side of the window; click it again to close it (and see more of
your tracks). Use the Media Browser to add media (in this case, digital
song files or movies) to your GarageBand project for use as ringtones.

* Go to Beginning button: Clicking this button returns the playhead to
the beginning of the Timeline. (Note that this button appears only when
you’re not playing a song.)

* Move Back/Forward One Measure buttons: To move quickly through
your song by jumping to the previous or next measure, click the corre-
sponding button.

+~ Play button: Hey, old friend! At last, a control you've probably used
countless times before — and it works just like the same control within
iTunes or on your audio CD player. Click Play, and GarageBand begins
playing your entire song. Notice that the Play button turns green. To
pause the music, click Play again; the button loses that sexy green
sheen, and the playhead stops.

v Time/Tempo display: This cool-looking LCD display shows you the cur-
rent playhead position in seconds.
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You can click the clock icon at the left of the display to choose Beats &

Project mode, which includes these features:
® Measures: Displays the current measure and marks the beat
e Chord: Displays note and chord names
® Project: Shows or changes the song’s key, tempo, and signature
v Volume slider: Here’s another familiar face. Just drag the slider to raise

or lower the volume.

Of course, more controls are scattered around the GarageBand window, but
these are the main controls used to compose a song — which is the next stop!

Composing Made Easy

In this section, I cover the basics of composition in GarageBand, working
from the very beginning. Follow along with this running example:
1. Click the GarageBand icon in the Dock; it looks like an electric guitar.

2. If GarageBand opens a window for a previous project, close it by
clicking the Close button in each window.

GarageBand displays the top-level New Project dialog, as shown in
Figure 15-2.

u New Project
Slay

2

Ringtone Hip Hop

Figure 15-2:
Start
creating
y()ur new Details
song here.
|

Electronic Songwriter Empty Project
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3. Click New Project from the list at the left.

4. Click the Empty Project icon, and click the Choose button.
GarageBand displays the Source dialog.

5. Click the Software Instrument icon.

In this chapter, I focus on using software instrument tracks, which are
the easiest for a non-musician to use (and don’t require you to actually
play any notes on an instrument).

6. Click the Create button.

You see the window shown in Figure 15-1. Now you’re ready to add tracks.

Adding tracks

Although I'm not a musician, I am a music lover. | know that many classical
composers approached a new work in the same way you approach a new
song in GarageBand — by envisioning the instruments they wanted to hear.
(Iimagine Mozart and Beethoven would’ve been thrilled to use GarageBand,
but I think they did a decent job with pen and paper.)

If you've followed along to this point, you've noticed these things:

v A Musical Typing keyboard in your GarageBand window: You can
record the contents of a software instrument track by playing the Musical
Typing keyboard layout. (As you might imagine, this isn’t the best solu-
tion.) If you’re a musician, the best method of recording your own notes is
with a MIDI instrument, which I discuss later in the chapter. You can dis-
play the Musical Typing keyboard window at any time by pressing $8+K.

If the keyboard window is onscreen and you don’t need it, banish it by
pressing 38+K or by clicking the Close button in the keyboard window.

+* The example song with only one empty track: If you want to write the
next classical masterpiece for Classic Electric Piano, that’s fine. (I'm
a big fan of this instrument, so I'll use this track later in the example.)
Note that you can always delete a track completely, however. Click the
offending track to select it, and choose Track=>Delete Track from the
GarageBand menu bar.

You can use five kinds of tracks in GarageBand:

v Software instrument tracks: These tracks aren’t audio recordings.
Rather, they’re mathematically precise algorithms that your MacBook
renders (builds) to fit your needs. If you have a MIDI instrument con-
nected to your laptop, you can create your own software instrument
tracks. (More on MIDI instruments later in this chapter.)
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+” Real instrument tracks: These tracks are actual audio recordings, such
as your voice or a physical instrument without a MIDI connection.
(Think microphone.)

v Electric Guitar and Bass tracks: GarageBand includes a real instrument
track especially made for either an electric guitar or bass. This allows
you to use a number of different amplifiers and stompboxes (those
effect pedals that electric guitarists are always poking with their foot to
change the sound of their instruments).

v Drummer track: I call this feature “Ringo in a Box” — a drum track that’s
automatic, yet very configurable and easy to customize. You have pre-
sets galore, so you can quickly jump into different drum sets and play-
ing styles.

v Video tracks: The video sound track appears if you're scoring (adding
music to) an iMovie movie. Along with the video sound track, you get a
cool companion video track that shows the clips in your movie. (More
on this in the “Look, I'm John Williams!” sidebar later in this chapter.)

It’s time to add a software instrument track of your very own:

1. Press 38+Option+N (or click the New Track button).
GarageBand displays the New Track sheet.
2. Click the Software Instrument icon, and then click Create.

3. From the Library pane on the far left, choose the general instrument
category you want.

I chose Guitar, which prompts a second list of choices to the right, still
in the Library pane.

4. From the second list, choose your specific style of weapon, such as
Classic Clean for a simple playing style.

Figure 15-3 shows the new track that appears in your list when you

ﬁ follow these steps. Now you're ready to rock with both the original
electric piano and an electric guitar! If you like, you can hide the Library
by clicking the Show/Hide Library button at the upper-left corner of
the window.

<P GarageBand includes a Songwriter project (also available from the top-level
New Project dialog; refer to Figure 15-2). When you choose a Songwriter proj-
ect, GarageBand presents you with a full set of instrument tracks, plus a real
instrument track for your voice. You're instantly ready to start adding loops
and recording your own voice!
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Figure 15-3:
The new
track
appears,
ready to
rock.
|

Choosing loops

After you have a new, empty track, you can add loops to build your song

D from the Loop Browser. Apple gives you thousands of loops to choose from,
in a mind-boggling variety. Click the Loop Browser button (which bears a
loop symbol, somewhat like a roller coaster; refer to Figure 15-1) to display
your collection, as shown in Figure 15-4.

Classic Clean

Figure 15-4:
The Loop
Browseris a
great hang-
out for any
musician.
|
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Looking for just the right loop

The running project already includes two tracks but no loops yet. (Refer to
Figure 15-3.) Just for grins, add a Classic Electric Piano loop. Follow these
steps to search through the loop library for just the right rhythm:

1. In the Loop Browser, click the button that corresponds to the instru-
ment you're using.

I chose the Elec Piano button.

A list of different beats appears in the pane at the bottom of the Loop
Browser window. (Refer to Figure 15-4.)

2. Click one of the loops with a green musical-note icon.

Go ahead; this is where things get fun! GarageBand begins playing the
loop nonstop, allowing you to get a feel for how that particular loop
sounds.

The examples I chose for this chapter are software instruments, which
are identified by a green musical-note icon. (If you have a band at home,
have at it with real instruments.)

3. Click another entry in the list, and the application switches to that
loop.

Now you’re beginning to understand why GarageBand is so cool for both
musicians and the note-impaired. It’s like having your own band, with
members who never get tired, never miss a beat, and play whatever you
want while you’re composing. (Mozart would’ve loved this.)

If you want to search for a particular instrument, click in the Search box
at the top of the Loop Browser, and type the text you want to match.
GarageBand returns the search results in the list.

4. Scroll down the list, and continue to sample the different loops until
you find one that fits like a glove.

For this reporter, it’s Upbeat Electric Piano 01; refer to Figure 15-4.
5. Drag the entry to your Classic Electric Piano track, and drop it at the
very beginning of the Timeline (as indicated by the playhead).

Your window looks like Figure 15-5.

If you want that same beat throughout the song, you don’t need to add

any more loops to that track. (More on extending that beat in the next sec-
tion.) However, if you want the piano’s beat to change later in the song, you
add a second loop after the first one in the same track. For now, leave this
track as is.
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Classic Clean

Figure 15-5:
A track with

é,“‘ Whoops! Did you do something you regret? Don’t forget that you can undo
most actions in GarageBand by pressing the old standby 38+Z immediately
afterward.

Second verse, same as the first

When you compose, you can add tracks for each instrument you want in
your song:

v Each track can have more than one loop.

v Loops don’t have to start at the beginning; you can drop a loop any-
where in the Timeline.

For example, you might prefer to start a song with just your drum kit, with
your bass line beginning some time later (for a funkier opening).

You put loops on separate tracks so they can play simultaneously on dif-
ferent instruments. If all your loops in a song are added on the same track,
you hear only one loop at a time, and all the loops use the same software
instrument. By creating multiple tracks, you give yourself the elbow room to
bring in the entire band at the same time. It’s {iber-convenient to compose
your song when you can see each instrument’s loops and where they fall

in the song.

a\\J

Click the Reset button in the Loop Browser (refer to Figure 15-4) to choose
another instrument or genre category.
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Look, I'm John Williams!

You too can be a famous composer of
soundtracks . . . well, perhaps not quite as
famous as Mr. Williams, but even he had to start
somewhere. To add a GarageBand score to an
iMovie, choose Track= Show Movie Track
from the GarageBand menu bar to display the
Movie track. Now choose File=> Open Movie,
select the movie, and click Open.

At this point, you add and modify instrument
tracks and loops just as you would with any
other GarageBand project. The existing sound
for the iMovie project appears in the Movie

Sound track. A Video Preview thumbnail
appears within the Movie track. When you
click the Play button, the video is shown as
well so that you can check your work and
tweak settings (as described later in the
chapter).

After you finish composing, choose File=
Movie > Export Audio to Movie. You can select
the quality of the movie file. Note that you can't
edit your finished movie file using iMovie again,
so scoring should always be the last step in
your filmmaking process.

Resizing, repeating, and moving loops

If you haven’t already tried listening to your entire song, try it now. You
can click Play at any time without wreaking havoc on your carefully created
tracks. Sounds pretty good, doesn’t it?

But wait: [ bet the song stopped after about five seconds, right? (You can
watch the passing seconds using either the Time/Tempo display or the
second rule that appears at the very top of the Timeline.) I'm sure you want
your song to last more than five seconds! After the playhead moves past the
end of the last loop, your song is over. Click Play again to pause the playback;
then click the Go to Beginning button (shown in the margin and labeled in
Figure 15-1) to move the playhead back to the beginning of the song.

The music stops so soon because your loops are only so long. As mentioned
earlier, most loops are five seconds in length, and others are even shorter. To
keep the groove going, you must do one of three things:

1 Resize the loop. Hover the cursor over either the left or right edge of
most loops, and an interesting thing happens: The cursor changes to an
icon representing the left or right edge of the loop, with an arrow point-
ing away from the loop. That’s your cue to click and drag — and as you
drag, some loops expand to fill the space you’re making, repeating the
beats in perfect time. By resizing a loop, you can literally drag the loop’s
edge as long as you like.

+” Repeat the loop. Depending on which loop you chose, you might find
that resizing it doesn’t repeat the measure. Instead, the new part of the
loop is simply dead air. In fact, the length of many loops is limited to
anywhere from one to five seconds. However, if you move the cursor
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By repeat-
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you can
keep the
notes
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over the corner of a loop you want to extend, it turns into a vertical line
with a circular arrow, which tells you that you can click and repeat the
loop. GarageBand actually adds multiple copies of the same loop auto-
matically, for as far as you drag the loop. In Figure 15-6, you can see how
I repeated the Upbeat Electric Piano 01 loop.

Classic Clean

L]

v Add a new loop. You can switch to a different loop to change the music’s
flow. Naturally, the instrument stays the same, but there’s no reason you
can’t use a horn-riff loop in your violin track (as long as it sounds good
played by a violin)! To GarageBand, a software instrument track is compat-
ible with any software instrument loop you add from the Loop Browser, as
long as that loop is marked with your old friend, the green musical note.

You can also use the familiar Cut (38+X), Copy ($8+C), and Paste (§8+V) edit-
ing keyboard shortcuts to cut, copy, and paste loops both on the Timeline
and from track to track. And you can click a loop and drag it anywhere.

A track doesn’t have to be filled for every second with one loop or another.
Most of my songs have a number of repeating loops with empty space
between them as different instruments perform solo.

Each track can be adjusted so you can listen to the interplay between two or
more tracks or hear how your song sounds without a specific track:

1 Mute a track: Click the tiny speaker button under the track name in the
list, and the button turns blue to indicate that the track is muted. To
turn off the mute, click the speaker icon again.

v Change the volume or balance of a track: Use the mixer that appears
next to the track name. This comes in handy if you want an instrument
to sound louder or confine that instrument to the left or right speaker.

291
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Figure 15-7:
| just added
anew
marker in
my song'’s
Arrange-
ment track.
|
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Using the Arrangement track

GarageBand includes another method you can use to monkey with your
music: Use the Arrangement track to define (or mark) specific sections of a
song, allowing you to reorganize things by selecting, moving, and copying
entire sections. For example, you're probably familiar with a song’s chorus
(or refrain) and how often it appears during the course of the tune. With the
Arrangement track, you can reposition the entire chorus within your song,
carrying all the loops and settings within the chorus along with it. If you need
another chorus, just copy that arrangement.

To use the Arrangement track, display it by choosing Track= Show
Arrangement Track from the GarageBand menu bar. The Arrangement

track then appears as a thin strip at the top of the Track list. Click the Add
Marker button (the circular button bearing a plus sign) at the right side

of the Arrangement track, and you see a new marker appear, as shown in
Figure 15-7. You can drag the right side of the Arrangement marker to the left
or right to resize it, or drag it to move it anywhere in the song.

Classic Clean

il

To rename an Arrangement marker, click the current name to display the
menu of existing marker names, click Rename, type a new name for the
marker in the text box, and press Return. In Figure 15-7, you can see the first
marker is named Intro.

Now, here’s where Arrangement markers get cool:

+* To move an entire Arrangement marker: Click anywhere in the mark-
er’s title bar (except the title itself), and drag it anywhere you like in the
song. (You can hold down Shift while clicking multiple contiguous mark-
ers to select more than one.)
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+* To copy an Arrangement marker: Hold down the Option key, and drag
the desired marker’s title to the spot where you want the copy to appear.

v To empty the regions in an Arrangement marker: Select it, and press
Delete. To completely delete the marker, press Delete a second time.

Tweaking the settings for a track

You don’t think that bands like Rush and U2 just “play and walk away,” do
you? No, they spend hours after their recording session is over, tweaking
their music in the studio and on the mixing board until every note sounds
just as it should. You can adjust the settings for a track, too. The tweaks you
can perform include adding effects (pull a Hendrix by adding echo and reverb
to your electric guitar track) and kicking in an equalizer (for fine-tuning the
sound of your background horns).

To make adjustments to a track, follow these steps:

1. Click the desired track in the track list to select it.

[ 2. Click the Smart Controls button at the top left of the GarageBand
9, window (labeled in Figure 15-1).

You can also press B to hide or display the Smart Controls pane.

3. Click the Controls tab to show the settings shown in Figure 15-8.

Note that the settings you see will vary according to the type of instru-
ment track you've selected.

Figure 15-8:
Finesse your
tune by
tweaking
the sound of
a specific
track.
|
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4. Click the knob control or slider for a specific effect to change the

sound.

GarageBand offers a Visual Equalizer window you can use to create a

custom equalizer setting for each track. From the Smart Controls pane,
click the EQ button. To change the Bass, Low Mid, High Mid, or Treble
setting for a track, click and drag the equalizer waveform in the desired
direction. And yep, you can do this while your song is playing, so you
can use both your eyes and ears to define the perfect settings!

5. Click the Smart Controls button (or press B) to return to GarageBand.

Time for a Mark’s Maxim:

Save your work often in GarageBand, just as you do in iMovie. One power
blackout, and you’ll never forgive yourself. When you’re pleased with the
progress you’ve made in your project, press 35+S and enjoy the peace of mind
(and use Time Machine with an external backup drive for good measure).™

Joinin and jam... or talk!

GarageBand is even more fun if you happen
to play an instrument! (And yes, I'm envious,
no matter how much | enjoy the techno
and jazz music | create. After all, take away
my MacBook, and I'm back to playing the
kazoo — at least until | absorb all the Learn to
Play lessons for the guitar. More on Learn to
Play in the next sidebar.)

Most musicians use MIDI instruments called
controllersto play music on the computer. That
pleasant-sounding acronym stands for Musical
Instrument Digital Interface. A wide variety of
MIDI controllers is available these days, from
traditional MIDI keyboards to more exotic
fun, such as MIDI saxophones. For example,
Apple sells a 49-key MIDI keyboard from Line
6 for around $150. Alternatively, the highly
recommended Casio CTX-3000 offers 61 keys,
and it's available online for about $130. (Both
keyboards connect to your trusty MacBook
using a USB cable.)

If you have an older instrument with traditional
round MIDI ports — you’ll never confuse
them with USB connectors — you need a

USB-to-MIDI converter. You can find this
type of converter for around $50 on websites
catering to musicians.

After your instrument is connected, you can
record tracks using any software instrument.
Create a new software instrument track as
| demonstrate in this chapter, select it, and
play a few notes. Suddenly you're playing the
instrument you chose! If nothing happens,
check the MIDI status light— which appears in
the Time display (refer to Figure 15-1) — to see
whether it blinks with each note you play. If not,
check the installation of your MIDI connection,
and make sure you've loaded any required
drivers, as well as your MIDI settings within
QuickTime and the input settings in the System
Preferences Sound pane.

Drag the playhead to a beat or two before
the spot in the Timeline where you want your
recording to start. This gives you time to match
the beat. Then click the big red Record button
and start jamming! When you're finished, click
the Play button to stop recording.
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Sharing Your Songs

After you finish your song, you can play it whenever you like through
GarageBand. But then again, that isn’t really what you want, is it? You want to
share your music with others on an audio CD or download it to your iPod so

that you can enjoy it yourself while walking through the mall.

iTunes to the rescue! As with the other digital lifestyle applications I cover
in this book, GarageBand can share the music you make through the
digital hub that is your MacBook. (You’ll become an iTunes power user

in Chapter 12.)

Hey, GarageBand, teach me how to play!

In the early days of GarageBand, you were
limited to creating music. And if you were a
non-musician like yours truly, GarageBand had
no practical use as a tool for teaching yourself
how to actually p/ay an instrument.

Ah, but Apple’s addition of Learn to Play
actually turns GarageBand into your private
video tutor for basic piano and guitar! From the
New Project dialog (refer to Figure 15-2), click
the Learn to Play entry in the list on the left to
display your guitar and piano lessons. Right
out of the box, you have a solid introduction
to both instruments. You can also download
more lessons — which cover more advanced
topics such as fingering and chords — for each
instrument from the Lesson Store (available
from the New Project dialog). Your onscreen
instructor can even record what you play.

In fact, GarageBand includes the How Did |
Play feature, which can pinpoint the portions
of a lesson you played correctly and which

spots in the song you need to work on. (I'm
told musicians call such trouble spots flubs.
Having no musical talent whatsoever, anything
| attempted to play would be one giant flub.) To
try How Did | Play, open your favorite lesson,
click the Record button (with the red dot in the
center), and begin playing. To stop recording,
click the Play button. Now you can see the
portions of the song you played correctly
(where the notation area is green) and spots
where you, um, flubbed (the notation area turns
red). Oh, and make sure your instrument is in
tune, because even correct notes played on an
instrument that's out of tune produce errors for
How Did | Play!

If you find the free Learn to Play lessons
valuable, you can move up to the Artist
lessons, which are taught by famous musicians
(including favorites of mine such as Alex
Lifeson, John Fogerty, and Sting, who actually
teaches you how to play “Roxanne”)!
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Creating song files and vingtones in iTunes

You can create an AAC song file (or even a ringtone) from any project in just
a few simple steps:

1. Open the project you want to share.

2. Choose Share~>Song to iTunes from the GarageBand menu bar.

GarageBand displays the settings you see in Figure 15-9.

|
Figure 15-9:
Tweaking
settings for
iTunes
audio files.
|
\\3
To create a ringtone and send it to iTunes, choose Share > Ringtones to
iTunes from the GarageBand menu bar.
3. Click in each of the text boxes to type the title, artist name, composer
name, album name, and iTunes playlist for the tracks you create.
You can leave the defaults as they are if you prefer. Each track you
export is named after the song’s name in GarageBand.
MBER 4. Fron} t!le Quality pop-up menu, choose the proper audio quality for
S the finished file.

The higher the quality, the larger the file.
5. Click the Share button.

After a second or two of hard work, your MacBook opens the iTunes
window and highlights the new (or existing) playlist that contains your
new audio, whether it be a song or ringtone.
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Exporting a project

Sometimes, you’d like to create an audio file from a GarageBand project,
but you’d rather not automatically add that song or ringtone to your iTunes
Music Library. (Perhaps you now have audio proof that a family member
does indeed snore.) In that case, you can always export a song straight to
your hard drive by following these steps:

1. Open the project you want to export.

2. Choose Share = Export Song to Disk.

3. Type a name for the audio file.

Click the button next to the Save As text box to select a specific location
where the file should be created, or choose a preset from the Where
pop-up menu.

4. From the Quality pop-up menu, choose the desired audio quality.

As with sharing a song to iTunes, the higher the quality, the larger the
file.

5. Click Export.

Burning an audio CD

Ready to create a demo CD with your latest GarageBand creation? If your
MacBook has an internal or external optical drive, follow these steps to burn
an audio disc from within GarageBand:

1. Open the song you want to record to disc.

2. Load a blank disc into your optical drive.

If you see a dialog requesting that you choose an action, click the
Ignore button.

3. Choose Share= Burn Song to CD.
Note that the CD you create has only one track. To include more tracks on

the CD, share the song to your iTunes Library (as described earlier), create a
playlist containing the desired songs, and burn that playlist within iTunes.
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In this part . . .

v Create documents with the iWork applications.
v Troubleshoot and fix problems with your MacBook.

v~ Expand your MacBook with peripherals, external drives,
and more.

v Maintain your MacBook properly for peak performance.




Chapter 16

Desktop Publishing
with Pages

In This Chapter
Creating a Pages document
Entering, editing, and formatting text
Inserting tables and graphics
Resizing objects
Checking your spelling
Printing Pages documents

Sharing your work

th’s the difference between word processing and desktop publish-
ing? In a nutshell, it’s in how you design your document. Most folks

use a word processor like an old-fashioned typewriter, much like I'm using
Microsoft Word right now. (Yawn.)

A desktop publishing application allows far more creativity in choosing where
to place text, how to align graphics, and how to edit formats. I think desktop

publishing is more visual and intuitive, allowing your imagination a free hand
at creating a document.

In this chapter, I show you how to set your inner designer free from the
tedious constraints of word processing! Whether you need a simple letter, a
stunning brochure, or a multipage newsletter, Pages can handle the job with
ease — and you'll be surprised at how simple it is to use. Plus, Pages is a
free download for any MacBook of recent vintage (and free Apple software is
always A Good Thing).
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Creating a New Pages Document

To create a new Pages document, follow these steps:

g," 1. Click the Pages icon on the Dock.
If the Pages icon doesn’t appear on your Dock, click the Launchpad icon
i and then click the Pages icon (which looks like a document and pen). If
you haven’t installed the three iWork applications yet — Pages, Numbers,
and Keynote — click the App Store icon in your Dock and download
them directly!

2. Click the New Document button at the lower-left corner of the Open
dialog.

Pages displays the Template Chooser window, shown in Figure 16-1.

e e Choose a Template

Reports
Stationery
Fiyors & Postors
Cards
Miscellaneous

Newslattar

Figure 16-1:
Selecta
template
from the
Template
Chooser
window.
|

\\3

You can also create a new Pages document at any time from the File
menu. Just choose File> New to display the Template Chooser window.

3. In the list to the left, click the type of document you want to create.

The thumbnails on the right are updated with templates that match
your choice.
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4. Click the template that most closely matches your needs.

5. Click the Choose button to open a new document in the template
you selected.

Open an Existing Pages Document

A\\S

Of course, you can always open a Pages document from a Finder window.
Just double-click the document icon. (The All My Files location in the Finder
window Sidebar makes it easy to track down a document.) You can also open
a Pages document from within the program. Follow these steps:

1. Launch Pages as described in the preceding section.
2. Press 35+0 to display the Open dialog.

The Open dialog operates much the same as a Finder window in Icon,
List, or Column view mode. To open a document you’ve already saved
in your iCloud Drive, click the Pages item under the iCloud heading in
the sidebar at the left of the dialog and double-click the desired docu-
ment thumbnail in the thumbnail display at the right side of the dialog.
To open a document on your internal drive or network, click the desired
location in the Open dialog sidebar. (If you're into convenience like I am,
click one of the locations under the Favorites heading to jump immedi-
ately to common folders like your Music, Pictures, or Downloads!)

3. Click the desired drive in the Devices list at the left of the dialog, and
then click folders and subfolders until you locate the Pages document.

You can also click in the Search box at the top of the Open dialog and
type in a portion of the document name or its contents.

If you're using Icon view mode (or you're displaying the Preview column
in Column view mode), you can hover the cursor over a document
thumbnail and quickly flip through the different pages by clicking on the
left and right arrows that appear. This “find” feature can help you iden-
tify a particular Pages document without even opening it.

4. Double-click the thumbnail (or filename) to load it.
If you want to open a Pages document you've edited in the recent past, things

get even easier. Just choose Filew> Open Recent, and you can open the docu-
ment with a single click from the submenu that appears.

Pages can open, edit, and save documents created with the Macintosh
version of Microsoft Word.
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Saving Your Work

Pages fully supports El Capitan’s Auto-Save feature, but you may feel the
need to manually save your work after you finish a significant edit (or if you
need to take a break while designing). If you're editing a document that has
already been saved at least once, a new version of the document is saved to
its current location — and you can continue with your work.

However, if you're working on a new document that hasn’t previously been
saved, follow these steps to save it:

1. With the Pages document open, press 35+S.
2. Type a filename for your new document.

3. Open the Where pop-up menu, and choose a location in which to save
the document.

Note that Pages defaults to your iCloud Drive as the target location.
This way, you can open and edit your Pages document on any Mac or
iOS device that shares the same Apple ID. Alternatively, click the button
sporting the down arrow to expand the Save As sheet. This allows you
to navigate to a different location on your hard drive or network, or to
create a new folder to store this Pages project.

4. Click Save.

&,N\BER You can create a version of a Pages document by choosing File=> Save. To
& revert the current document to an older version, choose File=> Revert To.
Pages gives you the option of reverting to the last saved version, or you can
click Browse All Versions to choose from multiple versions of the document.

Touring the Pages Window

Before you dive into any real work, let me show you around the Pages
window. You'll find the following major components and controls, as shown
in Figure 16-2:

1 Pages list: This thumbnail list displays all the pages you've created
within your document. (For a single-page document, of course, the Page
list contains only a single thumbnail.) You can switch instantly between
different pages in your document by clicking the desired thumbnail in
the list. If the list isn’t visible, click the View button at the left side of the
Pages toolbar and click Show Page Thumbnails.
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|
Figure 16-2:
The major
points of
interest in

the Pages

window.

v Layout pane: This section takes up most of the Pages window. It’s where
you design and edit each page in your document.

+* Toolbar: Yep, Pages has its own toolbar. It keeps all the most common
application controls within easy, one-click reach.

v Inspector: This window extension allows you to quickly switch the
appearance of selected paragraphs, characters, and lists. You can hide
and display the Inspector from the View menu, or by clicking the Format
or Document buttons on the toolbar.

Pages list Toolbar
eee Example Pages Document — |
=l = . AT W] =) = B a EX =
T i e ki e T
= =
Contents *
Font
Helvetica Neue |}
Regular B | o
e+ u o O
= = =
0 =
aEl +
» Spacing 12 B
» Bullets & Lists None
|
Layout pane Inspector

Entering and Editing Text

If you've used a modern word processing program, you'll feel right at home
typing within Pages. The bar-shaped text cursor, which looks like a capital
letter I, indicates where the text you enter will appear in a Pages document.
To enter text, simply begin typing. To edit existing text in your Pages docu-
ment, select and highlight the text. As you type, Pages replaces the existing
text. You can delete text by clicking and dragging across the characters to
highlight them and then pressing Delete.
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Using Text and Graphics Boxes

Within Pages, text and graphics appear in boxes, which can be resized by
clicking and dragging one of the handles that appear around the edges of the
box. (Click the box to select it and hover the cursor over one of the square
handles; you'll see that it changes to a double-sided arrow, indicating that
Pages is ready to resize the box.)

You can also move a box, including all the stuff it contains, to another loca-
tion within the Layout pane. Click in the center of the box, and drag the box
to the desired spot. Note that Pages displays yellow alignment lines to help
you align the box with other elements around it (or with regular divisions of
égN\BER the page, such as the vertical center of a poster or flyer).

Y
To select text or graphics within a box, you must first click the box to select
it and then double-click the line of text or the graphic you want to change.

The Three Amigos: Cut, Copy, and Paste

“Hang on, Mark. You’ve covered moving stuff, but what if you want to copy

a block of text or a photo to a second location? Or how about cutting some-
thing from a document open in another application?” Good questions. That’s
when you can call on the power of the cut, copy, and paste features within
Pages. The next few sections explain how you do these actions.

Cutting stuff

Cutting selected text or graphics removes them from your Pages document
and places that material on your Clipboard. (Think of the Clipboard as a hold-
ing area for snippets of text and graphics you want to manipulate.) To cut
text or graphics, select some material and choose Edit=>Cut or press 38+X.

Copying text and images

When you copy text or graphics, the original selection remains untouched,
and a copy of the selection is placed on the Clipboard. Select some text or
graphics, and choose Edit=> Copy or press 38+C. To copy selected items
by dragging, hold down the Option key while you drag the items to their
destination.
“&N\Bfﬁ . . .
< If you cut or copy a new selection to the Clipboard, it erases what was
there. In other words, the Clipboard holds only the latest material you cut
or copied.
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Pasting from the Clipboard

Wondering what you can do with the stuff that’s stored on the Clipboard?
Pasting the contents of the Clipboard places the material at the current loca-
tion of the insertion cursor.

You must paste the contents before you cut or copy again to avoid losing
what’s on the Clipboard.

To paste the Clipboard contents, click the insertion cursor at the location
you want and choose Edit=>Paste or press 38+V.

Formatting Text the Easy Way

If you feel that some (or all) of the text in your Pages document needs a face-
lift, you can format that text any way you like. Formatting lets you change the
color, font family, character size, and attributes as necessary.

After the text is selected, you can apply basic formatting in two ways:

v~ Use the Inspector. The Inspector appears at the right side of the Pages
window (refer to Figure 16-2). The controls it displays vary according
to the selection you’ve made. (Click the Format button on the tool-
bar, which looks like a tiny blue paintbrush, to display and hide the
Inspector.) Click to select a font control to display a pop-up menu, and
then click your choice. For example, select a portion of text and open
the Font Family pop-up menu to change the font family from vanilla Arial
to something more daring. You can also select characteristics, such as
the text’s paragraph style, or choose italic or bold. The Inspector also
provides buttons for both vertical and horizontal text alignment.

” Use the Format menu. Most controls displayed within the Format
section of the Inspector are also available from the Format menu. Click
Format and hover the mouse cursor over the Font menu item, and you
can then apply bold, italic, and underlining to the selected text. You can
also make the text bigger or smaller. To change the alignment from the
Format menu, click Format and hover the mouse cursor over the Text
menu item.

Adding a Spiffy Table

In the world of word processing, a table is a grid that holds text and graphics
for easy comparison. You can create a custom table layout within Pages with
a few simple clicks.
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Follow these steps:

1.

Click the insertion cursor at the location where you want the table to
appear.

. Click the Table button on the Pages toolbar.

Pages displays thumbnail images of different table styles. You have a
selection of colors. Some tables also include highlighted rows and col-
umns. Use the left and right buttons to display different styles of thumb-
nails until you find the one that’s closest to the table you need.

\3
< Don’t worry if the style isn’t exactly right. You can always change the
layout by selecting the table and displaying the Format Inspector, where
you can fine-tune all sorts of font, color, grid, and border options.
3. Click the style thumbnail to insert the table.
If you need to change the number of rows or columns in your table,
Pages makes it easy. To add or delete rows or columns directly from the
table, select it and click the row and column buttons that appear. (Each
bears an equals sign, as shown in Figure 16-3.)
[ KK ] Example Pages Document
O~ | 1suv b il P GA_g W Z
pzart. METROPOLITAN SYMPHONY
Suscipit ipsum nec set ligula
F o H;;der:iFouler_ e
— O“‘- St
Figure 16-3: - —
Use Table (= =
controls to 2 Aermsing fow Color )
tweak your > Row & o Sze
table.
|
4. Click within a cell in the table to enter text.
“&N\BEH The table cell automatically resizes and wraps the text you enter to fit.
©
<&

You can paste material from the Clipboard into a table. See the earlier
section “Pasting from the Clipboard” for details.
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Here are a few pointers on how to dress up your table and make its data
more attractive and readable:

v Change the borders on a selected cell. Click the Format icon on the
toolbar to open the Inspector, click the Cell tab, and then click the
3 Border section.

Select a range of cells in a table by holding down Shift as you click. Hold
down 38 and click to select multiple cells that aren’t contiguous.

v Add a background color to selected cells, or fill them with an image
for a background. Click the Cell tab, and then click the Fill section in the
Inspector and choose a type of background.

Adding Alluring Photos

You can choose between two methods of adding a picture within your
Pages document:

v As a floating object: You place the image in a particular spot, and it doesn’t
move even if you make changes to the text. To add a floating object, drag
an image file from a Finder window and place it at the spot you want within
your document. Alternatively, you can click the Media button on the tool-
bar, click Photos, navigate to the location where the file is saved, and click

A3 the image thumbnail. Figure 164 shows the Media Browser in action.

Click the magnifying glass icon to search for a specific item using
keywords or by filename.

[ X X ] Example Pages Document
(=R ~ 0 il [ ] = v a B
View  Zoom bsert  Tabla  Chart  Text  Shace M . Commant Shara  Tips Format Document
- E = E
“ 3

» Shadow

Raflection

Figure 16-4:
Hey, isn't
that the
Pages
Media
Browser?
|

CONTENTS
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Note that a floating object (such as a shape or image) can be sent to the
background, where text does not wrap around it. To bring back a back-
ground object as a regular floating object, click the object to select it and
choose Arrange= Bring to Front. (More about background objects later
in this chapter.)

v As an inline object: The image flows with the surrounding text as you
make layout changes. To add an inline object, hold down the 38 key as
you drag an image file from a Finder window and place it where you
want within your document. You can also click the Media toolbar button
and click Photos to display the Media Browser. Navigate to the location
where the file is saved, hold down the 38 key, and drag the image thumb-
nail to the spot where you want it in the document.

To resize an image object, click the image to select it and drag one of the selec-
tion handles that appear along its border. (The handles look like tiny squares.)
The side-selection handles drag only that edge of the frame. The corner-
selection handles resize both adjoining edges of the selection frame. Hold down
the Shift key to make the vertical and horizontal proportions remain fixed.

3

Adding a Background Shape

To add a shape (such as a rectangle or circle) as a background for your text,
follow these steps:
1. Click the insertion cursor in the location you want.
2. Click the Shape button on the Pages toolbar, and choose a shape.
The shape appears in your document.
3. Click the center of the shape, and drag it to a new spot.

Shapes can be resized or moved in the same manner as image boxes. See
&g\\l\BEﬁ the preceding section.
< You can type over a shape set as a background. Before you do, though, select
the shape, and choose Arrange= Send to Back.

Are You Sure about That Spelling?

Pages can check spelling as you type (the default setting) or after you com-
plete your document. If you find automatic spell-checking distracting, you
should pick the latter method.

\‘&N\BE” . . . . .
&L As my technical editor reminds me, spell-checking only confirms that a word
matches an entry in the Pages dictionary, not that it’s the right word for the
job!If you've ever “red” a document that someone else “rote,” you understand.



Chapter 16: Desktop Publishing with Pages 3 ’ ’

To check spelling as you type, follow these steps:
1. Click the Edit menu, and hover the cursor over the Spelling and
Grammar menu item.
2. Choose Check Spelling While Typing from the submenu that appears.

If a possible misspelling is found, Pages underlines the word with a red
dashed line.

3. Right-click the word to choose a possible correct spelling from the list,
or choose Ignore Spelling if it’s spelled correctly.

To turn off automatic spell-checking, click the Check Spelling While Typing
menu item again to deselect it.

To check spelling manually, follow these steps:
1. Click within the document to place the text insertion cursor where the

spell check should begin.

2. Click Edit, hover the cursor over the Spelling and Grammar menu item,
and choose Check Document Now from the submenu that appears.

3. Right-click any possible misspellings, and choose the correct spelling,
or choose Ignore Spelling if the word is spelled correctly.

Printing Your Pages Documents

Ready to start the presses? You can print your Pages document on real
paper, of course, but don’t forget that you can also save a tree by creating
an electronic PDF instead of a printout. You’ll find the PDF button within the
standard El Capitan Print dialog.

To print your Pages document on old-fashioned paper, follow these steps:

1. Within Pages, choose File> Print.
Pages displays the Print sheet.
2. Click in the Copies field, and enter the number of copies you need.
3. Select the pages to print:
e To print the entire document, select All.

e To print a range of selected pages, select the From radio button and
enter the starting and ending pages.

4. Click the Print button to send the document to your printer.
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Sharing That Poster with Others

3

3

Besides printing — which is, after all, so very passé these days — you can
choose to share your Pages document electronically using several methods:

v Share on iCloud: If you stored your new masterpiece in your iCloud

Drive, you can send a link to the finished document in a number of dif-
ferent ways. Click the Share button on the Pages toolbar, and hover the
cursor over the Share Link via iCloud item to send the link through Mail,
Messages, Twitter, or Facebook. The recipient of the link can easily view
your document with a single click.

You can specify whether a shared document can be edited (or simply
viewed) by others. Click Share on the toolbar, and then click the View
Share Settings item. Click the Permissions pop-up menu to choose an
editable or view-only document. To assign an optional password (which
is required for anyone to open the document), click the Add Password
button. Finally, click Share Document to send the link to others using
Mail, Messages, Twitter, or Facebook.

+* Send a Copy: Maybe you prefer to send a copy of the actual document,

which the recipient can open using Pages on his or her own Mac or i0S
device. Click Share on the toolbar, and hover the cursor over the Send
a Copy item. You can send the document via Mail or Messages, or you
can make it available through AirDrop (if the recipient is within range of
your MacBook’s Wi-Fi signal).

If you decide to send your Pages document as an email attachment,
don’t forget that most ISPs have a maximum message size. If your docu-
ment is too large, your mail server probably will reject it.

v Export: You're not limited to sharing over that Internet thing! Pages

can also export your work directly to your drive in one of six different
formats: a PDF file, a Microsoft Word document, an ePub file (for use
with electronic book apps like iBooks), a document compatible with the
previous version of Pages, a ZIP archive, or even plain text. (Remember
when everything was in plain text?) Choose File=> Export To, and pick
your format; Pages displays any options you can set for that format.
When you’re ready, click Next and select the location where Pages
should save the file. Click Export, and sit back while your favorite desk-
top publishing application does all the work.

If the recipient of your document doesn’t need to edit your work, I rec-
ommend creating a PDF file, which keeps your document as close as
possible to how it appears in Pages.
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Creating Spreadsheets
with Numbers

In This Chapter
Creating, opening, and saving spreadsheets
Selecting cells, entering data, and editing data
Formatting cells
Adding and removing rows and columns
Creating simple calculations
Adding charts to your spreadsheets
Printing a Numbers spreadsheet

A re you downright afraid of spreadsheets? Does the idea of building a
budget with charts and all sorts of fancy graphics send you running
for the safety of the hall closet? Well, good MacBook owner, Apple has again
taken something that everyone else considers super-complex and turned

it into something that normal human beings can use! (Much as Apple did
with video editing and songwriting. Is there any type of software that Apple
designers can’t make intuitive and easy to use?) If your MacBook is less than
three years old, Numbers is a free download from the App Store.

In this chapter, I demonstrate how the Numbers spreadsheet program can
help you organize data and analyze important financial decisions for home
and business — everything from a household budget to your company’s
sales statistics!

Before You Launch Numbers . . .

In case you’re unfamiliar with applications like Numbers and Microsoft
Excel — and the documents they create — let me provide you with a little
background information.
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A spreadsheet organizes and calculates numbers by using a grid system of
rows and columns. The intersection of each row and column is a cell, which
can hold either text or numeric values. Cells can also hold calculations
called formulas and functions, which are usually linked to the contents of
surrounding cells.

Spreadsheets are wonderful tools for making decisions and comparisons,
because they let you plug in different numbers — such as interest rates or
your monthly insurance premium — and instantly see the results. These are
some of my favorite spreadsheets that I use regularly:

v Car and mortgage loan comparisons

v A college planner
&,N\BEH v My household budget (not that we pay any attention to it)
©
<&

Numbers can open, edit, and save spreadsheets created with Microsoft Excel.

Creating a New Numbers Document

Like Pages (Apple’s desktop publishing application that I cover in Chapter 1
of this minibook), Numbers ships with a selection of templates you can
modify quickly to create a new spreadsheet. For example, after a few
modifications, you can easily use the Budget, Loan Comparison, and
Mortgage templates to create your own spreadsheets.

To create a spreadsheet project file, follow these steps:

i 1. Click the Launchpad icon on the Dock.

2. Click the Numbers icon.
(1]
3. Click the New Document button at the lower-left corner of the Open

dialog that appears.

Numbers displays the Choose a Template window, shown in Figure 17-1.
(To display the Choose a Template window and start a new Numbers
project at any time, just choose File> New.)

4. From the list on the left, click the type of document you want to
create.

The document thumbnails in the center are updated with templates that
match your choice.

5. Click the template that most closely matches your needs.

6. Click the Choose button to open a new document using the template
you selected.
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CEK) Choose a Template
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Figure 17-1:
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templates

aren't fright-
ening at all!
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Opening an Existing Spreadsheet File

If you see an existing Numbers document in a Finder window (or you locate it
using Spotlight or the All My Files location), just double-click the Document
icon to open it. Numbers automatically loads and displays the spreadsheet.

It’s equally easy to open a Numbers document from within the program.
Follow these steps:

1. From Launchpad, click the Numbers icon to run the program.
2. Press 38+0 to display the Open dialog.

<P As a MacBook power user running OS X El Capitan, you can save and
load Numbers documents directly to and from your iCloud Drive. All
three iWork applications — Pages, Numbers, and Keynote — feature an
Open dialog that can display the contents of your iCloud Drive as well as
your laptop’s internal drive. If the spreadsheet is stored in your iCloud
Drive, click the Numbers item under the iCloud heading in the Sidebar
at the left of the dialog and then double-click the desired document
thumbnail.

3. If the document is stored on your MacBook’s internal drive, your
network, or one of your Favorites locations click the desired drive or
folder in the Sidebar at the left of the dialog. Drill down through fold-
ers and subfolders until you locate the desired Numbers document.
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A\\S

\\3

Save

3

If you're unsure where the document is, click in the Search box at the
top of the Open dialog and type a portion of the document name or even
a word or two of text it contains. Note that you can choose to search
your drive, your iCloud Drive, or both.

4. Double-click the spreadsheet to load it.

If you want to open a spreadsheet you've been working on over the last few
days, choose File> Open Recent to display Numbers documents that you've
worked with recently.

Those Spreadsheets!

Thanks to the Auto-Save feature in El Capitan, you no longer have to

fear losing a significant chunk of work because of a waning battery or a
coworker’s mistake. However, if you're not a huge fan of retyping data,
period, you can also save your spreadsheets manually after making a major
change. Follow these steps to save your spreadsheet to your hard drive:

1. Press 38+S.

If you're saving a document that hasn’t yet been saved, the Save As
sheet appears.

2. Type a filename for your new spreadsheet.

3. Open the Where pop-up menu, and choose a location in which to save
the file.

Common locations are your iCloud Drive, Desktop, Documents folder,
and Home folder.

If the location you want isn’t listed in the Where pop-up menu, click the
down-arrow button next to the Save As text box to display the full Save
As dialog. Click the desired drive in the Devices list at the left of the
dialog, and then click folders and subfolders until you reach the desired
location. Alternatively, type the folder name in the Spotlight search box
at the top right, and double-click the desired folder in the list of match-
ing names. (As a bonus, you can also create a new folder in the full Save
As dialog.)

4. Click Save.

After you save a Numbers document for the first time, you can create a
version of that document by choosing Filew> Save. To revert the current
document to an older version, choose File> Revert To. You can choose to
revert to the last saved version, or you can click Browse All Versions to
look through multiple versions of the document and choose one of those to
revert to.
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Exploring the Numbers Window

Apple has done a great job of minimizing the complexity of the Numbers
window. Figure 17-2 illustrates these major points of interest:

1 Sheets tabs: Because a Numbers project can contain multiple spread-
sheets, they’re displayed in the Sheets tabbed bar at the top of
the window. To switch among spreadsheets in a project, click the
desired tab.

v Sheet canvas: Numbers displays the rows and columns of your spread-
sheet in this section of the window; you enter and edit cell values within
the sheet canvas.

v Toolbar: The Numbers toolbar keeps the most common commands
you'll use within easy reach.

v Inspector: Located at the right side of the Numbers window, the
Inspector displays editing controls for the object that’s currently
selected, regardless of whether it’s a selection of text, a table, or a single
cell. (If you enter an equals sign [=] into a cell to create a formula, the
Inspector displays the Function list, where you can specify a calculation
that Numbers should perform.)
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Navigating and Selecting Cells
in a Spreadsheet

You can use the scrollbars to move around in your spreadsheet, but when
you enter data into cells, moving your fingers from the keyboard is a hassle.
Numbers has various handy navigation shortcut keys you can employ, as
shown in Table 17-1. After you commit these keys to memory, your produc-
tivity level will shoot straight to the top.

Table 17-1 Movement Shortcut Keys in Numbers

Key or Key Combination Where the Cursor Moves

Left arrow (<) One cell to the left

Right arrow (—) One cell to the right

Up arrow (T) One cell up

Down arrow ({) One cell down

Home To the beginning of the active worksheet

End To the end of the active worksheet

Page Down Down one screen

Page Up Up one screen

Return One cell down (also works within a selection)
Tab One cell to the right (also works within a selection)
Shift+Enter One cell up (also works within a selection)
Shift+Tab One cell to the left (also works within a selection)

You can also use the mouse or trackpad to select cells in a spreadsheet:

v To select a single cell, click it.

v To select a range of adjacent cells, click a cell at any corner of the range
you want and drag in the direction you want.

v To select a column of cells, click the alphabetic heading button at the top
of the column.

v To select a row of cells, click the numeric heading button at the far left
of the row.
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Entering and Editing Data in a
Spreadsheet

After you navigate to the cell in which you want to enter data, you're ready to
type your data. Follow these steps to enter That Important Stuff:

1. Either click the cell or press the spacebar.

A cursor appears, indicating that the cell is ready to hold any
data you type.

2. Enter your data.

<MBER
é,“\ Spreadsheets can use both numbers and alphabetic characters

within a cell; either type of information is considered data in the
Spreadsheet World.

3. When you’re ready to move on, press Return (to save the data and
move one cell down) or press Tab (to save the data and move one
cell to the right).

Make a mistake? No big deal:

v To edit data: Click within the cell that contains the data error (to select
the cell), and then click the cell again to display the insertion cursor.
Drag the insertion cursor across the characters to highlight them, and
then type the replacement data.

v To delete characters: Select the cell, and then highlight the characters
and press Delete.

Selecting the Correct Number Format

After you enter your data (in a cell, row, or column), you might need to
format it so it appears correctly. For example, say you want certain cells
to display a specific type of number, such as a dollar amount, percentage,
or date. Numbers gives you a healthy selection of number-formatting
possibilities.

P Characters and formatting rules — such as decimal places, commas, and
dollar and percentage notation — are part of number formatting. If your
spreadsheet contains units of currency, such as dollars, format it as such.
Then all you need to do is type the numbers, and the currency formatting is
applied automatically.
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Figure 17-3:
From the
Inspector,
you can for-
mat the data
you've
entered.
|

To specify a number format, follow these steps:

1. Select the cells, rows, or columns you want to format.
2. Click the Format toolbar button.
3. Click the Cell tab in the Inspector.

4. From the Data Format pop-up menu, choose the type of formatting you
want to apply, as shown in Figure 17-3.
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Aligning Cell Text Just So

You can also change the alignment of text in the selected cells. The
default alignment is flush left for text and flush right for numeric data. Follow
these steps:

1. Select the cells, rows, or columns you want to format.

See the earlier section “Navigating and Selecting Cells in a Spreadsheet”
for tips on selecting stuff.

2. Click the Format toolbar button.

3. Click the Text tab of the Inspector to display the settings shown in
Figure 17-4.
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4. Click the corresponding Alignment button to choose the type of

formatting you want to apply.

You can choose left, right, center, and justified (as well as the defaults of
text left and numbers right). Text can also be aligned at the top, center,

or bottom of a cell.

Do you need to set apart the contents of some cells? For example, you might
need to create text headings for some columns and rows or to highlight the
totals in a spreadsheet. To change such formatting, select the cells, rows,

or columns you want to format, and then open the Font Family, Font Size,

or Font Color buttons on the Text tab.

Formatting with Shading

Shading the contents of a cell, row, or column is helpful when your spread-
sheet contains subtotals or logical divisions. Follow these steps to shade

cells, rows, or columns:

1. Select the cells, rows, or columns you want to format.
2. Click the Format toolbar button.
3. Click the Cell tab of the Inspector.

321
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Figure 17-5:
Adding
shading and
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cells, rows,
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umns is
easy in
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|
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4. Click the triangle next to the Fill heading, and choose a shading

option from the Fill pop-up menu.

Figure 17-5 shows the controls for a gradient fill.
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5. Click the color box to select a color for your shading.

Numbers displays a color picker (also shown in Figure 17-5).

6. Click to select a color.

7. After you achieve the effect you want, click the color box again to

close the color picker.

You can also add a custom border to selected cells, rows, and columns from
the Cell tab. Click the triangle next to the Border heading to select just the

right border.

Inserting and Deleting Rows
and Columns

What’s that? You forgot to add a row, and now you’re three pages into your
data entry? No problem. You can easily add — or delete — rows and col-
umns. First, select the row or column adjacent to where you want to insert

(or delete) a row or column, and do one of the following:
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v For a row: Right-click and choose Add Row Above, Add Row Below, or
Delete Row from the shortcut menu that appears.

v For a column: Right-click and choose Add Column Before, Add Column
After, or Delete Column from the shortcut menu that appears.

If you select multiple rows or columns, right-click and choose Add. Numbers
inserts the same number of new rows or columns you selected.

You can also insert rows and columns via the Table menu at the top of the
Numbers window.

The Formula Is Your Friend

It’s time to talk about formulas, which are equations that calculate values
based on the contents of cells you specify in your spreadsheet. For example,
if you designate cell Al (the cell in column A at row 1) to hold your yearly
salary and cell B1 to hold the number 12, you can divide the contents of cell
Al by cell Bl (to calculate your monthly salary) by typing this formula into
any other cell:

=A1/B1

Formulas in Numbers always start with an equals sign, and they may include
one or more functions as well. A function is a preset mathematical, statisti-
cal, or engineering calculation that will be performed, like figuring the sum or
average of a series of cells.

“So what'’s the big deal, Mark? Why not use a calculator?” Sure, you could.
But maybe you want to calculate your weekly salary. Rather than grab a
pencil and paper, you can simply change the contents of cell Bl to 52, and —
boom! — the spreadsheet is updated to display your weekly salary.

That’s a simple example, of course, but it demonstrates the basics of using
formulas (and the reason why spreadsheets are often used to predict trends
and forecast budgets). It’s the what-if tool of choice for everyone who works
with numeric data.

To add a simple formula within a spreadsheet, follow these steps:

1. Select the cell that will hold the result of your calculation.
2. Type = (the equals sign).

The Formula Box appears within the confines of the cell.
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Figure 17-6:
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3. Click the Format button on the Numbers toolbar to display the avail-

able functions in the Inspector, as shown in Figure 17-6.
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=ABS(0) returns 0.

4. Click the category of calculation you want from the left column of the

Inspector.

Instead of scrolling through the entire function library, it’s easier to
choose a category — such as Financial for your budget spreadsheet —
to filter the selection. (Alternatively, you can click in the Search box and
type a function name or keyword.)

To display more information about a specific function, click it in the
right column of the Inspector. In Figure 17-6, choosing the SUM function
brings up a description at the bottom of the Inspector.

. After you select the perfect function in the right column, click the

Insert Function button.

The function appears in the Formula box, along with any arguments
it requires.

In case you're unfamiliar with the term argument, it refers to a value
specified in a cell that a formula uses. For example, the SUM formula
adds the contents of each cell you specify to produce a total; each of
those cell values is an argument.
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6. Click an argument button in the formula, and click the cell that con-
tains the corresponding data.

Numbers automatically adds the cell you indicated to the formula.
Repeat this step for each argument in the formula.

7. After you finish, click the Accept button — the green check mark — to
add the formula to the cell.

That’s it! Your formula is now ready to work behind the scenes, doing math
for you so the correct numbers appear in the cell you specified.

Adding Visual Punch with a Chart

Sometimes, you just have to see something to believe it, so it can help to use
the data you've added to a spreadsheet to generate a professional-looking
chart. After you've entered the data you want to chart, follow these steps:

\\3 1. Select the adjacent cells you want to chart by dragging.

To choose individual cells that aren’t adjacent, you can hold down the
38 key as you click.

2. Click the Chart button on the Numbers toolbar.
The Chart button bears the symbol of a bar graph.

Numbers displays the thumbnail menu shown in Figure 17-7. Note that
you can display different categories of charts by clicking one of the
three tabs at the top (2D/3D/Interactive), and you can scroll the menu to
reveal additional thumbnails by using the left- and right-arrow buttons.

3. Click the thumbnail for the chart type you want.

Numbers inserts the chart as an object within your spreadsheet so you
can move the chart. You can drag using the handles that appear on the
outside of the object box to resize your chart.

With your chart selected, click the Format toolbar button to display
your old friend the Inspector, complete with the controls you can use
to customize your chart’s appearance. For example, you can change the
colors and add (or remove) the title and legend.

A\\S

4. To change the default title, click the title box to select it; click it again
to edit the text.
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Figure 17-7:
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Printing Your Spreadsheet

You can easily send a Numbers spreadsheet to a USB or shared network
printer — or, if you’d rather create an electronic copy of the document as an
Adobe PDF, you can click the PDF button that appears on the Numbers Print
dialog and select a location where the file will be saved.

To print a Numbers spreadsheet on your default printer, follow these steps:

1. Choose File Print from the Numbers menu bar.

Because a Numbers document can contain multiple spreadsheets, you
can select a specific spreadsheet to print (by clicking it in the grid and
clicking the Print This Sheet radio button at the bottom of the window),
or you can print all spreadsheets in the document (by clicking the Print
All Sheets radio button).

2. Click the desired page orientation.

Spreadsheets with a large number of columns are often printed in land-
scape orientation to ensure that everything fits on the page. You can
also scale the spreadsheet so it automatically fits on the page by clicking
the Fit button (next to the Content Scale slider).
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. Click Print at the bottom of the window.

Numbers displays the Print dialog. To display additional settings, click
the Show Details button at the bottom of the sheet.

4. Click in the Copies field, and enter the number of copies you need.

5. Select the pages to print:

e To print the entire spreadsheet, select All.

e To print a range of selected pages, select the From radio button, and
enter the starting and ending pages.

. Click the Print button to send the document to your printer.

Click the Share toolbar icon to share your spreadsheet masterpiece
with others (either as a link to the document on your iCloud Drive or
an actual copy of the document file). You can also specify whether the
document should be view-only or password-protected.






Chapter 18

Building Presentations
with Keynote

In This Chapter
Creating a new presentation
Adding slides
Using selection boxes
Entering and editing text
Formatting text
Adding presenter’s notes
Inserting media and shapes
Running a slideshow

Printing slides and notes

’ t seems like only yesterday that [ was giving business presentations with
a clunky overhead projector and black-and-white acetate transparencies.
Fancy color gradients and animation were unheard of, and the only sound
my presentations made was the droning of the projector’s fan. [ might as well
have been using tree bark and chalk.

Thank goodness those “cave painting” days are gone. Cutting-edge presen-
tation software like Keynote makes slide creation easy and — believe it or
not — fun! This is the application Steve Jobs once used for his Macworld key-
notes every year. So much visual candy is available that you’ll never need to
shout to wake your audience again.

In this chapter, I first demonstrate how simple it is to build a stunning
Keynote presentation. Then you can see how to start and control your slide
display from the keyboard (or even your iPhone, iPad, or iPod touch). And
don’t forget that you can print your slides and notes so your audience can
keep a copy of your brilliant work.
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Creating a New Keynote Project

Like the other applications in the iWork suite, Keynote begins the document
creation process with a Theme Chooser window. To create a new presenta-
tion project, follow these steps:

i 1. Click the Launchpad icon on the Dock.
- 2. Click the Keynote icon, which looks like a lectern.

D 3. Click the New Document button at the lower-left corner of the Open
dialog.

The Theme Chooser window, shown in Figure 18-1, appears. (I have to
say that these are probably the most stunning visual building blocks I've
ever seen in a presentation application.)

K] Choose a Theme:

Standard

Figure 18-1:
Selecta
template
from the
Theme
Chooser
window.
|

4. Choose the aspect ratio, using either the Standard or Wide button at
the top of the window.

Although you don’t necessarily need to select an exact match for your
MacBook’s screen resolution, it’s a good idea to select the value closest
to your projector’s maximum resolution. If someone else is providing
the projector, the Standard size is the more compatible choice. If you'll
present on a typical high-resolution computer monitor, widescreen pro-
vides a better display. (Of course, nothing’s stopping you from creating
two documents of the same presentation, one in Standard ratio and one
using Wide ratio. As the Scouts say, “Be prepared!”)
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5. Click the theme thumbnail that most closely matches your needs.

6. Click the Choose button to open a new document that uses the theme
you selected.

Opening a Keynote Presentation

If an existing Keynote presentation file is visible in a Finder window, you can
double-click the document icon to open the project. If Keynote is already run-
ning, follow these steps to load a project from within the application:

1. Press 38+0 to display the Open dialog.

2. Click the desired drive in the Devices list at the left of the dialog; then
click folders and subfolders until you locate the Keynote project. If the
project is stored in your iCloud Drive, click the Keynote item under
the iCloud heading in the sidebar at the left of the dialog, and then
double-click the desired project thumbnail.

If the project is stored on your hard drive, the All My Files location can
quickly display all your documents. You can jump directly to any loca-
tion or folder under the Favorites heading by simply clicking on the
entry. Oh, and don’t forget that you can use the Search box at the top of
the Open dialog to locate the document by name or by some of the text
it contains.

3. Double-click the filename to load it.
\3
P If you want to open a Keynote document you’'ve edited in the recent past,

things get even easier! Just choose File> Open Recent, and you can open the
document with a single click from the submenu that appears.

Saving Vour Presentation

Because Keynote provides full support for the OS X Auto-Save feature, saving
your work often isn’t as critical as it used to be. To safeguard your work in a
world of power failures, though, follow these steps:

1. Press 38+S.

If you're saving a document that hasn’t yet been saved, the familiar Save
As sheet appears.

2. Type a filename for your new document.
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3. From the Where pop-up menu, choose a location in which to save the
document.

By default, Keynote saves the project directly to your iCloud Drive
(iCloud appears in the Where pop-up menu), making it available to other
Macs and iOS devices using the same Apple ID. To select a location not
available from the Where pop-up menu, click the button with the down-
arrow symbol to expand the sheet. You can also create a new folder from
the expanded sheet.

4. Click Save.

You can create a version of a Keynote presentation by choosing File=>Save. To
revert the current presentation to an older version, choose Filer> Revert To.
Keynote gives you the option of reverting to the last saved version, or you can
click Browse All Versions to browse multiple versions of the presentation and
revert to any saved version.

Putting Keynote to Work

a\\J

Ready for the 5-cent tour of the Keynote window? Launch the application
and create or load a project, and you see the tourist attractions shown in
Figure 18-2:

v~ Slides list: Use this thumbnail list of all the slides in your project to navi-
gate quickly. Click a thumbnail to switch instantly to that slide.

The Slides list can also display your project in outline format, allowing
you to check all your discussion points. (This is a great way to ferret out
any “holes” in your presentation’s flow.) While in outline mode, you can
still jump directly to any slide by clicking the slide’s title in the outline.
To display the outline, choose View Outline. You can switch back to
the default Navigator Slides list by choosing View > Navigator.

v Layout pane: Your slide appears in its entirety in this pane. You can add
elements to and edit the content of the slide from the Layout pane.

+* Toolbar: As does the toolbar in Pages and Numbers, the Keynote toolbar
makes it easy to find the most common controls you’ll use while design-
ing and editing your slides. Clicking an icon on the toolbar performs an
action, just as selecting a menu item does.

1 Presenter Notes pane: You might decide to add notes to one or more
slides — either for your own use or to print as additional information
for your audience. Click the View icon on the toolbar, and select Show
Presenter Notes (or choose View > Show Presenter Notes) to open the
Notes pane. This text box appears under the Layout pane.

v Inspector: Keynote displays this pane on the right side of the window
when you click the Format button, allowing you to format selected text
and images on the fly.
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Adding Slides

Keynote creates a single Title slide when you first create a project. However,
not many presentations are complete with just a single slide! To add more
slides to your project, use one of these methods:

v Click the Add Slide button on the toolbar.
v Choose Slide> New Slide.
v Press 38+Shift+N.
v Right-click an existing slide in the Slides list, and choose New Slide from
the menu that appears.
Keynote adds the new slide to your Slides list and automatically switches to
the new slide in the Layout pane.
o Need a slide that’s very similar to an existing slide you’ve already designed?

Right-click the existing slide, and choose Duplicate to create a new slide just
like it. (Consider this cloning without the science.)

To move slides to different positions in the Slides list (that is, to change
the order in your Keynote presentation), drag each slide thumbnail to the
desired spot in the list.
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Working with Text and Graphics Boxes

All the text and graphics placeholders on your first Title slide appear within
boxes. Keynote uses these boxes to manipulate text and graphics. You can
resize a box (and its contents) by clicking the box and dragging one of the
handles that appear around the edges of the box. (The cursor changes into a
double-sided arrow when you're “in the zone.”) Side selection handles drag
only the edge of the frame, whereas corner selection handles resize both
W adjoining edges of the selection frame.
To keep the proportions of a box constrained, hold down Shift while dragging
its corner handles.

Boxes make it easy to move text and graphics together (as a single unit) to

another location within the Layout pane. Click in the center of the box, and

drag the box to the desired spot. Keynote displays alignment lines to help

you align the box with other elements around it (or with regular divisions of

Q&N\BEII the slide, like horizontal center).

©

« To select a box, click it. To select text or graphics within a box (see the next
section), double-click the box.

When you’re resizing a photo in a box, hold down the Shift key while you
drag the frame. Doing so tells Keynote to preserve the image’s aspect ratio
so that the vertical and horizontal proportions remain fixed. You can also flip
images horizontally or vertically from the Arrange menu.

To delete an image, just click it to select it and press the Delete key.

Adding and Editing Slide Text

As with Pages, which also uses boxes for text layout, you can add or edit text
in Keynote with ease. For example, say you have a box with the placeholder
text Double-click to edit.Just double-click in that box, and the place-
holder text disappears, leaving the field ready to accept new text. Any new
text you type appears at the blinking cursor within the box.

Here are some additional ways to work with slide text:

v Add a new text box: Just click the Text button in the Keynote tool-
bar, and click one of the sample styles that appear. Your new text box
appears in the middle of the slide.

v~ Edit existing text: Click — using the bar-shaped cursor to select just the
right spot in the text — and drag the insertion cursor across the char-
acters to highlight them. Type the replacement text, and Keynote oblig-
ingly replaces the old text with the new text you type.
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1 Delete text: Click and drag across the characters to highlight them;
then press Delete. You can also delete an entire box and all its con-
tents: Right-click the offending box, and choose Delete from the menu
that appears.

When a box’s contents are just right, and you’re finished entering or editing
text, click anywhere outside the box to hide it from view. You can always
click the text again to display the box later.

Formatting Slide Text
for the Perfect Look

Keynote doesn’t restrict you to the default fonts for the theme you chose. It’s
easy to format the text in your slides — a different font family, font color, text
alignment, and text attributes (such as bolding and italicizing) — on the fly.

Select the desired text by double-clicking a box and dragging the text
cursor to highlight the characters. Now apply your formatting using one of
two methods:

v The Inspector: The font controls in the Inspector work in one of two
ways: After you've selected text, either click a font control to display
a pop-up menu, or click a button to immediately perform an action.
Opening the Font Size pop-up menu, for example, displays a range of
sizes for the selected text. With a single click of the B (bold) button, add
the bold attribute to the highlighted characters. To create bullets and
lists, click the Text tab at the top of the Inspector.

+ The Format menu: The controls on the Keynote Format menu generally
mirror those in the Inspector. To change the alignment from the Format
menu, click Format and hover the cursor over the Text menu item.

To change text attributes, click Format and hover the cursor over the
Font menu.

Using Presenter’s Notes in Your Project

As mentioned earlier, you can type presenter’s text notes in the Notes pane.
[ use them to display related topic points while presenting my slideshow.
However, you can also print the notes for a project along with the slides, so
presenter’s notes are also great for including reminders and To Do points for
your audience in handouts.

To type your notes, just click within the Notes pane. If that pane is hidden,
choose View> Show Presenter Notes, or click the View button at the far
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left of the Keynote toolbar and choose Show Presenter Notes. When you’re
finished adding notes, click in the Slides list or the Layout pane to return to
editing mode.

To display your notes while practicing, use the Keynote Rehearsal feature.
Click the Play menu at the top of the Keynote window, choose Rehearse
Slideshow, click the Tools icon at the top right, and select the Presenter
Notes check box to enable it. Now you can scroll through the notes while the
slideshow runs! (More on slideshows in a second.)

Every Good Presentation Needs Media

Figure 18-3:
It's not just
photos. You
can add
audio and
movie clips
to a slide
too!
|

Adding audio, photos, and movies to a slide is drag-and-drop easy in Keynote!
Simply drag an image, audio, or movie file from a Finder window, and place it
at the spot you want within your document.

You can also use the Media Browser. To do so, follow these steps:
1. Click the Media button on the toolbar, and then click the Photos,

Music, or Movies tab to select the desired type.

Keynote displays the contents of your various media collections (such
as your iPhoto and iTunes libraries).

2. When you find the file you want to add, drag it to the spot you want in
the document.

Figure 18-3 shows the Media Browser in action.
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i E » Background T a
N Edit Master Slice

This is the opening slide - it includes a great photo from the Macworld
Expo floor, which I'll use later to demonstrate some of the features of
Keynote.
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Having trouble finding that specific photo or movie? Click the Search icon

(which looks like a magnifying glass) at the top-right corner of the Media
Browser, and you can specify a particular filename or keyword.

Adding a Background Shape

Text often stands out on a slide when it sits on top of a background shape.
To add a shape (such as a rectangle or circle) as a background for your text,
follow these steps:

1. Click the insertion cursor in the location you want.

2. Click the Shape button on the Keynote toolbar, and choose a shape.
The shape appears in your document.

3. Click the center of the shape, and drag it to a new spot.

As with image boxes, you can resize or move shapes. You can read
about how to do just that in the earlier section “Working with Text and
Graphics Boxes.”

4. When the shape is properly positioned and sized, select it, and choose
Arrange~> Send to Back.

You want to “send the shape to the back” so that any text you enter sits
in front of the shape, not hidden behind it.

<P Of course, you're not limited to creating shapes and graphics within Keynote;
consider using an application like Adobe Photoshop or Illustrator to create
graphics that you can import into your slides! As mentioned earlier, you can
easily drag and drop your new graphic into a slide from a Finder window.

Creating Vour Keynote Slideshow

The heart of a Keynote presentation is the slideshow you build from the
slides you've created. A Keynote slideshow is typically presented as a full-
screen presentation, with slides appearing in linear order as they are sorted
in the Slides list.

You run a Keynote slideshow simply by clicking the Play button on the tool-
bar or by choosing Play=> Play Slideshow. You can advance to the next slide
by clicking, or by pressing the right bracket key, which looks like this: ].

Of course, other controls are available besides just the ones that advance to
the next slide. Table 18-1 lists the key shortcuts you’ll use most often during
a slideshow.
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Table 18-1 Keynote Slideshow Shortcut Keys
Key Action

] (right bracket) Next slide

[ (left bracket) Previous slide

Home Jump to first slide

End Jump to last slide

C Show or hide the pointer

number Jump to the corresponding slide in the Slides list
U Scroll notes up

D Scroll notes down

N Show current slide number

H Hide the slideshow and display the last application used

(the presentation appears as a minimized icon on the Dock)

B Pause the slideshow and display a black screen (press any
key to resume the slideshow)

Esc Quit

\3
< Keynote offers a number of settings you can tweak to fine-tune your slide-

show. To display these settings, choose Keynote=> Preferences, and click the
Slideshow button in the Preferences window.

<P If you have an iPhone, iPad, or iPod touch handy, and you’ve installed the iOS
version of Keynote on your device, choose Keynote Preferences to display
the Preferences window. Click the Remotes tab to link your device to your
laptop and Keynote. Now you can use your handheld device as a remote
during your slideshow. Sweet!

Printing Your Slides and Notes

I'll be honest: I don’t print handouts for every presentation I give. However,
if you're presenting a lengthy slideshow with plenty of information you want
your audience to remember or refer to later, nothing beats handouts that
include scaled-down images of your slides (and, optionally, your presenter’s
notes).

You're not limited to paper, though. You can also use Keynote to create an
electronic PDF (Portable Document Format) file instead of a printed handout,
which your audience members can download from your website. Or, if you're
an educator with access to an interactive whiteboard (such as a SMART
Board), you can use this new technology with Keynote.
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To print your slides and notes, follow these steps:

1. Within Keynote, choose File> Print or press 38+P.

Keynote displays the Print sheet, shown in Figure 18-4. (Note that some
printer-specific features may be different on your screen.) If necessary,
expand the Print sheet to show all the settings by clicking the Show
Details button at the bottom of the sheet.
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This is the opening slide - it includes a great photo from the Macworld
Expo floor, which I'll use later to demonstrate some of the features of
Keynote.

2. Click one of the following formats (each format displays a different set
of Layout options):

e Slide: Print each slide on a separate page at full size. You can
optionally choose to print the presenter notes for each slide as
well.

e Grid: Print multiple slides on a page at a reduced size. From the
Slides per Page pop-up menu, specify how many slides Keynote
should print on each page.

® Handout: Print a handout with multiple slides per page (and,
optionally, with presenter’s notes). Again, you can choose how
many slides appear on each page.

e Qutline: Print the contents of your Slides list in Outline view.
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3. Select the pages to print:
e To print the entire document, select the All radio button.

e To print a range of selected slides, select the From radio button, and
then enter the starting and ending pages.

4. Select or deselect additional options from the Options section.

5. Click the Print button to send the job to your printer.

QP You can also send a copy of your finished presentation as an attachment
within Mail or Messages. Or, if the presentation is saved to your iCloud Drive,
you can provide others with a web link through Twitter or Facebook. Click
the Share button on the toolbar to explore your sharing options. Note that
sharing a link for viewing a presentation (from the Share Link via iCloud
menu item) is different from sending an actual copy of the Keynote document
(from the Send a Copy menu item). For example, if your recipient needs to
edit your presentation, you should send a copy rather than a link.

Click the Share button on the toolbar, and choose View Share Settings to
password-protect your shared presentation or to share it as view-only.
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When Good Mac Laptops Go Bad

In This Chapter
Avoiding the blame (righteously)

Putting basic troubleshooting precepts to work
Using Mark’s Troubleshooting Tree
Getting help

’ wish you weren’t reading this chapter.

Because you are, I can only surmise that you're having trouble with your
MacBook, and that it needs fixing. (The other possibility — that you just like
reading about solving computer problems — is more attractive but much
more problematic.)

Consider this chapter a crash course in the logical puzzle that is computer
troubleshooting: the art of finding out What Needs Fixing. I tell you what to do
when you just plain can’t solve the problem yourself.

Oh, and you’re going to encounter a lot of Tips and Mark’s Maxims in this
chapter. I learned all of them the hard way, so | recommend committing them
to memory.

Repeat After Me: Ves, | Am a Tech!

Anyone can troubleshoot. Believe it, and put these common troubleshooting
myths to rest:

1~ It takes a college degree in computer science to troubleshoot. Tell that
to my troubleshooting teen. She’ll think it’s a hoot, because she has an
iMac in her room, as well as Apple computers in the classroom, and she
fixes minor problems all the time. You can follow all the steps in this
chapter without any special training.
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v I’'m to blame. Ever heard of viruses? Failing hardware? Buggy software?
Any of those things can cause the problem. It’s Mark’s Maxim time:

Don’t beat yourself up! Your laptop can be fixed.™

1 need to buy expensive utility software. Nope. You can certainly invest
in a commercial testing and repair utility if you like. My favorite is Drive
Genius 4 from Prosoft Engineering (www.prosofteng. com), but a third-
party utility isn’t a requirement for troubleshooting. (I do, however, con-
sider an antivirus application a must-have; you should have one already.
Hint, hint.)

v There’s no hope if I can’t fix it. Sure, parts fail and computers crash,
but your Apple Service Center can repair just about any problem. And
(ahem) if you backed up your laptop (as I preach throughout this book),
you’ll keep that important data (even if a new hard drive or mother-
board is in your future).

v~ It takes forever. Wait until you read the number one rule in the next sec-
tion; the first step takes but 10 seconds and often solves the problem.
Naturally, not all problems can be fixed so quickly. But if you follow the
procedures in this chapter, you should fix your MacBook (or at least
know that the problem requires outside help) in an afternoon.

With those myths banished, you can get down to business and start feeling
better soon.

Step-by-Step Laptop Troubleshooting

In the following sections, I walk you through my should-be-patented
Troubleshooting Tree, as well as the El Capitan built-in troubleshooting appli-
cation, Disk Utility. I also introduce you to a number of keystrokes that can
make your MacBook jump through hoops.

The number one rule: Reboot!

The simple fact is that rebooting your MacBook can often solve a number of
problems. If you're encountering these types of strange behavior with your
laptop, a reboot might be all you need:

v Intermittent problems communicating over a network

v A garbled screen, strange colors, or screwed-up fonts

v The swirling Beach Ball of Doom that won’t go away after several minutes

v An application that locks up

v An external device that seems to disappear or can’t be opened


http://www.prosofteng.com/
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Why is rebooting so darned effective?

Rebooting fixes problems because it resets
everything. Your network connection, for
example, might be acting up or might have
timed out, and rebooting restores it. Hardware
connections are reset when you reboot, which
can “magically” bring recalcitrant external
peripherals back to life. Rebooting also fixes

AC power flickerings you undoubtedly have
noticed from time to time, which can even
affect a laptop running on an AC adapter. Such
interruptions in constant juice might not bother
you or me (or your less-intelligent toaster),
but they can play tricks on your laptop that
rebooting can fix.

problems due to brownouts or those notorious

To put it succinctly, here’s a modest Mark’s Maxim:

Always try a reboot before beginning to worry. Always.™

If you're in the middle of a program, try to save all your open documents
before you reboot. That might be impossible, but try to save what you can.

As your first (and best) option for shutting down, click the Apple menu ()
and choose Shut Down. If you need to force a locked application (one that’s
not responding) to quit so that you can reboot, follow these steps to quash
that locked application:
1. Click the Apple (§) menu, and choose Force Quit.
The dialog shown in Figure 19-1 appears.

2. Click the offending application, and then click the Force Quit button.

[ NON ] Force Quit Applications
If an app doesn't respond for a while, select its
name and click Force Quit.
7 Calendar
¥ Grab
© iTunes
—
Figure 19-1: & Finder
Force a
recalcitrant
application _ _
to take Off. | Command.option-cacape, | ce Qu
|
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When you get everything to quit, you should be able to click the Apple menu
and choose Shut Down (not Restart) without a problem.

If your MacBook simply won’t shut down (or you can’t get the offending
application to quit), do what must be done:

1. Press and hold your laptop’s Power button until it shuts itself off.
You have to wait about five seconds for your MacBook to turn itself off.

If holding the Power button down on your MacBook doesn’t do the trick,
press the Power button and the Left Option+Left Shift+Left Control key-
board shortcut at the same time, then release them all at the same time.
(This method also resets some of your MacBook’s internal hardware set-
tings, which is often A Good Thing.)

\\3

2. Wait about ten seconds.

3. Press the Power button again to restart the computer.

After everything is back up, check whether the problem is still apparent. If
you use your laptop for an hour or two and the problem doesn’t reoccur, you
likely fixed it!

Special keys that can come in handy

A number of keys have special powers over your MacBook. I'm not kidding!
These keys affect how your road warrior starts up, and they can really come
in handy while troubleshooting.

Using Safe Boot mode

You can use Safe Boot mode to force El Capitan to run a directory check of
your boot drive and disable any login items that might be interfering with your
system. Follow these steps:

1. Use the Shut Down menu item from the Apple (&) menu to completely
turn off your laptop.

2. Press the Power button to restart the computer.

3. Immediately after you hear the start-up tone, press and hold down the
Shift key (and keep holding it down until you see the boot progress
indicator).

4. After El Capitan completely boots, you’re in Safe Boot mode, and you
can check the operation of your MacBook using Disk Utility (or a com-
mercial utility application).

5. Once you’re ready to return to normal operation, restart your
MacBook again (this time without pressing the Shift key).
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Start-up keys

Table 19-1 provides the lowdown on start-up keys. Hold down the indicated
key either when you push the Power button or immediately after the screen
goes blank during a restart. (As | just mentioned, the Shift key shortcut to Safe
mode is the exception; you should press it and hold it down after you hear
the start-up tone.)

Table 19-1 Start-Up Keys and Their Tricks

Key Effect on Your MacBook

C Boots from the CD or DVD that's loaded in your optical drive
(if you have one)

Media Eject Ejects the CD or DVD in your optical drive (if you have one)

Option Displays a system boot menu, allowing you to choose any
bootable operating system on your laptop

Shift Boots in Safe mode

T Starts your MacBook in Target Disk mode (using your
Thunderbolt or FireWire port)

3B+V Shows 0S X Console messages

38+R Boots from the El Capitan Recovery HD volume

38+S Starts your Mac in Single User mode

38+0ption+P+R Resets Parameter RAM (PRAM)

Some of the keys and combinations in Table 19-1 might never be necessary
for your machine, but an Apple technician might instruct you to use them.

Danger, Will Robinson!

Many Disk Utility functions can actually wipe »~ Partitioning and erasing drives

your drives clean of data |n_stead of repairing Setting up RAID arrays with the Raid
them! These advanced functions are unlikely to Assistant

help you with troubleshooting a problem with
your existing volumes. v~ Restoring files from disk images

Remember: Don't use the following Disk
Utility functions unless an Apple technician
tells you to:
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Figure 19-2:
The physi-
cian of
drives: the

El Capitan
Disk Utility.
|

All hail Disk Utility,
the troubleshooter’s friend

The El Capitan Disk Utility is a handy tool for troubleshooting and repairing
your MacBook’s drive. You can find it in the Utilities folder in Launchpad.

Fire up Disk Utility to open the rather powerful-looking window shown in
Figure 19-2.
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Mount Point I Type: SATA Internal Physical Velume
Capacity; 80.47 GB  Available: 255168
Used: 54,87 GB  Owners: Enabled
Device: disk0s2 | Connection: SATA

In the left column of the Disk Utility window, you can see

v The physical drives in your system (the actual hardware)
v The volumes (the data stored on the drives)

You can always tell a volume, because it’s indented below the physical
drive entry.

v+ Any CD or DVD loaded on your MacBook

v USB, Thunderbolt, or FireWire external drives

For example, referring to Figure 19-2, | have one internal drive (the APPLE
SSD entry) and one USB 2.0 external drive (the PNY USB entry). The hard
drive has two volumes (Wolfgang and Mother), and the external drive has
one volume (Transporter).

The information at the bottom of the Disk Utility window is the specifications
for the selected drive or volume. This info includes capacity, free space, and
the number of files and folders for a volume, or connection type and total
capacity for a drive.
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So exactly what is a disk permission, anyway?

Because El Capitan is built on a UNIX base,
lots of permissions can apply to the files on
your drive — that is, who can open (or read
or change) every application, folder, and
document on your drive. Unfortunately, these
permissions sometimes get messed up by
wayward applications or power glitches, or
application installers that do a subpar job

If you're an experienced 0OS X user and
you're looking for the old familiar Repair
Disk Permissions button in Disk Utility, let me
shorten your search: It no longer exists in El
Capitan! Instead, disk permissions are now
automatically checked and repaired as part of
the First Aid process. Progress marches on, but
I'll miss that old codger.

of cleaning up after themselves. And if the
permissions on a file are changed, applications
often lock up or refuse to run altogether.

Repairing permissions and disks

Disk Utility can check the format and health of both drives and volumes (and
correct any problems it finds) with the First Aid button.

First Aid

@"P‘L STy, Using Disk Utility to repair your hard drive carries a couple of caveats:

+* You may not be able to immediately repair problems on your boot
drive or boot volume. This limitation actually makes sense, because
you’re actually using that drive and volume right now.

If First Aid finds a problem on your boot drive but reports it can’t fix
that error, boot your MacBook from the OS X Recovery HD volume.
Reboot and then hold down the 38+R keyboard shortcut immediately
after you hear the start-up chord. Then run Disk Utility from the window
that appears. Because you’ve booted your laptop from the Recovery HD
volume, you can repair those problems with your start-up drive. (You
should be able to select your boot hard drive or volume and click the
First Aid button.)

1+ You can’t repair CDs and DVDs. CDs and DVDs are read-only media and
thus can’t be repaired (at least by Disk Utility).

If your MacBook is having trouble reading a CD or DVD, wipe the disc
with a soft cloth to remove dust, oil, and fingerprints. Should that fail,
invest in a disc-cleaning contrivance of some sort.

To check and repair problems using First Aid, follow these steps:

- 1. Click the Go menu and choose Utilities, then double-click the Disk
= Utility icon.
2. In the list at the left side of the Disk Utility window, click the drive or
volume you want to check.
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3. Click the First Aid button and click the Run button that appears.
4. Click Done to exit First Aid.

If changes were made (or if you had to boot from the OS X Recovery HD
volume), Disk Utility may prompt you to reboot after repairs have been
made.

Figure 19-3 illustrates the details you'll see if you click Show Details to
expand the display. Although some of the messages might include cryptic
Linux details, you can still tell from the figure that the operation is successful
(and you get that snazzy green check mark). All is well!

Disk Utility
Restoro Partition Erase  Image Uniock Unmount
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this drive is eostles
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|

Mark’s MacBook Troubleshooting Tree

As hip-hop artists say, “All right, kick it.” And that’s just what my MacBook
Troubleshooting Tree is here for. If rebooting your laptop didn’t solve the
problem, follow these steps in order until you either find the solution or run
out of steps (more on that in the next section).

QP If you're not sure quite what’s producing the error, this process is designed
to be linear — followed in order — but if you already know that you're having
a problem with one specific peripheral or one specific application, feel free to
jump to the steps that concern only hardware or software.

Step 1: Investigate recent changes

The first step is a simple one that many novice MacBook owners forget.
Simply retrace your steps and consider what changes you made to your
system recently. Here are the most common culprits:
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v Did you just finish installing a new application? Try uninstalling it by
removing the application directory and any support files it might have
added to your system. (And keep your applications current with the
most recent patches and updates from the developer’s website.)

v+ Did you just apply an update or patch to an application? Uninstall the
application, and reinstall it without applying the patch. If your MacBook
suddenly works again, check the developer’s website, or contact the
application’s technical support department to report the problem.

v Did you just update El Capitan? Updating OS X can introduce problems
in your applications that depend on specific routines and system files.
Contact the developer of the application, and look for updated patches
that bring your software in line with the latest El Capitan updates.

v Did you just make a change in System Preferences? Return the options
you changed to their original settings; then consult Chapter 5 for infor-
mation on what might have gone wrong. (If the setting in question isn’t
listed in Chapter 5, consider searching the OS X online Help or the Apple
support website for more clues.)

v Did you just connect (or reconnect) an external device? Try unplug-
ging the device and then rebooting to see if the problem disappears.
Remember that many peripherals need software drivers to run; without
those drivers installed, they don’t work correctly. Check the device’s
manual or visit the company’s website to search for software you
might need.

If you didn’t make any significant changes to your system before you encoun-
tered the problem, proceed to the next step.

Step 2: Run Disk Utility

The next step is to run Disk Utility and use First Aid. The earlier section
“Repairing permissions and disks” shows how to complete this task on your
El Capitan boot drive.

Step 3: Check your cables

Cables can work themselves loose, and sometimes they fail. Check all the
cables to your external devices — make sure that they’re snug — and verify
that everything’s plugged in and turned on. (Oh, and don’t forget to check for
crimps in your cables or even Fluffy’s teeth marks.)

If a FireWire, Thunderbolt, or USB device acts up, swap cables around to find
whether you have a bad one. A faulty cable can have you pulling your hair
out in no time.

349
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Step 4: Check your Trash

Check the contents of the Trash to see whether you recently deleted files or
folders by accident. Click the Trash icon in the Dock to display the contents.
If you deleted something by mistake, right-click the item in the Trash and
choose Put Back.

[ know this one from personal experience. A slight miscalculation while
selecting files to delete made an application freeze every time I launched it.

Step 5: Check your Internet and network connections

Now that always-on DSL and cable modem connections to the Internet are the
norm, don’t forget an obvious problem: Your laptop can’t reach the Internet
if your ISP is down or your network is no longer working!

When you’re at home, a quick visual check of your DSL or cable modem usu-
ally indicates whether a connection problem exists between your modem and
your ISP. For example, my modem has a set of informative activity lights that

I always glance at first. However, if your laptop is connected to the Internet
through a larger home or office network, and you can’t check the modem visu-
ally, you can check your Internet connection by pinging www . apple . com:

1. Click the Spotlight icon at the right side of the Finder menu bar, and
type Network Utility in the search box.

. Click the Network Utility entry.

. Click the Ping button.

. Enter www . apple.com in the Address box.

. Click Ping.

G e W N

You should see successful ping messages. If you don'’t get a successful
ping and you can still reach other computers on your network, your
cable modem, DSL modem, or ISP is likely experiencing problems. If you
can’t reach your network at all, the problem lies in your network hard-
ware or configuration. (In an office environment, your network system
administrator will be happy to help you at this point, especially if you're
blood relatives.)

Step 6: Think virus

If you've made it to this point, it’s time to run a full virus scan. Make sure
that your antivirus application has the latest updated data files. My antivirus
application of choice is Virus Barrier X8 from Intego (www.intego. com). If
you don’t want to invest in a commercial antivirus application, I can also rec-
ommend the excellent freeware ClamXav 2 (http://clamxav.com).
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If a virus is detected, and your antivirus application can’t remove it, try quar-

antining it instead. This basically disables the virus-ridden application and
prevents it from infecting other files.

Step 7: Check your login items

El Capitan might encounter problems with applications you’ve marked as
login items in System Preferences. Your account’s login items are applica-
tions that run automatically every time you log in to your MacBook. If one of
these login items is to blame for your laptop’s problems, your MacBook will
encounter some type of trouble every time you log in. (This is usually the
case when you receive an application error message each time you start the
computer.)

To check the boot process, it’s time to use that fancy Safe Boot mode I dis-
cussed earlier in the chapter. Restart your MacBook, and press and hold
down the Shift key after you hear the start-up tone. Login items are disabled
when you’re running in Safe mode, so if your laptop starts up without any
errors, you know that one or more login items are probably to blame.

If your computer starts without problems in Safe mode, the next step is to
check your login items. Restart your MacBook, and then follow this proce-
dure for each item in the login list:

1. Open System Preferences, click Users & Groups, and then click the
Login Items button.

2. Select the first item from the list, and remove it.

You can delete the selected item by clicking the Delete button, which
bears a minus sign. (If a recurring error message mentions a specific
application that appears in the Login Items list, that’s your likely culprit,
so start by deleting that item.)

3. Restart your MacBook.

4. If your laptop is still misbehaving, repeat Steps 2 and 3, and disable a
new login item.

5. When your MacBook starts up normally, you have discovered the per-
petrator. You'll likely need to delete that application and reinstall it.

Don’t forget to add back each of the working login items to the Login
Items list using the Add button (which carries a plus sign)!

Step 8: Turn off your screen saver

The next step is to turn off your screen saver. This remedy is a long shot,
but it isn’t unheard of to discover that a faulty, bug-ridden screen saver has
locked up your MacBook. If you are running a screen saver other than one
from Apple, and your computer never wakes up from Sleep mode or hangs
while displaying the screen saver, you’ve found your prime suspect.



352 Part V: Getting Productive and Maintaining Your MacBook

MBER
\x&
&

Reboot your MacBook (if necessary), open System Preferences, click Desktop
& Screen Saver, and click the Screen Saver button. Then do one of the
following:

v Switch to an Apple screen saver.

v Click the Start After pop-up menu and choose Never.

Step 9: Run System Information

Ouch. You've reached the final step, and you still haven’t uncovered the
culprit. At this point, you’ve narrowed the possibilities to a serious prob-
lem, such as bad hardware or corrupted files in your OS X System folder.
Fortunately, El Capitan provides the System Information utility, which dis-
plays real-time information on the hardware in your system. To start System
Information, follow these steps:

1. Click the Apple menu and choose About This Mac.
2. Click the System Report button.

3. Click each of the Hardware categories in turn, double-checking to
make sure everything looks okay.

You don’t have to understand all the technical hieroglyphics. If a Hardware
category doesn’t return what you expect or displays an error message,
though, that’s suspicious. (If your MacBook doesn’t have a specific type of
hardware onboard — for example, an optical drive — you won’t see informa-
tion in that category.)

The Diagnostics category shows whether your MacBook passed the Power
On self-test.

Okay, | Kicked It, and It Still
Won't Work

Don’t worry, friendly reader. Just because you’ve reached the end of my
MacBook Troubleshooting Tree doesn’t mean you’re out of luck. In the fol-
lowing sections, I discuss the online help available in OS X and on the Apple
website, as well as local help in your own town.
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Local service, at your service

In case you need to take in your MacBook for service, an Apple Store or Apple
Authorized Service Provider is probably in your area. To find the closest ser-
vice, launch Safari and visit the Apple website Support page (www.apple.
com/support), then click the Apple Authorized Service Providers link at the
bottom of the page. You can search by city and state or zip code. Click one

of the locations near you to display the provider’s mailing address, website
address, telephone number, and even a map of the location.

Always call your Apple service provider before you lug your (albeit light-
weight) laptop all the way to the shop. Make sure you know your MacBook’s
serial number (which you can display in System Information) and which ver-
sion of OS X you're using.

The 0S X Help Center

Although most OS X owners tend to blow off the Help Center when the
troubleshooting gets tough, that’s never the best course of action. Always
take a few moments to search the contents of the Help Center by choosing
Finder = Help to see whether any mention is made of the problem you’ve
encountered.

Apple Help Online

If you haven’t visited the Apple MacBook Support site yet, run, don’t walk, to
www .apple.com/support/macbook. There you will find

v~ The latest patches, updates, and tutorials for the MacBook line

v+ MacBook and OS X discussion boards, moderated by Apple

v Tools for ordering spare parts, checking on your remaining warranty
coverage, and searching the Apple knowledge base

v Do-it-yourself instructions (PDF files) that you can follow to repair or
upgrade your MacBook


http://www.apple.com/support/
http://www.apple.com/support/
http://www.apple.com/support/macbook




Chapter 20

Adding New Stuff to Your Laptop

In This Chapter
Adding memory

Upgrading your hard drive
Adding USB, Thunderbolt, and FireWire devices

Reviewing what add-ons are available

N o laptop is an island.” Somebody famous wrote that, I'm sure.

“Without getting too philosophical — or invoking the all-powerful Internet
yet again — the old saying really does make sense. All computer owners usu-
ally add at least one peripheral (external device), such as a printer, trackball,
iPod, backup drive, or scanner. [ talk about the ports on your MacBook in
Chapter 1. These holes aren’t there just to add visual interest to the sides of
your treasured laptop. I cover your ports (and what you can plug into them)
in detail in this chapter.

But what about the stuff inside your road warrior? That’s where things get
both interesting and scary at the same time. In this chapter, I describe what
you can add to the innards of your computer, as well as how to get inside
there if you work up the courage to go exploring.

More Memory Will Help

FEvery computer benefits from more memory — and no, there’s no however
stuck on the end of that statement! For once, I'm happy to report, there’s no
exception, no matter what type of computer you own. Hard as it is to believe,
just keep in mind this Mark’s Maxim:
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More memory helps. Always.™

Period. End of statement. No matter what type of computer you own, how old
it is, or what operating system you use, adding more memory to your system
(to the maximum it supports) significantly improves the performance of your
operating system (and practically every application you run).

Memory maximizes the power of your computer. The more memory you
have, the less data your laptop has to temporarily store on its drive. Without
getting into virtual memory and other techno-junk, just consider that extra
memory as extra elbow room for your applications and documents. Believe
me, both OS X and Windows 7 and 8.x efficiently use every kilobyte of
memory you can provide.

If your MacBook is already stuffed full with the maximum amount of memory
it can hold, you can skip this section.

Unfortunately, owners of all of the latest MacBook models (except the 13-inch
non-Retina MacBook Pro) can skip this section as well, because these models
can’t be upgraded. (Because these laptops are sealed units — literally — you
must visit your local Apple hardware technician if your laptop’s memory mal-
functions and needs replacing. The same is true for the battery in all current
MacBook models.)

If you're using the current 13-inch non-Retina MacBook Pro (or an older
MacBook with upgradeable memory), read on!

Figuring out how much
memory you have

To see how much memory your computer has, click the Apple menu (&) and
choose About This Mac. In the dialog that appears, click the Memory tool-
bar button.

Click the Memory Upgrade Instructions link at the bottom of the dialog. OS X
El Capitan automatically opens a Safari browser window with online instruc-
tions on how to upgrade the RAM in your specific MacBook model. If you're
confident about your technical skills, you can use this documentation as a
guide to removing and installing memory modules, along with the step-by-
step procedure described in the next section.

While you're within the confines of the About This Mac dialog, click the
Overview toolbar button to display both the machine speed (processor
speed) and the common identifier that Apple uses to refer to your specific
model. For example, my MacBook Air has a 1.8 GHz Intel Core i5 processor,
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and it’s identified as a mid-2012 model. Write down these two figures. We're
starting a handy list that will help you when you order your memory!

How you plan memory upgrades depends on how much memory you want.
Most MacBook owners simply opt to install the maximum amount of memory
possible. So if your 4GB 13-inch non-Retina MacBook Pro is upgradeable to
8GB and it currently uses the two default 2GB modules supplied by Apple,
you can add 4GB of additional RAM by replacing the existing memory
modules with two 4GB memory modules. At the time of this writing, a 4GB
memory module should set you back less than $40.

I should note that 4GB of memory is certainly acceptable for running the
applications bundled with El Capitan. With that said, these applications will
run significantly faster with 8GB instead!

If your primary applications include video editing, game playing, audio pro-
duction, or image editing, you can use all the memory your laptop can hold.

In the past, Apple’s prices for upgrade RAM were, well, outrageous (as in,
“Boy, Howdy, I can’t afford that!”). Recently, however, Apple’s prices have
become far more competitive. If you're interested in comparison shop-
ping, I can heartily recommend any of these online sources that cater to
Mac owners:

v MacMall: www.macmall.com
v CDW: www . cdw.com/content /brands/apple/default.aspx

1 Newegg: www . newegg.com

Installing memory modules

I'm happy to report that adding extra memory to your laptop is one of the
easiest internal upgrades you can perform. Therefore, | recommend that
you add memory yourself unless you simply don’t want to mess with your
laptop’s internal organs. Your local Apple service specialist will be happy to
install new RAM modules for you (for a price).

If you have a knowledgeable friend or family member who can help you
install your hardware, buy that individual the proverbial NSD (short for Nice
Steak Dinner) and enlist him or her in your cause. Even if you still do the
work yourself, it’s always better to have a second pair of experienced eyes
watching, especially if you're a little nervous.
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Climbing inside your Mac laptop

This section on laptop upgrades is short for
a reason: Laptops simply aren’t meant to be
disassembled. As | mention several times in this
book, internal expansion in older MacBooks is
severely limited. Basically, you can add extra
memory and swap out your drive. Adding
memory is easy, but swapping out your hard
drive requires more work and considerable
preparation. And you can’t make any internal
modifications to the current crop of MacBook
models, which are sealed units. (Breaking in
will likely void your warranty.)

Therefore, | always recommend that you
seek professional servicing when you need
to repair your laptop. For example, if your
laptop’s LED screen is cracked or broken,

do not try to fix it yourself! Sure, you might
see a number of used LED panels on eBay,
but these parts aren’t designed to be easily
swapped out, like a desktop computer’s video
card. Besides, if you make a mistake when
trying to fix something deep in the bowels of
your laptop, you might end up causing more
damage than you repair.

The moral of the story? Let your local Apple
dealer’s service technicians perform major
surgery on your laptop, and buy an AppleCare
Protection Plan that can cover your laptop like
a blanket for up to three years!

Read more about swapping out drives in the
later section “Gotta have internal.”

To add memory modules to an older MacBook Pro, follow these steps:

1. Get ready to operate.

a. Spread a clean towel on a stable work surface, such as your

Ritchen table.

The towel helps protect your screen from scratches.

b. Find a small Phillips screwdriver. (Some new models use a “star”
screwdriver, so take a second to make sure you're using the

right tool!)

c. Shut down your laptop, and wait at least ten minutes for it to

cool down.

d. Unplug all cables from the computer.

2. Close the computer, and flip it over on top of the towel.

3. Ground thyself!

Check out the nearby “Let’s get grounded!” sidebar.

4. Remove the screws and bottom cover.

Depending on the model, you may have to remove up to ten screws
before you can put aside the cover. Note that some screws may be
longer than others. If so, they must be replaced in the same locations.
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Place the screws in a handy plastic bowl for safekeeping. Tah-dah! That
wasn’t much of a challenge, was it? Here’s your chance to gaze with rapt
fascination at a portion of the bare innards of your favorite computer.

5. Locate the memory modules in your MacBook’s svelte chassis.
6. If you're replacing an existing memory module, remove it.

To remove a memory module, gently spread the two tabs at the ends of
the socket, as shown in Figure 20-1. Then lift and slide the module away
from the socket.

[ NaNs) Force Quit Applications

If an application doesn't respond for a while,
select its name and click Force Quit.

&3 App Store

¥ Grab

7 iPhoto

Figure 20-1: @ iTunes

Remove a

memory & Finder
module like
You can open this window by pressing [ P
a pro' Command-Opticn-Escape. M
|

\3
S Save the old module in the static-free packaging that held the new

module. Your old RAM (which you can now sell on eBay) will be pro-
tected from static electricity.

7. Position the new module in the socket.

a. Line up the module’s gold connectors toward the socket at a
25-degree angle.

b. Line up the notch in the module with the matching spacer in
the socket.

See what I mean in Figure 20-2.

8. Press gently but firmly on both ends of the module until the module’s
tabs click into place on both ends of the socket.

Figure 20-3 shows in which direction you should press on the module.
If the module doesn’t seem to fit, make sure once again that the notch
on the module connector lines up with the spacer in the socket. Never
attempt to make it fit through sheer force!

9. Replace the bottom covers and screws.

To replace the bottom cover, just reverse the steps at the beginning
of this list. (It’s rather like changing the oil in my Dad’s 1970 Ford
pickup truck.)
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Congratulations! You’'ve done it. You're now a MacBook Pro memory guru!
To verify that all is well with your road warrior, boot the computer, click the
Apple menu (&), choose About This Mac, and then click the Memory toolbar
button. Your laptop should report the additional memory.
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Let's get grounded!

Follow one cardinal rule when the unguarded
insides of any computer are in easy reach:
Always ground yourself before you touch
anything! Your body can carry enough static
electricity to damage the circuitry and chips
that make up the brains of your MacBook Pro,
and touching those parts without grounding
yourself is an invitation to disaster.

Grounding yourself is easy: Just touch a
conductive metal surface (preferably steel)
around your workplace for a few seconds
before you dig in. (Don't use something inside
your laptop; use a metal surface outside

your MacBook Pro’s case.) After you ground
yourself, you can safely handle both your
laptop’s internal components and any new
hardware components you might be installing
(such as memory modules or a hard drive).

If you walk anywhere in the room — hunting
for a screwdriver, perhaps, or taking a sip of
liquid reinforcement that you've stashed a
comfortable distance away — you must ground
yourself again before you get back to work.
Remember: You can pick up a static charge by
simply walking.

Considering a Hard Drive Upgrade?

Asking whether you can upgrade your hard drive is a trick question. Yes,

you certainly can upgrade your hard drive. But before you start cruisin’ the

Internet for a 2TB monster, [ have two suggestions:

v Don’t upgrade your internal hard drive yourself.

v Be sure you really need a hard drive upgrade.

3

Apple’s pretty generous when configuring drive storage for its base systems.
Current models run with anywhere from a 128GB solid-state drive to a 1TB
solid-state or magnetic hard drive.

Most folks simply don’t need more than 128GB or 500GB of drive space (even
with Windows loaded in a separate partition for use with Boot Camp, which I
discuss in Chapter 2). You're likely to find that you still have plenty of elbow
room on your drive for a typical family’s needs unless you're heavily into

v Digital video (DV)

v Cutting-edge video games

v Tons of digital audio or digital photos
If you're short on drive space, clean up your existing drive by deleting all the
crud you don’t need. This includes game and application demos, duplicate or

work copies of images and documents, archived files you downloaded from
the Internet, and the contents of the Trash. You can read how in Chapter 21.

361
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& If you decide that you do need to upgrade your MacBook’s internal drive, I
strongly recommend that you don’t install your new hard drive yourself. Call

on the services of an Apple technician to upgrade your drive!

Ponder your external options

If you find that you do need additional hard drive space, I recommend using
an external drive. Use a high-speed Thunderbolt, FireWire, or USB port to
connect a second hard drive the quick and easy way. (If your MacBook
model isn’t equipped with a FireWire port, you can concentrate on USB or
Thunderbolt.)

Most of today’s external peripherals don’t even require the driver soft-
ware that Mac old-timers remember with such hatred. You simply plug in
a FireWire, Thunderbolt, or USB device, and it works. You can move your
external drive between different Macs with a minimum of fuss and bother.
A typical external USB 3.0 hard drive that holds 1TB costs less than $80.

An external hard drive can do anything that your internal hard drive can

do. You can boot from it, for example, or install a different version of OS X
(great for beta testers like me). External optical drives work just the same as
internal models; Apple sells an external USB SuperDrive optical drive for the
MacBook Retina, MacBook Air, and MacBook Pro Retina for about $80.

Apple’s AirPort Time Capsule unit is an external hard drive with a difference:
It stores the huge Time Machine backup files created by the Macs running El
Capitan on your network, and it uses a wireless connection to transfer data!
(In fact, if you're thinking of adding a wireless base station to your wired
network, your Time Capsule actually acts as a full AirPort Extreme Base
Station, complete with USB port for connecting a USB printer.) At the time

of this writing, Time Capsule is available with either a 2TB ($299) or 3TB
($399) drive.

A\

One problem with external drives is that data typically transfers more slowly
over a USB or FireWire connection than via an internal drive. (A Thunderbolt
external drive can actually deliver transfer speeds comparable to your inter-
nal drive, but at the time of this writing, it’'s somewhat more expensive than
USB or FireWire hardware.) That’s why most Mac owners use their external
drives to store lesser-used documents and applications or Time Machine
backups. Their favorite applications and often-used documents are housed
on the faster internal drive.

Putting a port to work

A MacBook can carry up to three kinds of high-speed ports, any of which is a
good match for connecting any external device:
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v+~ USB 2.0/3.0/C: The USB standard is popular because it’s just as common
in the PC world as it is in the Mac world. (Most PCs don’t have FireWire
or Thunderbolt ports.) The current MacBook Retina includes a single
USB-C port (which acts as a USB 3.0 port, but can also charge the
laptop), while all other models carry at least two USB 3.0 ports. Older
MacBook models that can run El Capitan have at least one USB 2.0 port.
Hardware manufacturers can make one USB device that works on both
types of computers.

Naturally, USB 3.0 offers faster data transfer speeds than the older USB
2.0 standard. So if your MacBook model sports USB 3.0 or USB-C ports,
you should buy only USB 3.0 external hard drives, CD/DVD recorders, or
flash drives. 'Nuff said.

v FireWire 800: The faster FireWire 800 port has replaced the older
FireWire 400 port (also called IEEE 1394) on today’s 13-inch non-Retina
MacBook Pro model. However, with an adapter, you can use your
FireWire 800 port to connect older FireWire 400 external devices to
your MacBook.

WING/

The physical FireWire 800 connector is shaped differently than the
FireWire 400 port, so don’t try to force the wrong connector into the
wrong port!

v Thunderbolt 1/2: A Thunderbolt external drive offers much better per-
formance than either a FireWire 800 or a USB 3.0 drive. Today’s shiny
Thunderbolt drives are getting cheaper every day. As with USB ports,
the higher the version number the faster the port, so if your MacBook
model comes with a Thunderbolt 2 port, invest in Thunderbolt 2
peripherals. The MacBook Air and MacBook Pro proudly sport at least
one Thunderbolt port on the side, but (as I mentioned previously) the
MacBook Retina has only a USB-C port.

The MacBook’s mystery slot
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If you're wondering what that inch-long slot on
the side of your MacBook Air or MacBook Pro
is for, you'll be pleased to hear that it's called
an SDXC card slot. Why the glee? Well, this
slot allows your laptop to directly accept the
storage cards used by many of today's digital
cameras and mass-storage video camcorders,
without requiring an external device or a cable
connection to your camera!

Some MacBook owners also use SDC/SDXC
cards for storage, much like a USB flash
drive. | find that a USB flash drive offers
far more storage for less cost (as well as
being compatible with other Macs and PCs).
If you have a large number of SDC/SDXC
cards collecting dust in your drawer, why
not use them?
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Connecting an external drive

With FireWire, Thunderbolt, or USB, you can install an external hard drive
without opening your laptop’s case. With your MacBook turned on, follow
these steps:

1. Connect the FireWire, Thunderbolt, or USB cable between the drive
and your computer.

2. Plug the external drive into a convenient surge protector or uninter-
ruptible power supply (if necessary).

Note that some external devices are bus-powered, meaning that they
don’t need a separate power supply. These devices draw their power
directly from the port.

3. Switch on the external drive.

4. If the drive is unformatted (or formatted for use in Windows), parti-
tion and format the external drive.

The drive comes with instructions or software for you to do this. (Don’t
worry; your external drive comes from the factory completely empty,
and you won’t damage anything by formatting it.) Partitioning divides
the new drive into one (or more) volumes.

If the drive comes preformatted for use with a Windows PC, I strongly
suggest reformatting it for use with OS X. Doing so will result in faster
performance and more efficient use of space.

After the drive is formatted and partitioned, the volumes you’ve created
immediately appear on the desktop. Shazam!

Gotta have internal

If you decide that you must upgrade your existing internal drive — or if your
internal drive fails and needs to be replaced — you should always take your
MacBook to an authorized Apple service center and allow the techs there to
sell you a drive and make the swap. Here are four darned good reasons why:

v Warranty: You're very likely to void your laptop’s warranty by attempt-
ing a drive upgrade yourself.

v Selection: If you're worried about choosing the proper drive, your
friendly neighborhood Apple technician can order the correct type and
size of drive for you.

v Difficulty: Swapping a drive in your Mac laptop is a downright pain.

v Backup: That very same Apple service technician can back up all the
data on your existing drive, format the new drive, and move all your
data to its new mansion, so you won’t lose a single document. That will
save you time and possible angst.
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Perhaps you won'’t be truly satisfied with your life until you upgrade your
MacBook’s internal drive. I'm sure you can find a magazine article that
purports to show you how. I've seen many how-to articles on the web that
claim to lead you down a rosy path to a hard drive upgrade. Here’s my take
on those savvy instructions: You're walking into a minefield using someone
else’s map, so you better have complete faith in your technical skills. (And a
darn good backup.)

A List of Dreamy Laptop Add-Ons

The USB toys I cover in this section might add a cable or two to your collec-
tion at the side of your road warrior, but they’re well worth the investment.
And they can really revolutionize how you look at technologies such as tele-
vision, digital audio, and computer gaming.

Game controllers

If you're ready to take a shot at the enemies — whether they be Nazi soldiers,
chattering aliens, or the latest jet fighters — you'’ll likely find your keyboard
and mouse somewhat lacking. (And if that enemy happens to be a friend

of yours playing across the Internet, you’ll be ruthlessly mocked while you
fumble for the right key combination.) Instead, pick up either a USB joystick
(for flying games) or a gamepad (for arcade and first-person shooting games).

Uideo controllers

For armchair directors, specialized USB digital video controllers make edit-

ing easier. The ShuttleXpress from Contour Design (www.contourdesign.
com) provides a five-button jog control that can be configured to match any
DV editor. For $60, you get the same type of editing controller as dedicated

video-editing stations costing several thousand dollars.

Music hardware

Ready to put GarageBand to the test with your favorite version of “Chop-
sticks”? You'll need a USB piano keyboard. | recommend the Keystation 49es
from M-Audio (www .m-audio.com), which retails for a mere $100. It provides
49 keys and uses a USB connection.


http://www.contourdesign.com/
http://www.contourdesign.com/
http://www.m-audio.com/




Chapter 21
Tackling the Housekeeping

In This Chapter
Cleaning unnecessary stuff off your drive
Backing up your data with Time Machine
Fixing hard drive permission errors and catalog problems
Automating tasks in El Capitan

Updating OS X automatically

N othing runs better than a well-oiled machine, and your laptop is no
exception. (Well, you actually shouldn't oil it, but you know what

I mean.) With a little El Capitan maintenance, you can ensure that your
MacBook performs as efficiently as possible (which translates into longer
battery life and faster operation overall).

In this chapter, I demonstrate how you can make good use of every byte of
storage space provided by your drive. I also show you how to back up and
restore that hard drive to an external drive, using Time Machine.

The El Capitan Automator application is a great housekeeping tool. It allows
your laptop to perform tasks automatically that used to require your atten-
tion. I show you how you can create Automator applications and set them up
to run by themselves. (It sounds a little spooky, but you’ll have a ball!)

And it’s important to never forget about updating OS X itself. But then again,

with Software Update configured correctly, you can live life free and easy,
surfing the web and eating ice cream (or yogurt — your pick).

Cleaning Unseemly Data Deposits

Criminy! Where does all this stuff come from? Suddenly that spacious 512GB
solid-state drive has only 19GB left, and you're starting to feel pinched.
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Before you consider buying a new internal or external drive (which you can
read about in Chapter 20), take the smart step: Sweep your laptop’s drive
clean of unnecessary and space-hogging software and temporary files.

Getting dirty (or, cleaning
things the manual way )

If you're willing to dig into your data a little, you have no reason to buy
additional software to help clean up your hard drive. All you really need is
the willpower to announce, “I simply don’t need this item any longer.” (And,
sometimes, that’s tougher than it might seem.)

Unnecessary files and unneeded folders
Consider all the stuff you probably don’t really need:

v Game demos and shareware that you no longer play or use (or
even remember)

v Movie trailers and other QuickTime video files that have long since
passed into obscurity

v Temporary files that you created and promptly forgot about

v Log files that chronicle application installations and errors

v Zip and Stufflt archives that you downloaded and no longer covet

v GarageBand loops and iMovie video clips you'll never use

v iTunes music and videos that no longer appeal to your eye and ear
How hard is it to clean this stuff off your drive? Easier than you might think!
Here are some ways to clear space on your laptop’s internal drive:

» You can easily delete files.

»* You can move seldom-used files and folders to external storage (such as
a USB flash drive, an external hard drive, or a DVD).

» You can uninstall applications purchased from the App Store using
Launchpad. From the Launchpad display, click and hold down the icon
until it wiggles. If an X button appears on the icon, you can click the X to
remove the application from your MacBook.

»* You can get rid of an unnecessary application by deleting its application
folder that was created during the installation process.
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Always check the application’s README file and documentation for
any special instructions before you manually delete any application’s
folder! If you created any documents in that folder that you want to keep,
don’t forget to move them before you trash the folder and its contents.

In fact, some applications may come with their own uninstall utility, so
checking the README file and documentation may save you unnecessary
steps.

Removing an application or file from your drive usually involves two
simple steps:
1. Display the file or application folder in a Finder window.
2. Delete the file or folder with one of these steps:
¢ Drag the icon to the Trash.
¢ Press 38+Delete.
¢ Right-click the icon and choose Move to Trash.
e Select the icon and click the Delete button on the Finder toolbar
(if you added one).
Truly, no big whoop.

Don’t forget to actually empty the Trash, or you’ll wonder why you aren’t
regaining any drive space. (El Capitan stores the contents of the Trash until
you manually empty the Trash, just in case you want to undelete some-
thing.) To get rid of that stuff permanently and reclaim the space, right-click
the Trash icon in the Dock and choose Empty Trash from the pop-up menu
that appears.

Associated files in other folders

Some applications install files in different locations across your drive.
(Applications in this category include Microsoft Office and Photoshop.) How
can you clear out these orphan files after you delete the application folder?

The process is a little more involved than deleting a single folder, but it’s still
no big whoop. Here’s the procedure:

1. Click the Search text box in a Finder window.

You can read more about searching and the Finder window in Chapter 6.
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Figure 21-1:
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2.

Type the name of the application in the Search text box and choose
Name Matches from the pop-up menu.

Figure 21-1 shows a typical search. | wanted to remove orphan files
associated with Toast Titanium. By searching for the word Toast, 1 found
both the application and its main folder. This trick displays files cre-
ated in other folders that include your search word in their names, such
as project files, PDF files, and the font files that appear in the system
Fonts folder.

3. Decide which of these files belong to the application to be deleted.

Be sure that the files you choose to delete are part of the deleted
application. In Figure 21-1, a word processing document named
Instructions on Making a Perfect Piece of Toast is definitely not part of
Toast Titanium!

Many associated files either
¢ Have the same icon as the parent application

e Are in the Preferences, Caches, or Application Support folders

. In the Search Results window, click the associated files you want to

delete, and just drag them to the Trash.

Don’t empty the Trash immediately after you delete these associated
files. Wait a few hours or a day. That way, if you realize you deleted a file
you truly need, you can easily restore it from the Trash.
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Figure 21-2:
Piriform’s
CCleaner for
Mac is a
great tool
for cleaning
your
MacBook's
drive.
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Using a commercial clean-up tool

If you’d rather use a commercial application to clean up your drive, many are
available. However, most are shareware and perform only one task. For exam-
ple, Tidy Up! 4 from Hyperbolic Software (www.hyperbolicsoftware.com)
finds only duplicate files on your drive, matching by criteria such as filename,
size, content, and extension. It’s a good tool at $30.

For keeping your MacBook’s drive slim and trim, | recommend CCleaner

for Mac, from Piriform (www.piriform.com/mac/ccleaner), as shown

in Figure 21-2. This great utility can clean everything from Internet crud
(browser cookies and your surfing history) to those OS X system caches that
can grow so doggone huge. And you can easily fine-tune whatever CCleaner
for Mac wants to remove. The utility can also uninstall many applications
with a single click. Oh, and did | mention that it’s free? I really like free!

[ XX 4 Piriform CCleaner

CCleaner Free 1.09.313
' iMac 12.2, Intel Core i5 @ 2.70GHz, 32.0GB RAM

; Applications
@ satarl ANALYSIS COMPLETE - (2.943 secs)
Cleaner Internet Cache

Internet History ~ 456 MB (3,834 files) to be removed
Cookies

Download History
System

Trash

Recent Documents.

Details of files to be removed

@ Safari - Internet Cache 129,834 KB 2521 files
Recent Applications L] Salarf - \nlernAet History 3,080 KB 2 1jles
Recent Servers @ Safari - Cookies 3,800 KB 206 files
Options Recent Places @ Safari - Download History 0KB 1 files
M Logs System - Recent Documents 0KB 30 files
9 ¥
Directory Service Cache System - Recent Applications 0KB 30 files
User Downloads System - Recent Servers 0KB 4 files
Font Registry Cache System - Logs 8,459 KB 73 files
Unneeded Languages #\ Applications - Adobe Flash Player 2KB 30 files
ﬁsys;em:iphianons rﬁ& Applicaticns - Dropbox 110 KB 3 files
uic| 00|
' /A Applications - Grab 0KB 1 files
@ Advanced o
Custom Files and Folders 7% Applications - Tunes 0KB 1 files
# Applications - Messages 6 KB 3 files
7’& Applications - Microsoft Word 0KB 1 files
7 Applications - Preview 0KB 1 files
% Applications - TextEdit 0KB 1 files

A Annlicatinne - Tranamissinn nKR 1 filas

Analyze Run Cleaner

Online Help

Backing Up Your Treasure

Do it. I won’t lecture you about backing up your drive. Well, perhaps for just
a moment. Imagine what it feels like to lose everything — names, numbers,
letters, reports, presentations, saved games, photographs, and music.
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Then ask yourself, “Self, isn’t all that irreplaceable stuff worth just a simple
backup?” It’s time for a Mark’s Maxim:

Back up your hard drive. On a regular basis.™

You can back up your files either by saving them to external media or — as
[ strongly recommend — by using the awesome Time Machine feature in
El Capitan.

Saving files

The simplest way to back up files is simply to copy the files and folders to
an external hard drive, a USB flash drive, a CD, or a DVD. Nothing fancy,
but it works.

Backing up to an external hard drive or USB flash drive

If you use an external hard drive with your MacBook, you can easily drag
backup files to it from your internal hard drive. Follow these steps:
1. Open separate Finder windows for
® The external drive
¢ The internal drive

Because you’re using El Capitan, you can also open a Finder tab within a
single Finder window to accomplish the same task — from the keyboard,
press 38+T.

2. From your internal drive, select the files and folders you want to
back up.

3. Drag the selected files to the external drive window.

Backing up to CD and DVD

You can burn backups of your most important files to a recordable CD or
DVD. Owners of the MacBook, MacBook Air, and MacBook Pro Retina need
to use an external SuperDrive or third-party recorder, however. Saving your
data is more labor-intensive this way, but the end result is a truly “bullet-
proof” backup that doesn’t rely on an external hard drive.

To use the Finder’s Burn feature with a CD or DVD, follow these steps:

1. Load a blank disc into your MacBook’s optical drive.

If you're using the default settings in the CDs & DVDs pane in System
Preferences, a dialog asks you for a disc name.
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2. Choose Open Finder from the Action pop-up menu and click OK.

3. Double-click on the Untitled optical disc icon on your Desktop to open
a Finder window showing the contents of the disc.

4. Drag the files and folders you want to back up into the disc’s Finder
window.

They can be organized any way you like. Don’t forget that the total
amount of data shouldn’t exceed 700MB on a CD. You should also stick
within 4GB or so (on a standard recordable DVD) or 8GB (on a dual-layer
recordable DVD). You can see how much free space remains on the disc
at the bottom of the disc’s Finder window.

5. Choose File=> Burn Disc.

You can also click the Action button that appears at the top of the disc’s
Finder window and choose Burn Disc from the pop-up menu.

6. Choose the fastest recording speed possible.
7. Click Burn.

If you've invested in Toast Titanium from Roxio (www.roxio.com) or
another CD/DVD recording application, you can create a new disc layout
to quickly burn the same files to your backup disc in the future. (Think of a
layout as a “road map” that indicates which files and folders Toast should
store on the backup.)

“Mark, can I back up individual files to cloud-based storage like iCloud Drive,
DropBox, Google Drive, and OneDrive?” Of course! These services are fine
for a handful of files (much like backing up a handful of files to CD or DVD),
but these cloud drives aren’t suitable for backing up the entire contents of
your MacBook’s internal drive. (You should always use Time Machine with
an external hard drive for that important chore.) Also, don’t forget that you
need an Internet connection to save or retrieve files from cloud storage.

Putting things right with Time Machine

If you enable backups via the El Capitan Time Machine feature, you can lit-
erally move backward through the contents of your MacBook’s hard drive,
selecting and restoring all sorts of data. Files and folders are ridiculously
easy to restore — and I mean easier than any restore you’ve ever performed,
no matter what the operating system or backup program. Time Machine can
even handle some deleted items, such as Contacts cards!


http://www.roxio.com/

3 74 Part V: Getting Productive and Maintaining Your MacBook

Because Time Machine should be an important and integral part of every
MacBook owner’s existence, Time Machine has its own pane in System
Preferences. (Apple is not messing around!)

Apple’s AirPort Time Capsule device is designed as a wireless storage drive

P for your Time Machine backup files. If you're interested in a single Time
Machine backup location for multiple Macs across your wireless network,
Time Capsule is a great addition to your home or office. Note, however, that
the Time Capsule drive isn’t meant to be mobile, so while you're on the road,
you still need an external USB or Thunderbolt drive to safeguard your data.
Q&N\BE” . . . . . .
& Before you can use Time Machine, it must be enabled in the Time Machine

pane in System Preferences. I cover the Time Machine configuration settings
(and how to turn on the feature) in more detail in Chapter 5.

Here’s how you can turn back time, step by step, to restore a file or folder
you deleted or replaced:

1. From a Finder window, open the folder that contained the item you
want to restore.

2. Click the Time Machine icon in the Finder menu bar and click Enter
{ ") Time Machine.

The oh-so-ultra-cool Time Machine history appears behind your folder,
complete with its own set of buttons at the bottom of the screen,

as shown in Figure 21-3. On the right, you see a timeline that corre-
sponds to the different days and months included in the backups El
Capitan has made.

42 Dropbox

& All My Files
<3 iCloud Drive Documents ~
e Today (Naw)
. ¢ Applications
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3. Click within the timeline to jump directly to a date. The folder’s con-
tents on that date are displayed.

Alternatively, use the Forward and Back arrows at the right to move
through the folder’s contents over time. (You should see the faces of
Windows users when you riffle through a specific folder to locate some-
thing you deleted several weeks ago!)

The backup date of the items you’re viewing appears in the button bar
at the bottom of the screen.

4. After you locate the file or folder you want to restore, click it to
select it.

5. Click the Restore button at the bottom right of the Time Machine
button bar.

If you want to restore all the contents of the current folder, click the
Restore All button instead.

Time Machine returns you to the Finder, with the newly restored file now
appearing in the folder. Out-standing!

For robust backup-and-restore protection, Time Machine has everything a
typical Mac owner at home is likely to ever need. Therefore, this is an easy
Mark’s Maxim to predict:

Connect a high-capacity external hard drive and turn on Time Machine. Do
it now. Don’t make a humongous mistake.™

Maintaining Hard Drive Health

3

Shifty-eyed, sneaky, irritating little problems can bother your hard drive: per-
missions errors. Incorrect disk and file permissions can

v Make your MacBook lock up

v Make applications act screwy (or refuse to run)

v Cause weird behavior in a Finder window or System Preferences

Problems with your drive’s catalog file can also result in corrupted data and
files that won’t open.

To keep El Capitan running at its best, I recommend that you check your hard
drive at least once per week.
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To fix any permissions or catalog errors on your system, follow these steps:

1. Click the Launchpad icon in the Dock, and then click within the

i Search box at the top of the window.
< 2. Type the word disk.
=
oisk U 3. Click the Disk Utility icon.
4. At the left, click the volume or named partition you want to check.
5. Click the First Aid button and click Run.

Disk Utility does the rest and then displays a message about whatever it
has to fix. (When will someone invent a car with a First Aid button?)

Automating Those Mundane Chores

One popular feature in El Capitan — Automator — can save you a tremen-
dous amount of time behind the keyboard. You use Automator (shown

in Figure 21-4) to create applications with a relative of AppleScript called
AppleFEvents. (In case you're unfamiliar with AppleScript, it’s the simple
programming language you can use to automate tasks and applications
within El Capitan.)

Of course, writing an application might sound daunting — akin to single-
handedly building your own nuclear submarine over a long weekend — but
Automator is actually easy to use. Heck, you might find it downright fun/
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You can also create workflows, which are sequential (and repeatable) opera-
tions that are performed on the same files or data. Then your Automator
application can automatically launch whatever applications are necessary to
get the job done.

Here’s a great example: You work with a service bureau that sends you a
huge ZIP file every week with new product shots for your company’s market-
ing department. Unfortunately, these images are flat-out huge — taken with a
24-megapixel camera — and they’re always in the wrong orientation. Before
you move them to the Marketing folder on your server, you have to labori-
ously resize each image and rotate it and then save the smaller version.

With help from Automator, you can build a custom application that automati-
cally reads each image in the folder, resizes it, rotates it, and even generates
a thumbnail image or prints the image. Then it moves the massaged images
to the proper folder. You’d normally have to manually launch Preview to
perform the image operations and then use a Finder window to move the new
files to the right location. But now, with Automator, a single double-click of
your custom application icon does the trick.

You find Automator in the Utilities (or Other) folder in Launchpad (or, from a
Finder window, in your Applications folder). Currently, Automator can handle
specific tasks in more than 100 applications (including the Finder). But both
Apple and third-party developers can add new Automator task support to
both new and existing applications.

To create a simple application with Automator, launch the application and
follow these steps:
1. Click the New Document icon.
2. Select Application and click the Choose button.
3. Click the desired application in the Library list.
Automator displays the actions available for that application.

4. Drag the desired action from the Library window to the workflow
window on the right.

5. Modify any specific settings provided for the action you chose.
6. Repeat Steps 3 through 5 until you have completed the workflow.
g’g‘“‘NG! 7. Click the Run button (at the upper right) to test your script.
Use sample files while you're fine-tuning your application lest you acci-
dentally do something deleterious to an original (and irreplaceable) file!
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When the application is working as you like, press 38+S to save it.
In the Save dialog that appears, type a name for your new application.

Click the Where pop-up menu and specify a location where the file
should be saved.

. Click the File Format pop-up menu and choose Application.
12.

Click Save.

Your new Automator application icon includes the Automator robot
standing on a document. Most normal human beings would call you a
programmer, so make sure you're inscrutable from now on! If you plan
to use your new Automator application often, don’t forget that you can
make it more convenient to use by dragging the application icon to the
Dock or to the desktop.

To find all the actions of a certain type in the Library list, click in the Search
box at the top of the Library list and type a keyword, such as save or burn.
You don’t even need to press Return!

If you want your Automator application to run every time you log in — for
example, the application tracks your time on a project — follow these steps
to set up the application as a login item:

S U1 e W N

. Open System Preferences.

. Display the Users & Groups pane.

. Click the Login Items button.

. Click the plus button at the bottom of the list.

. Navigate to the location of your new Automator application.
. Click Add.

Now your Automator application is really automatic. Watch your sig-
nificant other gape in amazement as your MacBook begins to work
without your touching the keyboard! (If you've added the application
icon to your Dock, you can also simply right-click the icon and choose
Options= Open at Login from the menu that appears. Either way, your
MacBook gets the message.)

Updating 0S X Automatically

[ prefer that my MacBook clean up after itself as much as possible, so updat-
ing El Capitan should be automatic as well. In OS X El Capitan, operating
system updates are performed in the App Store, but you configure the update
process from System Preferences.
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The App Store uses the Internet, so you need an Internet connection to shake
hands with the Apple server and download any updates.

Updates can be found in two convenient spots:

v+ The Apple menu: Click the Apple menu (&) and then choose App Store.
Click the Update icon in the App Store toolbar, which alerts you to any-
thing new that’s available.

v System Preferences: Click the App Store icon in the System Preferences
window.

If you take the System Preferences route, you can set the App Store to
check for critical system updates and install them automatically:

e Select the Automatically Check for Updates check box to enable it.
e Select the Install OS X Updates check box to enable it.

e Select the Install System Data Files and Security Updates check box to
enable it.

You can even display any updates immediately from within the App Store
System Preferences pane (click the Check Now button).

With automatic downloading disabled, OS X launches the Updates pane of
the App Store and displays any available updates with short descriptions.
You can manually click the Update button next to a specific update. El
Capitan also displays a Notification window alerting you to new updates. You
can choose to continue with the update from the Notification window, or wait
and update manually later.

If you're using the same Apple ID on more than one Mac, the applications
you've purchased through the App Store on your other Macs can be auto-
matically downloaded to this computer as well. Select the Automatically
Download Apps Purchased on Other Macs check box to enable it, and then
sit back and watch convenience happen.
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In this part . . .

v Commit Mark’s top laptop rules to memory.

v Avoid the worst computing pitfalls known to man.




Chapter 22
Top Ten Laptop Rules to Follow

In This Chapter
Protect your laptop while you're in transit
Pack that MacBook with RAM
Track your Mac with a hidden beacon
Encrypt your MacBook’s drive
Save energy by disabling wireless hardware
Use a surge protector

Back up your laptop

A h, the sedentary life of a desktop Mac. It sits there, like a bump on a log,
comfortable and immobile. As long as you have a stable surface and
an uninterrupted power supply, your iMac, Mac mini, or Mac Pro is a happy

puppy.

But you, good reader, are mobile! Whether you’re on campus or attending a
convention, your Mac laptop is rarely running in the same spot, so it’s sus-
ceptible to all sorts of road warrior pitfalls. In this chapter, [ remind you of
ten of the most important rules every laptop owner should follow to prevent
chaos and carnage while traveling.

Keep Vour Laptop in a Bag

Using a laptop case or bag sounds like common sense. But MacBooks are so
doggone sexy that you'd be surprised how many people carry them around
without any protection. These Mac owners hear phrases like “unibody con-
struction” and “solid-state drive” and figure that their laptop can survive a
construction site, college campus, or hotel room.
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Part of that is true. Mac laptops are some of the toughest ever made, but
they’re not immune to bumps, scratches, and the rare fall. The moral? If you
carry around your MacBook without any protection, soon it will look like a
boxer after a bad fight.

If you're like me, you're proud that your computers remain in pristine condi-
tion, so use a laptop bag or case that offers ample padding and a convenient
shoulder strap or carry handle. (My laptop bag even converts to a back-
pack. It includes plenty of extra space for power supplies, discs, and all the
assorted hoo-hah that you know you need to carry with you.) Spend an extra
$30 on a laptop bag, and your $2,000 computer can weather the worst the
world can dish out.

Using a traditional laptop bag comes with a caveat, however. Some folks
think a bag draws too much attention to its expensive cargo. (And to some
extent, | agree. Few people tote an obvious 15-by-7-inch bag with a hardware
manufacturer’s logo emblazoned on it these days.) If you’re a member of this
group, consider a well-padded laptop sleeve (with corner protectors) that
allows you to carry your MacBook in your backpack, such as the BookBook
cover [ describe in Chapter 1. The laptop always goes on top of those heavy
books, of course. Remember, though, that the padding is the important thing.
Without that extra cushion, you might as well just toss your unprotected
laptop in with the rest of your books and must-have equipment.

Maximize Your RAM

Like any other computer running Windows or OS X, your MacBook will ben-

efit from all the system RAM (memory) you can squeeze onto it. (Chapter 20
describes the benefits of extra RAM.) The virtual memory functionality built
into El Capitan (which I also describe in Chapter 20) results in mediocre per-
formance during memory-intensive tasks such as video and image editing.

When your laptop has a full complement of RAM, its performance will rival
the performance of a desktop computer with the same processor — and
you'll be using it on the go!

Current MacBook models can be configured with anywhere from 4GB to

16GB of RAM at the time you order one from Apple, depending on the model.
Unfortunately, you can’t add more memory after purchase, so order your
new MacBook with the maximum amount of memory you can afford! If you
own an older MacBook model that can be upgraded, I discuss adding memory
in Chapter 20.
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Install a Tracker Application

Suppose the unthinkable happens: Your laptop is stolen while you're on
vacation or on a business trip, and you know that the chances it will be
returned are next to nil. You've resigned yourself to replacing it (and all your
data). But wait! What if I told you that you might just receive an email on your
desktop computer that tells you the thief’s Internet (IP) address, or perhaps
even his or her telephone number?

If this scenario sounds a little like a James Bond movie, you'll be surprised to
discover that several tracker applications are available for El Capitan that can
run invisibly on your laptop. A tracker application can turn your MacBook
into a transmitting beacon, broadcasting to you its current location and all
the Internet information it can get. Then you can alert the police, who will
apprehend the crook (who might be in the middle of creating a new album

in Photos).

In fact, the Find My Mac feature built in to El Capitan is a tracker application
in disguise! (Note that you must set up your iCloud account in the iCloud
pane in System Preferences before you can use Find My Mac, as [ cover in
Chapter 5.) If your MacBook is lost or stolen, you can visit www. icloud.
com, sign in with the same Apple ID, and click Find My iPhone; then click the
All Devices menu at the top of the window and click on your MacBook. From
the display that appears, you can choose to Remote Lock or Remote Erase
your MacBook.

If you prefer a commercial solution, check out LoJack from Absolute Software
(www.absolute.com), which invisibly sends a signal to the company’s secu-
rity center each time your laptop is connected to the Internet or a telephone
line. LoJack for Laptops Standard edition costs about $40 per year. This

is pocket change for a corporate road warrior or design professional who
depends on both the laptop and the irreplaceable data it contains.

Keepeth Thy Drive Encrypted

In Chapter 5, I discuss a number of System Preferences panes. The Security
pane is particularly important to laptop users, because it allows you to
encrypt your drive. Encryption prevents just about anyone from accessing
(or even identifying) any of the files you've stored on your MacBook. The
robust encryption provided by El Capitan will certainly stymie just about
anyone but the NSA. (I won’t even go there.)


http://www.icloud.com/
http://www.icloud.com/
http://www.absolute.com/
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In System Preferences, click Security & Privacy, click the FileVault tab, and
then click Turn On FileVault. You can use your Apple ID to unlock your
MacBook’s drive, or you can choose a unique recovery key, just in case.
(Your login account password is your primary password.) El Capitan takes
care of automatically encrypting and decrypting files as necessary. You won'’t
even know it’s working.

To take full advantage of an encrypted drive, you need the proper login
mode (as I discuss in Chapter 10). Think about this possible security back
door: From the Users & Groups pane, you've set your laptop to automatically
log you in every time you boot your MacBook Air. This scenario is the very
definition of Not Secure because your login account password automatically
bypasses the FileVault encryption! Therefore, make sure that you actually
have to log in to access your account. For the full scoop, see Chapter 10.

Brand Vour MacBook

Put your brand on your laptop! Whether by using an engraving tool on the
bottom of the machine (my personal favorite) or a permanent metal tag,
your MacBook deserves some sort of identifying information. After all, most
people are honest, so you might not need that tracking software mentioned
earlier in this chapter. You might have left your laptop behind by accident,
and someone would like to return it to you. (Don’t forget to offer a reward!)

Some laptop owners want to include their name, address, and other contact
information. Other road warriors feel more comfortable with just their name
and email address. Whatever information you choose to provide, branding
your laptop is as important as backing it up.

Disable Your Wireless

Funny how we don’t think about it, but wireless communications take juice,
and that power comes straight from your laptop’s battery! Because your Mac
laptop comes with built-in Wi-Fi and Bluetooth hardware, you're constantly
broadcasting — sending and receiving, or at least trying to exchange data
with others.

Therein lies the rub: If you’re not connected to a wireless network or
Bluetooth device, you're wasting precious battery power. That’s why El
Capitan lets you turn off your Wi-Fi and Bluetooth hardware to save energy.
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When you're sitting in a crowded auditorium without access to an AC socket
or a wireless network, the energy savings you reap when you disable your
wireless hardware can be significant.

In fact, you might have to disable your wireless connectivity in situations
where cellphones are not allowed, such as on an airplane flight or in cer-
tain areas of a hospital. And, because I'm a security-conscious kind of guy, I
always disable my wireless hardware whenever I'm not using it (even if 'm in
range of a wireless network). Call me overly careful, but none of my shared
files have ever been sucked out of my MacBook without my permission!

To turn off your Wi-Fi hardware from the El Capitan Finder menu bar, click
the Wi-Fi status icon and choose Turn Wi-Fi Off from the menu. To turn off
your Bluetooth hardware from the menu bar, click the Bluetooth icon and
choose Turn Bluetooth Off.

Take a Surge Protector with Vou

&
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I'll be honest: [ usually am not a huge supporter of surge protectors, because
I think they do only half the job. That job is protecting both your hardware
and your data. And, as you probably know, a surge protector doesn’t provide
backup power in case of a brownout or total loss of power, like a UPS (unin-
terruptible power supply) can.

Of course, many locales around the world offer a less-than-perfect power
grid, which translates into a sudden loss of power — usually at exactly the
wrong moment. (Think Great American Novel Takes a Nosedive.) Unlike a
desktop, however, your MacBook is smart enough to immediately switch
from AC current to its battery in case of a power failure (much like a UPS). So
why am I suggesting a surge protector for your laptop, especially seeing as
how it adds bulk and weight to your laptop bag or luggage?

v The risk of a power spike: A surge protector is good protection from a
massive power spike, such as an overload or lightning strike.

v~ Extra sockets on tap: Don’t forget that you might need several more AC
sockets for external devices, such as a hard drive, projector, and por-
table printer. A surge protector can provide extra access to power, even
when your host can’t.

Naturally, if you're traveling to a country with different AC standards (and dif-
ferent socket configurations), invest in an AC plug adapter that’s compatible
with the standard used at your destination.
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Use Power-Saving Features

Apple allows you considerable control over your MacBook’s sleep schedule,
which is a real boon to power-hungry laptop owners. In System Preferences,
click Energy Saver to display the Battery and Power Adapter settings.

If your laptop is running on battery power, and you need to conserve as
much power as possible, click the Battery tab. Make sure that you move
the Computer Sleep and Display Sleep sliders to 5 minutes or less. (You
should also enable the Put Hard Disks to Sleep When Possible check box.)
Now you’re squeezing the maximum amount of computing time out of your
remaining battery power.

If you're running your laptop while connected to an AC outlet, click the
Power Adaptor tab. Although power isn’t a problem, I still don’t recommend
that you set the Computer Sleep and Display Sleep sliders to Never. (Sleep
mode helps prolong the life of your MacBook’s display, and a sleeping laptop
generates practically no heat.) However, you can set both sliders for a much
longer delay while connected to AC power, such as the 30 minutes I use for
my display sleep.

Use an External Keyboard and Mouse

Does your laptop remain at your home, dorm room, or office for long periods
of time? If so, I recommend that you invest in an external keyboard and an
external mouse, trackball, or trackpad for two very good reasons:

v Adding external input devices helps lessen the wear and tear on your
laptop’s keyboard and trackpad.

v External input devices are generally more comfortable and convenient
to use than those offered by your MacBook, especially for gaming.

If price is no obstacle, a wireless keyboard and pointing device allow you far
more freedom of movement. Note, though, that a standard USB keyboard and
mouse do just as fine a job and cost less.

In fact, you can have two external keyboards if you like: one to work with
your laptop while you're running El Capitan (which has all the keys unique
to an Apple keyboard), and one to use when you’re running Windows under
Boot Camp (with those gnarly Windows-specific keys). Techno-suave.
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Not Again! What Is It with You
and Backing Up?

Yes, this is one of the Top Ten Laptop Rules as well. 'm not kidding: If

you think you don’t need to back up on a regular basis, you will eventually
lose every byte of data you have. Period. It’s only a matter of time. Even if

you have incredible luck and don’t do something you regret with a Finder
window, your MacBook is just a machine, and it will wear out in the long
run. (Especially with the mobile life of a road warrior, with all the bumps
and bruises of travel.) That’s why hard drive manufacturers list MTBF (Mean
Time Between Failures) figures for their hard drives.

Backing up your drive with Time Machine isn’t difficult and doesn’t take long,
and it does indeed protect every file and folder. Chapter 21 explains every-
thing you need to know. After you finish your first full backup, drop me a line
at mark@mlcbooks . com with the subject I’ve Got Laptop Peace of
Mind. We can celebrate together!


mark@mlcbooks.com




Chapter 23

Ten Things to Avoid
Like the Plague

In This Chapter
Dodging USB 1.1 storage devices
Shunning email and web phishing expeditions
Skirting those strange-sized discs
Keeping liquids at arm’s length
Banishing outdated disk utilities
Eschewing pirated software
Steering clear of the root/System Administrator account
Sidestepping unsecured public wireless networks
Spurning refurbished hardware
Expelling dust and dirt

’ f you've read other books I've written in the Dummies series, you might
recognize the title of this chapter. It’s one of my favorite Part of Tens sub-
jects. I don’t like to see any computer owner fall prey to pitfalls. Some pitfalls
are minor (such as not keeping your laptop clean), and others are downright
catastrophic (such as providing valuable information over the Internet to
persons unknown).

All these potential mistakes, however, have one thing in common: They’re
easy to prevent with a little common sense — that is, as long as you’re aware
of them. And making you aware is my job. In this chapter, I fill in what you
need to know. Consider these pages valuable experience gained easily!
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USB 1.1 Storage Devices

Man, a USB 1.1 storage device is the very definition of sluggish. Only a creak-
ing USB 1.1 external device such as a hard drive, USB hub, or CD-ROM drive
could be as slow as a turtle on narcotics.

Unfortunately, you still find countless examples of USB 1.1 hardware hanging
around. eBay is stuffed to the gills with USB 1.1 equipment, and your family
and friends might try to bestow that old 4x CD-RW drive on you as a gift.
(This present, like your Aunt Harriet’s fruitcake, is one you should politely
refuse.) These drives were considered cool in the early days of the colorful
iMac G3, when USB was a new technology. Today, a USB 1.1 hard drive is
simply a slow-as-maple-syrup-in-January embarrassment (especially when it’s
hanging off your snazzy USB 3.0 port on your new MacBook Air).

[ do admit that plenty of great USB 1.1 devices are still around these days,
such as joysticks, keyboards, mice, and other controllers, along with print-
ers that work just fine with slower transfer rates. However, if a peripheral’s
job is to store or move data quickly — including hard drives, network con-
nections, USB hubs, CD-ROM drives, and USB flash drives — give a USB

1.1 device a wide berth. Opt instead for a Thunderbolt 1/2, USB 2.0/3.0, or
FireWire device.

Phishing Operations

Phishing is no phun. No, that’s not a misspelling. In Internet lingo, phishing
refers to an attempt by unsavory characters to illegally obtain your personal
information. If that sounds like an invitation to identity theft, it is. Thousands
of sites have defrauded individuals like you and me (along with banks and
credit card companies) out of billions of dollars. Unfortunately, the phishing
industry has been growing like a weed, and more innocent folks are being
ripped off every day. (The lowlifes running phishing operations are pond
scum. I'm being polite here because this will appear in print.)

A phishing scam works like this: You get an email purporting to be from a
major company or business, such as eBay, a government agency, or a credit
card company. The message looks genuine, with all the proper graphics and
company information. It warns you that you must “update” your login or
financial information to keep it current, or that you must “validate” your infor-
mation. It even provides you with a convenient link to an official-looking web
page. After you enter your oh-so-personal information on that bogus page, the
info is piped directly to the bad guys, and they’re off to the races.
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Here’s a Mark’s Maxim that every Internet user should take to heart:

No legitimate company or agency will ever solicit your personal informa-
tion through an email message!™

WING/ Never respond to these messages. If you smell something phishy, open your
§g~ web browser and visit the company’s site (the real one) directly. Then con-
tact the company’s customer support personnel. They’ll certainly want to
know about the phishing expedition, and you can help by providing them
with the email and web addresses used in the scam.

In fact, sending any valuable financial information through unencrypted
email — even to those you know and trust — is a bad idea. Email messages
can be intercepted or read from any email server that stores your messages.

Oddly Shaped Optical Discs

Your MacBook Pro’s optical drive (or your external SuperDrive, if you have
one) is a marvel of precision — and it’s doggone svelte to boot. Today’s opti-
cal drives typically don’t require a loading tray: You just slide your CD or
DVD into the drive, and the disc smoothly disappears from sight. Press the
Media Eject key, right-click the disc icon on the desktop and choose Eject, or
drag the disc icon to the Trash, and the disc appears like magic. No need to
give the loading and ejecting procedures a second thought, right?

Well, good reader, that’s true — but only if you're loading a standard 1.2mm-
thick, 120mm round CD or DVD into your drive! Note that [ didn’t say

+* An 80mm minidisc: Yes, they're cute. Yes, all sorts of devices have used
them, from DV camcorders to digital cameras. But no, they’re not sup-
ported by many slot-loading drives, so there’s a good chance one will
refuse to eject.

v A credit-card-shaped or triangular disc: Friends, these discs just aren’t
natural! Of course, that’s part of their pizzazz for advertisers, who give
them away in scads. A square disc works in a tray-loading drive, but a
slot drive will likely get indigestion and refuse to eject it.

v A super-thick disc: Sure, a tray DVD drive can likely accept a disc with
a thick, printed paper label, but if that disc is more than 1.5mm thick,
it can actually damage your laptop’s slot-loading drive. Consider these
words: “Marge, it’s stuck in there!” Now imagine how you would feel if
you were the one saying that.
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All three of these oddly shaped discs have one thing in common: The damage
you may cause by attempting to use one in your MacBook Pro or external Super-
Drive is not covered under your Apple warranty. A weighty statement indeed.

If you do need to read from or record to a nonstandard disc size on a regular
basis, I recommend that you pick up a USB external tray-loading drive, which
can easily handle any size disc you toss at it.

Submerged Keyboards

Do you really want a submerged keyboard? Your answer should be an
unequivocal no! And that’s why you should make it a rule to keep all bever-
ages well out of range of keyboards, trackpads, and external devices, such as
speakers and mice — especially when kids or cats are in close proximity to
your laptop.

If soda gets spilled on your MacBook, you're likely to be visited with inter-
mittent keyboard problems (or, in the worst case, a short in your laptop’s
motherboard). Suffice it to say that 12 inches of open space can make the dif-
ference between a simple cleanup and an expensive replacement!

Antiquated Utility Software

Everyone’s gotta play the upgrade game. If you're using OS X El Capitan,

you must upgrade your older utility programs — such as an older copy of
TechTool Pro from Micromat (www.micromat . com) that supports only OS

X Lion, Mountain Lion, and Mavericks. [ know you spent good money on ’em,
but these older disk utility applications can do more harm than good to a
hard drive under OS X El Capitan. Of course, you should avoid utility software
designed for ancient versions of Mac OS X, such as Panther and Jaguar. (In
fact, those antique applications probably wouldn’t even run with El Capitan.)

A number of things change when Apple makes the leap to a new version of
OS X. These include subtle changes to disk formats, memory management in
applications, and the support provided for different types of hard drives and
optical drives. If you use an older utility application, you could find yourself
with corrupted data. (In fact, most utilities now refuse to run if they don’t
recognize the version of OS X you’re running.)

Now that you’re using OS X El Capitan, make sure you diagnose and repair
disk and file errors by using only a utility application specifically designed to
run in El Capitan (including, of course, Disk Utility). Your laptop’s drive will
thank you.


http://www.micromat.com/
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Software Piracy

Avoiding pirated software is a no-brainer. Don’t endorse software piracy.
Remember, Apple’s overall market share among worldwide computer users
currently weighs in at around 22 percent. Software developers know this, and
they have to expect (and receive) a return on their investment, or they’ll find
something more lucrative to do with their time. As a shareware author, I can
attest to this fact firsthand.

Pirated software might seem attractive. The price is right, no doubt about

it. But if you use an application without buying it, you're cheating the devel-
oper, who will eventually find doing Macintosh programming no longer worth
the time and trouble. Believe me, the MacBook is a great machine, and El
Capitan is a great operating system, but the sexiest laptop won’t make up for
an absence of good applications.

Pay for what you use, and everyone benefits.

The Forbidden Account

You may never have encountered the root, or System Administrator, account
in OS X — and that’s A Good Thing. Note that I'm not talking about a stan-
dard Administrator (or Admin) account. Every Mac needs at least one Admin
account. (In fact, it might be the only visible account on your computer.) Any
Standard user account can be toggled between Standard and Admin status
with no trouble.

The root account, though, is a different beast altogether, and that’s why it’s
disabled by default. All UNIX systems have a root account. As you know, El
Capitan is based on a UNIX foundation, so it has one too. Anyone logging in
with the root account can do anything on your system, including deleting or
modifying files in the System folder (which no other account can normally
access). Believe me, deliberately formatting your hard drive is about the only
thing worse than screwing up the files in your System folder.

Luckily, no one can access the root/System Administrator account by acci-
dent. In fact, you can’t assign the root account through System Preferences;
you have to use the Directory Utility application located in your Utilities
folder. Unless an Apple support technician tells you to enable and use it, you
should promptly forget that the root account even exists.
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Unsecured Wireless Connections

[ like free Internet access as much as the next technology author. It’s cool,
it’s convenient, and public-access wireless networks are popping up all
over the world. A number of U.S. cities now offer citywide free wireless
Internet access.

However, just because something is free doesn’t mean it’s safe. Impromptu
and overly trusting bungee jumpers, take note.) Unfortunately, the free
public wireless access you're likely to encounter is not secure. Anyone can
join, and the information you send and receive can be intercepted by any
hacker worthy of the name. A public network uses no WEP or WPA key, so

no encryption is involved. Therefore, you have no guarantee that your private
email, your company’s financial spreadsheets, and your Great American
Novel aren’t being intercepted while you’re uploading and downloading them
in the airport.

\‘@N\Bfﬁ If you must use your laptop on an unsecured public network, make sure that
3y the connection itself is secure instead. For example, don’t check your email
by using a web browser unless your ISP or email service offers an encrypted
SSL (Secure Sockets Layer) connection. (Yep, I'm talking again about that
little padlock that appears in Safari, which I discuss in Chapter 8. It’s not just
for ordering things online!) If you need to establish a secure connection with
your home or office network, use an SSL-enabled Virtual Private Network
(VPN) client, which allows you to transfer files and remotely operate a host
computer with bulletproof security.

Naturally, El Capitan includes a built-in basic VPN client, so you don’t

need additional software to connect. Open System Preferences, click the
Network icon, and then click the Add (plus sign) button. Click the Interface
pop-up menu and choose VPN. Then select the correct VPN type and click
Create. (To add VPN host capability to OS X, upgrade to OS X Server via the
App Store.)

-.:J!

Network

Refurbished Hardware

Boy, do I hate refurbished stuff. Like my single-minded quest to rid the world
of floppy disks, I likewise make it a point to dispel the myth that you're
actually “saving” money when you buy a refurbished (or remanufactured)
piece of hardware. As the saying goes, if it sounds too good to be true, it
probably is.
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Consider what you get when you buy a refurbished external hard drive. It’s
likely that the drive was returned as defective and then was sent back to the
factory. There the manufacturer probably performed the most cursory of
repairs (just enough to fix the known problem), perhaps tested the unit for a
few seconds, and then packed it back up again. Legally, retailers can’t resell
the drive as a new item, so they cut the price so low that you’re willing to
take a chance on it.

Before you spend a dime on a so-called bargain that’s remanufactured — 1
can’t get over that term — make sure you find out how long a warranty you’ll
receive, if any. Consider that the hardware is likely to have crisscrossed the
country at least once, picking up a few bumps and bruises during its travels.
Also, you have no idea how well the repairs were tested or how thoroughly
everything was inspected.

[ don’t buy refurbished computers or hardware. Most of the tales I've heard
about folks who did ended badly. (The exception is the Apple online store,

where you can find a refurbished Mac with a full warranty.) Take my advice:
Spend the extra cash on trouble-free, new hardware that has a full warranty.

Dirty Laptops

Clean your machine. Every computer (and every piece of computer hard-
ware) appreciates a weekly dusting.

You should clean your screen every two or three days — unless you like
peering through a layer of dust, fingerprints, and smudges. Never spray any-
thing directly on your screen or your MacBook’s case. I highly recommend
using pre-moistened LCD cleaning wipes typically used for notebook comput-
ers or computer monitors.

Your laptop’s case really doesn’t need a special cleaning agent. In fact, you
shouldn’t use any solvents on it. But a thorough wipe with a soft cloth should
keep your MacBook’s case in spotless shape.
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= (equals) sign, Numbers application, 323
3D map option, Maps application, 136-137
80mm minidiscs, 393
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AAC (Advanced Audio Coding)
format, 212, 296

Absolute Software's LoJack
application, 385

AC plug adapter, 387

account names, 170-171

activation hot corners, 104

Add To button, Photos application, 240

add-ons, USB, 365

Address box, Safari browser, 143, 144-145

addresses. See Maps application

Advanced Audio Coding (AAC)
format, 212, 296

aGent V6 HD webcam, 30, 31

AIFF format, 212

AirDrop, 197

AirPlay Mirroring feature, 102

AirPort Express Base Station, 19,
193, 194, 231

AirPort Time Capsule, 193, 194, 362, 374

ALAC (Apple Lossless) format, 212

albums, Photos application, 242-245

alerts, 115-116, 134

aliases, 63-64

AND, used in searches, 121

animation, 111, 275-276

Aperture Library, 268

Apple ID, 38

Apple Lossless (ALAC) format, 212

Apple MacBook Support site, 353

Apple menu, 50, 55

Apple service center, 35

Apple support center, 85
Apple TV, 102, 216
AppleCare Protection Plan, 40
AppleEvents, 376-378
AppleScript, 376
Application menu, 50
applications
access to, restricting, 177-180
active, viewing, 74-75, 111
adding to Dock, 79
animation when opening, 111
copying to another MacBook, 41
force quitting, 343
grouping windows by, 105
hiding, 71
icons for, 63
opening, 54-57
patches to, problems caused by, 349
pre-installed, 27-29
printing parameters for, 84
quitting, 57, 71, 343
recent, 108
removing, 56
Split View used with, 89-91
supplied with OX X El Capitan,
28-29
switching between, 71, 105
Apply button, System Preferences, 100
arguments, in spreadsheets, 324
Arrangement markers,
GarageBand, 292-293
Artist lessons, GarageBand, 295
aspect ratio
Keynote application, 330
Photos application, 252
Attachment Browser, Notes
application, 94-95
attachments
Mail application, 312
Notes application, 94-95
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attributes of images, adjusting, 254
audience for this book, 1-2
audio. See also iTunes
adding to presentations, 336-337
audio CDs, 213-214
digital, 214-219
effects, importing to iMovie, 270
formats supported by iTunes, 211-213
muting, 70, 155
overview, 12
ripping audio files, 224-225
streaming to speakers, 102
Audio Mute key, 70
audiobooks, 213
AutoFill button, Safari browser, 146
Automator feature, 376-378
AVCHD format, 267
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Back button, Safari browser, 145
Back to My Mac feature, 114, 165
background
of Desktop, 78, 103-104
of documents, 156, 310
of Keynote slides, 337
in movies, 277
backing up
importance of, 389
overview, 371-372
preferences for, 112-113
saving files, 372-373
Time Machine feature, 373-375
Badge App icon, 116
banners, 134
base stations
Apple models, 193-196
installing, 194
joining wireless networks, 195-196
non-Apple, 195, 196
overview, 192
bass tracks, GarageBand, 285
battery
calibrating, 36-37
charging, 13, 35
conserving power, 35-37, 388

external, 37
monitoring level, 36
overview, 13
sealed, 19
Beats & Project mode, GarageBand, 284
Belkin Thunderbolt Express Dock, 31-32
black-and-white effects, 254
blocking cookies, 157
Bluetooth
overview, 16
turning off, 386-387
using Handoff feature with, 164
bonus chapters, 4
BookBook case, 29-30
bookmarks, Safari browser, 144, 149-151
Boolean searches, 121
Boot Camp feature, 29, 43, 388
boxes, 24-25
brightness, 36, 102
burning, music to CDs, 232-233, 297
buying digital media, 235-236
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cables
checking, 349
connecting, 25-26
Ethernet, 198, 199
overview, 32
power, 13
calendars, 114, 128
calibrating battery, 36-37
camcorders
importing video from, 266-267
slot for, 363
cameras
FaceTime HD camera, 13, 18, 30
importing images from, 241-242
restricting access to, 179
slot for, 363
CAP (Cookie Acceptance Plan), 157
captions, in photo books, 256
cases, 20, 29, 397
Casio CTX 3000 MIDI keyboard, 294
catalog errors, 375-376
categories, Spotlight search box, 124
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CD drives, sharing, 12, 22
CD-ROMs, burning to, 232
CDs
backing up to, 372-373
blank, 32
burning to, 178, 297
importing images from, 242
nonstandard-sizes/shapes, 393-394
overview, 212
CDW website, 357
cells
in spreadsheets, 318, 321-322
in tables, 308-309
characters, in spreadsheets, 319
charging batteries, 35
charts, in spreadsheets, 325-326
Cheat Sheet pages, 4
Chess application, 28
children. See parental controls
Chord feature, GarageBand, 284
ClamXav 2 software, 350
cleaning laptop, 397
clearing history data, Safari browser, 159
Clipboard, Pages application, 306-307
clips, video (iMovie)
adding, 271-272
cropping, 274
editing, 273-274
importing, 266-267
marking, 272-273
removing, 273
reordering, 273
rotating, 274
selecting section of, 273-274
trimming, 274
clock, screen saver with, 104
Close button, in application windows, 57
closed networks, 196
closing
documents, saving changes when, 108
laptop, 26
windows, 61-62, 71, 108
CNET’s MacFixIt forum, 86
coffee-table photo book, creating, 254-257

collections, of bookmarks, 150
colors, 102, 107, 254
columns, in spreadsheets
headings for, 321
inserting, 322-323
selecting, 318
shading, 321-322
Command key, 70
commands, format for, 3
compact discs. See CDs
Computer Sleep slider, 388
Contacts application, 28, 114
Content Library, iMovie application, 264
Content pane, Safari browser, 143
content ratings/restrictions,
iTunes, 234-235
context menus, 50
Contour Design's ShuttleXpress video
controller, 365
controllers (MIDI instruments), 294
controllers, game/video, 365
Cookie Acceptance Plan (CAP), 157
cookies, 157-158
cooling pads, 37
copies, number to print, 84
copying items
Arrangement markers, GarageBand, 293
in Finder, 66-67
in Pages application, 306
shortcut for, 71
cover of laptop, 26
CPU, 15
credit-card-shaped discs, 393
crooked photos, straightening, 253
cropping
images, 251-253
video clips, 274
Ctrl key, 70
currency, in spreadsheets, 319
custom stations, iTunes, 228
customization
Desktop, 77-79
Spotlight feature, 123-125
cutting items, 71, 306
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damage, during shipping, 24
Dashboard feature, 76-77, 105-106
Delete key, 70
descriptions, in photo books, 256
Desktop
background of, 78, 103-104
customizing, 77-79
Dock, 47-48
hiding menu bar from, 93-94
icons on, 48, 77-78
menu bar, 49-50
opening applications from, 56
overview, 46-47
windows on, 50
Desktop & Screen Saver pane, System
Preferences, 103-104
desktop publishing. See Pages application
DHCP (Dynamic Host Configuration
Protocol) server, 191, 200, 201
dial-up modems, 191
Dictation feature, restricting access
to, 178
Dictionary, 11, 178
digital extraction, 224-225
digital lifestyle suite, 27
dimensions, 19
directions, Maps application,
137-138
dirty laptops, 397
disabling hot corners, 104
disc slot, 12
disk permissions, 347
Disk Utility
caution using, 345
fixing permissions and catalog errors,
375-376
general discussion, 346-348
Display Sleep slider, 388
Displays pane, System
Preferences, 101-102
DNS (Domain Name System)
address, 200
Do Not Disturb mode, 115

Dock
adding items to, 79-80
overview, 47-48
resizing, 81-82
restricting modification of, 179
Stacks on, 80-81
Dock pane, System Preferences, 110-111
docking station, 31-32
documents. See also Pages application
adding photos to, 309-310
background of, 310
copying to another MacBook, 41
creating, 302-303
exporting, 312
in iCloud, 114, 163
icons for, 63
opening, 71, 303
printing, 311
recent, 108
saving, 108, 304
sharing, 312
Domain Name System (DNS) address, 200
downloading files
automatic, in iTunes, 236
general discussion, 152-153
music, in iCloud, 229
using Safari browser, 147
Downloads folder, as stack, 81
Drop Box folder, 185
drummer tracks, GarageBand, 285
Dummies.com online articles, 4
duplication, 68
Duration Settings button, Photos
application, 257
DV format, 267
DVD drives, sharing, 22-23
DVD Player, 28
DVD-ROMs, burning to, 232
DVDs
backing up to, 372-373
blank, 32
burning to, restricting, 178
importing images from, 242
nonstandard-sizes/shapes, 393-394
Dynamic Host Configuration Protocol
(DHCP) server, 191, 200, 201
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effects, for images, 254
ejecting
media, 70, 82
removable devices, 82
El Capitan. See OS X El Capitan
electric guitar tracks, GarageBand, 285
e-mail. See Mail application
Enable Power Nap feature, 109
encryption
of files and folders, 185-186, 385-386
of networks, 196
overview, 156
Energy Saver feature, 108-109, 388
engraving laptop, 386
enhancing images, 253
Equalizer, iTunes, 225-226
equals (=) sign, Numbers application, 323
equations. See formulas, in spreadsheets
Ethernet, wireless, 16
Ethernet cables, 198, 199
Ethernet port, 15, 20, 25-26, 198
Event/Project Library pane, iMovie
application, 264, 271
events
iPhoto, 245
searching for, 119
exiting applications. See quitting
applications
explicit language, in Dictionary, 178
exporting
documents, 312
GarageBand projects, 297
extensions, to Photos application, 92
external batteries, 37
external cameras. See FaceTime HD camera
external drives
connecting, 364
importing images from, 242
overview, 362
ports for, 362-363
Thunderbolt, 363
USB 1.1, 392
external keyboards, 388
external mouse, 388
external USB DVD burners, 22

ofF e

Facebook, sending photos to, 260
Faces tool, Photos application, 245-247
FaceTime HD camera, 13, 18, 30
Family Sharing, 113, 166
fans, 80
Fast user switching feature, 182-183
favorites
iMovie, 272
Photos, 239
Safari, 142, 144, 146
files
adding to Dock, 79-80
downloading, 152-153
encrypting, 185-186, 385-386
icons for, 63
opening, 71
saving, for backup, 372-373
searching for, 119
sharing with users, 184-185
transferring via wireless network, 197
FileVault, 185-186, 385-386
filters, Photos application, 254
Find My Friends widget, 93
Find My Mac feature, 114-115, 165, 385
Finder
closing windows, 61-62, 71
copying items, 66-67
duplicating items, 68
icons in, 62-64
minimizing windows, 59-60, 71
monitoring battery level, 36
moving windows, 60
opening applications from, 57
resizing windows, 58-59
restoring windows, 59-60
restricting access to, 180-181
scrolling windows, 58-59
search window, Spotlight and, 122-123
selecting items, 65-66
sidebar in windows, 68
Simple Finder, 180-181
tab in, 69
zooming windows, 60
firewall, 112, 205-207
FireWire mini-DV camcorder, 266-267
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FireWire port, 14, 19, 363
First Aid, Disk Utility, 347-348
flash drives, 20-21, 242
Flickr, sending photos to, 260

floating objects, Pages application, 309-310

folders
adding to Dock, 80
duplicating, 68
encrypting, 185-186, 385-386
Home folder, 72-73
in Notes application, 131
opening, 71
searching for, 119
spring-loaded, 67
subfolders within, 73
fonts, smoothing of, 108
For Dummies website, 85
Force Click feature, 52, 53
Force Quit, 57, 343
Force Touch trackpad, 12
formulas, in spreadsheets, 323-325
forums, support, 86
Forward button, Safari browser, 145
full-screen mode
overview, 60
Split View in, 89-91
two-finger switching in, 53
functions, in spreadsheets, 323-324

oG o

Game Center, permissions in, 180
game controllers, 365
GarageBand application
adding loops, 291
adding tracks, 285-287
Arrangement track, 292-293
bass tracks, 285
burning audio CDs, 297
choosing loops, 287-289
drummer tracks, 285
electric guitar tracks, 285
exporting projects, 297
importing content to iMovie from, 269
loops in, 287-291
muting tracks, 291
overview, 281-284
real instrument tracks, 285
repeating loops, 290-291

resizing loops, 290
ringtone, creating, 296
sharing songs, 295
software instrument tracks, 285, 286
song files, creating, 296
Songwriter project, 286
track settings, 293-294
video sound tracks, 285
volume of tracks, 291
Gatekeeper feature, 180
gateway router IP address, 200
General pane, System Preferences,
106-108
Genius, iTunes, 216, 220
Genre field, iTunes, 218
geotagging, in Photos application, 92
graphics boxes, 306, 334
grayscale setting, of printer, 156
grounding laptop, 361
grouping windows by applications, 105

o/ o

handling of MacBook, 26
Handoff feature, 108, 163-164
hard drives
cleaning up, 367-371
encrypting, 185-186, 385-386
importing images from, 242, 268
maintenance of, 375-376
solid-state drives, 20-21
space on, freeing up, 367-371
upgrading, 361-365
hardware
icons for, 63
refurbished, 396-397
turning off, 35
USB add-ons, 365
for wired networks, 198-199
HDMI port, 15
HDV (high-definition video) format, 267
headings, in spreadsheets, 321
headphone port, 15
Help system, 71, 85. See also support
high-definition video (HDV) format, 267
highlighting, preferences for, 107
History list, Safari browser, 147,
153, 159
Home button, Safari browser, 146
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Home folder

of deleted users, 174

encrypting, 185-186

general discussion, 72-73
home page, Safari browser, 148-149
Home Sharing, 216, 231
Hot Corners, 104, 106
How Did I Play feature, GarageBand, 295
hyperlinks, sharing, 144, 152

o] o

iCloud
account set up, 38
configuring, 164-166
documents in, 163
Handoff feature, 163-164
iTunes and, 229
Keychain passwords, 158
overview, 161-162
preferences for, 113-115, 164-165
storage management, 166
iCloud Drive
backing up to, 373
document management in, 163
opening Numbers document from, 315
opening Pages document from, 303
preferences for, 114
sharing documents on, 312
iCloud Photo Library, 258
iCloud Tabs, 154
icons
on Desktop, 48, 77-78
in Finder, 62-64
preferences for, 107
in this book, 3-4
wiggling, 56
identity theft, 392-393
IEEE 1394 port, 363
images. See also photos; Photos
application
adding to documents, 309-310

adding to Keynote presentations, 336-337

black-and-white effects, 254
colors in, 254

crooked, straightening, 253
cropping, 251-253
downloading, 153

editing, 250-254

effects for, 254

enhancing, 253

iCloud preferences for, 114
importing to iMovie, 268
location data for, 92
orientation of, 251
retouching, 253

rotating, 251

sending to social media, 260
sharing, 240, 259-260
synchronizing, 165

for user accounts, 172-173

iMovie application

adding clips, 271-272
backgrounds, 277

common controls and displays, 262-263
creating movie project, 262-263
cropping video clips, 274
editing clips, 273-274

favorites, 272

importing still images, 268
importing video clips, 266-267
maps, 277

marking clips, 272-273
movie-making process, 265
narration of movies, 270
overview, 261

rejecting clips, 272

removing clips, 273

reordering clips, 273

rotating video clips, 274
selecting section of clip, 273-274
sharing movies, 280

Theater mode, 277

themes, 263

titles, 275-276

trailers, 262-263, 278-280
transitions, 274-275

trimming video clips, 274
Voiceover controls, 270

importing

from another Mac, 40-42
images, 240-242

to iMovie, 266-268

from Windows, 42-43

Info button, Photos application, 240
inline objects, Pages application, 310
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Inspector window
Keynote application, 332, 335
Numbers application, 316
Pages application, 305, 307
installing
base stations, 194
memory modules, 357-361
instant messaging, 28
instruments, learning to play, 295
Intego's Virus Barrier X8 software, 350
Intel processor power, 18
interactive whiteboards, 338
internal drives, upgrading, 364-365
Internet connection
checking, 350
sharing, 190-191
Internet protocol (IP) addresses, 191, 200
Internet radio. See Radio feature, iTunes
iPad/iPhone/iPod
syncing media to, 229-230
using for Keynote presentations, 338
iPhoto, 245, 268
iTunes
automatic downloading, 236
burning music to CDs, 232-233
buying digital media, 235-236
content ratings/restrictions, 234-235
deleting songs from, 218
Equalizer, 225-226
iCloud and, 229
importing content from to iMovie, 269
Library, 217-219
overview, 211
Parental settings, 233-235
playing audio CD, 213-214
playing digital audio files, 214-219
playlists, 219-221
Radio feature, 226-228
ripping audio files, 224-225
sharing media, 230-231
song information, 222-224
supported audio formats, 211-213
syncing music, 229-230
visuals, 233
watching video, 219
iTunes Match service, 229
iTunes U, 212
iWork suite, 27

° ] °
jacks, Line Out, 12
jump cuts, 275

oK o

keyboard shortcuts, 71-72, 106, 124
keyboards
condition of, 35
external, 388
illuminating, 70
overview, 12
protecting, 394
treatment of, 26
wireless, 388
keyboards (instrument), MIDI, 294
Keychain, 114, 158
Keynote application
adding media, 336-337
adding slides, 333
background shapes, 337
creating presentations, 330-331
graphic boxes, 334
opening presentations, 331
overview, 329, 332-333
presenter’s text notes, 332, 335-336
printing slides and notes, 338-340
reverting presentation to older
version, 332
saving presentations, 331-332
slideshows, 337-338
text boxes, 334
text on slides, 334-335
Keystation 49es piano keyboard, 365
keywords, in Spotlight search, 118
kids. See parental controls

o/ o

Laplink's PCmover Express, 43
launching. See opening
Launchpad, 55-56
Layout pane
Keynote application, 332, 333
Pages application, 305
LCD Font Smoothing, 108
Learn to Play feature, GarageBand, 295
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LED screen. See screen
Libraries list, iMovie application, 264
Library, iTunes, 217-219
lighting, 24
Line Out jacks, 12
links, sharing, 144, 152
local service, 353
location data
for images, 92
in Photos application, 249-250
for reminders, 130
tracked by websites, 158
location of MacBook, 23-24, 385
Lock Screen, notifications on, 116
log files, 179
logging in/out, 182-184
login items, 57, 351
Logitech optical trackball, 52
LoJack application, 385
Loop Browser, GarageBand, 283
lost Mac. See Find My Mac feature

ol o

Mac OS X Hints forum, 86

MacBook Air
compared to other MacBooks, 18-20
cost of, 19
magnetic power connector, 13
ports on, 363
SDXC card slot, 363

MacBook Pro. See also memory
compared to other MacBooks, 18-20
connecting to wired networks, 198
cost of, 19
dimensions of, 19
magnetic power connector, 13
optical drive, 12
ports on, 363
SDXC card slot, 363
weight of, 19

MacBook Pro Retina
compared to other MacBooks, 18-20
cost of, 19
USB port on, 363

MacBook Support site, 353

MacBooks
cleaning, 397
comparison of, 18-20

condition of, 34-35
connecting cables to, 25-26
cost of, 19
engraving, 386
handling of, 26
location of, 23-24, 385
parts of, 11-13
registering, 40
remote control of, 165, 170
types of, 17-20
unpacking, 24-25
MacFixIt forum, 86
MacMall website, 357
Macworld website, 85
magazines, 85
magnetic power connector, 13
MagSafe 2 connector, 13
Mail application
attachments, 312
iCloud preferences for, 114
opening via Safari browser, 147
restricting contacts in, 180
maintenance of hard drives, 375-376
managed user accounts, 169. See also
parental controls
manual, MacBook, 25
Maps application, 134-138
Mark's Maxim icon, 4
Match subscription service, iTunes, 229
M-Audio's Keystation 49es piano
keyboard, 365
Measures feature, GarageBand, 284
media
adding to Keynote slides, 336-337
ejecting, 70
Media Browser, GarageBand, 283
memory. See RAM (Random Access
Memory); storage
menu bar, Desktop, 49-50, 93-94
menus, 3, 49-50
metadata, 119
Micromat's TechTool Pro software, 394
microphones, recording from, 270
Microsoft Word application, 303
MIDI (Musical Instrument Digital Interface)
instruments, 294
Migration Assistant, 40-42
minidiscs, 393
mini-DV camcorder, 266-267
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minimizing windows, 59-60, 71, 110
Mission Control
active applications, viewing, 74-75
preferences for, 105-106
Spaces feature, 75-76
MLC Radio, 227
modems, 191
monitors, multiple, 105
mouse, 106, 388. See also trackpads
MOV format, 267
movies. See also iMovie application
adding to presentations, 336-337
iTunes and, 212
MP2 format, 212
MP3 format, 211, 232
MPEG-2 format, 267
MPEG-4 format, 267
multimedia files, playing, 153
multiplayer games, restricting
access to, 180
Multi-Touch feature, 53
music. See also GarageBand
application; iTunes
music hardware, 365
Music Library, iTunes, 217-219
Musical Instrument Digital Interface (MIDI)
instruments, 294
Musical Typing keyboard, GarageBand, 285
muting audio
GarageBand application, 291
iMovie application, 270
key for, 70
Safari application, 155
My Photo Stream feature, 165, 259

o\ o

names, searching for, 119
networks. See also wired networks;
wireless networks
checking connections, 350
closed, 196
displaying connections, 78-79
firewalls and, 205-207
overview, 187-188
pinging, 201-203
settings, copying to another MacBook, 41
sharing, 190-191, 203-205
testing, 201-203

new features in OS X El Capitan
browsing attachments within
Notes, 94-95
expanding pointer, 91
extensions to Photos application, 92
Find My Friends widget, 93
hiding menu bar from Desktop, 93-94
overview, 89
Split View, 89-91
Newegg website, 357
noise, of hard drive, 21
NOT, used in searches, 121
notes, in Keynote application
general discussion, 335-336
overview, 332
printing, 338-340
Notes application
attachments within, 94-95
general discussion of, 130-132
iCloud preferences for, 114
Notification Center
adding Find My Friends widget to, 93
displaying, 53
general discussion, 132-134
notifications from websites, 159
preferences for, 116
notifications, Safari browser, 159
Notifications preferences pane, System
Preferences, 115-116
Numbers application. See also columns, in
spreadsheets; rows, in spreadsheets;
spreadsheets
aligning text, 320-321
cells, 318
charts, 325-326
creating spreadsheets, 314-315
editing data, 319
entering data, 319
formulas, 323-325
inserting columns, 322-323
inserting rows, 322-323
number format, 319-320
opening spreadsheets, 315-316
overview, 313-314, 316
printing spreadsheets, 326-327
reverting spreadsheet to older
version, 316
saving spreadsheets, 316
shading cell contents, 321-322



Index 409

o () o

On button, 34
opening
applications, 54-57
documents, 71, 303
downloaded files, automatically, 153
files, 71
folders, 71
Safari browser, 141
operating systems. See OS X El Capitan;
updating OS X; Windows
optical drives
backing up to, 372-373
blank discs for, 32
lack of, 20, 22-23
MacBook Pro, 12
overview, 16
playing audio CD, 213-214
protecting, 393-394
USB SuperDrive, 362
optical output port, 15
optical trackball, 52
Option key, 70
OR, used in searches, 121
orientation of images, 251
OS X. See updating OS X
OS X El Capitan. See also Desktop;
Finder; new features in OS X El
Capitan; trackpads
Help system, 85
opening applications, 54-57
overview, 45-46
quitting applications, 57
setting up, 39-40
toggling toolbars, 61
UNIX foundation of, 51
OS X Help Center, 353
outlets, 23
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padlock icon, Safari browser, 156
Page Up and Page Down keys, 58
Pages application
adding photos, 309-310
background shapes, 310
copying items, 306

creating documents, 302-303
cutting items, 306
entering and editing text, 305
exporting documents, 312
floating objects, 309
formatting text, 307
graphics boxes, 306
opening documents, 303
overview, 304-305
pasting items, 307
printing documents, 311
resizing objects, 309
saving documents, 304
sharing documents, 312
spell-checking, 310-311
tables, 307-309
text boxes, 306
paging, two-finger, 53
parental controls
application controls, 179-180
categories of, 177-178
iTunes, 233-235
overview, 176-177
Simple Finder, 180-181
tracking user actions, 179
passwords
after sleep or screen saver, 104
Keychain passwords, 158
for user accounts, 171, 182
pasting items, 71, 307
patches to applications,
problems with, 349
paths, format for, 3
PCmover Express, 43
PDF files, 156, 256, 311, 326
performance. See maintenance of hard
drives; RAM (Random Access Memory)
peripherals
displaying, 78
USB add-ons, 365
permissions
errors with, 375-376
repairing, 347
personal information, solicitation
of, 392-393
personalization. See customization
phishing, 392-393
photos. See images; Photos application
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Photos application
albums, 242-245
attributes adjustment, 254
cropping images, 251-253
editing images, 250-254
enhancing images, 253
extensions to, 92
Faces tool, 245-247
filters, 254
geotagging in, 92
iCloud Photo Library and, 258
importing images, 240-242
location data, 249-250
My Photo Stream feature, 259
organizing images, 242-250
orientation of images, 251
overview, 237-240
photo book, creating, 254-257
removing photos from, 244
removing red-eye, 253
retouching photos, 253
rotating images, 251
shared albums, 259
Smart Albums, 243-244
undoing actions, 245, 252
physical dimensions, 19
piano keyboard, 365
pictures. See images
pinging networks, 201-203
pinned tabs, 155
pirated software, 395
Play Full Screen button, iMovie
application, 271
playhead
GarageBand application, 283
iMovie application, 264
playlists
iTunes, 219-221, 227-228
searching for, 119
podcasts, 212
pointer, expanding, 91
pop-up ads, Safari browser, 159
ports
for external drives, 362-363
MIDI, 294
overview, 14-15, 19
power button, 13
power cable, 13

power spikes, 387
power strip, 387
power switch, 34
power-saving
general features for, 388
with solid-state drive, 20-21
preferences. See System Preferences
pre-installed applications, 27-29
presentations. See also Keynote
application
opening, 331
reverting to older version, 332
saving, 331-332
presenter’s text notes, 332, 335-336
printers
grayscale setting, 156
restricting access to, 178
printing
documents, 311
general discussion, 83-84
Keynote slides and notes, 338-340
shortcut for, 71
spreadsheets, 326-327
web pages, 147, 156
privacy. See security
Privacy pane, Safari browser, 157-158
programs. See applications
Project feature, GarageBand, 284
Project pane, iMovie application,
264, 271
projector resolution, 330
protecting laptop. See also security
branding, 386
disabling wireless, 386-387
encrypting drive, 385-386
keeping in bag, 383-384
keyboard protection, 394
optical drive protection, 393-394
overview, 383
pirated software, avoiding, 395
root/System Administrator account,
avoiding, 395
surge protector, 387
tracker applications, 385
Public folder, 185
public-access to MacBook, 181
pushpins, 135
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Quick Look feature, 57, 118
QuickTime Player, 153

Quit command, 57

quitting applications, 57, 71, 343

o R e

Radio feature, iTunes, 226-228
RAM (Random Access Memory)
available, viewing, 356-357
inability to upgrade, 20
installing memory modules, 357-361
maximizing, 384
overview, 355-356
upgrading hard drive, 361-365
Reading List, Safari browser, 144, 151
real instrument tracks, GarageBand, 285
rebooting, 342-344
recent changes, investigating, 348-349
recent items, 56, 108
recording audio, 270
recovery key, FileVault, 185-186
red-eye, removing, 253
refurbished hardware, 396-397
registering MacBook, 40
Reload button, Safari browser, 146-147
remanufactured hardware, 396-397
Remember icon, 4
reminders
iCloud preferences for, 114
searching for, 119
Reminders application, 127-130
remote control of MacBook, 165, 170
Remote Disc, 23
removable devices, ejecting, 82
resizing
charts, in spreadsheets, 325
Dock, 81-82
loops, in GarageBand, 290
objects, in Pages, 310
windows, 58-59
resolution
of projector, 330
of screen, 102
restoring windows, 59-60
restraining cable, 32
retouching images, 253

reversing last action, 71
reverting
photo to older version, 332
presentation to older version, 332
spreadsheet to older version, 316
right-clicking, using trackpad, 54
ringtones, 212-213, 296
ripping audio files, 224-225
root account, 395
rotating
images, 251
two-finger, 53
video clips, 274
routers, 191
routes, Maps application, 138
rows, in spreadsheets
headings for, 321
inserting, 322-323
selecting, 318
shading, 321-322
Roxio's Toast Titanium software,
265, 373

oS e

Safari browser
bookmarks, 149-151
cookies, 157-158
downloading files, 152-153
History list, 147, 153, 159
home page set up, 148-149
iCloud preferences for, 114
Keychain passwords, 158
major sections of, 142-143
navigation, 145-148
notifications, 159
opening, 141
overview, 141
pop-up ads, 159
printing web pages, 156
Reading List, 151
security, 156-159
sharing links, 152
tabbed browsing, 154-155
Top Sites display, 144, 146, 153
trackpad gestures used with, 145, 154
visiting websites, 143-145
Safe Boot mode, 345, 351
Satellite mode, Maps application, 136

Index 4 ’ ’
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saving
documents, 108, 304, 311
files, for backup, 372-373
scanners, restricting access to, 178
screen
brightness of, 102
broken, 358
cleaning, 397
colors on, 102
condition of, 34-35
overview, 11
resolution of, 102
sharing, iCloud preferences for, 114
widescreen display, 11, 18
screen savers, 103-104, 351-352
screen wipes, 32
scrolling
preferences for, 107
two-finger, 53
in windows, 58-59
SD/SDXC card slot, 15, 363
searching. See also Spotlight feature
for photos, 240
for settings in System Preferences, 100
for songs in iTunes, 218
for websites, 144-145
widgets for, 28
Secondary Click check box, 52
Secure Empty Trash command, 83
Secure Sockets Layer (SSL) connection, 396
security. See also firewall; protecting
laptop; user accounts
after sleep or screen saver, 104
base stations and, 196
downloaded files, 153
Home folder, 185-186
phishing and, 392-393
Safari browser, 156159
Spotlight feature and, 121, 124-125
unsecured wireless networks, 396
virus scan, running, 350-351
selecting items
all, shortcut for, 71
in Finder, 65-66
servers, recent, 108
service center, 35
shading cells contents, in
spreadsheets, 321-322
Shared folder, 184-185

sharing
CD drive, 22-23
documents, 312
DVD drive, 22-23
files with users, 184-185
GarageBand songs, 295
Internet connection, 190-191
Keynote presentations, 340
links, 144, 152
media, using iTunes, 216, 230-231
movies, 280
notes, 132
photos, 240, 259-260
reminders, 130
screen, iCloud preferences for, 114
using networks, 203-205
web pages, 147-148
Sharing pane, System Preferences,
111-112
sharing-only user account, 170
Sheet canvas, Numbers application, 316
Sheets tabs, Numbers application, 316
shelves for laptops, 24
shipping damage, 24
shortcut menus, 50, 54
shortcuts. See aliases; keyboard
shortcuts
Show All Tabs button, Safari browser, 146
shutting down laptop. See turning
off laptop
ShuttleXpress video controller, 365
Sidebar button, Safari browser, 147
Simple Finder, 180-181
Sleep mode
overview, 35
preferences for, 108-109
requiring password after, 104
settings for, 388
sleeves for laptop, 29, 384
slides. See Keynote application
slideshows
Keynote application, 337-338
Photos application, 239
Smart Albums, 243-244
Smart Playlists, iTunes, 221
Smart Zoom, two-finger, 53
social media
restricting access to, 178
sending photos to, 260



Index 4 ’3

software. See applications
software instrument tracks,
GarageBand, 285, 286
software piracy, 395
solid-state drives, 20-21
song information, iTunes, 222-224
Songwriter project, GarageBand, 286
sound. See audio
Spaces feature, 75-76, 105-106
speakers, streaming audio to, 102
spell-checking, 310-311
Split View, 89-91, 239
sports, finding info about, 119
Spotlight feature
basic search, 117-120
customizing, 123-125
expanding into Finder search
window, 122-123
overview, 117
preferences for, 100-101, 123-124
security and, 121, 124-125
spreadsheets. See also columns, in
spreadsheets; Numbers application;
rows, in spreadsheets
characters in, 319
creating, 314-315
currency in, 319
opening, 315-316
overview, 314
printing, 326-327
reverting to older version, 316
saving, 316, 326
spring-loaded folders, 67
SSL (Secure Sockets Layer) connection, 396
Stacks feature, 80-81
standard level user accounts, 169, 173
Standard mode, Maps application, 136
stands, 37
starting up laptop. See turning on laptop
start-up keys, 345
status bar
Finder window, 66
Safari browser, 143
Stealth mode, 206
stocks, finding info about, 119
stolen laptop, 385
Stop button, Safari browser, 146

storage. See also external drives;
hard drives
on hard drive, freeing up, 367-371
in iCloud, 166
overview, 15-16
stores, restricting access to, 177
streaming content
photos, 165, 259
to TV, 102
subfolders, 73
subnet mask, 200
Suggested Faces thumbnail, Photos
application, 247
SuperDrive optical drive, 22, 362
support
Apple MacBook Support site, 353
Apple support center, 85
El Capitan Help system, 85
local service, 353
OS X Help Center, 353
user groups, 86
websites, 86
surge suppressors, 30-31
switches, network, 198
switching
between applications, 71, 105
between user accounts, 182-183
from Windows to Mac, 2
synchronization. See iCloud
System Administrator account, 395
System Information utility, 352
System Preferences
accessing, 98
Apply button, 100
changes in, problems caused by, 349
copying settings to another MacBook, 41
Desktop & Screen Saver pane, 103-104
Displays pane, 101-102
Dock pane, 110-111
Energy Saver pane, 108-109
General pane, 106-108
iCloud Preferences pane, 113-115,
164-165
Mission Control preferences
pane, 105-106
Notifications preferences pane, 115-116
organizing panes in, 99
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System Preferences (continued)
overview, 97-100
Sharing pane, 111-112
Spotlight Search box, 100-101, 123-124
Time Machine pane, 112-113
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tables, Pages application, 307-309
tabs

Finder, 69

Safari browser, 142, 154-155
tactile feedback, 12
Tap to Click check box, 52
tasks, automating, 376-378
Technical Stuff icon, 3
TechTool Pro software, 394
templates

Numbers application, 314

Pages application, 302
text

deleting, 70

editing, in Pages, 305

entering, in Pages, 305

in movies, 275-276

presenter’s text notes, 332, 335-336

size of, in Safari browser, 146

on slides, 334-335
text boxes

Keynote application, 334

Pages application, 306
text log files, 179
Theater mode, iMove application, 277
themes

for Keynote presentations, 330

for movies, 263

for slideshows, 257
Three Finger Drag check box, 52
three-key shortcuts, 71
Thunderbolt connector, 197-198
Thunderbolt Express Dock, 31-32
Thunderbolt external drive, 363
Thunderbolt port, 14
Time Capsule. See AirPort Time Capsule
time limits on laptop use, 177
Time Machine feature, 112-113, 373-375
Timeline, GarageBand, 283
Time/Tempo display, GarageBand, 283
Tip icon, 3

titles, in movies, 275-276
Toast Titanium software, 265, 373
Toolbars, toggling, 61
Top Sites display, Safari browser,
144, 146, 153
Track list, GarageBand, 282
trackball, 52
tracker applications, 385
tracking user actions, 179
trackpads
condition of, 35
on different MacBook types, 18
Force Click feature, 53
Multi-Touch feature, 53
overview, 12, 51
preferences for, 52
right-clicking using, 54
using with Safari browser, 145, 154
tracks, GarageBand
adding, 285-287
Arrangement track, 292-293
bass tracks, 285
drummer tracks, 285
electric guitar tracks, 285
muting, 291
real instrument tracks, 285
settings for, 293-294
software instrument tracks, 285
video sound tracks, 285
volume of, 291
trailers, movie, 262-263, 278-280
Transit mode, Maps application, 136
transitions, in movies, 274-275
trash, 82-83, 350
triangular discs, 393
troubleshooting. See also support
checking cables, 349
checking Internet and network
connections, 350
checking login items, 351
checking trash, 350
Disk Utility and, 346-348, 349
investigating recent changes, 348-349
overview, 341-342
rebooting, 342-344
running virus scan, 350-351
special keys for, 344-345
System Information utility, 352
turning off screen saver, 351-352
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turning off
Bluetooth, 386-387
Wi-F, 386-387
turning off laptop
preferences for, 109
trouble with, 343
turning on laptop, 109
TV, streaming content to, 102
Twitter, sending photos to, 260

olf o

undoing actions
keyboard shortcut for, 71
Photos application, 245, 252
uninterruptible power supply (UPS), 30-31
UNIX, OS X El Capitan and, 51
unpacking MacBook, 24-25
unsecured wireless networks, 396
updates to this book, 4
updating OS X, 349, 378-379
upgrading
hard drive, 361-365
to new MacBook, 10
utility programs, 394
UPS (uninterruptible power supply), 30-31
USB 1.1 storage devices, 392
USB add-ons, 365
USB dial-up modems, 191
USB flash drives, 20-21, 242, 363
USB piano keyboard, 365
USB ports, 14, 19, 363
USB SuperDrive optical drive, 22, 362
USB-to-Ethernet connector, 197-198
USB-to-MIDI converters, 294
user accounts. See also parental controls
account names, 170-171
adding, 170-172
administrator account, 168-169
copying to another MacBook, 41
deleting, 173-174
Guest account, 175
images for, 172-173
levels of, 169
logging in, 182-184
logging out, 184
login items, 175-176

modifying, 172-173
overview, 167-168
passwords for, 171, 182
public-access, 181
sharing files between, 184-185
sharing-only, 170
standard level, 169, 173
switching between, 182-183
username for, 182

user groups, 86

utility programs, upgrading, 394

oo

video card, 17
video clips. See clips, video (iMovie)
video controllers, 365
video sound tracks, GarageBand, 285
videos, 212, 219. See also iMovie
application

Viewer control, iMovie application, 264
Viewer pane, Photos application, 239
view-only documents, 312
virtual desktop. See Spaces feature
Virtual Private Network (VPN) client, 396
Virus Barrier X8 software, 350
viruses. See security
Visual Equalizer window, GarageBand, 294
Visualizer, iTunes, 233
Voiceover controls, iMovie application, 270
volume

adjusting, 70

of tracks, in GarageBand, 291
volumes, adding to Dock, 79-80
VPN (Virtual Private Network) client, 396

o/ o

Warning icon, 3
warranty, 364, 397. See also AppleCare
Protection Plan
wastebasket. See Trash
WAV format, 212
weather, finding info about, 119
web addresses
format for, 3
of radio stations, 227
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web browsers, 107. See also Safari browser

web surfing. See also Safari browser
overview, 27
searching, 28
webcams, 30, 31
websites. See also Safari browser
adding to Dock, 80
restricting access to, 177
searching, 119, 144-145
support, 86
WEP encryption, 196
whiteboards, interactive, 338
widescreen display, 11, 18
widgets
adding to Dashboard, 76
displaying, 76
in Notification Center, 133
rearranging, 77
removing, 77
for searches, 28
using contents of web page, 147
Wi-F, turning off, 386-387
wiggling icons, 56
Wiley For Dummies website, 85
windows
active, determining, 62
arranging, 60
closing, 61-62, 71, 108
on Desktop, 50
grouping by applications, 105
minimizing, 59-60, 71, 110
moving, 59-60
open, displaying all, 74
resizing, 58-59
restoring, 59-60
scrolling in, 58-59
zooming, 59-60, 110

Windows
importing from, 42-43
pinging PC running, 202
switching to Mac from, 2
using on MacBook, 29

wired networks. See also networks
combining with wireless, 189
connecting non-Retina MacBook

Pro to, 198

hardware for, 198-199
joining, 199-200
overview, 197-198
speed of, 190
vs. wireless, 190-191

wireless networks. See also networks
base stations and, 192-196
combining with wired, 189
Ethernet, 16, 41
file transfer via, 197
joining, 192, 195-196
overview, 192
unsecured, 396
vs. wired, 190-191

Word application, 303

workflows, 377

WPA2 encryption, 196

wrist rest, 32

o/ o

zooming
Photos application, 239
two-finger, 53
windows, 59-60, 110
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